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G U Í A  D E  L E C T U R A

Cómo leer este manual

Cada entrada de este manual sigue el mismo esquema. En el lado izquierdo están las 
rutas de operación y los detalles técnicos; a la derecha, en una barra lateral cálida, 
encuentras siempre la explicación en lenguaje claro. Pequeños iconos al inicio de cada 
línea te indican de un vistazo qué tipo de información viene a continuación.

LO S  C U AT R O  I C O N O S

Dónde lo encuentro. La ruta concreta de clics por la app — barra de menús, 
sección del Inspector o paso del modo principiante. Aquí también aparecen los 
atajos de teclado asociados. El icono es un pin de mapa y muestra: aquí se sitúa 
la función en la interfaz de usuario.

Detalles. Valores predeterminados, rangos de valores y rutas de código. Te lo 
encuentras sobre todo en los ajustes de entrenamiento, que no son una entrada 
de menú sino parámetros numéricos. El icono muestra una pequeña tarjeta de 
especificación.

Técnico. Lo que la función hace internamente, qué parámetros surten efecto, 
a qué reacciona y qué efectos secundarios tiene. Para lectores que quieren 
entender qué está pasando detrás de las bambalinas. El icono es un bloque de 
deslizadores y representa simbólicamente las palancas bajo el capó.

En pocas palabras. El mensaje principal con palabras claras — sin jerga, sin 
código. Lee esta sección primero si solo quieres saber rápidamente para qué 
sirve una función y cuándo la necesitas. El icono es un bocadillo y representa 
«en resumen». Esta columna siempre está sobre un tono arena cálido para que 
el ojo la encuentre de inmediato.

C O LO R E S  D E  CA P Í T U LO S

Cada capítulo tiene su propio color de acento, que reconocerás por la insignia de ID 

(por ejemplo M1 ) a la izquierda de cada título de entrada y por los pequeños iconos 
previos. Al hojear, ves de un vistazo en qué capítulo te encuentras.

1 Menús 2 Inspector 3 Ajustes
4

Ventanas auxilia
res

6 Entrenamiento

7
Ajustes preesta
blecidos

8 Exportaciones 9 SfM
10

Modo princi
piante



C O N S E J O S  D E  N AV E G A C I Ó N

Inicio rápido. Si solo te interesa la operación de la app, salta directamente al 
Capítulo 10 — Modo principiante. Es la variante guiada con cuatro pasos y no 
requiere conocimientos previos.

Profundizando. Capítulo 2 — Inspector y Capítulo 7 — Ajustes preestableci­
dos explican los controles y los perfiles de calidad preconfigurados disponibles 
en el Modo Experto.

Consultar. El índice y la búsqueda de texto completo del PDF te ayudan a encon
trar una función concreta. No tienes que leer el manual de principio a fin.



R A D I A N C E K I T

C A P Í T U L O

Introducción — Lo que debes saber

¿Qué es RadianceKit?

RadianceKit es una app nativa de macOS que convierte una serie de fotos normales o 
un vídeo en una reconstrucción 3D recorrible. La entrada es, por ejemplo, de 50 a 500 
tomas que hayas hecho alrededor de un objeto, por una habitación o sobre un paisaje. 
La salida es lo que se conoce como una escena de Gaussian-Splatting — un modelo 3D 
que puedes ver en el Mac en tiempo real desde cualquier ángulo, que se puede expor
tar e incrustar en sitios web y que, en sus aspectos principales, parece fotorrealista.

La app funciona por completo de forma local en tu Mac — no se suben imágenes 
a la nube, no se requiere login y no hay suscripción. Hace uso intensivo de la GPU 
de tu Mac con Apple Silicon (serie M): un entrenamiento completo puede durar entre 
dos minutos y varias horas según la escena y el ajuste preestablecido. Mientras la 
computación está en curso, puedes seguir trabajando con total normalidad en el Mac; 
RadianceKit continúa en segundo plano y te avisa cuando el resultado está listo.

Hay dos modos de operación: el Modo principiante (Simple Mode) te guía en cuatro 
pasos por el flujo Importar → Elegir ajuste preestablecido → Entrenar → Exportar. El 
Modo Experto (Expert Mode) abre un gran Inspector con todos los controles, una ven
tana de previsualización en vivo y gráficos de diagnóstico. Puedes cambiar entre modos 
en cualquier momento; los datos de la escena se conservan.

¿Qué es Gaussian Splatting?

Gaussian Splatting (a menudo abreviado como 3DGS o simplemente Splatting) es un 
método relativamente nuevo para representación 3D fotorrealista, presentado en 2023 
en un paper de Graz e INRIA. La idea: en vez de modelar una escena como una malla 
clásica de polígonos (triángulos) o como una rejilla de vóxeles, se compone a partir 
de millones de pequeñas y suaves «nubecitas» 3D — cada nubecita individual es una 
distribución Gaussiana 3D (de ahí el nombre) con su propia posición, tamaño, forma, 
color y transparencia. Estas nubecitas se entrenan para que, en conjunto desde todos 
los ángulos de visión de tus fotos de entrada, den la imagen correcta.
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En la práctica, esto significa que Gaussian Splatting puede representar reflejos, brillos, 
follaje suave, pelo o cortinas como no puede el modelado 3D clásico — o solo a un 
coste enorme. A cambio, el resultado no es un modelo 3D editable en sentido clásico — 
no puedes simplemente mover una pared o reubicar un jarrón. Es más bien una captura 
congelada del espacio por la que puedes moverte con libertad. Para muchas aplicacio
nes — visualización arquitectónica, presentación de producto, tours virtuales, ciencias 
forenses, patrimonio cultural — esa es exactamente la fortaleza adecuada.

Para convertir las imágenes de entrada en una escena 3D se necesitan dos pasos. 
Primero, la app calcula mediante un proceso llamado Structure-from-Motion (SfM) 
dónde estaba la cámara en cada foto. Como subproducto, se genera una nube de 
puntos gruesa de la escena. Después comienza el entrenamiento Gaussian-Splatting 
propiamente dicho: partiendo de esa nube gruesa, los millones de «nubecitas» 3D se 
distribuyen, hacen crecer, refinan y reajustan en posición y color de forma gradual has
ta que, desde todos los ángulos de visión de entrada, dan la imagen correspondiente.

No tienes por qué saber nada de esto para usar RadianceKit. El modo principiante ocul
ta por completo estos pasos. Pero si quieres entender qué significan los números de 
diagnóstico del Modo Experto (iteración, loss, Gaussianos, SSIM …) o por qué algunas 
escenas quedan más bonitas que otras, los capítulos posteriores del manual te darán 
las respuestas.
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C A P Í T U L O

Capítulo 1 — Barra de menús

La barra de menús de RadianceKit organiza todas las funciones que no se encuentran 
directamente en la ventana principal o el Inspector. Son sobre todo acciones que 
afectan a toda la escena (Open, Save, New Project), controlan el entrenamiento (Start, 
Pause, Continue), manejan la vista 3D (auto-rotación, captura de pantalla, color de 
fondo) y disparan exportaciones a varios formatos 3D y multimedia. Además, hay acce
sos a todas las ventanas auxiliares (User Guide, Pareto Dashboard, Holdout Analysis, 
BayesOpt Console).

Los atajos de teclado se enumeran a la derecha de cada entrada de menú. Convencio
nes: ⌘  es la tecla Command (tecla de Apple), ⇧  es Shift, ⌥  es Option (Alt) y ⌃  
es Control. Ejemplo: ⇧⌘T  significa Shift+Command+T. Todos los atajos documentados 
aquí también se enumeran en una ventana general dedicada en Help → Keyboard
Shortcuts (⌘/​).

Las siguientes 42 entradas están documentadas en orden de inventario (M1–M42), 
agrupadas por el menú de nivel superior al que pertenecen. Todas las entradas se han 
verificado contra el estado actual del código (líneas 175–477). No se han eliminado ni 
reemplazado entradas respecto al inventario; el sistema NSUndoManager proporciona 
una nueva entrada del menú Edit (Cmd-Z para «Remove Image») y por eso no aparece 
en el código de RadianceKitApp (véase la nota al final del capítulo).
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R A D I A N C E K I T Capítulo 1 — Barra de menús

Menú File

Figura 1:  Menú File expandido — entradas M1 a M6

El menú File reemplaza la entrada estándar «New Window» de Apple por acciones 
específicas del proyecto. Cubre la carga/guardado de escenas, una lista dinámica de 
Recientes, la importación de workspace y un reinicio total a un estado vacío.

M1 File > Open Scene…

D Ó N D E

Barra de menús → File → Open Scene… (⌘O).

T É C N I C O

Abre un diálogo de archivo para los formatos pa
quete RadianceScene , .ply , .splat  y .spz . 
Selección única, puede mostrar tanto archivos co
mo directorios (para el formato de paquete). Tras 
una selección correcta, la ruta se añade a la lista 
de Recientes y la escena se carga de forma asín
crona — la anterior se reemplaza y la pipeline 
de entrenamiento se inicializa con el estado carga
do. Los archivos PLY/SPZ/Splat se leen mediante 
sus respectivos cargadores de formato; el paque
te .radiancescene  es un directorio con manifest, 
snapshot de la nube y resultado de SfM.

E N  P O CA S  PA L A B R A S

Así recargas en la app una esce­
na ya entrenada. Funciona con 
el formato propio de RadianceKit 
y con los formatos estándar PLY, 
SPLAT y SPZ que producen otros 
programas de splatting. Úsalo 
cuando, p. ej., hayas entrenado 
una escena durante la noche y 
quieras seguir o exportar al día 
siguiente. Al abrir, el estado ac­
tual de la ventana principal se 
reemplaza — así que guarda an­
tes si la escena actual aún te im­
porta. La ruta aterriza automáti­
camente en «Open Recent» (M3) 
para que vuelvas más rápido la 
próxima vez.
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R A D I A N C E K I T Capítulo 1 — Barra de menús

M2 File > Save Scene…

D Ó N D E

Barra de menús → File → Save Scene… (⌘S).

T É C N I C O

Abre un diálogo de guardar archivo con el tipo 
de contenido paquete RadianceScene  y un nombre 
de archivo precargado scene.radiancescene. Escri
be un paquete de directorio con manifest.json , la 
nube Gaussiana serializada (snapshot PLY) y un vol
cado del resultado de SfM, de modo que el entrena
miento continuado también funcione tras reabrir. La 
entrada está deshabilitada mientras no existan aún 
Gaussianos. No guarda en la ruta de logs de entre
namiento, sino donde apunte el diálogo de guardar 
— típicamente en ~/​Documents/​.

E N  P O CA S  PA L A B R A S

Guarda tu escena actual como 
archivo (más exactamente: co­
mo una carpeta paquete que pa­
rece un archivo). Solo después 
podrás reabrirla más tarde con 
«Open Scene…» (M1). El paquete 
contiene tanto la nube Gaussia­
na como el resultado de SfM, 
así que también puedes añadir 
entrenamiento continuado (M12–
M14) después. Mientras no ha­
yas terminado un entrenamien­
to, la entrada aparece atenua­
da. El nombre predeterminado es 
scene.radiancescene — pero 
en el diálogo de guardar puedes 
ponerle tu propio nombre.

M3 File > Open Recent > [nombres de escena]

D Ó N D E

Barra de menús → File → Open Recent → (lista).

T É C N I C O

Submenú dinámico generado a partir de una lista 
de rutas abiertas recientemente (guardadas en los 
ajustes). Cada entrada de la lista está etiquetada 
con el nombre de archivo y se carga al hacer clic. 
Si la lista está vacía, aparece en su lugar la etiqueta 
deshabilitada «No Recent Scenes». Al estilo Apple, 
la lista contiene las N escenas abiertas más recien
temente — el límite se aplica al escribir en los 
ajustes, no en el constructor del menú.

E N  P O CA S  PA L A B R A S

Aquí ves las escenas abiertas 
más recientemente y puedes sal­
tar a una con un clic, sin pasar 
por el diálogo de archivo. Si aca­
bas de empezar, la lista está 
vacía y atenuada en el menú. Ca­
da escena que abres mediante 
«Open Scene…» (M1) aterriza au­
tomáticamente en esta lista. Si 
la lista llega a estar demasiado 
llena o quieres limpiarla por ra­
zones de privacidad, usa «Clear 
Recent» (M4).
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R A D I A N C E K I T Capítulo 1 — Barra de menús

M4 File > Open Recent > Clear Recent

D Ó N D E

Barra de menús → File → Open Recent → Clear 
Recent.

T É C N I C O

Borra la lista de Recientes en los ajustes. Surte 
efecto de inmediato, sin diálogo de confirmación. 
La entrada solo aparece en el submenú cuando 
hay efectivamente entradas en la lista de Recientes 
(queda bajo un separador después de las rutas).

E N  P O CA S  PA L A B R A S

Borra la lista de escenas abiertas 
recientemente. Útil cuando has 
estado jugueteando con un data­
set de prueba y ya no quieres ver 
las rutas. Los archivos de escena 
en sí no se eliminan — solo el 
enlace en el menú. La acción sur­
te efecto de inmediato, sin con­
firmación; después, el submenú 
muestra «No Recent Scenes». La 
entrada solo se ve si hay efecti­
vamente escenas en la lista — 
cuando está vacía, es invisible.

M5 File > Import COLMAP / Metashape Workspace…

D Ó N D E

Barra de menús → File → Import COLMAP / Me
tashape Workspace… (⇧⌘I).

T É C N I C O

Abre un selector de carpeta. Espera una carpe
ta con el layout de workspace COLMAP (p. ej., 
sparse/​0/​cameras.{bin,txt} más images/​). Tras la 
selección, se ejecuta una comprobación previa del 
workspace — detecta los tres layouts (sparse/​0/​
, sparse/​, raíz) y si la reconstrucción es bina
ria ( cameras.bin ) o en formato de texto ETH3D 
( cameras.txt ). Si todo está bien, se importa el 
workspace; en caso contrario, solo aparece un aviso 
en el registro de la app. Véase también el Capítulo 9 
«Backends de SfM», Q6 para la lógica completa de 
la pipeline.

E N  P O CA S  PA L A B R A S

Si usas Metashape, COLMAP, 
RealityCapture o un software si­
milar para la reconstrucción de 
cámara y tienes una exportación, 
carga la carpeta aquí. Radiance­
Kit se salta entonces la etapa de 
SfM y empieza a entrenar direc­
tamente — lo que ahorra horas 
en escenas grandes. Arrastrar 
y soltar sobre la ventana prin­
cipal funciona igual. Se espera 
una carpeta con el layout COL­
MAP (es decir, sparse/​0/​ con 
cameras.*  más una carpeta 
images/​). Más información so­
bre los layouts y flujos soporta­
dos en el Capítulo 9 «Backends 
de SfM».
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M6 File > New Project

D Ó N D E

Barra de menús → File → New Project (⇧⌘N).

T É C N I C O

Comprueba si hay trabajo sin guardar. En ese caso, 
aparece un diálogo de confirmación antes de perder 
nada. Si no hay nada que guardar, el reinicio se 
ejecuta de inmediato — limpia las imágenes impor
tadas, el resultado de SfM, la nube Gaussiana, el 
estado del entrenamiento y todos los indicadores 
de UI dependientes. Nota: la biblioteca de ajustes 
preestablecidos creada por el usuario se conserva 
porque vive en los ajustes de la app y no en el 
estado del proyecto.

E N  P O CA S  PA L A B R A S

Restablece todo a un inicio vacío 
— como si acabaras de abrir la 
app recién. Si aún tienes traba­
jo sin guardar, la app pregunta 
primero. Úsalo cuando quieras 
empezar de cero con una esce­
na completamente distinta. Las 
imágenes importadas, el resulta­
do de SfM, la nube Gaussiana y el 
estado de entrenamiento se lim­
pian por completo. Tus propios 
ajustes preestablecidos se con­
servan, en cambio, porque viven 
en los ajustes de la app y no per­
tenecen a la escena.

Menú Mode

Figura 2:  Menú Mode con conmutadores Simple y Expert Mode

Dos conmutadores simples entre el Simple Mode guiado (tipo asistente, 4 pasos) y el 
Expert Mode completo (layout clásico del Inspector con todos los controles).
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R A D I A N C E K I T Capítulo 1 — Barra de menús

M7 Mode > Simple Mode

D Ó N D E

Barra de menús → Mode → Simple Mode (⌘1).

T É C N I C O

Cambia el estado de la app a Simple Mode. El área 
principal de la app muestra entonces el flujo guiado 
en lugar del layout experto. El estado de modo se 
guarda en los ajustes (véase S1 «Default Mode» en 
el Capítulo 3 Settings).

E N  P O CA S  PA L A B R A S

Cambia a la variante paso a pa­
so en la que la app te guía por 
importar, procesar, previsualizar 
y exportar. Recomendado si es­
tás empezando o necesitas un 
resultado rápido. La mayoría de 
los controles de detalle están 
ocultos — trabajas con predeter­
minados sensatos. Si más tarde 
quieres profundizar, cambia sim­
plemente a Expert Mode (M8). 
Cuál es el modo activo al iniciar 
la app se puede configurar en los 
ajustes (Capítulo 3, S1).

M8 Mode > Expert Mode

D Ó N D E

Barra de menús → Mode → Expert Mode (⌘2).

T É C N I C O

Cambia el estado de la app a Expert Mode. Esto 
despliega el layout completo del Inspector con to
das las secciones (Presets, TrainingConfig, Enhan
cements, Metrics, LossChart, ProjectNavigator). En 
Expert Mode son accesibles todos los parámetros 
de entrenamiento, el selector COLMAP, los conmu
tadores mid-compact y los diagnósticos. La previ
sualización en vivo también funciona solo en este 
modo.

E N  P O CA S  PA L A B R A S

Cambia a la vista completa con 
todos los controles. Aquí ves grá­
ficas de loss en tiempo real, 
puedes afinar todos los paráme­
tros y gestionar en paralelo va­
rias configuraciones de compa­
ración mediante ajustes preesta­
blecidos. Recomendado si quie­
res entender qué está haciendo 
el entrenamiento internamente o 
si quieres experimentar de ma­
nera dirigida. La previsualización 
en vivo, el selector COLMAP y 
los diagnósticos también son ac­
cesibles solo aquí. Si te sientes 
abrumado, vuelve a Simple Mode 
mediante M7 — tu escena se 
conserva en el proceso.
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Menú Training

Figura 3:  Menú Training con el submenú Continue — entradas M9 a M14

Cuatro acciones en torno al run de entrenamiento: iniciar, pausar, cancelar y extender 
por un número fijo de iteraciones. Las tres entradas Continue tienen bloqueo IAP (no 
son clicables en la versión de prueba gratuita).

M9 Training > Start Training

D Ó N D E

Barra de menús → Training → Start Training (⇧⌘T).

T É C N I C O

Inicia la pipeline de entrenamiento de forma asín
crona. Requisito: existe un resultado de SfM y no 
hay otra pipeline en curso. Ambas condiciones blo
quean la entrada si no se cumplen. Al iniciar, se 
leen los valores de configuración actuales, se crea 
un nuevo log JSONL en ~/​Documents/​RadianceKit/​
Logs/​training_​YYYY-MM-DD_​HHmmss.jsonl y, según 
la elección de estrategia, se toma la vía clásica o la 
MCMC. El estado de entrenamiento pasa de «idle» 
a «training».

E N  P O CA S  PA L A B R A S

Pulsa el gran botón verde — una 
vez hayas importado las fotos 
y hecha la reconstrucción de cá­
mara, arranca el entrenamiento 
Gaussian-Splatting propiamente 
dicho. Deja correr la app; según 
el ajuste preestablecido, entre 1 
minuto (Quick) y varias horas 
(MCMC Quality). La entrada se 
mantiene atenuada mientras no 
haya aún un resultado de SfM 
o haya otra pipeline en curso. 
Cada run escribe además un log 
en ~/​Documents/​RadianceKit/​
Logs/​, que luego puedes ana­
lizar mediante el Pareto Dash­
board (M40).
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M10 Training > Pause Training

D Ó N D E

Barra de menús → Training → Pause Training.

T É C N I C O

Pausa el entrenamiento en curso. Solo está habi
litado cuando el estado de entrenamiento es «trai
ning». Pausar detiene el bucle de iteración en el 
siguiente punto seguro de sincronización, mantiene 
todo el estado GPU (buffers de Gaussianos, mo
mentos del optimizador, posición del scheduler) y 
cambia a «paused». Reanudar ocurre pulsando de 
nuevo (el título de la entrada es estático — pero 
la app alterna entre Pause/Resume en la lógica 
real). Los entrenamientos pausados no sobreviven 
al cierre de la app; en ese caso, guarda la escena 
y extiéndela más tarde mediante una entrada Conti
nue Training (M12–M14).

E N  P O CA S  PA L A B R A S

Detiene brevemente el entrena­
miento sin perder progreso. Útil 
cuando necesitas el ordenador 
para algo más importante por 
un momento. Haz clic de nue­
vo para reanudar. No funciona 
entre reinicios de la app — si 
quieres continuar realmente más 
tarde, termina el entrenamiento 
con Cancel (M11), guarda la es­
cena con Save Scene (M2) y lue­
go usa Continue Training (M12–
M14). Durante la pausa la GPU 
está totalmente inactiva; la me­
moria, sin embargo, permanece 
reservada.

M11 Training > Cancel Training

D Ó N D E

Barra de menús → Training → Cancel Training.

T É C N I C O

Cancela el entrenamiento en curso. Activo cuando 
el estado de entrenamiento no es «idle». Establece 
la bandera de cancelación en el motor de entrena
miento, que termina limpiamente el bucle de itera
ción en el siguiente punto de sincronización, escribe 
la entrada de resumen final en el log JSONL y resta
blece el estado a «idle». La nube entrenada hasta 
ese momento se conserva (se puede guardar o ex
portar) pero queda marcada como «cancelled».

E N  P O CA S  PA L A B R A S

Cancela definitivamente el en­
trenamiento en curso. El estado 
actual se conserva — así que si 
tras unas miles de iteraciones ya 
tienes un resultado presentable, 
aún puedes exportarlo. Si solo 
quieres interrumpir brevemente, 
usa Pause (M10) en su lugar. En 
el log de entrenamiento, el run 
se marca como «cancelled» y el 
valor final de loss aún se escri­
be. Una escena cancelada tam­
bién se puede continuar median­
te Continue Training (M12–M14) 
más tarde, siempre que entre­
tanto no se haya cerrado la app.
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M12 Training > Continue Training > +5.000 iteraciones

D Ó N D E

Barra de menús → Training → Continue Training → 
+5,000 iterations.

T É C N I C O

Continúa el entrenamiento durante 5.000 iteracio
nes más. Activo cuando un entrenamiento comple
tado es reanudable y la versión completa está des
bloqueada. La reanudabilidad se da cuando existe 
un entrenamiento completado y todo el estado del 
optimizador sigue en memoria. Al continuar, los mo
mentos de Adam y el scheduler de LR se conservan, 
así que la continuación se comporta como un run 
continuo de 25K/45K/60K en lugar de un reinicio. El 
log JSONL recibe una nueva entrada de config con 
el setup incremental. Solo disponible en la versión 
completa.

E N  P O CA S  PA L A B R A S

Añade otros 5.000 pasos de en­
trenamiento. Úsalo cuando el re­
sultado tras el primer run esté 
cerca, pero aún no del todo níti­
do. Solo funciona en la versión 
completa de pago. A diferencia 
de un run totalmente nuevo, el 
estado del optimizador se con­
serva, así que la continuación se 
siente como un run continuo. Si 
necesitas más de 5.000 pasos, 
ve directo a M13 (+10.000) o M14 
(+20.000).

M13 Training > Continue Training > +10.000 iteraciones

D Ó N D E

Barra de menús → Training → Continue Training → 
+10,000 iterations.

T É C N I C O

Idéntico a M12, pero con 10.000 iteraciones adicio
nales. Mismos requisitos, misma vía del scheduler 
de LR. Recomendado cuando el entrenamiento ini
cial se ejecutó con un ajuste preestablecido inter
medio y quieres ver una mejora significativa sin 
reiniciar el run desde cero.

E N  P O CA S  PA L A B R A S

Extiende el entrenamiento en 
10.000 pasos — el del medio de 
los tres valores Continue dispo­
nibles. Buena elección cuando el 
primer run estuvo bien pero aún 
quieres mejorar claramente. Co­
mo en M12 y M14, el schedule de 
la tasa de aprendizaje continúa 
de forma fluida en lugar de reini­
ciarse. Solo disponible en la ver­
sión completa.
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M14 Training > Continue Training > +20.000 iteraciones

D Ó N D E

Barra de menús → Training → Continue Training → 
+20,000 iterations.

T É C N I C O

Idéntico a M12 / M13, pero con 20.000 iteraciones 
adicionales. El mayor salto Continue preestablecido. 
En entrenamientos MCMC suele ser lo que marca la 
diferencia entre «vale» y «calidad de benchmark»; 
en Classic, más allá de 35–40K la experiencia 
muestra que se añade poco.

E N  P O CA S  PA L A B R A S

Añade 20.000 pasos de entrena­
miento adicionales, el valor má­
ximo de Continue. Úsalo cuando 
de verdad quieras exprimir el úl­
timo ápice de calidad. En entre­
namientos clásicos más allá de 
40.000 pasos esto a menudo no 
aporta mucho más — mientras 
que en MCMC suele valer la pena, 
porque la convergencia se esta­
blece más despacio allí. Espera 
un tiempo de ejecución extra sig­
nificativo según la escena. Como 
M12 y M13, esta entrada también 
solo está disponible en la versión 
completa.

Menú Viewport

Figura 4:  Menú Viewport con Edit Mode, controles de cámara y submenú Background

Controla la vista 3D: Edit Mode para selección y limpieza de Gaussianos, controles de 
cámara (auto-rotación, reproducción, grabación), captura de pantalla, color de fondo y 
reset.
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M15 Viewport > Enter/Exit Edit Mode

D Ó N D E

Barra de menús → Viewport → Enter Edit Mode (o 
«Exit Edit Mode», según el estado). ⇧⌘E.

T É C N I C O

El título de la entrada es dinámico y muestra «Exit 
Edit Mode» o «Enter Edit Mode» según el estado. Al 
pulsar, se conmuta el Edit Mode en el renderer de la 
vista. Al salir del Edit Mode, la selección actual tam
bién se restablece. El Edit Mode activa la selección 
por clic sobre Gaussianos, la selección por caja y el 
borrado de Gaussianos marcados (véase el área de 
editor de la UI). Deshabilitado mientras no haya un 
renderer de vista adjunto.

E N  P O CA S  PA L A B R A S

Alterna entre la vista 3D normal 
y un modo de edición en el que 
puedes marcar y eliminar Gaus­
sianos individuales (p. ej., floa­
ters o outliers en el fondo). Al 
salir, la selección se restablece 
automáticamente. La entrada se 
mantiene atenuada mientras no 
haya aún una escena visible en 
la vista. La etiqueta cambia entre 
«Enter Edit Mode» y «Exit Edit 
Mode» según el estado — así 
siempre sabes en qué modo es­
tás.

M16 Viewport > Toggle Auto-Rotation

D Ó N D E

Barra de menús → Viewport → Toggle Auto-Rotation 
(⌘⌥T).

T É C N I C O

Activa o desactiva la rotación continua de la cámara 
de la vista alrededor de un eje vertical a través del 
centro de la escena. El eje y la velocidad provienen 
de la configuración del control de cámara. La auto-
-rotación es un efecto puramente de vista y no 
influye ni en el entrenamiento ni en la grabación — si 
usas en paralelo la grabadora de vídeo de plato gi
ratorio (M18), la auto-rotación entrega exactamente 
la trayectoria que la grabadora captura.

E N  P O CA S  PA L A B R A S

Rota continuamente la cámara 
despacio alrededor de tu escena 
para verla desde todos los lados 
sin arrastrar con el ratón. Haz 
clic de nuevo para detener la ro­
tación. Útil al revisar escenas ya 
entrenadas o como animación de 
fondo para una demostración en 
vivo. Si grabas un vídeo en pa­
ralelo (M18), la auto-rotación en­
trega exactamente el movimien­
to que la grabadora captura.
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M17 Viewport > Toggle Camera Playback

D Ó N D E

Barra de menús → Viewport → Toggle Camera Play
back.

T É C N I C O

Alterna la reproducción de la trayectoria de cámara. 
Si existe una trayectoria de cámara grabada (p. ej., 
de una grabación previa o porque se ha cargado un 
transforms.json ), la trayectoria se reproduce — la 

cámara de la vista ya no se mueve en respuesta 
al ratón/trackpad, sino que reproduce la trayectoria 
fotograma a fotograma. Pulsar de nuevo pausa la 
reproducción.

E N  P O CA S  PA L A B R A S

Reproduce una trayectoria de cá­
mara grabada o importada pre­
viamente. Así puedes retrazar la 
trayectoria original con la que se 
capturó la escena, o comprobar 
un movimiento orbital planifica­
do antes de la exportación de 
vídeo. Mientras la reproducción 
está activa, las entradas de ratón 
y trackpad están deshabilitadas 
— la cámara sigue estrictamente 
la trayectoria. Hacer clic de nue­
vo pausa la reproducción. Si no 
has cargado ni grabado una tra­
yectoria, no pasa nada.

M18 Viewport > Record Turntable Video

D Ó N D E

Barra de menús → Viewport → Record Turntable 
Video.

T É C N I C O

Alterna la grabación de la vista. En la primera pulsa
ción arranca una grabación de fotogramas a una 
ruta temporal; en la segunda, la grabación se termi
na, se codifica y se escribe en una ruta MP4 (la ruta 
se pide mediante un diálogo de guardar). A diferen
cia de Export → Media → Orbit Video (M31), que 
produce una trayectoria 360° fija con una duración 
configurable, la grabadora de plato giratorio captura 
en vivo lo que ves en la vista — así también puedes 
grabar un movimiento de cámara manual.

E N  P O CA S  PA L A B R A S

Graba un vídeo directamente en 
la vista. Da igual si la cámara rota 
automáticamente o la mueves tú 
con el ratón — todo lo que ves 
se guarda en un archivo MP4. A 
diferencia de la exportación «Or­
bit Video» (M31), aquí controlas 
tú el movimiento de cámara. El 
primer clic arranca la grabación, 
el segundo la termina y pregun­
ta dónde guardar. Útil cuando, p. 
ej., quieres mostrar un travelling 
concreto de detalle que no sería 
posible con el movimiento orbital 
rígido.
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M19 Viewport > Save Screenshot

D Ó N D E

Barra de menús → Viewport → Save Screenshot 
(⇧⌘S).

T É C N I C O

Captura un único fotograma de la vista a resolución 
de renderizado completa (es decir, no el layout de 
píxeles de la ventana, sino el contenido completo 
del render target) como archivo PNG. La ruta se 
pide mediante un diálogo de guardar. El color de 
fondo (M21–M23) queda fijado. Los ajustes de ups
caling MetalFX/MPS de Enhancements (véase I27/
I28) surten efecto si están activos — la captura 
muestra entonces la salida upscaled.

E N  P O CA S  PA L A B R A S

Guarda una instantánea de tu 
vista 3D actual como imagen 
PNG. Útil para material de marke­
ting o una comparación rápida. 
Nota: el fondo es parte de la 
imagen — si necesitas transpa­
rencia, exporta en su lugar un 
archivo de escena. La resolución 
corresponde al render target in­
terno, no al tamaño de ventana 
— por eso la imagen suele ser 
más nítida de lo que se ve en 
la ventana. También entran los 
ajustes de upscaling cualesquie­
ra (Inspector → Enhancements).

M20 Viewport > Copy Camera Info

D Ó N D E

Barra de menús → Viewport → Copy Camera Info.

T É C N I C O

Lee la pose actual de la cámara de la vista (posi
ción, punto look-at, vector up) y los valores de FOV 
del control de cámara y los escribe como texto mul
tilínea al portapapeles. El formato es legible para 
humanos (etiqueta = valor por línea), no JSON. Útil 
para reproducir una vista concreta con fines de de
puración o para compartir con soporte.

E N  P O CA S  PA L A B R A S

Copia la posición y dirección 
de visión actuales de la cámara 
como texto al portapapeles. Si 
quieres, p. ej., mostrar a un com­
pañero de desarrollo dónde un 
punto de la escena se ve raro, 
solo tienes que pegar el texto en 
un correo o ventana de chat. El 
formato es legible para humanos 
(una línea por valor), no JSON. 
Pensado sobre todo para repor­
tes de bugs o solicitudes de so­
porte.
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M21 Viewport > Background > Dark Gray

D Ó N D E

Barra de menús → Viewport → Background → Dark 
Gray.

T É C N I C O

Establece el color de fondo de la vista a un gris 
oscuro (RGB 0,1/0,1/0,1). El renderer usa este color 
como fondo contra el que se componen los Gaus
sianos. El color predeterminado al iniciar la app se 
controla mediante la opción de ajustes S3 «Default 
Viewport Background».

E N  P O CA S  PA L A B R A S

Tiñe el fondo de la vista 3D de 
gris oscuro. Elección estándar 
para la mayoría de las escenas — 
ofrece buen contraste tanto para 
Gaussianos claros como oscuros 
sin que el ojo se ancle en un 
área puramente negra o blanca. 
El color también queda fijado en 
capturas (M19) y vídeos orbitales 
(M31). Si Dark Gray te resulta po­
co espectacular, prueba también 
Black (M22) o White (M23) para 
comparar. Cuál es el color activo 
al iniciar la app se puede confi­
gurar en los ajustes (S3).

M22 Viewport > Background > Black

D Ó N D E

Barra de menús → Viewport → Background → Black.

T É C N I C O

Establece el color de fondo de la vista a negro puro 
(RGB 0/0/0). Ayuda cuando la escena tiene muchos 
floaters brillantes y quieres identificarlos, o para 
material de marketing con un look-and-feel oscuro.

E N  P O CA S  PA L A B R A S

Fondo negro. Bueno para es­
cenas muy luminosas o cuan­
do quieres mirar en Edit Mode 
y buscar pequeños Gaussianos 
brillantes (floaters) que se pier­
den en el gris. También ideal 
para material de marketing con 
un look oscuro y dramático. El 
color queda fijado en capturas y 
vídeos orbitales — si necesitas 
transparencia para un composi­
te posterior, el negro es la peor 
elección. Para floaters oscuros, 
cambia al revés a White (M23).
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M23 Viewport > Background > White

D Ó N D E

Barra de menús → Viewport → Background → Whi
te.

T É C N I C O

Establece el color de fondo de la vista a blanco puro 
(RGB 1/1/1). Útil cuando la escena tiene contenido 
predominantemente oscuro y quieres ver floaters 
oscuros (ruido de fondo típico de exteriores).

E N  P O CA S  PA L A B R A S

Fondo blanco. Útil cuando el mo­
tivo se ve mejor claro sobre os­
curo, o para encontrar outliers 
oscuros que luego puedes elimi­
nar en Edit Mode (M15). En esce­
nas exteriores, el blanco es a 
menudo más útil que el negro, 
porque los floaters típicos de ex­
teriores tienden a ser oscuros. 
Como con las otras opciones de 
fondo, el color queda fijado en 
capturas y vídeos.

M24 Viewport > Reset Camera

D Ó N D E

Barra de menús → Viewport → Reset Camera.

T É C N I C O

Restablece la cámara de la vista, abandona la vista 
de la cámara de entrenamiento y detiene la auto-ro
tación. Eso devuelve la cámara a la posición inicial 
(típicamente: delante de la escena, mirando ligera
mente desde arriba), la auto-rotación queda apaga
da, y si el renderer estaba mostrando la cámara de 
entrenamiento (una de las poses de SfM), vuelve a 
la cámara libre.

E N  P O CA S  PA L A B R A S

Trae la cámara de la vista de 
vuelta a la posición inicial. Si te 
has perdido moviéndote o has 
empujado la escena fuera de 
cuadro — haz clic aquí una vez 
y vuelves a ver lo que deberías 
estar viendo. A la vez, apaga 
la auto-rotación si está activa y 
vuelve, desde una cámara de en­
trenamiento congelada, a la vis­
ta libre. Así obtienes un reinicio 
limpio de la vista en cualquier 
caso.
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Menú Export

Figura 5:  Menú Export con tres grupos de submenú — 3D Formats, Media y Photogram
metry

Ocho destinos de exportación más dos exportaciones de fotogrametría, agrupados en 
tres secciones (3D Formats, Media, Photogrammetry). Los seis primeros se construyen 
mediante una rutina helper común que abre un diálogo de guardar y registra la expor
tación en el catálogo de formato. Las entradas de fotogrametría tienen lógica individual. 
Todas las exportaciones de fotogrametría y algunas exportaciones 3D solo están dispo
nibles en la versión completa.

M25 Export > 3D Formats > Export PLY…

D Ó N D E

Barra de menús → Export → 3D Formats → PLY 
(⌘E).

T É C N I C O

Abre un diálogo de guardar con nombre de archivo 
predeterminado gaussians.ply . Al aceptar, la nu
be Gaussiana actual se escribe en el formato PLY 
ASCII/binario estandarizado — compatible con Su
perSplat, PolyCam, PlayCanvas y todos los visores 
3DGS habituales. Coeficientes SH completos, preci
sión completa (Float32 por campo). El tamaño de 
archivo a menudo es de varios cientos de MB con ≥ 
500K Gaussianos.

E N  P O CA S  PA L A B R A S

Guarda tu escena 3D como ar­
chivo PLY estándar. Este es el 
formato más universal — casi 
cualquier software puede cargar­
lo, desde SuperSplat a PolyCam 
o PlayCanvas. Sin embargo, los 
archivos se vuelven grandes, a 
menudo varios cientos de me­
gabytes. Usa PLY cuando quie­
ras seguir trabajando con calidad 
completa o archivar. Si quieres 
compartir la escena por la web, 
mira SPZ (M27) o Compressed 
PLY (M26) en su lugar — son mu­
cho más pequeños.
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M26 Export > 3D Formats > Export Compressed PLY…

D Ó N D E

Barra de menús → Export → 3D Formats → Com
pressed PLY.

T É C N I C O

Escribe la nube Gaussiana en el formato PLY 
comprimido con cuantización propia de los cam
pos de posición, escala, rotación y SH. Archivos 
5–10× más pequeños que el PLY sin comprimir 
(M25) con pérdida visual mínima. Compatible con 
SuperSplat (que lee el estándar PLY comprimido) 
y PlayCanvas. Nombre predeterminado gaussians_​
compressed.ply.

E N  P O CA S  PA L A B R A S

Como PLY normal, pero 5–10 ve­
ces más pequeño. La calidad se 
mantiene casi igual. Úsalo cuan­
do quieras compartir el archivo 
online o enviarlo por correo. Fun­
ciona directamente con SuperS­
plat y PlayCanvas. Si tu sistema 
de destino necesita archivos aún 
más pequeños (móvil, demos en 
navegador), usa SPZ (M27) en su 
lugar — está comprimido aún 
más agresivamente. Para calidad 
de edición plena, usa el PLY sin 
comprimir (M25).

M27 Export > 3D Formats > Export SPZ…

D Ó N D E

Barra de menús → Export → 3D Formats → SPZ.

T É C N I C O

Escribe la nube Gaussiana en el formato SPZ — el 
formato de splat comprimido publicado por Niantic 
con cuantización agresiva (~90 % más pequeño que 
PLY sin comprimir). Optimizado sobre todo para vi
sores web y apps móviles. Compatible con Niantic 
Splatt3R, gsplat.js y el visor de navegador de Nian
tic.

E N  P O CA S  PA L A B R A S

Uno de los formatos más peque­
ños. Cerca de 10× más pequeño 
que un PLY normal. Úsalo prin­
cipalmente cuando quieras mos­
trar la escena en un navegador 
o verla en una app de móvil. 
Para máxima calidad, PLY es la 
mejor elección. SPZ lo desarrolló 
Niantic y funciona directamente 
con gsplat.js, Splatt3R y el visor 
web de Niantic. Por la fuerte 
compresión, ya no puedes seguir 
entrenando con archivos SPZ fá­
cilmente — usa PLY para edición.
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M28 Export > 3D Formats > Export glTF…

D Ó N D E

Barra de menús → Export → 3D Formats → glTF.

T É C N I C O

Escribe un archivo .glb  (glTF binario) con la 
extensión KHR_gaussian_splatting. Conforme al es
tándar, apto para pipelines que usan engines glTF 
como Babylon.js o Three.js e implementan la exten
sión KHR_gaussian_splatting.

E N  P O CA S  PA L A B R A S

Guarda la escena en el formato 
glTF que muchos programas 3D y 
engines web entienden — siem­
pre que soporten la extensión 
Gaussian-Splatting. Si tienes una 
pipeline 3D específica (p. ej., 
Three.js o Babylon.js) que la en­
tiende, este es tu formato. El 
archivo sale como .glb  binario 
— un único paquete que contie­
ne todo. Para flujos de splatting 
clásicos, PLY o SPZ suelen ser 
la mejor elección, ya que más he­
rramientas los entienden direc­
tamente.

M29 Export > 3D Formats > Export .splat…

D Ó N D E

Barra de menús → Export → 3D Formats → .splat.

T É C N I C O

Escribe el formato .splat  de Antimatter15 — ta
maño fijo de 32 bytes por Gaussiano (posición 
como 3× Float32, escala como 3× Float32, rotación 
como cuaternión normalizado 4× Uint8, RGB+opaci
dad como 4× Uint8). Sin coeficientes SH superiores 
al DC. El archivo más pequeño con compatibilidad 
directa de navegador. Para gsplat.js y el visor de 
demo online de antimatter15.

E N  P O CA S  PA L A B R A S

El formato más sencillo para vi­
sores web. Pequeño y mostrable 
inmediatamente en cualquier na­
vegador. Pero pierde la ilumina­
ción de detalle (los coeficientes 
SH superiores se pierden — el 
splat se ve igual desde todos 
los ángulos en vez de reaccio­
nar a la luz). Bueno para máxi­
mo rendimiento web, pero para 
fotorrealismo, SPZ o PLY es me­
jor. Funciona con el visor online 
de antimatter15 y gsplat.js. Cada 
Gaussiano ocupa 32 bytes fijos, 
lo que hace al formato simple y 
compatible — pero a costa de la 
profundidad de detalle.
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M30 Export > 3D Formats > Export SOG…

D Ó N D E

Barra de menús → Export → 3D Formats → SOG.

T É C N I C O

Escribe la nube Gaussiana en el formato SOG. SOG 
(«Self-Organizing Gaussian») es el formato Play
Canvas con layout de atlas de texturas y compre
sión WebP de los datos cuantizados. Escala con un 
ratio de tamaño 15–20× mejor que PLY. La exporta
ción llama internamente a cwebp  como herramienta 
externa — por lo que en la variante sandbox (App 
Store) puede estar restringido.

E N  P O CA S  PA L A B R A S

Formato muy pequeño para flu­
jos PlayCanvas. Cerca de 15–20 
veces más pequeño que PLY por­
que los datos se empaquetan en 
un layout de atlas de texturas 
y se comprimen en WebP. Si no 
tienes un flujo PlayCanvas, SPZ 
o Compressed PLY suelen ser la 
mejor elección. La exportación 
llama internamente a cwebp  
como herramienta externa — en 
la versión de App Store (sand­
box), este paso puede estar res­
tringido.

M31 Export > Media > Export Orbit Video…

D Ó N D E

Barra de menús → Export → Media → Orbit Video.

T É C N I C O

Renderiza una órbita 360° alrededor del centro de 
la escena y la codifica como MP4 (H.264) o MOV 
(HEVC, según el predeterminado del sistema). A di
ferencia de M18 (grabación en vivo), la trayectoria 
aquí es fija — la duración se elige en los ajustes o en 
el paso de exportación de Simple Mode.

E N  P O CA S  PA L A B R A S

Produce automáticamente un ví­
deo de giro alrededor de tu esce­
na. No hace falta mover nada a 
mano. Bueno para redes sociales 
o una demo rápida. Si quieres 
controlar tú la cámara, usa Re­
cord Turntable Video (M18) en 
su lugar. La trayectoria es fija: 
una órbita completa de 360° alre­
dedor del centro de la escena; 
eliges la duración en los ajustes 
o en el paso de exportación de 
Simple Mode. El vídeo sale como 
MP4 H.264 o MOV HEVC según el 
sistema.
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M32 Export > Media > Export Web Viewer…

D Ó N D E

Barra de menús → Export → Media → Web Viewer.

T É C N I C O

Empaqueta un visor HTML autónomo (basado en 
gsplat.js) más los datos Gaussianos codificados en 
Base64 en un único archivo .html . Este archivo 
funciona offline en cualquier navegador moderno — 
sin dependencias de servidor, sin URLs externas. El 
tamaño de archivo es un factor de aprox. 1,3 mayor 
que la variante SPZ (por el overhead de Base64).

E N  P O CA S  PA L A B R A S

Guarda tu escena como una pá­
gina web autoarrancable. Doble 
clic en el archivo HTML → el na­
vegador se abre → escena 3D 
interactiva lista. Funciona sin in­
ternet, se puede enviar por co­
rreo, es la forma más sencilla de 
compartir el resultado con ami­
gos o clientes. El archivo contie­
ne el visor gsplat.js completo y 
los datos Gaussianos en un único 
documento — nada se carga des­
de la web. El tamaño de archivo 
es alrededor de un tercio mayor 
que una exportación SPZ, pero a 
cambio el destinatario no necesi­
ta software adicional.

M33 Export > Photogrammetry > Export SfM (transforms.json)…

D Ó N D E

Barra de menús → Export → Photogrammetry → Ex
port SfM (transforms.json).

T É C N I C O

Vía de exportación dedicada (no a través de la 
rutina helper común), porque no se exporta una 
nube Gaussiana sino el resultado de SfM. Abre 
un diálogo de guardar con transforms.json  como 
predeterminado y tipo de contenido json . Al acep
tar, se escribe un transforms.json  compatible con 
nerfstudio con intrínsecos de cámara, poses (como 
matriz 4×4 en convención NeRF) y rutas de frame. 
El texto de ayuda de la UI indica que las imágenes 
de entrenamiento deben copiarse en paralelo como 
carpeta hermana images/​. Activo solo si existe un 
resultado de SfM y la versión completa está desblo
queada.

E N  P O CA S  PA L A B R A S

Si quieres usar el resultado 
de SfM en otro software co­
mo nerfstudio, Brush, gsplat u 
OpenSplat, aquí exportas las po­
siciones de cámara. Pon tus imá­
genes de entrenamiento además 
en una carpeta images/​ junto al 
archivo transforms.json  — 
si no, el programa de destino 
no puede emparejar las imáge­
nes. La entrada aparece atenua­
da mientras no exista resultado 
de SfM, y bloqueada en la versión 
de prueba gratuita. Para el flujo 
COLMAP-workspace, usa M34 en 
su lugar.
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M34 Export > Photogrammetry > Export SfM (COLMAP Workspace)…

D Ó N D E

Barra de menús → Export → Photogrammetry → Ex
port SfM (COLMAP Workspace).

T É C N I C O

Abre un diálogo de guardar con nombre predeter
minado colmap-workspace  (sin extensión, porque 
es una carpeta). Escribe un workspace COLMAP 
estándar con sparse/​0/​cameras.bin, images.bin , 
points3D.bin . Permite abrir en otras herramientas 

como Postshot, Nerfstudio o Meshroom una recons
trucción SfM calculada o importada en RadianceKit, 
o, para un re-run A/B, volverla a cargar como entra
da ya calculada dentro del propio RadianceKit (me
diante M5) — ahorra tiempo de cálculo. Activo solo 
si existe un resultado de SfM y la versión completa 
está desbloqueada.

E N  P O CA S  PA L A B R A S

Como M33 pero en formato COL­
MAP en lugar de nerfstudio. Si 
usas Postshot, Meshroom, Nerfs­
tudio u otra herramienta con un 
flujo COLMAP, esta es tu expor­
tación. Un efecto colateral útil: 
puedes recargar esta carpeta 
más tarde mediante M5 en Ra­
dianceKit y ahorrar el tiempo de 
cálculo de SfM en el siguiente 
run — especialmente en escenas 
grandes, un ahorro de horas. Co­
mo M33, solo disponible cuando 
existe un resultado de SfM, y blo­
queada en la versión de prueba 
gratuita.

Menú Help

Figura 6:  Menú Help con documentación, carpeta y entradas de análisis

Siete entradas: dos ventanas de documentación (User Guide, Keyboard Shortcuts), tres 
atajos a carpeta (Training Logs, Exports, Storage) y tres ventanas de análisis (Pareto 
Dashboard, Holdout Analysis, BayesOpt Console). Al estilo Apple, el menú Help aparece 
a la derecha del todo. El menú Help estándar se reemplaza por completo por la variante 
propia de RadianceKit.

25 / 242



R A D I A N C E K I T Capítulo 1 — Barra de menús

M35 Help > User Guide

D Ó N D E

Barra de menús → Help → User Guide (⌘?).

T É C N I C O

Abre la ventana User Guide. Muestra navegación 
con una barra lateral de temas y un área de detalle 
desplazable con tamaño predeterminado 860×640. 
Los contenidos están almacenados de forma estáti
ca (no parseados desde Markdown).

E N  P O CA S  PA L A B R A S

Abre la guía dentro de la app. Si 
no quieres leer todo este manual, 
encuentras los pasos clave direc­
tamente en el programa. La guía 
está construida como su propia 
ventana con una barra lateral de 
temas — así puedes saltar di­
rectamente a temas individuales. 
Los contenidos son más cortos 
que este manual y se centran en 
los flujos más habituales.

M36 Help > Keyboard Shortcuts

D Ó N D E

Barra de menús → Help → Keyboard Shortcuts (⌘/).

T É C N I C O

Abre la ventana Keyboard Shortcuts — un layout 
simple de scroll con todos los atajos de la app, 
agrupados por menú de nivel superior. Tamaño 
predeterminado 440×560. Los contenidos también 
están almacenados de forma estática.

E N  P O CA S  PA L A B R A S

Abre una ventana con la lista 
completa de todos los atajos de 
teclado. Si no te acuerdas de, 
p. ej., qué tecla arranca el entre­
namiento, mira ahí. Un resumen 
también está al final de este 
capítulo. La lista se agrupa por 
menú de nivel superior, así sal­
tas rápido al área correcta. Útil 
cuando estás cambiando de un 
estilo de ratón a un estilo de te­
clado.

26 / 242



R A D I A N C E K I T Capítulo 1 — Barra de menús

M37 Help > Open Training Logs…

D Ó N D E

Barra de menús → Help → Open Training Logs… 
(⇧⌘L).

T É C N I C O

Calcula la carpeta de logs como ~/​Documents/​
RadianceKit/​Logs, la crea si es necesario y la 
abre en Finder. Cada run de entrenamiento escribe 
allí su propio archivo JSONL training_​YYYY-MM-DD_​
HHmmss.jsonl.

E N  P O CA S  PA L A B R A S

Abre en Finder la carpeta con 
todos los protocolos de entre­
namiento previos. Si algo ha 
salido mal o quieres consultar 
exactamente cuándo convergió 
el entrenamiento a qué valor, 
lo encuentras aquí en archivos 
JSONL. Por run de entrenamiento 
se crea exactamente un archivo 
con marca de tiempo — también 
puedes alimentarlo a otras he­
rramientas o enviarlo por correo 
a soporte. Si quieres un análi­
sis gráfico, el Pareto Dashboard 
(M40) es el mejor punto de parti­
da.

M38 Help > Open Exports Folder…

D Ó N D E

Barra de menús → Help → Open Exports Folder…

T É C N I C O

Análogo a M37 pero con ~/​Documents/​RadianceKit/​
Exports. Creada en el primer run de auto-test o en 
el primer clic; después aterrizan ahí las rutas prede
terminadas de todas las exportaciones de auto-test 
(p. ej., autotest_​<timestamp>.ply). Las exportacio
nes seleccionadas manualmente mediante el diálo
go de guardar NO necesariamente van aquí, sino 
donde el usuario las guarde — así que esta carpeta 
interesa sobre todo para auto-tests.

E N  P O CA S  PA L A B R A S

Abre la carpeta donde la app co­
loca sus propias exportaciones 
(sobre todo runs de auto-test). Si 
pusiste manualmente una expor­
tación en otro sitio con el diálogo 
de guardar, está allí y no en esta 
carpeta. Útil para limpiar o com­
probar cuánto espacio ocupan 
las exportaciones de prueba pre­
vias. Si quieres una visión gene­
ral completa con logs y paquetes 
de escena, usa Manage Storage 
(M39) en su lugar.
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M39 Help > Manage Storage…

D Ó N D E

Barra de menús → Help → Manage Storage…

T É C N I C O

Abre el navegador de almacenamiento (véase Ca
pítulo 4 Ventanas auxiliares, IDs W7–W12). Lista to
das las escenas persistidas, logs de entrenamiento, 
exportaciones y cachés en la carpeta ~/​Documents/​
RadianceKit/​ con tamaño, permite reveal en Finder 
y mover a la papelera por entrada.

E N  P O CA S  PA L A B R A S

Abre un navegador de ventana 
que te muestra cuánto espacio 
en disco ocupa RadianceKit — 
por escena, log y exportación. 
Puedes eliminar elementos indi­
viduales directamente, sin tener 
que ir a Finder. Útil tras un uso 
prolongado, cuando el disco se 
llena — los logs y exportaciones 
de auto-test anteriores pueden 
sumar varios gigabytes. Median­
te reveal en Finder siempre pue­
des llegar también a la vista clá­
sica.

M40 Help > Pareto Dashboard…

D Ó N D E

Barra de menús → Help → Pareto Dashboard… 
(⇧⌘D).

T É C N I C O

Abre el Pareto Dashboard (véase Capítulo 4, 
IDs W13–W22). El dashboard carga todos los 
logs JSONL de entrenamiento desde ~/​Documents/​
RadianceKit/​Logs/​, los organiza por escena y ajuste 
preestablecido y dibuja un scatter plot de Pareto 
(predeterminado: loss vs Gaussianos, opcionalmen
te loss vs wallclock o PSNR vs iteraciones).

E N  P O CA S  PA L A B R A S

Abre una visión general de todos 
los entrenamientos previos como 
gráfico. Ves de un vistazo qué 
run entregó el mejor equilibrio 
de calidad y tamaño. Útil cuando 
quieres comparar distintos ajus­
tes preestablecidos. Por defecto, 
el gráfico muestra loss frente a 
número de Gaussianos — pero 
también puedes cambiar a tiem­
po de wallclock o PSNR. Los da­
tos proceden de los logs JSONL 
de entrenamiento (M37); cuantos 
más runs tengas, más significati­
vo es el análisis.
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M41 Help > Holdout Analysis…

D Ó N D E

Barra de menús → Help → Holdout Analysis… 
(⇧⌘H).

T É C N I C O

Abre la ventana Holdout Analysis (véase Capítulo 4, 
IDs W23–W29). Carga un transforms.json , dibuja 
las cámaras como un globo 3D y permite divisiones 
train/test fold (angulares o lineales, 2–8 folds). La 
salida es un fold-assignment.json que el entrena
miento puede usar como conjunto de test en las 
respectivas configuraciones de entrenamiento.

E N  P O CA S  PA L A B R A S

Te ayuda a dividir tus capturas 
de cámara en conjuntos de en­
trenamiento y test — así puedes 
medir objetivamente lo buena 
que es tu escena (sobre imáge­
nes que el entrenamiento nunca 
vio). Más bien una herramienta 
de investigación y benchmark. 
Las cámaras se muestran como 
un globo 3D; puedes elegir entre 
2 y 8 folds, ya sea uniformemen­
te en ángulo o linealmente a lo 
largo del orden. El resultado es 
un pequeño archivo JSON que el 
entrenamiento usa después co­
mo conjunto de test.

M42 Help > BayesOpt Console…

D Ó N D E

Barra de menús → Help → BayesOpt Console… 
(⇧⌘B).

T É C N I C O

Abre la BayesOpt Console (véase Capítulo 4, IDs 
W30–W39). Carga espacios de búsqueda predefi
nidos (p. ej., «MCMC scale-reg + opacity-reg + 
ssim»), ejecuta trials de optimización bayesiana de 
forma asíncrona y muestra la curva de convergencia 
y el log de trials en vivo.

E N  P O CA S  PA L A B R A S

Una consola de auto-tuning inte­
grada. En vez de probar manual­
mente distintos parámetros, la 
app puede correr sola durante la 
noche y al final sugerir los me­
jores valores para tu escena. He­
rramienta muy avanzada — para 
la mayoría de los flujos basta 
con un buen ajuste preestableci­
do (véase Capítulo 7). Eliges un 
espacio de búsqueda predefinido 
(p. ej., «MCMC scale-reg + opa­
city-reg + ssim») y ves la curva 
de convergencia en vivo, así co­
mo el log de trials. Planifica de 
varias horas a días según el se­
tup.

Aviso: Cmd-Z en el menú Edit

Desde mayo de 2026, el Project Navigator en Expert Mode soporta eliminar imágenes 
importadas mediante el botón menos o la tecla Backspace y deshacer mediante 
Cmd-Z . Esta acción Cmd-Z aparece en el menú Edit de macOS (proporcionado por 

SwiftUI) como «Undo Remove Image» mientras una imagen eliminada sea aún recupe
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rable. Está registrada mediante el sistema conforme al estándar, no en ; por eso no hay 
una entrada M-ID dedicada en el inventario.

Resumen de atajos de teclado

Entrada de menú Atajo

File > Open Scene… ⌘O

File > Save Scene… ⌘S

File > Import COLMAP / Metashape Workspace… ⇧⌘I

File > New Project ⇧⌘N

Mode > Simple Mode ⌘1

Mode > Expert Mode ⌘2

Training > Start Training ⇧⌘T

Viewport > Enter/Exit Edit Mode ⇧⌘E

Viewport > Toggle Auto-Rotation ⌘⌥T

Viewport > Save Screenshot ⇧⌘S

Export > 3D Formats > PLY ⌘E

Help > User Guide ⌘?

Help > Keyboard Shortcuts ⌘/

Help > Open Training Logs… ⇧⌘L

Help > Pareto Dashboard… ⇧⌘D

Help > Holdout Analysis… ⇧⌘H

Help > BayesOpt Console… ⇧⌘B

Menú Edit (provisto por el sistema, en Expert Mode con selección activa del Project 
Navigator):

Acción Atajo

Undo Remove Image ⌘Z

Remove Selected Image Backspace / Delete
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C A P Í T U L O

Capítulo 2 — Inspector (Vista Experto)

Figura 7:  Modo Experto vacío — Project Navigator a la izquierda (Images 0, Cameras, Log), 
vista vacía en el medio, Inspector a la derecha con las secciones Presets/Training Configu

ration/Enhancements/ Training Metrics

Inspector vacío antes de la importación: La barra lateral izquierda muestra el conta
dor de imágenes 0 y la pista de soltar «Drop images here / or tap + to import». El 
Inspector de la derecha está totalmente funcional, pero los ajustes preestablecidos son 
solo informativos (sin entrenamiento activo). El ajuste preestablecido predeterminado 
«Preview» (5K iter) está marcado. Camera Alignment está en Apple Photogrammetry, 
Densification en Classic, SSIM Weight en 0,20, Render Scale al 50 %. En Training Me
trics se muestran estados vacíos («Start training to see live metrics») y en Loss History 
(«Loss curve will appear during training»).
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Figura 8:  Inspector con 60 imágenes de un ramo cargadas — la barra lateral de imágenes 
muestra los primeros nombres de archivo frame_0001.jpg ff, la cabecera dice «60 images 

ready»

Inspector tras la importación: El estado de la cabecera dice «60 images ready». 
La barra lateral de imágenes lista los 60 fotogramas importados ( frame_0001.jpg  a 
frame_0945.jpg , cada 16º fotograma del dataset de 960 cámaras como subconjunto 

para iteraciones rápidas). La lógica auto de la escala de renderizado comprueba la 
resolución de imagen (1536×2048 = 3,1 MP) y ajusta Render Scale en consecuencia. El 
botón Play (verde, abajo a la izquierda) está ahora activo e inicia el entrenamiento con 
el ajuste preestablecido activo.

Figura 9:  Inspector a mitad de entrenamiento — la vista en vivo muestra la reconstrucción 
del ramo, barra de métricas debajo (Loss / LR / nº de Gaussianos / iteraciones), tarjeta de 

ajuste preestablecido «Preview» con insignia «Modified» si se ajustaron parámetros

Inspector durante el entrenamiento: La barra de título muestra el progreso global 
«RadianceKit — Training NN %». La vista renderiza la reconstrucción Gaussiana en 
curso en tiempo real (actualizada cada 50 iteraciones — el intervalo de previsualización 
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en vivo se puede configurar en Settings → General → Training → Live Preview). Barra 
de métricas bajo la vista: Loss actual, Learning Rate, número de Gaussianos y contador 
de iteración (p. ej., 1.600/5.000 con el ajuste preestablecido Preview). La tarjeta de 
ajuste preestablecido «Preview» del Inspector recibe una insignia «Modified» en cuan
to cualquier parámetro se desvía del predeterminado integrado. La barra lateral «Log» 
recopila los eventos de las etapas de SfM y entrenamiento.

Figura 10:  Inspector tras completarse el entrenamiento — la vista muestra la reconstrucción 
terminada del ramo (2.991 Gaussianos tras 5K iteraciones en 13s), barra de título «Training 

Complete — 2.991 Gaussians»

Inspector tras el entrenamiento: La barra de título muestra el número final de Gaus
sianos (aquí 2.991 — muy compacta, porque la escena sintética del ramo en Blender 
tiene geometría sencilla sobre fondo claro). La vista muestra la nube de puntos termi
nada — la navegación de arrastre orbital está activa (rota alrededor del centro de la 
escena). La sección Training Metrics está ahora rellena con valores finales, la gráfica 
de Loss History muestra el transcurso de las 5.000 iteraciones completas. La sección 
Export, abajo, está ahora activa (todos los botones de formato habilitados).

El Inspector es la barra lateral derecha en Modo Experto (⌘2). Agrupa todos 
los parámetros relevantes para el entrenamiento en siete secciones colapsables. El 
orden predeterminado de arriba abajo en el primer inicio es: Look, Presets, Training 
Configuration, Metrics, Loss Chart, Enhancements y Export. La sección «Look» (ajus
tes de imagen post-entrenamiento) es el renombrado real en la UI de la antigua 
sección «Finishing» — su rawValue  interno de enum sigue siendo «Finishing» 
por razones de persistencia, pero la cabecera mostrada se llama «Look». Cada 
sección se puede colapsar haciendo clic en la cabecera, y el orden se puede reor
ganizar por arrastrar y soltar (InspectorView.swift:81-97). En el primer inicio, las 
siete secciones arrancan colapsadas (inspectorCollapsedSections toma por defecto 
Set(InspectorSection.allCases)); después, el estado de la app persiste las preferen
cias de colapsado y orden entre inicios.

Varios controles del Inspector también aparecen, en forma casi idéntica, en los Ajustes 
(Capítulo 3) — típicamente backend de SfM, sky masking y defaults similares. La divi
sión es deliberada: Settings provee la plantilla global de la app para proyectos recién 
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creados, el Inspector sobrescribe esos valores para el proyecto abierto actualmente. 
Una vez conoces la lógica de operación de un lado, puedes usar el otro a ciegas.

La columna izquierda del Modo Experto — el Project Navigator — no forma parte 
del Inspector, pero es su vecino directo. Allí puedes seleccionar imágenes importadas 
haciendo clic, previsualizarlas con la barra espaciadora vía Quick Look y eliminarlas con 
el botón menos o la tecla Suprimir (con Cmd-Z para deshacer). El Inspector sigue la 
selección actual de la barra lateral con información de detalle según el contexto, pero 
las siete secciones principales se mantienen siempre disponibles.

Sección Look (L1–L5)

La sección Look (su rawValue  interno sigue siendo «Finishing») es la sección superior 
del Inspector y reúne en un solo lugar los ajustes de imagen post-entrenamiento. To
dos los reguladores trabajan de forma no destructiva: cada deslizador vuelve a aplicar 
el FinishingPass  sobre una instantánea pristina sin modificar (color DC, opacidad y 
escalado originales) — el ajuste es por tanto idempotente, no acumulativo. El resultado 
aparece en vivo en la vista (WYSIWYG, exactamente como la exportación posterior) 
y se hornea en cada exportación. La sección solo está disponible tras completarse 
un entrenamiento (antes aparece «Available after a training run completes.»); sus 
valores se restablecen con cada nuevo entrenamiento. Mientras una exportación está 
en curso, todos los reguladores están bloqueados — aparece un aviso de bloqueo 
«Locked while exporting — the file uses the current settings.» y el GroupBox queda 
deshabilitado.

L1 Deslizador Saturation

D Ó N D E

Inspector → Sección Look → GroupBox → Satura
tion.

T É C N I C O

Deslizador 0,5–1,2, visualización a dos decimales (p. 
ej., «1.00»). Escala el croma SH-DC de cada splat 
alrededor del valor de luminancia: 1,0 = sin cambios, 
< 1,0 = desaturado (color tirado hacia la escala de 
grises), > 1,0 = más intenso. Matemáticamente, el 
color DC se recalcula desde la instantánea pristina 
( desaturateDC ), de modo que mover el deslizador 
repetidamente no se acumula. Se validó sobre ma
terial de dron DJI (viaducto de Pensford), que tien
de a exagerar el color — el default de dron es 0,82. 
Solo actúa sobre la base de color (SH grado 0); los 
coeficientes SH superiores quedan intactos.

E N  P O CA S  PA L A B R A S

Cómo de intensos son los colores 
del splat terminado. 1.00 deja to­
do como se entrenó, valores por 
debajo tiran el color hacia el gris 
— bien para material de dron o 
vídeo, que a menudo sale sobre­
saturado. Valores por encima de 
1.0 lo hacen más intenso. Puedes 
mover el deslizador adelante y 
atrás cuanto quieras sin que na­
da se «amontone», porque la app 
siempre recalcula desde el esta­
do original sin tocar. Visible en 
vivo en la vista y exactamente así 
en la exportación.
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L2 Deslizador Splat length

D Ó N D E

Inspector → Sección Look → GroupBox → Splat 
length.

T É C N I C O

Deslizador 0,3–1,0, visualización a dos decimales. 
Acerca los tres ejes de escalado de cada Gaus
siano hacia su media en el espacio logarítmico 
( shortenScale , factor alpha ): 1,0 = sin cambios, 
valores más pequeños hacen más redondos los 
splats alargados en «aguja», 0 serían esferas puras. 
Ataca los splats con forma de aguja, sobreestirados, 
sin cambiar el tamaño global, y reduce así los típi
cos artefactos de «confeti». Se aplica desde la ins
tantánea pristina (escalado logarítmico original), por 
eso es idempotente. Conmuta con Splat size (L3), 
porque ambos trabajan en el espacio logarítmico.

E N  P O CA S  PA L A B R A S

Hace más redondos los splats 
demasiado largos y astillados. 
1.00 deja la forma como se en­
trenó, valores más bajos enco­
gen las «agujas» alargadas hacia 
manchas más redondeadas — 
eso calma las reconstrucciones 
granulosas, plagadas de artefac­
tos de confeti. El tamaño global 
se mantiene igual, solo se trata 
de la elongación. Se puede com­
binar sin problemas con Splat si­
ze (L3).

L3 Deslizador Splat size

D Ó N D E

Inspector → Sección Look → GroupBox → Splat size.

T É C N I C O

Deslizador 0,5–2,0, visualización a dos decimales. 
Escala cada Gaussiano de forma uniforme en los 
tres ejes ( sizeScale ): 1,0 = sin cambios, < 1,0 = 
más pequeño/denso/nítido, > 1,0 = más grande/«es
ponjoso» (rellena los huecos entre los splats). Co
mo los escalados están en el espacio logarítmico, 
la multiplicación se realiza como un offset aditivo 
log(factor)  — eso conmuta con Splat length (L2), 

porque un offset constante deja intacta la desvia
ción respecto a la media. Desde la instantánea pris
tina, por tanto idempotente. Nuevo en esta versión.

E N  P O CA S  PA L A B R A S

Escala todos los splats de for­
ma uniforme, más grandes o 
más pequeños. 1.00 es el esta­
do entrenado, valores por debajo 
aprietan la nube de puntos y la 
hacen más nítida, valores por en­
cima cubren los huecos entre los 
splats (queda más suave, «es­
ponjoso»). Práctico para cerrar 
ópticamente una reconstrucción 
agujereada o, al revés, para reve­
lar más detalle. Se lleva sin pro­
blemas con Splat length (L2) — 
ambos reguladores no se influ­
yen mutuamente.
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L4 Fade far region (con sub-deslizadores)

D Ó N D E

Inspector → Sección Look → GroupBox → conmu
tador «Fade far region» más los sub-deslizadores 
«Fade start ×radius» y «Fade floor».

T É C N I C O

Conmutador que activa una caída radial de opaci
dad con la distancia al baricentro de la cámara 
— el «confeti lejano», débilmente observado, del 
fondo se desvanece. Solo para capturas orbi­
tales: el conmutador está deshabilitado cuando 
finishingContext.fadeEligible es false (vuelos li
neales, demasiadas pocas cámaras o cámaras de
generadas); entonces, en lugar de los sub-desliza
dores, aparece el aviso «Far-fade applies only to or
bit captures (not this scene).» La aptitud se deter
mina por la cobertura de azimut de las posiciones 
de cámara (una órbita rodea el baricentro y rellena 
muchos sectores de brújula, un vuelo lineal solo 
~2). Dos sub-deslizadores controlan la geometría: 
Fade start ×radius (1,0–3,0) fija el radio interior 
como múltiplo del radio orbital, dentro del cual rige 
la opacidad plena; Fade floor (0,0–1,0) es el factor 
de opacidad muy más allá del radio de fade. Impor
tante: el fade se salta la zona del sky-dome (los 
Gaussianos congelados de los índices [0, frozen
Count)), para que la cúpula de fondo deliberada no 
se atenúe también.

E N  P O CA S  PA L A B R A S

Desvanece los restos esponjo­
sos del borde exterior de la 
escena — justo los grumos de 
«confeti lejano» que flotan muy 
atrás en las capturas envolven­
tes. Funciona solo con capturas 
orbitales/envolventes reales; con 
vuelos de dron rectos o dema­
siadas pocas cámaras, el conmu­
tador queda atenuado y un aviso 
explica por qué. Si está activo, 
se añaden dos reguladores finos: 
«Fade start ×radius» fija a partir 
de qué distancia (como múltiplo 
del radio del círculo) empieza 
el desvanecimiento, «Fade floor» 
cuánto siguen viéndose al final 
los splats lejanos (0 = del todo 
fuera, 1 = sin cambios). Un sky-
-dome reconstruido a propósito 
(I44) nunca se toca — el cielo se 
conserva.
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L5 Botón Reset finishing

D Ó N D E

Inspector → Sección Look → GroupBox → «Reset 
finishing» (abajo, botón pequeño).

T É C N I C O

Restablece todos los ajustes de Look a los defaults 
(FinishingPass.Settings() = Saturation 1,0, Fade 
desactivado, Splat length 1,0, Splat size 1,0) y dis
para de inmediato un nuevo finishing, de modo que 
la vista salta de vuelta al estado entrenado sin mo
dificar. controlSize(.small). Como todo el stack de 
Look recalcula de forma idempotente desde la ins
tantánea pristina, «volver al default» es exactamen
te la salida original del entrenamiento — sin pérdida 
de calidad por ir y venir varias veces. Como todos 
los reguladores de la sección, queda bloqueado du
rante una exportación en curso.

E N  P O CA S  PA L A B R A S

Restablece de un clic todos los 
reguladores de Look a su están­
dar (Saturation 1.00, Fade desac­
tivado, ambos deslizadores Splat 
a 1.00) — la vista muestra 
después de nuevo exactamente 
el resultado recién entrenado. 
Práctico cuando te has dejado 
llevar y quieres empezar limpio 
de cero. Como la app siempre re­
calcula desde el estado original, 
no hay pérdida de calidad. Mien­
tras una exportación está en cur­
so, el botón (como los deslizado­
res) está bloqueado.

Sección Presets (I1–I11)

La sección Presets es la forma más rápida de aplicar una configuración probada. Los 
ajustes preestablecidos integrados (Capture Class, Classic, MCMC, Hybrid) ofrecen 
puntos de partida reproducibles a partir de más de 560 experimentos documentados; 
los propios se pueden guardar, exportar, importar y compartir. La lista se agrupa por 
categorías (Capture Class, Classic, MCMC, Hybrid, Custom) y puede haber más de una 
categoría expandida al mismo tiempo. El menú contextual (clic derecho sobre una fila) 
hace accesibles Export, Duplicate y — para ajustes preestablecidos personalizados — 
Delete.
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I1 Botón Save…

D Ó N D E

Inspector → Sección Presets → botón Save… (barra 
de acciones de abajo).

T É C N I C O

Abre un popover con campo de texto y botones 
Save/Cancel. El estado actual de TrainingConfig se 
persiste como nuevo ajuste preestablecido perso
nalizado (codificado en JSON, almacenado a nivel 
de app). El proceso de guardado copia los 81 pará
metros de entrenamiento más la estrategia de den
sificación actual. El ajuste preestablecido aterriza 
automáticamente en la categoría Custom, con inde
pendencia de cuál fue el ajuste integrado del que 
derivó. Los nombres vacíos y las entradas con solo 
espacios en blanco se rechazan. Los nombres ya 
existentes no se rechazan — cada ajuste tiene su 
propio ID interno; los nombres duplicados son téc
nicamente válidos pero, en la práctica, confusos.

E N  P O CA S  PA L A B R A S

Guarda tu configuración actual 
como ajuste preestablecido re­
utilizable. Haz clic en el botón, 
escribe un nombre en el popo­
ver y pulsa Save — los 81 pa­
rámetros, incluida la estrategia 
de densificación, aterrizan bajo 
el nombre elegido en la catego­
ría Custom. Lo necesitas cuando 
has dedicado esfuerzo y no quie­
res empezar de cero en tu próxi­
mo proyecto. Especialmente útil 
para setups recurrentes como 
«Drone 4K» o «Indoor fast». Los 
nombres duplicados son técnica­
mente válidos pero, en la prác­
tica, confusos — mejor escoge 
algo descriptivo.

I2 Campo de texto Preset Name

D Ó N D E

Popover de Save → campo de texto «Preset Name».

T É C N I C O

Campo de texto simple con borde redondeado y 
forma ancha. El valor se toma como nombre del 
ajuste preestablecido al pulsar Save. Sin límite de 
longitud en la UI, pero el nombre almacenado debe 
ser codificable en JSON y mostrable en las listas de 
la UI — emojis y acentos funcionan. El contenido se 
restablece automáticamente a cadena vacía al abrir 
el popover. El botón Save se mantiene deshabilitado 
mientras el campo esté vacío tras un trim. No hay 
autosugerencia ni autocompletado con el nombre 
del ajuste preestablecido activo.

E N  P O CA S  PA L A B R A S

Aquí escribes el nombre de tu 
ajuste preestablecido. Escoge al­
go descriptivo como «Drone 4K 
30fps» o «Indoor fast» — así 
lo encontrarás más tarde en la 
categoría Custom. Se permiten 
emojis y acentos, no hay un lí­
mite duro de longitud. Mientras 
el campo esté vacío o solo con­
tenga espacios, el botón Save se 
mantiene atenuado. Al reabrir el 
popover, el campo vuelve a estar 
vacío — no hay autocompletado 
con el nombre del ajuste activo.
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I3 Botón Cancel (diálogo Save)

D Ó N D E

Popover de Save → botón Cancel (izquierda).

T É C N I C O

Cierra el popover sin guardar. Descarta el contenido 
del campo de texto — en la próxima apertura, la ló
gica del botón Save… (I1) lo restablece a vacío. Esti
lo de botón estándar, sin diálogos de confirmación, 
sin hotkeys. La TrainingConfig actual no cambia, 
porque la vía de guardado ni siquiera se ejecutó.

E N  P O CA S  PA L A B R A S

Cierra el popover Save sin guar­
dar nada. Si has cambiado de 
idea, te has equivocado al teclear 
o has abierto el diálogo por acci­
dente — simplemente pulsa Can­
cel. Tu configuración de entrena­
miento actual no cambia, porque 
no se ha escrito nada. Al reabrir 
el popover, el campo de nombre 
vuelve a estar vacío. Sin aviso de 
seguridad, sin hotkey — clic y 
fuera.

I4 Botón Save (diálogo Save)

D Ó N D E

Popover de Save → botón Save (derecha, estilo pro
minente).

T É C N I C O

Dispara la persistencia real. Valida de nuevo que el 
nombre no esté vacío (chequeo defensivo) y enton
ces escribe la TrainingConfig actual como JSON al 
almacenamiento de la app. Luego cierra el popover. 
Resaltado en azul, atenuado mientras el campo de 
texto esté vacío. Si guardar falla (p. ej., porque el 
almacenamiento de la app está lleno — muy impro
bable), por ahora no hay un diálogo de error visible; 
el ajuste preestablecido simplemente no aparecería 
en el próximo arranque de la app.

E N  P O CA S  PA L A B R A S

Con un clic en Save tomas el 
nombre y escribes tu setup ac­
tual como nuevo ajuste prees­
tablecido. El popover se cierra, 
el ajuste aparece de inmedia­
to en la categoría Custom de 
la lista y desde entonces pue­
de activarse con un clic. El 
botón está resaltado en azul 
( borderedProminent ) y se 
mantiene atenuado mientras el 
campo de nombre esté vacío. Si 
guardar falla (p. ej., UserDefaults 
lleno), no hay diálogo de error 
visible — el ajuste simplemente 
faltaría en el próximo arranque 
de la app.
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I5 Botón Export…

D Ó N D E

Inspector → Sección Presets → barra de acciones → 
botón Export….

T É C N I C O

Exporta el ajuste preestablecido actualmente selec
cionado como archivo .radiancepreset  (interna
mente JSON). Deshabilitado si no hay ajuste selec
cionado. Al hacer clic, la app abre un diálogo de 
guardar con un nombre de archivo de ajuste (nom
bre del ajuste + extensión .radiancepreset ). El 
formato guardado contiene la TrainingConfig com
pleta más metadatos (nombre, categoría, ID, flag de 
integrado). El doble clic en Finder abre la app — 
pero no automáticamente la importación; el usuario 
tiene que usar el botón Import (I6).

E N  P O CA S  PA L A B R A S

Selecciona un ajuste preestable­
cido en la lista y pulsa Export — 
entonces puedes guardarlo como 
archivo .radiancepreset  y, 
p. ej., enviárselo a un compañe­
ro o transferirlo a un segundo 
Mac. El receptor lo carga en su 
lado con el botón Import… (I6) de 
nuevo. Funciona igual con inte­
grados y propios. El botón apare­
ce atenuado mientras no se haga 
clic en nada de la lista. Truco: por 
el menú contextual (I8) es aún 
más rápido — ahí no tienes que 
seleccionar primero el ajuste.

I6 Botón Import…

D Ó N D E

Inspector → Sección Presets → barra de acciones → 
botón Import….

T É C N I C O

Abre un diálogo de archivo que solo permite ar
chivos .radiancepreset  (multiselección deshabili
tada). Al seleccionar, el archivo JSON se carga, 
valida e inserta en la categoría Custom — con un 
nuevo ID interno, para que no haya colisiones con 
los integrados. La importación fija automáticamente 
la categoría a Custom, incluso si el ajuste exportado 
era, p. ej., originalmente un integrado. Los archivos 
corruptos o incompatibles con una versión de sche
ma más antigua se rechazan en silencio, sin diálogo 
de error (el log de consola sí da información).

E N  P O CA S  PA L A B R A S

Lee un archivo 
.radiancepreset  del disco. 

Útil cuando alguien te envía un 
setup probado o tú mismo quie­
res mantener tus ajustes prees­
tablecidos favoritos sincroniza­
dos entre varios Macs. Los ajus­
tes importados siempre aterri­
zan en la categoría Custom — 
aun cuando se hayan exportado 
originalmente desde los integra­
dos. Los archivos corruptos o an­
ticuados se ignoran en silencio; 
el log de consola muestra el mo­
tivo. La multiselección está des­
habilitada en el diálogo, así que 
un archivo por clic.
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I7 Fila de ajuste preestablecido (activación por clic)

D Ó N D E

Inspector → Sección Presets → cada fila de ajuste 
preestablecido en cada categoría.

T É C N I C O

Al hacer clic en una fila se reemplazan todos los 
campos de la TrainingConfig por los valores del 
ajuste preestablecido, se recuerda el ID del ajuste 
activo y se restablece el estado Modified. El check 
de activo delante de la fila solo aparece cuando el 
ajuste está seleccionado Y no modificado. En cuan
to se cambia un valor en TrainingConfig (deslizador, 
stepper, conmutador en las otras secciones del Ins
pector), aparece una insignia naranja «Modified» 
tras el nombre. Los ajustes preestablecidos integra
dos no pueden sobrescribirse — ante modificación 
tienes que crear una copia mediante el botón Save 
(I1).

E N  P O CA S  PA L A B R A S

Hacer clic en una fila activa el 
ajuste preestablecido y toma to­
dos los valores allí guardados 
en los ajustes de entrenamien­
to actuales. El check delante del 
nombre muestra qué ajuste está 
activo. En cuanto luego mueves 
cualquier deslizador, stepper o 
conmutador en las otras seccio­
nes, aparece una insignia naran­
ja «Modified» tras el nombre — 
porque tu setup se desvía ya del 
ajuste preestablecido. Los inte­
grados no se pueden sobrescri­
bir; si quieres conservar los cam­
bios, crea una copia con el botón 
Save… (I1) o duplica el ajuste (I9).

I8 Menú contextual «Export…»

D Ó N D E

Clic derecho en cualquier fila de ajuste preestable
cido → primera entrada «Export…».

T É C N I C O

Funcionalidad idéntica a I5 (botón Export…), pero 
accesible más cómodamente — sin que el ajuste 
preestablecido tenga que seleccionarse primero. 
Exporta directamente el ajuste clicado en la fila. 
Funciona igual para todas las categorías (integrada 
o custom), sin restricción. La exportación contiene 
el flag de integrado y la categoría original, pero en 
la reimportación la categoría se mapea a Custom 
como se describe en I6.

E N  P O CA S  PA L A B R A S

Vía rápida para exportar — clic 
derecho sobre el ajuste deseado 
y elegir «Export…». Ahorra el ro­
deo de clic previo y luego pulsar 
el botón Export…. Funciona igual 
con todas las categorías, tam­
bién con integrados. El archivo 
.radiancepreset  creado es 

idéntico al de I5; en la reimporta­
ción posterior aterriza automáti­
camente en la categoría Custom.
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I9 Menú contextual «Duplicate»

D Ó N D E

Clic derecho en cualquier fila de ajuste preestable
cido → segunda entrada «Duplicate».

T É C N I C O

Clona el ajuste preestablecido en la categoría Cus
tom. Crea un nuevo ID interno, añade « Copy» al 
nombre y guarda la copia. También funciona con 
ajustes integrados — el clon es entonces editable. 
El original queda intacto. La TrainingConfig se copia 
valor por valor (round-trip JSON), así que no que
dan bindings de referencia entre original y copia.

E N  P O CA S  PA L A B R A S

Crea una copia editable de un 
ajuste preestablecido en la cate­
goría Custom. Útil si, p. ej., quie­
res el ajuste integrado «Quality» 
como punto de partida y luego 
solo quieres mover un poco el 
deslizador SSIM. Flujo: duplicar, 
renombrar (menú contextual o 
nueva ejecución de Save…), ajus­
tar, listo. El original queda intac­
to — puedes volver a él cuando 
quieras. También funciona con 
integrados, que es la única ma­
nera de usar sus valores como 
base y a la vez hacerlos edita­
bles.

I10 Menú contextual «Delete»

D Ó N D E

Clic derecho en filas de ajustes preestablecidos 
propios → última entrada «Delete» (rojo, destructi
vo).

T É C N I C O

Solo visible para ajustes personalizados. Los inte
grados no se pueden eliminar. La entrada está mar
cada como destructiva, aparece en rojo en el menú 
contextual y queda separada tras un divisor para 
que no se haga clic por accidente. No hay diálogo 
de confirmación — un clic elimina el ajuste de inme
diato. El ajuste eliminado no es recuperable (Cmd-Z 
no funciona aquí — el Undo existe en la build actual 
solo para la lista de imágenes, no para operaciones 
de ajustes preestablecidos). Si el ajuste eliminado 
estaba activo, la TrainingConfig actual no cambia, 
solo se anula la selección de ajuste activo.

E N  P O CA S  PA L A B R A S

Elimina tus propios ajustes pre­
establecidos. Para los integrados 
(Quick, Preview, Balanced, Qua­
lity, Ultra Detail, Drone / Aerial, 
360° Walkaround, Photo / Object, 
etc.) «Delete» ni siquiera es visi­
ble — no puedes cargártelos por 
accidente. Atención: no hay avi­
so de seguridad ni undo, un clic y 
el ajuste desaparece. Si no estás 
seguro, primero saca una copia 
de seguridad a disco mediante 
Export… (I5/I8) — la puedes re­
importar cuando quieras. Si el 
ajuste estaba activo, tu Training­
Config no cambia, solo desapare­
ce el check.
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I11 Cabecera de categoría (expandir/colapsar)

D Ó N D E

Inspector → Sección Presets → cada cabecera de 
categoría (Capture Class, Classic, MCMC, Hybrid, 
Custom).

T É C N I C O

Estado de colapsado por categoría con predeter
minados distintos: el grupo curado Capture Class 
arranca expandido, Classic, MCMC, Hybrid y Cus
tom arrancan colapsadas. El estado no se persiste 
— al reiniciar la app, todas las categorías vuelven al 
estado por defecto. La flecha chevron rota animada. 
El número de la derecha en la cabecera muestra el 
número de ajustes en esa categoría. El área de im
pacto de clic abarca toda la región de la cabecera.

E N  P O CA S  PA L A B R A S

Expande y colapsa categorías 
para mantener la lista de ajus­
tes preestablecidos ordenada. Al 
iniciar la app, el grupo Captu­
re Class está abierto, Classic, 
MCMC, Hybrid y Custom están 
cerrados. Haz clic en la cabecera 
(toda la región es clicable) y la 
lista se despliega o pliega con 
una breve animación de chevron. 
El pequeño número de la derecha 
muestra cuántos ajustes hay en 
la categoría. Tras reiniciar la app, 
vuelve el estado por defecto — la 
app deliberadamente no persiste 
este ajuste de colapso.

Sección Training Configuration (I12–I22)

Figura 11:  Recorte de solo la sección Training Configuration — Camera Alignment (Apple 
Photogrammetry activo, Native (Beta) inactivo), Densification (Classic activo), Max Iterations 

5.000 / Densify Until 3.500 con icono de enlace, deslizador SSIM Weight 0,20, deslizador 
Render Scale al 100 % (1.536×2.048 = 3,1 MP)

Aquí viven las palancas centrales: qué backend de SfM debe calcular, cómo funciona 
la densificación, cuántas iteraciones, cuánto peso SSIM. Con la estrategia MCMC apa
recen dos conmutadores adicionales («MCMC Quality» y «Auto-scale by scene») que 
quedan ocultos en modo Classic. Con el backend Native SfM se añade el campo de 
override de FOV, necesario solo para fotogramas de vídeo sin distancia focal EXIF.
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I12 Selector Camera Alignment

D Ó N D E

Inspector → Training Configuration → Camera Align
ment (selector segmentado arriba).

T É C N I C O

Selector segmentado con dos opciones: Apple Pho
togrammetry y Native (Beta). La selección determi
na el backend de SfM usado en la próxima recons
trucción de cámara. A la vez influye en qué otros 
elementos del Inspector son visibles: Native mues
tra además el FOV override (I13), necesario solo con 
fotogramas de vídeo sin EXIF. Nota: para capturas 
exteriores muy grandes puedes importar el resulta
do de una herramienta externa (Metashape o COL
MAP) mediante workspace import — véase Capítulo 
1 (M5) y Capítulo 9 (Q3, Q6).

E N  P O CA S  PA L A B R A S

Aquí eliges cómo se reconstru­
yen las posiciones de cámara 
— el conmutador más importan­
te para la calidad final. Apple 
Photogrammetry es el estándar 
rápido y basta para la mayoría 
de los escaneos de objetos. Nati­
ve (Beta) es el desarrollo propio 
compatible con App Store, bueno 
para órbitas y escenas de plato 
giratorio, y necesita el FOV ove­
rride (I13) con fotogramas de ví­
deo sin EXIF. Con sets exteriores 
muy grandes puedes alternativa­
mente calcular las cámaras en 
Metashape o COLMAP y cargar 
el resultado mediante workspace 
import. Los detalles y recomen­
daciones por tipo de escena se 
encuentran en el Capítulo 9.

I13 Campo FOV Override (Native SfM)

D Ó N D E

Inspector → Training Configuration → FOV Override 
(solo visible con Camera Alignment = Native).

T É C N I C O

Campo de texto numérico (rango 0-170°), predeter
minado 0 = determinación automática a partir de 
EXIF o heurística. La entrada manual se necesita 
cuando las imágenes de entrada se extrajeron de un 
vídeo que no contiene metadatos de focal. Valores 
típicos: iPhone Wide ≈ 73°, DJI Mavic Wide-Crop ≈ 
70°, dron con sensor de cuadro completo ≈ 84°. El 
valor se hace clamp a [0, 170] — los valores fuera se 
empujan de vuelta. Solo afecta a la pipeline nativa 
de SfM (Q4/Q5); Apple Photogrammetry ignora por 
completo este valor.

E N  P O CA S  PA L A B R A S

Si tus imágenes no tienen EXIF 
(típico con fotogramas extraídos 
de vídeo), introduce aquí el cam­
po de visión horizontal de la 
cámara en grados. Valores apro­
ximados: iPhone Wide ≈ 73°, DJI 
Mavic Wide-Crop ≈ 70°, dron con 
sensor de cuadro completo ≈ 84°. 
Un 0 deja que la app adivine 
sola — a menudo va bien, pero 
puede salir mal con lentes raras. 
Los valores por encima de 170° 
se hacen clamp automáticamen­
te. El campo solo es visible y solo 
surte efecto si has elegido Native 
como Camera Alignment (I12) — 
Apple Photogrammetry lo ignora 
por completo.
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I15 Selector Densification

D Ó N D E

Inspector → Training Configuration → Densification 
(selector segmentado, siempre visible).

T É C N I C O

Cambia entre las dos estrategias de densificación: 
Classic (procedimiento original 3DGS con clone/
split/prune y umbral de gradiente) y MCMC (Sto
chastic Gradient Langevin Dynamics con Relocation, 
NeurIPS 2024). Al cambiar de Classic a MCMC, la 
app fija los campos específicos de MCMC automáti
camente a valores por defecto probados (pesos de 
reg = 0, multiplicador de tope MCMC 3,0, schedule 
de sample/noise). Sin esa inicialización automática, 
las sesiones con ajustes preestablecidos antiguos 
sufrían el bug de colapso MCMC de la 1.4.4 
(460K→5 Gaussianos, watchdog kill). La selección 
del selector determina además qué elementos del 
Inspector son visibles — con MCMC aparecen I16/
I17. Efecto detallado por campo en el Capítulo 6, 
T11–T16 (Classic) y T61–T73 (MCMC).

E N  P O CA S  PA L A B R A S

La elección central de estrategia 
para hacer crecer el número de 
Gaussianos. Classic está bien tu­
nada a partir de 459 experimen­
tos, produce resultados rápidos 
y de alta calidad, y no requiere 
conocer ningún campo de MCMC. 
MCMC es el enfoque más recien­
te (NeurIPS 2024), más reprodu­
cible y prescinde del ajuste ma­
nual de umbrales — pero calcula 
alrededor de 6× más para una 
calidad comparable. Al cambiar a 
MCMC, la app fija defaults segu­
ros automáticamente para que el 
entrenamiento no caiga en el co­
lapso de 1.4.4. Los detalles de los 
campos de estrategia están en el 
Capítulo 6 (T11–T16 Classic, T61–
T73 MCMC).

I16 Conmutador MCMC Quality

D Ó N D E

Inspector → Training Configuration → MCMC Quality 
(solo con Densification = MCMC).

T É C N I C O

Cambia la acumulación de gradientes a 2 pasos (ac
tivo) o 1 paso (inactivo). Acumula los gradientes de 
dos vistas de cámara consecutivas antes de ejecu
tar el paso del optimizador. Empíricamente (Sesión 
33, V544a) reduce el error L1 final en torno al 6 % 
(0,0246 con Quality vs 0,0261 sin, en promedio de 
3 trials sobre Horse-Full-MCMC). El precio: el doble 
de tiempo de entrenamiento. Con entrenamientos 
muy largos (200K iteraciones) esto añade más de 
10 minutos de espera — así que solo merece la pena 
si los últimos puntos porcentuales de calidad son 
realmente necesarios. Solo afecta al entrenamiento, 
no al formato de exportación ni a la visualización en 
la vista.

E N  P O CA S  PA L A B R A S

Modo de calidad para MCMC con 
acumulación de gradientes entre 
dos vistas. Hace el resultado fi­
nal empíricamente alrededor de 
un 6 % mejor (L1 0,0246 en lugar 
de 0,0261 en la prueba Horse), 
pero cuesta el doble de tiempo. 
Si ya estás ejecutando un entre­
namiento MCMC de 200K (fácil­
mente 2 horas), se añade casi 
otra hora. Merece la pena para 
renderizados de exhibición final 
o al cierre de una sesión de barri­
do de calidad, menos en el flujo 
diario. Solo visible cuando Densi­
fication está en MCMC (I15).
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I17 Conmutador Auto-scale by scene

D Ó N D E

Inspector → Training Configuration → Auto-scale by 
scene (solo con MCMC).

T É C N I C O

Cuando está activo, escala el techo efectivo de 
max-Gaussians con el número de puntos init de 
SfM × multiplicador de tope MCMC (predetermina
do 3,0). Ejemplo: SfM da 250K puntos init, tope 
base = 150K, multiplicador 3,0 → techo efectivo = 
max(150K, 750K) = 750K. Cuando está desactivado, 
solo se aplica estrictamente el base. Se introdujo en 
v1.4.5 porque las grandes capturas exteriores con 
más de 1000 fotogramas y, consecuentemente, alta 
densidad de puntos SfM, mataban de hambre la 
densificación con el tope rígido por defecto de 150K 
— los puntos sobrantes se quedaban, los nuevos no 
podían surgir. Predeterminado OFF en ajustes per
sonalizados, ON en los integrados de MCMC. Solo 
afecta al tiempo de entrenamiento, no a la exporta
ción.

E N  P O CA S  PA L A B R A S

Deja que el número máximo de 
Gaussianos crezca con el tamaño 
de la escena (más exactamente: 
con el número de puntos init 
de SfM). Con escenas pequeñas 
apenas notas diferencia, con es­
cenas exteriores grandes a me­
nudo es crucial para la calidad 
— de otro modo el entrenamien­
to «se asfixia» porque el techo 
predeterminado de 150K es muy 
bajo para la escena. Se intro­
dujo en la v1.4.5 después de 
que sets exteriores muy grandes 
(más de 1000 fotogramas) toca­
ran visiblemente el tope. Con los 
ajustes preestablecidos integra­
dos de MCMC está activado de 
antemano; en los propios, está 
desactivado por defecto.

I18 Stepper Max Iterations

D Ó N D E

Inspector → Training Configuration → GroupBox → 
Max Iterations.

T É C N I C O

Stepper con rango 1.000–100.000, paso 1.000. De
termina el número total de iteraciones del optimiza
dor. Linealmente correlacionado con el tiempo de 
entrenamiento (mitad ≈ 50 % del tiempo). Sweet 
spots empíricos: 20K (Classic Balanced, L1≈0,028), 
40K (Classic Quality, L1≈0,023), 200K (MCMC Full, 
L1≈0,0246). Por encima de 40K con Classic apenas 
aporta mejoras en promedio — diminishing returns. 
Al cambiar, si la función link (I19) está activa, 
Densify Until se arrastra de forma proporcional (ra
tio predeterminado: 0,5, es decir, Densify-Until = 
Max/2).

E N  P O CA S  PA L A B R A S

Cuántos pasos de entrenamien­
to se ejecutan — más es me­
jor, pero también cuesta lineal­
mente más tiempo. Regla prácti­
ca: 20.000 para buena calidad, 
40.000 para el óptimo con la es­
trategia Classic (por encima de 
eso en promedio apenas aporta 
nada más). MCMC necesita bas­
tante más, 200.000 es aquí el 
estándar. Duplicar las iteracio­
nes duplica aproximadamente el 
tiempo de entrenamiento. Con 
el botón de enlace (I19) activo, 
Densify Until se arrastra pro­
porcionalmente — prácticamen­
te siempre lo que quieres.
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I19 Botón Link/Unlink (Densify ↔ Iterations)

D Ó N D E

Inspector → Training Configuration → GroupBox → 
pequeño botón de enlace entre Max Iterations y 
Densify Until.

T É C N I C O

Botón conmutador que congela el ratio de Densify 
Until respecto a Max Iterations. Cuando está activo 
(icono de enlace resaltado), en cada cambio de 
Max Iterations el Densify Until se arrastra propor
cionalmente. Cuando está desenlazado (icono link-
-plus), los valores permanecen independientes. El 
predeterminado está enlazado, porque eso refleja la 
correlación típica — cuando subes el entrenamiento 
al doble de iteraciones, normalmente quieres dejar 
correr también la densificación proporcionalmente 
más. El ratio se calcula a partir del valor actual al 
establecer el botón de enlace; un ratio típico es 0,5 
(Densify-Until = la mitad del número de iteraciones).

E N  P O CA S  PA L A B R A S

Pequeño botón clip entre Max 
Iterations y Densify Until. Cuan­
do está activo (icono de en­
lace resaltado), los dos valo­
res se mueven juntos — si 
duplicas las iteraciones, Den­
sify Until también se dupli­
ca en el mismo ratio. Cuando 
no (icono link.badge.plus ), 
puedes ajustarlos de forma in­
dependiente. El predeterminado 
está enlazado, porque eso refleja 
la correlación típica — un entre­
namiento más largo suele querer 
una fase de densificación más 
larga. Para el 99 % de los casos 
déjalo bloqueado.

I20 Stepper Densify Until

D Ó N D E

Inspector → Training Configuration → GroupBox → 
Densify Until.

T É C N I C O

Stepper con rango 500–50.000, paso 500. Determi
na el índice de iteración a partir del cual ya no 
se añaden nuevos Gaussianos mediante clone/split 
(Classic) o relocalización (MCMC). Tras alcanzarlo, 
solo se refinan posición y color. Valores más altos = 
más Gaussianos = archivo más grande, más tiempo 
de GPU por iteración (+30-60 % de tiempo de GPU 
por paso). Valores típicos: 15K (para 30K max-iter), 
20K (para 40K), 100K (para 200K MCMC). Con link 
activo (I19), escalado automáticamente. Actúa de 
forma distinta con Classic vs MCMC: Classic detie
ne del todo el crecimiento, MCMC detiene la lógica 
de relocalización, pero la adaptación de sample/noi
se sigue corriendo.

E N  P O CA S  PA L A B R A S

Hasta qué iteración pueden aña­
dirse nuevos Gaussianos — con 
Classic mediante clone/split, con 
MCMC mediante relocalización. 
Después, solo se trata de refinar 
color y forma de los puntos exis­
tentes. Más alto = más detalle, 
pero también archivo más gran­
de y +30-60 % de tiempo de 
GPU por paso. Valores típicos: 
15K (para 30K max-iter), 20K (pa­
ra 40K), 100K (para 200K MCMC). 
Normalmente cuelga vía link (I19) 
de Max Iterations — rara vez tie­
ne sentido desacoplarlo manual­
mente.
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I21 Deslizador SSIM Weight

D Ó N D E

Inspector → Training Configuration → GroupBox → 
SSIM Weight.

T É C N I C O

Deslizador 0,0–1,0 en pasos de 0,05, mostrado co
mo «0.20». Mezcla loss L1 (0,0) y loss SSIM (1,0). 
L1 ajusta la luminosidad por píxel, SSIM ajusta la si
militud estructural (bordes, estadísticas locales). El 
predeterminado 0,2 es el valor del paper 3DGS ori
ginal (Kerbl 2023) y se ha verificado como compro
miso robusto en numerosas sesiones. Valores más 
altos (0,5+) favorecen la preservación de detalle, 
pero pueden ignorar errores locales de luminosidad. 
Valores más bajos (< 0,1) llevan a pérdida de detalle 
en bordes nítidos. El cómputo de SSIM corre en 
el shader con una ventana Gaussiana 11×11. Rendi
miento: en 0,0 (solo L1), el entrenamiento es aprox. 
un 8-12 % más rápido, porque el cómputo SSIM se 
omite en el shader.

E N  P O CA S  PA L A B R A S

Con qué fuerza se pondera la 
similitud estructural de imagen 
(bordes, patrones locales) frente 
a la comparación pura de lumi­
nosidad. 0,2 es el estándar del 
paper 3DGS original y basta para 
casi todas las escenas. Más alto 
(0,5+) para estructuras finas co­
mo pelo, pelaje o vegetación — 
ahí más peso estructural ayuda. 
Más bajo (0,0) hace el entrena­
miento alrededor de un 8-12 % 
más rápido, porque se omite el 
cómputo SSIM en el shader, pero 
cuesta detalle en bordes nítidos. 
Si no tienes una buena razón pa­
ra un cambio, deja 0,2 como está.

48 / 242



R A D I A N C E K I T Capítulo 2 — Inspector (Vista Experto)

I22 Deslizador Render Scale

D Ó N D E

Inspector → Training Configuration → GroupBox → 
Render Scale.

T É C N I C O

Deslizador 0,25–1,0 en pasos de 0,25, mostrado 
como «100%». Escala la resolución de renderizado 
del entrenamiento relativa al tamaño de la imagen 
fuente. La mayor palanca de rendimiento: 50 % re
duce el tiempo de GPU aprox. un 75 % (porque 4× 
menos píxeles), 25 % aprox. un 94 %. El umbral de 
gradiente se escala junto automáticamente. Bajo el 
deslizador aparece una visualización de resolución 
en vivo en MP (p. ej., «2304×1296 (3,0 MP)»). Si 
el valor actual se desvía del recomendado, «— reco
mendado: 50 %» se muestra en texto naranja. La 
recomendación apunta a ~3 MP de resolución efec
tiva — el rango más eficientemente procesado por 
las GPUs de Apple Silicon. Las imágenes fuente 4K 
reciben, p. ej., una recomendación de 25 % automá
ticamente; las imágenes FullHD, 100 %. Un cambio 
también dispara la realocación de buffers.

E N  P O CA S  PA L A B R A S

A qué resolución renderiza el 
entrenamiento — una de las ma­
yores palancas de rendimiento. 
Completa (100 %) da la mejor ca­
lidad, pero cuesta mucho tiempo 
de GPU con imágenes grandes. 
Media (50 %) ahorra alrededor 
del 75 % de tiempo de GPU, 
porque se calculan cuatro veces 
menos píxeles — perfecto para 
fuentes 4K. Bajo el deslizador 
ves la resolución efectiva en me­
gapíxeles; la app apunta a unos 3 
MP, porque eso corre con la ma­
yor eficiencia en Apple Silicon. 
Si tu valor se desvía de eso, la 
app muestra un aviso naranja de 
«recomendado» — normalmente 
vale la pena seguirlo.
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Sección Enhancements (I26–I29, I42–I44)

Figura 12:  Recorte de solo la sección Enhancements — tres filas: Post-Training Compactifi
cation (toggle on), Viewport Scaling (selector segmentado Off/MetalFX/Lanczos), Perceptual 

Loss (deslizador en «Off»). Cada fila con subtítulo explica su función

La sección Enhancements agrupa tres funciones que mejoran la calidad de imagen sin 
cambiar en sí el bucle de entrenamiento. Las dos primeras (I26-I27) son etapas post-
-entrenamiento o de vista: Compactification limpia tras terminar el entrenamiento, el 
Viewport Scaling es un renderer puro de vista que no influye en el entrenamiento en 
curso. El Perceptual Loss (I29), pese a pertenecer a la sección, es un componente del 
entrenamiento — se activa como término de loss adicional durante el entrenamiento; de 
ahí la separación de los reguladores de vista mediante un divisor. A partir de la v1.6, 
la sección también tiene un grupo Outdoor (I42–I44: Sky Masking, Mid-Training Floater 
Cleanup, Reconstruct Sky Dome) — opciones de entrenamiento contra los floaters del 
cielo que antes vivían en la ventana de Ajustes y que ahora residen aquí por proyecto.
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I26 Conmutador Post-Training Compactification

D Ó N D E

Inspector → Enhancements → Post-Training Com
pactification.

T É C N I C O

Activa el post-procesado V443: tras terminar las 
iteraciones de entrenamiento, los Gaussianos con 
opacidad por debajo de 0,01 (1 % de visibilidad) se 
eliminan. Empíricamente, esto reduce el tamaño de 
archivo en ~55-58 % sin pérdida visible de calidad 
— porque esos Gaussianos visualmente no aportan 
de todos modos. La compactificación corre como 
una pasada compact GPU y tarda fracciones de se
gundo a unos segundos según el número de Gaus
sianos. No afecta al rendimiento del entrenamiento. 
Si este conmutador está desactivado, también se 
exportan los Gaussianos invisibles — solo relevante 
si quieres usar el formato para otra etapa de en
trenamiento (Continue Training); en caso contrario, 
almacenamiento desperdiciado.

E N  P O CA S  PA L A B R A S

Limpia tras el entrenamiento los 
Gaussianos que de todos modos 
no puedes ver (opacidad por de­
bajo del 1 %). Hace los archivos 
de exportación aproximadamen­
te la mitad de grandes (~55-58 
% de reducción de tamaño) sin 
pérdida visible de calidad. Corre 
como una breve pasada de GPU 
tras la última iteración, tarda so­
lo fracciones de segundo a unos 
segundos. Debería estar prác­
ticamente siempre activado — 
la única razón para desactivarlo 
es si quieres continuar el en­
trenamiento más tarde median­
te Continue Training y necesitas 
conservar también los Gaussia­
nos invisibles. Con flujos norma­
les de exportación déjalo simple­
mente activado.
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I27 Selector Viewport Scaling

D Ó N D E

Inspector → Enhancements → Viewport Scaling (se
lector segmentado con tres opciones: Off, MetalFX, 
Lanczos).

T É C N I C O

Un único selector segmentado que elige el upscaler 
de la vista — las tres opciones son mutuamente 
excluyentes. Cuando la resolución de entrenamien
to (vía I22 Render Scale) es menor que el tamaño 
de la vista, el modo elegido escala el fotograma 
renderizado hasta el tamaño de visualización. Off 
= simple estirado bilineal. MetalFX = el Spatial Ups
caler basado en ML de Apple, la opción más nítida 
(el modelo ML está optimizado para bordes nítidos), 
sobrecarga aprox. 1-2 ms por fotograma en GPUs 
M3. Lanczos = los Metal Performance Shaders de 
Apple con resampling sinc de 8 taps, clásico sin 
ML, sobrecarga mínima (< 0,5 ms), calidad inferior 
a MetalFX, pero sin el «alisado» típico del ML de 
estructuras finas de líneas. La pipeline del rende
rer se reconfigura en vivo al conmutar — visible 
al instante, sin reinicio. Contexto: antes eran dos 
conmutadores separados (MetalFX + Lanczos) que 
podían estar activos a la vez — un estado contradic
torio en el que MetalFX pasaba en silencio por enci
ma de Lanczos. El selector elimina ese estado; un 
estado «ambos-activos» heredado eventualmente 
de sesiones antiguas se cura solo a MetalFX en el 
siguiente cambio. Actúa solo en la vista en vivo, 
no en las exportaciones renderizadas (vídeo orbital, 
capturas) — esas se renderizan a la resolución com
pleta de la fuente.

E N  P O CA S  PA L A B R A S

Afila la imagen en vivo en la 
vista — especialmente útil si tra­
bajas con resolución de entrena­
miento reducida (Render Scale 
50 %, véase I22). Tres niveles, 
de los que siempre hay solo 
uno activo: «Off» simplemente 
estira los píxeles, «MetalFX» usa 
el aprendizaje automático de Ap­
ple para los bordes más nítidos 
(prácticamente siempre la mejor 
elección), «Lanczos» es el filtro 
clásico sin ML — tómalo como 
fallback en caso de que MetalFX 
te alise líneas o muestre artefac­
tos en una escena. Surte efecto 
en vivo, sin reinicio. Solo actúa 
en la vista en vivo, no en vídeos 
orbitales exportados o capturas 
— esos se renderizan a la resolu­
ción completa de la fuente. A di­
ferencia de antes, ya no puedes 
elegir por error dos modos a la 
vez.
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I29 Deslizador Perceptual Loss

D Ó N D E

Inspector → Enhancements → Perceptual Loss.

T É C N I C O

Deslizador 0,0–0,2 en pasos de 0,01, mostrado en 
0,0 como «Off», en otro caso como «0.05», etc. 
Activa un término de loss adicional que compara el 
blur Gaussiano multiescala del renderizado con la 
imagen ground truth (3 escalas de blur). Captura 
diferencias estructurales que L1+SSIM por sí solos 
no detectan. Implementación V460. Empíricamente, 
un valor de 0,05-0,1 mejora la puntuación L1 en 
las sesiones unos pocos puntos porcentuales, pero 
cuesta ~5 % de tiempo de entrenamiento (forward 
pass adicional por los kernels de blur). Por encima 
de 0,15, el entrenamiento se vuelve inestable y L1 
vuelve a empeorar (el término de loss domina la op
timización). Actúa durante el entrenamiento, no en 
post-procesado — pese a su posición en la sección 
«Enhancements», no es un acabado posterior puro.

E N  P O CA S  PA L A B R A S

Un término de loss adicional que 
comprueba la similitud estructu­
ral de imagen sobre tres etapas 
distintas de blur. Ayuda especial­
mente en escenas con estructu­
ras finas como pelo, tela o vege­
tación, porque captura patrones 
que L1+SSIM por sí solos no ven. 
Los valores más pequeños son 
más seguros — 0,05 a 0,1 es el 
sweet spot; por encima de 0,15 
el entrenamiento se vuelve ines­
table y el loss vuelve a empeorar. 
En 0 (Off), la función está total­
mente apagada y no cuesta na­
da; activa, come alrededor de un 
5 % del tiempo de entrenamiento 
por el forward pass extra a través 
de los kernels de blur. Actúa, pe­
se a la sección «Enhancements», 
directamente durante el entrena­
miento, no solo en post-procesa­
do.
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I42 Enmascaramiento de cielo

D Ó N D E

Inspector → Enhancements (grupo Out
door) → Conmutador «Sky Masking». Bound: 
AppState.trainingConfig.skyMaskingEnabled (por 
proyecto, @DefaultFalse ). Predeterminado: 
false .

T É C N I C O

Activa la segmentación de píxeles de cielo basada 
en Apple Vision previa al entrenamiento. Antes de 
iniciarlo, para cada cámara de entrada se extrae 
la región de cielo mediante la máscara de primer 
plano de Apple Vision (Sky = Background) y se 
asigna como máscara por píxel a la respectiva cá
mara. Durante el entrenamiento, la contribución del 
loss por píxel se multiplica por el complemento del 
enmascaramiento de cielo — los píxeles de cielo 
contribuyen 0 al gradiente, por lo que los Gaussia
nos que se proyectan al cielo no reciben señales 
de optimización y por tanto no se vuelven más 
«densos» ni más «brillantes». Reduce significativa
mente los floaters (grupos oscuros en el cielo) en 
escenas de exteriores o dron. Cuesta una regresión 
de L1 del ~3 % en el entrenamiento clásico de 40K 
(véase memory/​dev_​outdoor-floater-reduction.md). 
Solo es útil para escenas exteriores con cielo cla
ramente reconocible; en escenas interiores o con 
fondos blancos, la segmentación de cielo identifica 
zonas equivocadas y bloquea señales válidas de 
loss. El valor ahora se almacena por proyecto (ya 
no es global de la app) y sigue al ajuste preestable
cido / archivo de escena.

E N  P O CA S  PA L A B R A S

En tomas exteriores con cielo en 
el encuadre, a menudo se forman 
grupos negros o coloreados en el 
cielo — los llamados «floaters». 
Esta opción detecta automática­
mente dónde está el cielo y le 
dice al entrenamiento: «Deja el 
cielo en paz.» Funciona muy bien 
para vuelos de dron y escenas 
de paisaje. En interiores o con 
fondos oscuros puede empeorar 
la imagen — así que solo actívalo 
cuando hay cielo real visible. De­
talles: memory/​dev_​outdoor-
floater-reduction.md.
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I43 Limpieza de floaters a mitad del entrenamiento

D Ó N D E

Inspector → Enhancements (grupo Outdoor) → Con
mutador «Mid-Training Floater Cleanup». Bound: 
AppState.trainingConfig.floaterCleanupEnabled 
(por proyecto, @DefaultFalse ). Predeterminado: 
false .

T É C N I C O

Habilita dos pasadas adicionales de control de den
sidad durante el entrenamiento Classic de 40K 
(ajuste preestablecido «P4 Quality»): en la iteración 
20,000 y en la 30,000. Ambas pasadas examinan 
todos los Gaussianos según tres criterios: (a) opaci
dad muy baja (predeterminado 0,005), (b) tamaño 
en espacio de pantalla diminuto, (c) sin contribu
ciones al loss en las últimas 1000 iteraciones. Los 
Gaussianos que cumplen las tres condiciones se 
purgan. Efecto: ~5–15 % menos Gaussianos al final 
del entrenamiento, visiblemente menos grupos os
curos en el cielo en escenas de dron/exteriores. 
Cuesta una regresión de L1 del ~1–3 % en esce
nas interiores de primer plano, por eso no está 
activa por defecto. Las dos iteraciones de limpieza 
(20K, 30K) están codificadas y de momento no se 
pueden cambiar desde la UI; para entrenamientos 
más cortos (p. ej. P2 Preview 5K), el conmutador 
no tiene efecto, porque nunca alcanza los hitos 
de iteración. Nuevo: el conmutador solo se pue
de manejar cuando el ajuste preestablecido activo 
usa el densificador Classic (densificationStrategy 
== .classic). Con MCMC o Hybrid queda deshabi­
litado y aparece un aviso inline, porque esas estra
tegias gestionan de todos modos los Gaussianos 
muertos por sí mismas (MCMC vía relocalización, 
Hybrid vía una lógica combinada de reloc/ruido) 
— las pasadas manuales de limpieza serían ahí 
inútiles o contraproducentes. Referencia de código: 
RadianceKitApp.swift, pestaña General. Detalles: 
memory/​dev_​outdoor-floater-reduction.md.

E N  P O CA S  PA L A B R A S

Durante el entrenamiento, a ve­
ces se forman puntos Gaussia­
nos «muertos» que ya no contri­
buyen a la calidad de la imagen 
pero ocupan memoria. Esta op­
ción hace una limpieza dos veces 
durante un entrenamiento largo 
(en 20K y 30K iteraciones) y eli­
mina esos cadáveres. En escenas 
exteriores con cielo es especial­
mente útil, porque la mayoría de 
los floaters se reúnen allí. Para 
entrenamientos pequeños o pri­
meros planos de muebles, no 
es realmente necesario. El con­
mutador solo se puede activar 
cuando tu ajuste preestablecido 
usa el densificador Classic — 
con ajustes MCMC o Hybrid que­
da atenuado (junto con una bre­
ve explicación), porque esos lim­
pian sus puntos muertos por su 
cuenta.

55 / 242



R A D I A N C E K I T Capítulo 2 — Inspector (Vista Experto)

I44 Reconstruir cúpula de cielo

D Ó N D E

Inspector → Enhancements (grupo Outdoor) → 
Conmutador «Reconstruct Sky Dome». Bound: 
AppState.trainingConfig.skyDomeEnabled (por pro
yecto, @DefaultFalse ). Predeterminado: false .

T É C N I C O

Activa la proyección de Sky Dome previa al entrena
miento (V549e MVP). Tras el SfM y antes del inicio 
del entrenamiento, se extrae de la imagen para cada 
cámara de entrada la máscara de cielo de Apple 
Vision compartida con I42, los píxeles de cielo se 
desproyectan usando los intrínsecos de la cámara 
sobre una superficie esférica virtual (radio prede
terminado 8× el radio de la escena). Sobre esa 
esfera se inicializan ~5000 nuevos Gaussianos con 
medias de color de los píxeles de cielo proyectados, 
escala muy grande (1,0 en unidades de escena) y 
opacidad inicial 0,95. Estos 5000 Gaussianos no 
son una máscara de cielo en sentido clásico — se 
entrenan como todos los demás, pero la alta opaci
dad inicial los mantiene en una capa delgada. Resul
tado: en vistas novel de 360° en escenas exteriores/
dron aparecen el color y las estructuras de nube 
reales en lugar de los grupos de confeti oscuro. El 
valor se recuerda entre reinicios. Solo útil para es
cenas exteriores con al menos cobertura de cámara 
de 360°; en capturas puras de objeto sin vista del 
cielo no tiene efecto. Estado: experimental, valida
ción A/B más amplia sobre más sets exteriores aún 
pendiente.

E N  P O CA S  PA L A B R A S

En lugar de que el entrenamiento 
intente «adivinar» el cielo a par­
tir de los pocos píxeles visibles 
(lo que lleva a floaters), Radian­
ceKit proyecta los píxeles de cie­
lo directamente sobre una esfera 
virtual alrededor de la escena 
antes de iniciar el entrenamien­
to. Cuando luego rotas la escena 
terminada en 360°, ves cielo real 
en lugar de grupos negros. Solo 
funciona en tomas exteriores en 
las que de hecho hay cielo en 
el encuadre. Para escaneos de 
salones o tomas de estudio no 
aporta nada.
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Sección Metrics (I30–I38)

Figura 13:  Recorte de solo la sección Training Metrics tras un entrenamiento completado en 
el ramo (5K iteraciones, 2.991 Gaussianos finales) — tabla con métricas de entrenamiento 
(Iteration, Loss, SSIM Loss, Combined Loss, Gaussian Count, Learning Rate, Elapsed, ETA)

Mientras un entrenamiento está en curso, la sección Metrics muestra nueve valores 
en vivo del bucle de entrenamiento. Antes de iniciar un entrenamiento, la sección está 
vacía («Start training to see live metrics»). Todos los valores se actualizan cada ~30 
iteraciones (frecuencia de actualización del stream). La sección es de solo lectura — 
ningún elemento es clicable o modificable. Para un análisis más profundo, consulta 
los logs de entrenamiento JSONL en ~/​Documents/​RadianceKit/​Logs/​ (script python3 
scripts/​analyze_​logs.py best 5).
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I30 Iteration

D Ó N D E

Inspector → Metrics → Iteration. Solo lectura.

T É C N I C O

Se muestra en el formato «4523 / 40000» — 
iteración actual sobre el total de iteraciones planifi
cadas. Cuenta de forma sincronizada con el bucle 
de entrenamiento, que empuja los valores cada ~30 
iter. El segundo número corresponde al valor de 
Max Iterations en el momento del inicio; ya no cam
bia, aun cuando el usuario ajuste después el step
per — el run en curso usa su propia copia snapshot. 
Si la app añade iteraciones adicionales mediante el 
menú Training (Continue Training +5K/+10K/+20K), 
el denominador aumenta.

E N  P O CA S  PA L A B R A S

Dónde está el entrenamiento 
ahora mismo. «4523 / 40000» 
significa: 4523 de 40.000 pasos 
hechos, así que aproximadamen­
te el 11 % completado. El número 
de la izquierda cuenta hacia arri­
ba en tiempo real; si se queda 
parado durante minutos, el en­
trenamiento está colgado — nor­
malmente indicio de throttling 
de GPU o una app competidora. 
El número de la derecha corres­
ponde al valor de Max Iterations 
(I18) al inicio del entrenamiento 
y ya no cambia, aun cuando ajus­
tes después el stepper. Con Con­
tinue Training (+5K/+10K/+20K) 
crece según los pasos adiciona­
les.

I31 Loss

D Ó N D E

Inspector → Metrics → Loss. Solo lectura.

T É C N I C O

Valor float con seis decimales (p. ej., «0.024385»). 
Mide el loss combinado L1+SSIM (mezcla controla
da vía I21 SSIM Weight) más el Perceptual Loss 
opcional (I29) y otros regularizadores. La escala 
no es absoluta, sino dependiente de la escena — 
exige el mismo dataset para la mayoría de las 
comparaciones. Valores finales típicos con buenas 
configuraciones: - Classic Quality 40K iter: 0,022–
0,025 (Horse, Truck, Garden) - MCMC Full 200K 
iter: 0,024–0,028 - Outdoor dron 30K: 0,030–0,060 
(peor por razones de geometría) - Apartamentos in
door: 0,018–0,025

Valores por encima de 0,10 tras 5K iteraciones indi
can problemas de SfM (malas poses de cámara) — 
aborta y recalcula el SfM.

E N  P O CA S  PA L A B R A S

Cuánto se desvía la imagen ren­
derizada aún del original — com­
binado de L1, SSIM y posiblemen­
te Perceptual Loss. Más pequeño 
es mejor. Por debajo de 0,03 nor­
malmente es muy bueno, por de­
bajo de 0,05 aún aceptable; las 
escenas exteriores están, por ra­
zones de geometría, más bien 
en 0,03-0,06. Por encima de 0,10 
tras varios miles de iteraciones 
es una señal de aviso — nor­
malmente es la reconstrucción 
de cámara (el SfM no funcionó 
limpiamente). La escala no es ab­
soluta, sino dependiente de la 
escena; haz comparaciones solo 
dentro del mismo dataset. Si el 
número de repente sube a sal­
tos, normalmente ha ocurrido un 
evento de explosión de gradien­
te.
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I32 Learning Rate

D Ó N D E

Inspector → Metrics → Learning Rate. Solo lectura.

T É C N I C O

Visualización en notación científica (p. ej., 
«1.60e-04»). Tasa de aprendizaje actual para los 
parámetros de posición (3DGS tiene seis LRs in
dependientes para posición, SH-DC, SH-Rest, opa
cidad, escala, rotación — aquí se muestra la LR 
de posición como valor representativo). Valor inicial 
predeterminado 1,6e-4, que decae mediante decay 
exponencial a ~1,6e-6 al final del entrenamiento. El 
decay es ajustable mediante el campo LR schedule 
en la configuración de entrenamiento (campo T en 
el Cap. 6). Si la LR se mantiene inusualmente alta 
(p. ej., 1e-3 o más después de 10K iteraciones), 
podría indicar una configuración cargada incorrec
tamente.

E N  P O CA S  PA L A B R A S

Lo grandes que son ahora mis­
mo los pasos de optimización — 
concretamente la tasa de apren­
dizaje para las posiciones Gaus­
sianas. Empieza en 1.60e-04 
y cae exponencialmente has­
ta cerca de 1.60e-06 al final 
del entrenamiento («1.60e-06» = 
0,0000016). La curva corre auto­
máticamente, no tienes que ajus­
tar nada aquí. Si el valor tras 
más de 10.000 iteraciones sigue 
siendo mayor que 1e-3, proba­
blemente se cargó una config 
incorrecta — aborta el entrena­
miento y elige un nuevo ajus­
te preestablecido. Internamente, 
3DGS tiene seis tasas de apren­
dizaje independientes (posición, 
SH-DC, SH-Rest, opacidad, esca­
la, rotación); aquí solo ves la LR 
de posición como sustituto.

I33 SH Degree

D Ó N D E

Inspector → Metrics → SH Degree. Solo lectura.

T É C N I C O

Entero 0-3. Grado de spherical harmonics para la 
representación de color. Empieza en 0 (solo el com
ponente DC, es decir, color independiente de la 
dirección por Gaussiano — es decir, solo una cons
tante RGB) y sube progresivamente hasta 3 a lo 
largo del entrenamiento. El schedule estándar sube 
el grado en 1000/2000/3000 iteraciones en 1 cada 
vez. SH-3 corresponde a 48 coeficientes de color 
por Gaussiano (3 canales RGB × 16 funciones base 
SH). Mayor grado SH = más reflejos dependientes 
de la dirección (las superficies brillantes se ven 
correctamente distintas bajo distintos ángulos de 
visión), pero también más memoria y entrenamiento 
más lento.

E N  P O CA S  PA L A B R A S

Lo compleja que es ahora mismo 
la representación de color por 
Gaussiano. Empieza en 0 (solo un 
color independiente de la direc­
ción por punto) y se sube por pa­
sos a 3 — típicamente en la itera­
ción 1000, 2000 y 3000. La etapa 
3 significa 48 coeficientes de 
color por Gaussiano y permite re­
flejos dependientes de la direc­
ción, es decir, que las superficies 
brillantes se ven correctamente 
distintas desde diversos ángulos 
de visión. No necesitas tocar es­
to activamente, el schedule corre 
automáticamente. Un grado más 
alto cuesta más memoria y ralen­
tiza un poco el entrenamiento — 
pero es el precio para brillos rea­
listas.
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I34 Gaussians

D Ó N D E

Inspector → Metrics → Gaussians. Solo lectura.

T É C N I C O

Número actual de Gaussianos en el modelo, forma
teado con separador local (p. ej., «524.318»). Cre
cimiento: - Classic: empieza en los puntos init de 
SfM (típicamente 50K-300K), crece mediante clone/
split hasta justo antes de Densify Until, después 
estático hasta el final del entrenamiento (módulo 
pruning) - MCMC: los puntos sample se añaden 
hasta el tope MCMC, después solo relocalización

Valores finales sanos: - Classic Quality: 400K-700K 
(Horse 524K, Garden 800K) - MCMC Full: exacta
mente en el tope (predeterminado 150K, con multi
plicador auto-scale × número de SfM, según escena 
500K-1,5M)

Con MCMC, si el número cae a < 60 % del tope → 
anomalía (indicador de colapso, sugiere regulariza
dores demasiado agresivos).

E N  P O CA S  PA L A B R A S

Cuántos puntos Gaussianos tie­
ne actualmente el modelo 3D. 
Crece durante el entrenamien­
to hasta alcanzar Densify Until 
(I20); después, el número se 
mantiene prácticamente cons­
tante. Más puntos = más detalle, 
pero también archivo más gran­
de y renderizado más lento en 
la vista. 500.000 Gaussianos es 
una media típica para Classic 
Quality en una escena media; 
MCMC Full aterriza, según el au­
to-scale (I17), entre 500K y 1,5M. 
Si el número con MCMC de re­
pente cae por debajo del 60 % del 
tope, es un indicador de colapso 
— normalmente regularizadores 
demasiado agresivos.

I35 GPU Memory

D Ó N D E

Inspector → Metrics → GPU Memory. Solo lectura.

T É C N I C O

Estimación del consumo de memoria del buffer de 
Gaussianos como número de Gaussianos × 616 
bytes (formateado en estilo memoria). 616 bytes 
es el tamaño empírico de un Gaussiano totalmente 
equipado (posición, escala, rotación, opacidad, co
eficientes SH grado 3, acumulador de gradiente). La 
visualización no captura el overhead del renderer 
(buffer de tiles, buffer de sort, buffer backward) 
— el requisito real de memoria GPU es típicamente 
2-3× este valor. Con 500K Gaussianos: mostrado 
~290 MB, real ~700 MB. Con 1,5M Gaussianos: 
mostrado ~880 MB, real ~2,5 GB. En M3 Max con 
64+ GB de memoria unificada es no crítico, en M3 
Pro con 18 GB ya es un límite.

E N  P O CA S  PA L A B R A S

Una estimación de cuánta me­
moria GPU ocupan los propios 
Gaussianos — alrededor de 616 
bytes por punto. El consumo real 
de GPU es 2-3× más alto que 
el mostrado, porque el renderer 
añade sus propios buffers de tile, 
sort y backward. En un MacBook 
con 16-18 GB de memoria uni­
ficada deberías mantenerte por 
debajo de 500K Gaussianos; con 
M3 Max o Studio (64+ GB) puedes 
ejecutar fácilmente 1,5M y más. 
Si el entrenamiento se cae de re­
pente o el sistema hace swap, 
normalmente se ha alcanzado el 
límite aquí — baja Render Scale 
(I22) o reduce Densify Until (I20).
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I36 Speed

D Ó N D E

Inspector → Metrics → Speed. Solo lectura.

T É C N I C O

Iteraciones por segundo con un decimal («24.3 it/
s»). Calculado por el entrenador como media móvil 
sobre las últimas ~100 iteraciones. Valores típicos: 
- ajuste preestablecido Quick (1K iter): 80-120 it/
s (corto, sin estado estable) - Classic 20K @ 1,0 
Render Scale (escena Truck, M3 Max): 25-35 it/s 
- Classic 20K @ 0,5 Render Scale: 80-120 it/s - 
MCMC 200K @ 0,5 Render Scale: 25-50 it/s (más 
lento por la relocalización) - Con 1M+ Gaussianos y 
resolución completa: < 10 it/s

Una velocidad decreciente a lo largo del entrena
miento es normal — más Gaussianos = más cómpu
to por iteración. Las caídas repentinas (p. ej., de 30 
→ 5 it/s) indican thermal throttling de GPU o apps 
competidoras.

E N  P O CA S  PA L A B R A S

Lo rápido que está corriendo 
el entrenamiento, en iteraciones 
por segundo. Típicamente está 
en 20-50 it/s, con Render Scale 
reducido (50 %) y escenas pe­
queñas también 80-120 it/s. Cae 
a lo largo del entrenamiento de 
forma natural, porque más Gaus­
sianos = más trabajo por itera­
ción. Las caídas repentinas (p. 
ej., 30 → 5 it/s) indican thermal 
throttling de GPU o apps compe­
tidoras — pestañas de navega­
dor con vídeo, copia de Time Ma­
chine, indexado de Fotos. Mante­
ner la app en primer plano y ce­
rrar programas en segundo plano 
suele ayudar. Con 1M+ Gaussia­
nos y resolución completa, por 
debajo de 10 it/s es normal.

I37 Elapsed

D Ó N D E

Inspector → Metrics → Elapsed. Solo lectura.

T É C N I C O

Tiempo ya transcurrido como «4:23» (m:ss) o 
«1:23:45» (h:mm:ss). Cambio de formato a partir de 
1 hora. Mide solo el tiempo de entrenamiento puro, 
no las fases previas (cómputo de SfM, importación 
de imágenes). Con pause/resume el reloj sigue co
rriendo — es decir, es wall-clock, no tiempo de CPU.

E N  P O CA S  PA L A B R A S

Cuánto tiempo lleva corriendo 
el entrenamiento, como cronó­
metro puro (tiempo wall-clock). 
Formato es «m:ss» hasta una 
hora, después «h:mm:ss». No es 
«tiempo de CPU», sino «cuánto 
tiempo llevamos esperando» — 
así que los tiempos de pausa 
también cuentan. Mide solo la fa­
se pura de entrenamiento, no el 
cómputo previo de SfM ni la im­
portación de imágenes. Útil para 
comparar con el ETA (I38) — 
si Elapsed supera claramente el 
ETA original, el entrenamiento se 
ha vuelto más lento de lo previs­
to en algún punto.
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I38 ETA

D Ó N D E

Inspector → Metrics → ETA. Solo lectura.

T É C N I C O

Tiempo restante estimado como «17:42» o 
«1:12:35». Cálculo: (Max Iterations − iteración ac
tual) / iteraciones por segundo. Muestra «–» cuan
do la velocidad es actualmente cero (al principio 
o durante una pausa). La estimación no se ajusta 
al ralentizamiento típico hacia el final del entrena
miento — especialmente con MCMC y Classic con 
valores grandes de Densify-Until, el entrenamiento 
tiende a volverse más lento porque entran cada vez 
más Gaussianos. En la realidad suele quedar 10-20 
% por encima del ETA inicial.

E N  P O CA S  PA L A B R A S

Cuánto tiempo se espera que 
quede — calculado a partir de 
las iteraciones restantes y la ve­
locidad actual (I36). Una estima­
ción aproximada: si el Mac de 
repente se vuelve más lento (más 
Gaussianos de la fase de densify, 
thermal throttling, otras apps), 
puede durar más de lo mostrado. 
La app no tiene en cuenta el ra­
lentizamiento típico hacia el final 
del entrenamiento, así que el fi­
nal real suele caer un 10-20 % por 
encima del ETA inicial. Si le su­
mas un 15 % extra, suele encajar. 
Muestra «–» cuando la velocidad 
es ahora mismo 0 (inicio del en­
trenamiento o pausa).
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Sección Loss Chart (I39–I41)

Figura 14:  Recorte de solo la sección Loss History tras un entrenamiento completado — 
Current 0,0064, Min 0,0035 (verde), curva azul de 0,027 (iteración 1) a 0,0035 (iteración 5K) 

con codo característico hacia la iter 200, debajo gráfico Gaussian Count naranja

La sección Loss Chart visualiza el transcurso del entrenamiento a lo largo del tiempo. 
Consiste en dos gráficos: un gráfico Loss Curve (grande, arriba, azul) y un gráfico 
Gaussian Count (más pequeño, abajo, naranja). Ambos se construyen en vivo durante 
el entrenamiento y persisten hasta el siguiente inicio de entrenamiento. Antes del 
primer entrenamiento, el área está vacía («Loss curve will appear during training»). 
Los gráficos son dibujos de path SwiftUI puros (no el framework Swift Charts), así que 
renderizan con fluidez incluso con 100K+ puntos.
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I39 Current Loss (visualización)

D Ó N D E

Inspector → Loss Chart → área de etiqueta izquier
da «Current: 0.0287». Solo lectura.

T É C N I C O

Valor float del último sample point de loss, forma
teado con cuatro decimales. Idéntico a I31 (Loss en 
la sección Metrics), solo que aquí formateado de 
forma más compacta. La fuente es el historial de 
loss — una lista que recibe una entrada cada ~30 
iteraciones. Solo se añaden valores finitos a la lista 
— NaN/Infinity (muy raros, en el caso de un bug de 
explosión de gradiente) se filtran.

E N  P O CA S  PA L A B R A S

El valor de loss actual en nota­
ción más corta que en la sec­
ción Metrics (cuatro decimales). 
De contenido idéntico a I31, pero 
aquí la visualización está justo 
en el gráfico de loss y te da el 
valor numérico exacto al obser­
var la curva. Como todas las mé­
tricas en vivo, se actualiza cada 
~30 iteraciones. Los valores NaN 
o Infinity (extremadamente raros 
con bugs de explosión de gra­
diente) la app los filtra automáti­
camente. Útil al mirar el gráfico 
para no tener que saltar a la otra 
sección.

I40 Min Loss (visualización)

D Ó N D E

Inspector → Loss Chart → área de etiqueta derecha 
«Min: 0.0245» (verde). Solo lectura.

T É C N I C O

Mínimo de todos los valores de loss vistos jamás del 
run de entrenamiento actual. Recalculado en vivo a 
partir del historial de loss — sin persistencia sepa
rada. Visualizado con texto verde, porque «Min» 
= «Best so far». La línea verde discontinua en el 
borde inferior del gráfico marca esta posición Y 
visualmente. Con sesiones de continue-training, el 
seguimiento del min se reinicia — el historial antiguo 
es reemplazado en la UI por el nuevo (no anexado). 
Si el entrenamiento actual corre peor que el previo, 
la visualización del min puede ser mayor que el re
sultado final anterior.

E N  P O CA S  PA L A B R A S

El valor de loss más bajo que es­
te entrenamiento ha visto hasta 
ahora — mostrado en verde, por­
que «el mejor hasta el momen­
to». La línea verde discontinua 
en el borde inferior del gráfico 
también marca esta posición vi­
sualmente. Si la curva actual es­
tá ahora claramente por encima, 
con suerte aún hay una mejora; 
normalmente Min es el indicador 
de resultado final que te importa 
después. Con sesiones de conti­
nue-training, el seguimiento del 
min se reinicia, porque el histo­
rial antiguo es reemplazado en la 
UI por el nuevo — el valor min 
puede por tanto verse peor que 
el resultado final anterior.
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I41 Gráfico Gaussian Count

D Ó N D E

Inspector → Loss Chart → segundo gráfico debajo 
(naranja). Solo lectura.

T É C N I C O

Gráfico de línea del número de Gaussianos sobre las 
iteraciones de entrenamiento. Fuente: el historial del 
número de Gaussianos (lista de pares (iter, count), 
rellenado por el entrenador cada ~30 iter). Escala Y 
dinámica entre mínimo y máximo del historial. Con 
la estrategia Classic la curva típicamente tiene este 
aspecto: subida sostenida hasta Densify Until, luego 
plana (con pequeñas fluctuaciones de pruning). Con 
MCMC: subida pronunciada hasta el tope, después 
línea horizontal (la relocalización mantiene el núme
ro constante). Si la curva cae pese a entrenamiento 
activo, la densificación está podando con demasia
da agresividad — indicio de defaults incorrectos o 
un bug conocido de colapso MCMC (tema del hotfix 
v1.4.4).

E N  P O CA S  PA L A B R A S

Cómo se desarrolla el número de 
Gaussianos a lo largo del tiem­
po de entrenamiento — el grá­
fico naranja más pequeño bajo 
la curva de Loss. Con la estrate­
gia Classic, la línea sube sosteni­
damente hasta alcanzar Densify 
Until (I20), después se mantiene 
plana con pequeñas fluctuacio­
nes de pruning. Con MCMC dis­
para con fuerza hasta el tope y 
después se mantiene horizontal, 
porque la relocalización mantie­
ne el número constante. Si la 
curva, pese a entrenamiento ac­
tivo, de repente cae hacia abajo, 
la densificación está siendo de­
masiado agresiva con el pruning 
— señal clásica del bug de colap­
so MCMC de la v1.4.4. Entonces 
ayuda la actualización de la app 
o volver a Classic.

¿Cómo leer la curva de loss?

El gráfico de loss es la herramienta de diagnóstico más importante del Inspector — 
ningún otro indicador muestra de manera tan directa si el entrenamiento avanza de 
forma útil o está estancado. La forma sana típica es una caída rápida en las primeras 
1000-3000 iteraciones (de ~0,15 a ~0,05), seguida de un descenso lento y sostenido 
hasta el final del entrenamiento (hasta 0,020-0,030). De forma logarítmica, la curva 
parece una diagonal suave.

¿Qué significa una meseta en el loss? Si la curva permanece plana durante varios 
miles de iteraciones, hay dos lecturas posibles: (a) el entrenamiento ha «convergido» 
— el loss ya no puede bajar de forma significativa, porque el modelo es tan bueno 
como puede ser con los datos y ajustes dados. Eso es lo deseado; está «listo». (b) El 
entrenamiento «se cuelga» — el loss aún podría bajar, pero la optimización se estanca 
(mínimo local, learning rate demasiado bajo, densificación desactivada). Para distinguir: 
si el valor de loss cae en un rango típicamente bueno (0,020-0,030 con indoor/objeto, 
0,040-0,060 con outdoor) y la curva está plana desde las 5K iteraciones, ha convergi
do. Si el valor es claramente más alto que con escenas comparables (p. ej., 0,08), se ha 
colgado.

Nota: meseta de Gaussianos ≠ meseta de loss. Una meseta en el número de Gaus
sianos no significa «el entrenamiento está hecho». Solo significa que la densificación 
ha dejado de añadir nuevos puntos — ya sea porque se ha alcanzado (Classic) o porque 
el tope MCMC está lleno. El entrenamiento continúa después y solo refina los puntos 
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existentes. La señal real de «listo» la lees en la curva de loss y en la visualización de 
Iteración (I30), no aquí.

Regla práctica para abortar: Si la curva de loss tras 5000+ iteraciones está por enci
ma de 0,08 y apenas baja, con alta probabilidad la reconstrucción de SfM está torcida. 
Aborta el entrenamiento, mira en el Capítulo 9 si el backend de SfM elegido encaja 
con la escena, posiblemente cambia a COLMAP/Native, después reinicia. Mejor invertir 
10 minutos en un SfM mejor que 2 horas de entrenamiento con una mala alineación de 
cámara.

¿Cuándo recurrir al Inspector?

Referencia rápida: ¿qué sección + qué controles para qué caso de uso típico?
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Tarea habitual Sección IDs de control

Desaturar los colores del splat 
terminado

Look L1 (Saturation)

Redondear splats de aguja/
confeti

Look L2 (Splat length)

Rellenar nube agujereada / 
agrandar splats

Look L3 (Splat size)

Desvanecer el «confeti lejano» 
en órbitas

Look L4 (Fade far region)

Descartar los ajustes de Look Look L5 (Reset finishing)

Cargar un setup prefabricado Presets I7 (clic en fila)

Guardar un setup propio Presets I1 → I2 → I4

Compartir un setup con un 
compañero

Presets I5 (Export) o I6 (Import)

Cambiar backend de SfM (p. 
ej., porque Apple-PG es muy 

inestable)

Training Configura
tion

I12 (véase Cap. 9)

Procesar fotogramas de vídeo 
sin focal EXIF

Training Configura
tion

I13 (FOV Override)

Rendimiento de COLMAP: 
GLOMAP en lugar de Classic

Training Configura
tion

I14

Cambiar de Classic a MCMC Training Configura
tion

I15

Dejar correr el entrenamiento 
más tiempo

Training Configura
tion

I18 (Max Iter) + I20 (Densify 
Until) — acoplados vía I19

Reducir a la mitad el tiempo de 
GPU

Training Configura
tion

I22 (Render Scale al 50 %)

Calidad de entrenamiento +6 % 
(MCMC)

Training Configura
tion

I16 (MCMC Quality)

Escena exterior con muchos 
puntos SfM

Training Configura
tion

I17 (Auto-scale by scene)

Configurar / cambiar la ruta de 
COLMAP

Training Configura
tion

I23 / I24 / I25

Hacer los archivos de exporta
ción más pequeños

Enhancements I26 (déjalo siempre activo)

Vista más nítida sin más tiempo 
de entrenamiento

Enhancements I27 (Viewport Scaling → Me
talFX)

MetalFX suaviza demasiado → 
alternativa

Enhancements I27 (Viewport Scaling → Lan
czos)

El último ápice de detalle con 
estructuras finas

Enhancements I29 (Perceptual Loss 0,05-0,1)Monitorizar el entrenamiento Metrics I30 (progreso), I36 (ritmo), I38 
(tiempo restante)

Valorar la calidad temprano Metrics I31 (Loss < 0,05 tras 5K = 
bueno)

Sospechar un problema de SfM Metrics + Loss Chart I31 + I39 (Loss > 0,08 tras 5K 
→ rehacer SfM)

Distinguir convergencia vs es
tancado

Loss Chart I39 + I40 (leer la meseta de 
loss)

Identificar un problema de den
sificación

Loss Chart I41 (la curva Gaussian cae → 
bug)67 / 242
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C A P Í T U L O

Capítulo 3 — Ajustes

La ventana de ajustes se abre con RadianceKit → Settings… o con el atajo de teclado 
estándar ⌘, . Contiene dos pestañas: General y AI Helpers. A diferencia de los valores 
del Inspector del Capítulo 2, los ajustes de esta ventana tienen efecto a nivel de apli­
cación (en todos los proyectos) — se persisten y sobreviven al reinicio de la app. La 
pestaña General agrupa tres secciones de contenido: Interfaz, Vista y Entrenamiento. 
(Los tres conmutadores de reducción de floaters en exteriores — Sky Masking, Mid-
Training Floater Cleanup, Reconstruct Sky Dome — que antes vivían aquí se trasladaron, 
a partir de la v1.6, a la sección Enhancements del Inspector experto, donde ahora se al
macenan por proyecto; véase el Capítulo 2, I42–I44.) La pestaña AI Helpers habilita los 
asistentes de aprendizaje automático on-device (Vision, CoreML) para el preprocesado 
de SfM y entrenamiento.

Los controles anteriores para habilitar o deshabilitar conjuntamente todos los AI Hel
pers ya no existen en la versión actual — por eso no se documentan aquí. La antigua 
zona «Coming Soon» para asistentes aún no entregados también se ha eliminado y no 
se referencia aquí.
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Pestaña General

Figura 15:  Ajustes → pestaña General con las secciones Interfaz, Vista, Entrenamiento y 
Experimental
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S1 Modo predeterminado

D Ó N D E

Settings → General → Interface → Selector Default 
Mode. Bound:. Predeterminado: .simple .

T É C N I C O

Controla en cuál de los dos modos de UI se abre 
la app tras el próximo arranque. «Simple Mode» es 
el flujo de asistente guiado en 4 pasos (Importar → 
Procesar → Previsualizar → Exportar, documentado 
en el Capítulo 10 bajo Z1–Z4), «Expert Mode» el 
diseño clásico de tres paneles con Navegador, Vista 
3D e Inspector experto del Capítulo 2. El valor se re
cuerda entre reinicios. Efecto idéntico al menú Mode 
→ Simple Mode (⌘1) / Mode → Expert Mode (⌘2), 
salvo que el menú cambia la sesión en curso mien
tras este selector establece el predeterminado para 
sesiones futuras. Ambos modos acceden al mismo 
estado del proyecto — los proyectos, las cámaras y 
la configuración de entrenamiento se conservan al 
cambiar de modo. Los botones de la barra de herra
mientas específicos de cada modo se renderizan de 
inmediato.

E N  P O CA S  PA L A B R A S

Aquí eliges con qué interfaz 
arranca RadianceKit en el próxi­
mo lanzamiento. «Simple Mode» 
es el modo principiante: cuatro 
pasos claros, ajustes preestable­
cidos predefinidos, apenas op­
ciones. «Expert Mode» es el la­
yout completo de caja de herra­
mientas con todos los controles 
que ves en el Capítulo 2. Puedes 
alternar en cualquier momento 
mediante el menú «Mode» sin 
perder imágenes ni progreso de 
entrenamiento.
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S2 Idioma

D Ó N D E

Settings → General → Interface → Selector Lan
guage. Bound:. Predeterminado: .system  (sigue el 
idioma de macOS).

T É C N I C O

Selecciona el idioma de visualización de toda la 
UI de la app, independientemente del idioma del 
sistema macOS. RadianceKit está localizado en 17 
idiomas ( de , en , pl , en-AU , ar-SA , más 12 
adicionales). Cuando se ajusta a «System», la app 
sigue al idioma de macOS. Con una elección explí
cita, el ajuste de idioma se recuerda entre reinicios; 
el efecto completo normalmente requiere reiniciar 
la app, porque los paquetes de localización solo 
se cargan al inicio. Se tienen en cuenta las 298 cla
ves de localización documentadas en el proyecto, 
incluidos todos los textos en sub-vistas y tooltips 
de ayuda.

E N  P O CA S  PA L A B R A S

Si tu Mac está en inglés pero 
prefieres la interfaz de Radian­
ceKit en alemán (o al revés), aquí 
lo configuras. La mayoría de los 
textos cambian de inmediato. Al­
gunos diálogos solo aparecen en 
el nuevo idioma tras reiniciar la 
app.

S3 Fondo de la vista

D Ó N D E

Settings → General → Viewport → Selector Back
ground. Bound:. Predeterminado: .darkGray  (RGB 
0,1, 0,1, 0,1).

T É C N I C O

Establece el color de fondo predeterminado para 
la vista 3D. Tres opciones: «Dark Gray» (RGB 0,1, 
0,1, 0,1 — predeterminado), «Black» (0, 0, 0) y 
«White» (1, 1, 1). El ajuste persiste el predetermina
do para nuevos proyectos y sesiones entre reinicios 
y al mismo tiempo actualiza el renderer Metal en 
ejecución de inmediato. Las mismas opciones se 
encuentran en el menú Viewport → Background 
(M21, M22, M23), pero el selector de ajustes define 
el predeterminado, mientras que el menú cambia 
la visualización en ejecución. Importante para cap
turas y vídeos de demostración: los fondos blancos 
resaltan más los floaters verdes/azules, los fondos 
oscuros son mejores para capturas de render lim
pias.

E N  P O CA S  PA L A B R A S

El color detrás de tus modelos 
3D en la ventana de previsua­
lización. Gris oscuro es el pre­
determinado y va bien con la 
mayoría de las escenas. El blan­
co es bueno para capturas de 
pantalla, el negro queda más ele­
gante para capturas de render. 
Puedes cambiar el color en cual­
quier momento desde el menú 
«Viewport → Background» para 
la escena en curso — este ajuste 
solo define qué color vuelve a es­
tar activo la próxima vez que la 
abras.
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S4 Auto-rotar tras el entrenamiento

D Ó N D E

Settings → General → Viewport → Conmutador «Au
to-Rotate After Training». Bound:. Predeterminado: 
false .

T É C N I C O

Inicia una rotación de plato giratorio continua de 
la cámara de la vista alrededor del centroide de 
la escena inmediatamente tras terminar el entrena
miento (tasa de rotación predeterminada ~0,3 rad/
s). Útil en la práctica para sesiones de demostra
ción, comparaciones A/B y para valorar al instante 
desde una vista 360° si se han formado «floaters» 
en el borde de la escena. El efecto es visualmente 
idéntico al menú Viewport → Toggle Auto-Rotation 
(M16, ⌘⌥T), salvo que este conmutador dispara el 
comportamiento de forma automática tras el final 
del entrenamiento, en vez de manualmente. Se pue
de interrumpir en cualquier momento desde el menú 
o haciendo clic en la vista (lo que pausa la rotación). 
No influye en el rendimiento de entrenamiento — la 
rotación solo se ejecuta cuando termina el entrena
miento.

E N  P O CA S  PA L A B R A S

Cuando está activado, la esce­
na 3D gira automáticamente en 
cuanto termina el entrenamiento 
— como un tiovivo. Resulta agra­
dable si lanzas un entrenamiento 
durante la noche y por la maña­
na quieres ver el resultado ya en 
movimiento sin tener que hacer 
clic. Para sesiones largas en las 
que solo monitorizas el entrena­
miento, déjalo desactivado.
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S5 Intervalo de previsualización en vivo

D Ó N D E

Settings → General → Training 
→ Selector Live Preview. Bound: 
AppState.trainingConfig.livePreviewInterval. 
Predeterminado: 0  (Off).

T É C N I C O

Determina el intervalo de iteraciones al que se ren
deriza la instantánea de entrenamiento en curso en 
la vista 3D. Cuatro valores discretos: 0 («Off»), 50, 
250, 1000 iteraciones. Con la previsualización en 
vivo activa, el entrenador copia el buffer de Gaus
sianos de la GPU a un buffer de render separado 
y dispara un redibujado de la vista. Con «Off», la 
vista solo se actualiza tras completarse el entrena
miento. Coste de rendimiento: cada 50 iteraciones, 
~5–10 % más lento en M3 Ultra; cada 250, ~1–
2 % más lento; cada 1000, no medible. Sobrecarga 
de memoria constante ~2 GB para el buffer de ins
tantánea, independientemente del intervalo. El valor 
sirve como predeterminado para nuevos entrena
mientos; tras el inicio del entrenamiento, el Inspec
tor de entrenamiento muestra el valor real en vivo 
del entrenamiento en curso. Con un intervalo de 50 
la impresión visual es un «crecimiento» fluido de la 
nube de puntos; con 1000 se ve a saltos.

E N  P O CA S  PA L A B R A S

Mientras el entrenamiento se es­
tá ejecutando, puedes escoger 
con qué frecuencia se actualiza 
la vista 3D. «Off» significa: sin 
actualización durante el entrena­
miento (lo más rápido). «Every 
50 Iterations» muestra casi en 
tiempo real cómo se va formando 
tu escena (ligeramente más len­
to). Para mirar cómodamente en­
trenamientos pequeños, «Every 
250» es un buen compromiso.
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S6 Retardo de throttle

D Ó N D E

Settings → General → Training → Selector Throttle. 
Bound: AppState.trainingConfig.throttleDelayMs. 
Predeterminado: 0  (Off).

T É C N I C O

Inserta un retardo artificial en milisegundos entre 
iteraciones de entrenamiento. Cuatro valores dis
cretos: 0 («Off»), 2 («Light»), 5 («Moderate»), 10 
(«Eco»). Propósito: durante entrenamientos largos 
(varias horas), la GPU estaría si no al 100 % de uso, 
lo que provoca una UI del sistema notablemente 
más lenta (el cursor se entrecorta, otras apps van 
pesadas). El retardo de throttle da a la GPU pau
sas en las que pueden ejecutarse otras tareas. El 
coste de rendimiento es considerable: con 5 ms de 
throttle, un entrenamiento típico de 40K tarda alre
dedor de un 50–80 % más que sin throttle. En modo 
de rendimiento «Eco» (10 ms), el retardo por itera
ción es mayor que la propia iteración — factor de 
2–3× más lento. Con throttle activo, aparece bajo 
el selector el aviso: «Throttle is on. Training will be 
slower than usual.» La propia app no reacciona no
tablemente mejor — solo se benefician otras apps.

E N  P O CA S  PA L A B R A S

Si tu Mac se calienta demasiado 
durante un entrenamiento largo 
u otros programas se vuelven de­
masiado pesados, activa aquí un 
freno. «Off» da gas a fondo a 
la GPU (lo más rápido). «Light» 
hace una pequeña pausa entre 
cada paso (un poco más lento, 
pero el sistema reacciona mejor). 
«Eco» es el freno más fuerte — 
bueno para entrenamientos noc­
turnos en un MacBook que no 
debe calentarse demasiado.
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Pestaña AI Helpers

Figura 16:  Ajustes → pestaña AI Helpers con el interruptor maestro y los sub-conmutadores
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S11 AI Helpers habilitados (maestro)

D Ó N D E

Settings → AI Helpers → primera sección → Conmu
tador «AI Helpers enabled». Bound:. Predetermina
do: true .

T É C N I C O

Interruptor maestro sobre todas las funciones AI 
Helpers en la pipeline. Cuando está desactivado, 
la pipeline de importación y SfM omite por com
pleto todas las etapas de preprocesado basadas 
en ML — sin llamada a Apple Vision, sin carga 
de modelo CoreML, sin despertar al NPU. Cuando 
está activado, se consultan los sub-conmutadores 
individuales (S12–S13). El valor se recuerda entre 
reinicios. Afecta a las siguientes etapas: (a) com
probación previa de calidad de fotograma antes de 
SfM (S12), (b) detección de cierre de bucle (S13). 
Importante: cuando está desactivado, los dos sub-
-conmutadores se inhabilitan y aparecen visualmen
te atenuados. La nota al pie subraya que todos los 
AI Helpers se ejecutan estrictamente on-device — 
sin subida de imágenes, sin procesamiento en la 
nube. La garantía de privacidad proviene del uso 
exclusivo del framework Apple Vision (localmente 
en el Neural Engine) y de modelos CoreML que se 
entregan directamente en el bundle de la app.

E N  P O CA S  PA L A B R A S

El interruptor principal para to­
das las funciones que interna­
mente usan IA / aprendizaje au­
tomático. El predeterminado es 
«activado», porque los asisten­
tes ahorran mucho tiempo sin 
que tus imágenes salgan del 
Mac. Si los quieres totalmente 
desactivados (p. ej., para ahorrar 
energía o porque tu Mac no tie­
ne NPU), desactívalos aquí — las 
dos subopciones de abajo se ate­
núan automáticamente y dejan 
de hacer nada.
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S12 Comprobación de calidad de fotograma

D Ó N D E

Settings → AI Helpers → Sección Available → Con
mutador «Frame quality check». Bound:. Predeter
minado: true .

T É C N I C O

Activa el screener de calidad de fotograma (Fase 
3.11), que analiza cada fotograma importado antes 
de la llamada a SfM. Pasos de la pipeline por foto
grama: (a) filtro de varianza laplaciana de Apple 
Vision (detección de desenfoque — umbral ~150), 
(b) comprobación basada en histograma de sobre/
sub-exposición (umbral: >5 % de píxeles en 0 o 
255), (c) detección de fotograma en blanco (desvia
ción estándar < 5 sobre todos los píxeles). Los foto
gramas que pasan las tres comprobaciones siguen 
adelante directamente. Los que fallan al menos una 
comprobación disparan un diálogo modal de confir
mación que enumera cada fotograma problemático 
con miniatura y motivo y pregunta si debe eliminar
se. Importante: sin borrado automático — el diálogo 
siempre es obligatorio, el usuario conserva la deci
sión final. Rendimiento: ~50 ms por fotograma en 
M3 Ultra, ejecutado en paralelo. Cuando está des
activado, todos los fotogramas se reenvían a SfM 
sin comprobar. Con el maestro (S11) desactivado, 
este conmutador aparece atenuado y no tiene efec
to. Estado entregado según la memoria: SHIPPED 
2026-05-23.

E N  P O CA S  PA L A B R A S

Antes del entrenamiento propia­
mente dicho, la app mira cada 
foto: ¿está borrosa?, ¿totalmen­
te oscura o blanca?, ¿en blanco? 
Si es así, te pregunta si quie­
res descartar la imagen — nunca 
elimina nada automáticamente. 
Esto ahorra muchas horas más 
adelante, porque una sola ima­
gen totalmente borrosa puede 
arruinar a veces todo el entre­
namiento. El predeterminado es 
«activado», porque el coste es 
casi cero y el beneficio, grande.
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S13 Detección de cierre de bucle

D Ó N D E

Settings → AI Helpers → Sección Available → Con
mutador «Loop closure detection». Bound:. Prede
terminado: true .

T É C N I C O

Activa la detección de cierre de bucle basada en 
feature print de Apple Vision. Para cada fotograma 
importado se calcula un vector de características 
de ~768 dimensiones que representa un embedding 
neuronal del contenido de la imagen. Todos los fea
ture prints se comparan luego por pares mediante 
similitud coseno. Los pares con similitud > 0,85 y 
distancia de índice de fotograma > 50 (es decir, fo
togramas no adyacentes) se identifican como «can
didatos a cierre de bucle» y se escriben en un 
archivo sidecar JSONL dentro de la carpeta del pro
yecto. Solo informativo — la secuencia de imágenes 
importada no se modifica. Propósito: da al solver 
de SfM (especialmente COLMAP) una pista de que 
esos fotogramas se agrupan en el espacio 3D. En 
el SfM nativo, la información del sidecar es actual
mente solo documental; COLMAP usa las pistas 
internamente mediante un archivo custom matches 
(integración manual posible, no cableada automáti
camente). Rendimiento: ~200 ms por fotograma en 
M3 Ultra, en paralelo. Cuando está desactivado, no 
se generan feature prints. Con el maestro (S11) des
activado, aparece atenuado.

E N  P O CA S  PA L A B R A S

Cuando caminas alrededor de un 
objeto fotografiando y acabas 
otra vez en el punto de partida, le 
ayuda enormemente al ordena­
dor saberlo. Esta opción detecta 
automáticamente cuáles de tus 
fotos se tomaron «casi desde 
el mismo sitio» y lo escribe en 
un pequeño archivo auxiliar. Las 
herramientas de SfM (especial­
mente COLMAP) pueden usar esa 
información para entregar una 
reconstrucción 3D más limpia. El 
predeterminado es «activado», 
porque corre sin tu intervención 
y no cambia nada en tus imáge­
nes.

Ajustes espejo del Inspector

Las entradas de ajustes restantes (S17–S33) de la tabla de inventario son espejos del 
Inspector experto y están documentadas en el Capítulo 2 (controles del Inspector I12–
I29). No aparecen físicamente en la ventana de Ajustes, sino que se listaron en el 
inventario solo porque se ejecutan a través de propiedades de TrainingConfig  que 
se persisten mediante y, por tanto, tienen formalmente carácter de ajuste. Para explica
ciones de fondo, véase allí.
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¿Cuándo qué?

Ajuste Ámbito Persistencia

S1 Modo predeter
minado

Global de la app Reinicio de la app

S2 Idioma Global de la app Reinicio de la app

S3 Fondo de la vis
ta

Global de la app (predeterminado) + 
runtime

Reinicio de la app

S4 Auto-rotar tras 
entrenamiento

Global de la app Reinicio de la app

S5 Intervalo de 
previsualización en 

vivo

Predeterminado para nuevos entre
namientos

Reinicio de la app

S6 Retardo de th
rottle

Predeterminado para nuevos entre
namientos

Reinicio de la app

S11 Maestro AI 
Helpers

Global de la app Reinicio de la app

S12 Comprobación 
de calidad de foto

grama

Global de la app Reinicio de la app

S13 Detección de 
cierre de bucle

Global de la app Reinicio de la app

Global de la app = afecta a todos los proyectos. Predeterminado para nuevos entrena
mientos = solo afecta al siguiente entrenamiento creado; las sesiones en curso no 
cambian. Entrenamiento actual = se aplica de inmediato a la configuración de entrena
miento en curso, pero no se persiste sin reimportación explícita.
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C A P Í T U L O

Capítulo 4 — Ventanas auxiliares

Además de la ventana principal (vista 3D más Inspector), RadianceKit gestiona siete 
ventanas adicionales, todas abribles desde el menú Help. La lista de arriba a abajo: 
User Guide (⌘?), Keyboard Shortcuts (⌘/), Open Training Logs… (no abre una ventana 
de la app sino el Finder; por eso no se trata más aquí), Manage Storage…, Pareto Dash
board… (⇧⌘D), Holdout Analysis… (⇧⌘H), BayesOpt Console… (⇧⌘B). Tres de ellas 
— Dashboard, Holdout, BayesOpt — son herramientas de análisis autónomas. Cada una 
tiene su propia pila view-model, lee o escribe archivos JSON en disco, y existe un argu
mento CLI por cada una que permite apuntar la ventana a un archivo concreto directa
mente al arrancar la app ( --dashboard-dir , --holdout-file , --bayesopt-autorun ).

Las cuatro ventanas simples (User Guide, Keyboard Shortcuts, Manage Storage, más 
las entradas del submenú Open Training Logs / Open Exports Folder) reciben una 
entrada corta por control. Las tres ventanas de análisis se documentan con más detalle 
— cada una con una introducción que explica qué ves en la ventana, cuándo deberías 
abrirla y cómo interpretar la imagen mostrada.

Al final del capítulo hay una sección de referencia cruzada al Inspector de la ventana 
principal: qué puedes leer de forma significativa del gráfico de loss en vivo y de la 
visualización del número de Gaussianos durante un entrenamiento en curso.
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User Guide (W1–W4)

Figura 17:  Ventana User Guide con barra lateral a la izquierda y contenido Markdown rende
rizado a la derecha

Qué es: Una ventana de ayuda integrada que renderiza el guide_​<language>.md entre
gado con la app. El idioma se deriva de los Ajustes (pestaña General → Idioma) o, si 
allí está «System», de las preferencias de idioma de macOS. El layout es clásico: barra 
lateral con todos los títulos a la izquierda, texto del cuerpo a la derecha.

CUÁNDO ABRIRLA  Cuando necesitas un recordatorio rápido de un único punto — como 
sustituto de palabra clave. La referencia completa es este manual; la ventana de ayuda 
integrada se parece más a lo que sería un --help  en la línea de comandos. Se 
actualiza con cada lanzamiento de la app, pero está mantenida deliberadamente más 
superficial en contenido.
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W1 NavigationSplitView (Sidebar + Detail)

D Ó N D E

Help → User Guide (⌘?).

T É C N I C O

Layout de dos columnas con una barra lateral estre
cha (al menos 180 pt de ancho) para el árbol de 
contenido y un área de detalle desplazable para 
el contenido Markdown real. La ventana tiene un 
tamaño mínimo de 700 × 500 pt. En la primera 
apertura, la ventana carga el guide_<lang>.md  
correspondiente del bundle de la app (fallback 
guide_en.md ), lo parsea en registros de bloque (tí

tulos H1–H4, párrafos, listas, tablas, separadores) y 
extrae por separado la estructura de títulos para la 
barra lateral. El formato inline (negrita, cursiva, co
de-span) se renderiza mediante el motor Markdown 
integrado. El idioma se lee de los ajustes de la app, 
con el caso especial del chino ( zh-Hans ) y el por
tugués brasileño ( pt-BR ), que se mantienen como 
tags de locale completos porque esas variantes di
fieren respectivamente del zh y del pt.

E N  P O CA S  PA L A B R A S

El texto de ayuda integrado, con 
la lista de temas a la izquierda y 
el contenido a la derecha. El idio­
ma se ajusta automáticamente 
según los ajustes del sistema. 
Funciona offline, pero está pen­
sado deliberadamente como ver­
sión corta — la referencia com­
pleta es este manual.

W2 List (barra lateral de títulos)

D Ó N D E

Columna izquierda en la ventana User Guide.

T É C N I C O

Lista de todos los títulos H2 y H3 del documento 
Markdown actual. Las entradas H2 aparecen sin 
sangría con peso Medium, las H3 con 16 pt de 
sangría a la izquierda y un estilo de foreground 
reducido. H4 y más profundos se ignoran, porque 
la profundidad haría la barra lateral confusa. Los 
IDs de anchor se generan a partir del texto del 
título mediante slugificación (minúsculas + espacios 
a guiones + filtrado de letras/números/guiones — el 
mismo algoritmo que usa GitHub para sus anchors 
Markdown, así que URLs externas a la doc también 
podrían aterrizar en el mismo anchor). La lista usa el 
estilo nativo de macOS.

E N  P O CA S  PA L A B R A S

La barra de navegación a la iz­
quierda. Toca una entrada y sal­
tas a la sección.
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W3 Button (título → salto a anchor)

D Ó N D E

Un botón por fila de la barra lateral.

T É C N I C O

Cada entrada de la barra lateral es un botón que fija 
el anchor actual, pero visualmente se ve como una 
entrada de lista. Una variable observadora dispara 
entonces el salto de scroll al anchor correspon
diente con una animación suave de 0,3 s. Tras el 
salto, el valor del anchor se restablece para que el 
siguiente clic sobre el mismo anchor dispare otra 
vez (de lo contrario el observador no volvería a dis
pararse porque el valor no habría cambiado).

E N  P O CA S  PA L A B R A S

Hacer clic te lleva al punto co­
rrespondiente del texto a la dere­
cha.

W4 ScrollView (contenido de detalle)

D Ó N D E

Columna derecha.

T É C N I C O

Área de contenido desplazable, apilada vertical
mente, con renderizado lazy, porque guías más 
largas pueden tener fácilmente más de 200 bloques 
Markdown — una variante no lazy los instanciaría 
todos a la vez. Cada bloque recibe su propio ID, ya 
sea el anchor del título (para H1–H3 saltables) o un 
placeholder de índice. El ancho máximo es de 720 
pt, padding 32 horizontal / 24 vertical, así que las 
líneas largas mantienen un layout bien legible. Las 
tablas se renderizan celda a celda con stacks hori
zontales y separadores; el código inline mediante el 
motor Markdown integrado. Los bloques de código 
reales se tratan actualmente como párrafos — una 
limitación conocida de la ventana Help.

E N  P O CA S  PA L A B R A S

El texto de ayuda en sí. Desplaza­
ble, ancho bien legible, tipografía 
clara.
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Keyboard Shortcuts (W5–W6)

Figura 18:  Ventana Keyboard Shortcuts — cinco grupos Navigation/Views/Capture/Editor/
Training con columna de hotkey a la izquierda y descripción a la derecha

LO QUE SE VE EN LA IMAGEN  Lista de referencia estática en cinco secciones. Navigation: 
Mouse Drag (Orbit/Fly), Shift+Drag/Right-Drag (Pan), Scroll (Zoom), WASD (movimiento 
fly-through), Q/E (Up/Down), F (Toggle Orbit/Fly), doble clic (re-centrar), Cmd+Scroll 
(ajuste FoV). Views: R (Reset Camera), T (Auto-Rotation), P (Camera Playback), B 
(ciclo de fondo), 0–9 (saltar a cámara de entrenamiento 1=10 %/5=50 %/0=última), Fle
cha Izquierda/Derecha (Prev/Next Cam). Capture: S (captura al escritorio), V (Turntable 
Video), C (Copy Camera Info). Editor: Tab (modo edición), Click/Drag (Paint-Select), 
Option+Click (Deselect), X / Delete (eliminar selección), Cmd-Z (deshacer último borra
do), [ / ] (tamaño de pincel menor/mayor), Esc (limpiar selección). Training: Start, 
Pause/Resume, Cancel, Continue +5K/+10K/+20K vía los atajos de menú en M9–M14.
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Qué es: Una visión general estática simple de todos los atajos de teclado — Navigation, 
Views, Capture, Editor, Training. El contenido está codificado en duro, sin carga de 
Markdown.

CUÁNDO ABRIRLA  Cuando buscas la forma más rápida de hacer algo en la vista. WASD 
fly-through, R para reset de cámara, B para ciclo de fondo — están todos aquí.

W5 ScrollView (área de contenido)

D Ó N D E

Help → Keyboard Shortcuts (⌘/).

T É C N I C O

Un área de scroll simple con una lista vertical den
tro. Padding 20 alrededor, sin árbol de navegación 
en barra lateral (la lista es lo bastante corta). El 
contenido se agrupa en cinco secciones (Naviga
tion, Views, Capture, Editor, Training). Una fila por 
combinación de teclas con texto traducible en am
bas columnas. La columna izquierda (código de te
cla) tiene ancho fijo de 180 pt, así las descripciones 
a la derecha se mantienen alineadas verticalmente. 
Sin interacción más allá del scroll — hacer clic en 
una fila no dispara nada; los atajos son modificado
res de teclado reales en el menú y la vista.

E N  P O CA S  PA L A B R A S

Tabla con todas las teclas. Cheat 
sheet estática para consulta rá­
pida.

W6 VStack (secciones de atajos)

D Ó N D E

Dentro del ScrollView.

T É C N I C O

Secciones apiladas alineadas a la izquierda con es
paciado de 16 pt. Dentro de las cinco secciones, ca
da una contiene una cabecera + secuencia de filas. 
Las cabeceras usan un estilo secondary subheadli
ne — deliberadamente no un formato de título, por
que las secciones no necesitan ser navegables. El 
contenido es deliberadamente plano (sin disclosure, 
sin búsqueda, sin filtro) para que el componente 
corra sin cambios en cualquier versión de macOS y 
el archivo se mantenga legible.

E N  P O CA S  PA L A B R A S

La agrupación de teclas por fun­
ción (Navigation, Views, Editor, 
etc.).
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Manage Storage (W7–W12)

Figura 19:  Ventana Manage Storage — la cabecera muestra «693 items · 16,74 GB total», 
tabla con archivos PLY de exportación ordenados por fecha, cada uno con insignia de forma

to + nombre + tamaño + fecha

LO QUE SE VE EN LA IMAGEN  Vista de tabla de todos los archivos gestionados por Radian
ceKit. La cabecera cuenta 693 ítems, 16,74 GB de tamaño total. Toolbar arriba: «Show 
in Finder» + «Refresh». Cada fila: icono PLY, nombre de archivo (p. ej., training_​
20260527T211321Z.ply), fecha de exportación, tamaño (varía de 7 KB a 218 MB), icono 
de lupa (Reveal) e icono de papelera (Move to Trash). Los archivos están ordenados por 
fecha, los más nuevos arriba. En esta grabación demo, las exportaciones PLY dominan 
porque se trabajó mucho con --benchmark .

Qué es: Una visión general del uso de disco de todo lo que RadianceKit almacena 
en ~/​Documents/​RadianceKit/​ — Logs, Exports, Scenes, paquetes de Capture (de la 
companion iOS), Imports (copias de staging de las imágenes de entrada). Un tamaño en 
bytes por entrada y dos botones: «Show in Finder» y «Move to Trash». Esto NO es una 
limpieza automática — la app no elimina nada por sí misma; decides por entrada.
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CUÁNDO ABRIRLA  Cuando el disco se llena. Los logs en particular se acumulan (un 
JSONL por intento de entrenamiento, más el _​qualityMetrics.json); las exportaciones 
también, claro (PLY 100 % datos crudos, una por exportación). También útil tras un 
crash, cuando el directorio de staging de imports aún tiene copias viejas de las 
imágenes de entrada (véase «Incidente de presión de disco» en dev_​v549f-needle-
reduction.md).

W7 Botón «Show in Finder»

D Ó N D E

Arriba a la derecha de la cabecera en la ventana del 
navegador de almacenamiento.

T É C N I C O

Abre todo el directorio de RadianceKit (~/​Documents/​
RadianceKit/​) en el Finder, así puedes ver direc
tamente la estructura de carpetas y también mani
pularla con el propio Finder. La acción abre una 
nueva ventana del Finder y no cambia al contenedor 
sandbox de la app — ~/​Documents/​RadianceKit/​ es 
el dominio normal de Documentos accesible a las 
apps, no una ruta de contenedor sandbox.

E N  P O CA S  PA L A B R A S

Abre el directorio en el Finder 
para que puedas trabajar con los 
archivos por tu cuenta.

W8 Botón «Refresh»

D Ó N D E

Cabecera, junto al botón Finder.

T É C N I C O

Dispara un escaneo en segundo plano que corre co
mo tarea asíncrona iniciada por el usuario para que 
escanear árboles de directorios grandes no bloquee 
la UI. La caminata real recorre cada subcarpeta co
nocida (Logs, Exports, Scenes, Captures, Imports) y 
produce una entrada de almacenamiento por hijo di
recto. Por entrada se determina el tamaño recursivo 
— preferentemente el uso real de disco (incluido el 
sharing de hardlinks de APFS) con fallback al tama
ño de archivo lógico.

E N  P O CA S  PA L A B R A S

Releee la lista por si has elimina­
do o añadido algo en el Finder 
entretanto.
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W9 List (entradas de almacenamiento)

D Ó N D E

Contenido principal bajo la cabecera.

T É C N I C O

Lista con este layout por fila: icono SF Symbols es
pecífico de categoría (documento para Logs, flecha 
de subida para Exports, cubo para Scenes, bandeja 
para Imports), nombre + subtítulo (etiqueta Kind 
+ fecha de modificación formateada), contador de 
bytes a la derecha (alineado a la derecha, monoes
paciado), botón Reveal (icono de lupa), botón pape
lera (papelera). Orden: primario por Kind (Scenes 
primero, luego Exports, Logs, Captures, Imports, 
Other), secundario por fecha de modificación des
cendente (lo más nuevo arriba). Si el escaneo sigue 
en curso, el área muestra en su lugar un indicador 
de progreso «Scanning…». Si no se encontró nada, 
una visualización empty-state con un icono de ban
deja.

E N  P O CA S  PA L A B R A S

Lista de todos tus datos de Ra­
dianceKit, ordenados por tipo y 
recencia. Por entrada ves el ta­
maño y puedes eliminar directa­
mente.

W10 Botón de fila «Reveal in Finder»

D Ó N D E

Por fila, icono de lupa a la derecha.

T É C N I C O

Abre el Finder y selecciona el ítem específico (ar
chivo o carpeta). Diferencia con W7: W7 abre el 
directorio raíz; W10 resalta exactamente esta entra
da. Flujo práctico: identificar una entrada grande, 
hacer clic en la lupa, después copiarla, por ejemplo, 
a un volumen externo.

E N  P O CA S  PA L A B R A S

Salta a esta entrada directamen­
te en el Finder para que la en­
cuentres rápido.
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W11 Botón de fila «Move to Trash»

D Ó N D E

Por fila, icono de papelera a la derecha junto a la 
lupa.

T É C N I C O

Dispara el diálogo de confirmación (W12). Solo 
tras la confirmación corre la operación estándar de 
macOS «move to trash» (es decir, reversible, sin 
borrado directo). Tras tirar a la papelera con éxito, 
la entrada se elimina de la lista y el contador total 
de bytes se actualiza. En caso de errores, se mues
tra un diálogo modal de error.

E N  P O CA S  PA L A B R A S

Mueve la entrada a la papelera. 
Un diálogo pregunta primero.

W12 ConfirmationDialog (confirmación de borrado)

D Ó N D E

Disparado por W11, mostrado como sheet de ma
cOS.

T É C N I C O

Diálogo estándar de confirmación con un título di
námico «Delete <name>?» y una línea de mensaje 
que indica explícitamente que la entrada va a la pa
pelera y puede restaurarse desde allí (hasta que se 
vacíe la papelera). Dos botones: «Move to Trash» 
como acción destructiva (mostrada en rojo) y «Can
cel» con vínculo automático a Esc. El diálogo es no 
modal en el sentido de que solo bloquea esta venta
na, no toda la app — es el estándar de macOS para 
borrados reversibles.

E N  P O CA S  PA L A B R A S

Aviso de seguridad antes de bo­
rrar. «Move to Trash» es reversi­
ble — mientras no se vacíe la 
papelera.
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Pareto Dashboard (W13–W22)

Figura 20:  Pareto Dashboard — estado vacío antes de la importación de reportes

Estado vacío (tras la primera apertura) — estado vacío con call-to-action «Open 
Reports Folder…». Los puntos de datos aparecen en cuanto se cargan los reportes de 
entrenamiento, véase la siguiente captura.

Figura 21:  Pareto Dashboard con 129 reportes de benchmark cargados — Gaussianos vs 
PSNR con frente de Pareto, filtros Scene/Strategy/Mip

LO QUE SE VE EN LA IMAGEN  La barra de herramientas de la cabecera muestra «129 
reports of 129» (todos los reportes de la carpeta seleccionada parseados con éxito 
— 21 archivos adicionales no pudieron parsearse por formato antiguo, véase la lista 
de avisos a la derecha). Ejes: selector de eje X en Gaussians , selector de eje Y en 
PSNR (dB) . Scatter plot: puntos verdes = estrategia Classic, puntos azules = MCMC. 
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La línea discontinua del frente de Pareto corre a lo largo de los mejores valores de 
PSNR alcanzados y se aplana hacia PSNR≈30 dB a partir de unos 500K Gaussianos. 
Chips de filtro a la derecha: 7 escenas (bicycle, bonsai, family, flowers, kitchen, stump, 
truck), 2 estrategias (classic, mcmc), 3 opciones de Mip-Splatting (All, On, Off). En este 
momento todos los filtros están abiertos, de ahí el denso cluster de puntos.

Qué es: Una herramienta de comparación multi-run. En el pasado entrenaste varias 
escenas, o la misma escena con distintos ajustes preestablecidos — cada uno de esos 
runs produce (si pasaste --benchmark  o lo llamaste mediante la función Benchmark) 
un archivo de reporte JSON que contiene, entre otras cosas, PSNR final, SSIM, LPIPS, 
número de Gaussianos y tiempo wallclock. El Dashboard lee toda una carpeta de esos 
reportes a la vez y los representa como scatter 2D con ejes seleccionables. Además, se 
dibuja el frente de Pareto (el conjunto de puntos no dominados) como línea discontinua.

CUÁNDO ABRIRLA  Después de haber producido al menos tres o cuatro reportes de entre
namiento. Con menos puntos, la línea de frente no es significativa. Caso de uso típico: 
intentaste reconstruir una escena exterior y ejecutaste sucesivamente P3 Balanced 
(Classic), P4 Quality (Classic), P7 MCMC Quality y P9 Outdoor (tuned) — ahora quieres 
saber qué configuración entrega el mejor PSNR por segundo de tiempo de entrena
miento, o cuál requiere menos Gaussianos para un PSNR dado.

CÓMO INTERPRETARLA  Ambos ejes son libremente seleccionables (eje X: psnr , ssim , 
lpips , …; eje Y lo mismo). La lógica de frente de Pareto en ParetoFront2D.indices 

sabe para cada métrica si «menor = mejor» (p. ej., LPIPS, Loss, Time) o «mayor = 
mejor» (PSNR, SSIM) — así que, según la elección de eje, la línea va de abajo-izquierda 
a arriba-derecha o de arriba-izquierda a abajo-derecha, siempre a lo largo de la mejor 
combinación alcanzada. Un punto es Pareto-óptimo si NINGÚN otro punto es al menos 
tan bueno en AMBAS dimensiones (es decir, ningún otro punto lo domina). Los puntos 
Pareto-óptimos están sobre la línea, los demás a la derecha/encima (según la orienta
ción del eje). Los puntos SOBRE la línea son los candidatos reales para «mejor ajuste 
preestablecido»; los puntos LEJOS de la línea son tiempo de entrenamiento desperdi
ciado.

CHIPS DE FILTRO  Puedes restringir la selección a una escena concreta (si solo quieres 
comparar runs de exteriores, p. ej.), a una estrategia concreta (Classic o MCMC) o 
a Mip-Splatting on/off (relevante tras la Fase Q1.5, donde Mip permanece como flag 
avanzado opt-in).

FLUJO DE EJEMPLO  Tienes tres reportes para la escena «truck» en ~/​Documents/​
RadianceKit/​Reports/​: Run A (P4 Quality, 40K iter, 524K Gs, 105 s, PSNR 23,4), Run B 
(P7 MCMC, 200K iter, 150K Gs, 693 s, PSNR 24,6), Run C (P9 Outdoor, 100K iter, 1,25M 
Gs, 312 s, PSNR 25,8). Pon el eje X en trainingTime, el eje Y en PSNR. El Run B queda 
arriba a la derecha, el Run C aún más arriba a la derecha, el Run A abajo a la izquierda. 
El frente de Pareto conecta A y C — ambos no dominados. El Run B está «perdido» (C 
es mejor en Time Y PSNR). Conclusión: para «truck» el default MCMC no compensa; o 
rápido+ok (A) o largo+muy bueno (C). Guarda la configuración de C como ajuste prees
tablecido propio (Inspector → I1 Save Preset).

Siguiente acción: Guardar la mejor configuración como ajuste preestablecido. Concre
tamente: mira los puntos de Pareto (al hacer hover se muestra PSNR/SSIM/LPIPS/Gs/
Time en el tooltip), decide cuál te encaja mejor en el trade-off tiempo-vs-calidad, abre 
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el reporte correspondiente (el nombre de archivo contiene la marca de tiempo del run), 
copia su configuración de entrenamiento a un nuevo run, o guárdala tras la siguiente 
sesión de entrenamiento como ajuste preestablecido mediante el Inspector.

W13 Botón «Open Reports Folder…»

D Ó N D E

Toolbar, arriba a la izquierda.

T É C N I C O

Abre un diálogo selector de carpeta con el prompt 
«Select a folder containing benchmark .json re
ports». Tras la confirmación, corre una tarea en se
gundo plano que parsea secuencialmente todos los 
archivos .json  de la carpeta. Los reportes defec
tuosos (JSON roto, schema incorrecto) se recopilan 
y se muestran al pie de la barra lateral como «N file 
failed to parse» — sin crash. Si ocurre un segundo 
clic mientras una primera carga sigue en curso, la 
tarea anterior se cancela para que dos resultados 
no escriban a la vez en el estado.

También vía CLI: --dashboard-dir /​ruta/​a/​reports 
carga la carpeta directamente al arrancar la app.

E N  P O CA S  PA L A B R A S

Selecciona la carpeta donde 
están tus reportes de bench­
mark. La ruta predeterminada 
es ~/​Documents/​RadianceKit/​
Reports/​. Después carga todos 
los JSONs a la vez.

W14 Selector «X-Axis»

D Ó N D E

Encima del gráfico, a la izquierda.

T É C N I C O

Selector tipo menú con todos los ejes de métri
ca disponibles del módulo de dashboard (PSNR, 
SSIM, LPIPS, número de Gaussianos, tiempo de 
entrenamiento, etc.). El predeterminado es número 
de Gaussianos. Al cambiar, el punto sobre el que 
estaba el hover se restablece, porque una posición 
resaltada previamente en el viejo sistema de coor
denadas ya no tiene sentido tras el cambio de eje. 
El selector está constreñido a ancho de contenido 
para que no abarque todo el ancho.

E N  P O CA S  PA L A B R A S

Qué métrica debe estar en el eje 
horizontal. Normalmente «tiem­
po de entrenamiento» o «núme­
ro de Gaussianos» porque son 
los «costes» que quieres compa­
rar.
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W15 Selector «Y-Axis»

D Ó N D E

Encima del gráfico, junto a X-Axis.

T É C N I C O

Idéntico a W14, salvo que el predeterminado es 
PSNR. La elección de eje se almacena de forma 
independiente, así que el usuario también puede 
elegir combinaciones sin sentido (X=PSNR, Y=PSNR 
— pondría todos los puntos en una diagonal). Esas 
combinaciones no se atrapan, sin embargo; una de
cisión deliberada, porque una comparación «SSIM 
vs PSNR» es bastante interesante para ver lo con
sistentes que son las métricas.

E N  P O CA S  PA L A B R A S

Qué hay en el eje vertical. Nor­
malmente «PSNR» o «SSIM» co­
mo medida de calidad.

W16 Conmutador «Show Pareto Front»

D Ó N D E

A la derecha de los selectores de ejes.

T É C N I C O

Conmutador estándar de macOS. Si está activo, se 
dibuja en el gráfico de Pareto una línea con el fren
te de Pareto 2D calculado, además de la nube de 
puntos. Estilo: discontinua (patrón de guiones 4–
4), gris semitransparente, ancho de línea 1,5 pt. El 
cálculo de Pareto corre en el hilo principal — con 
el número típico de reportes (≤ ~50) es rápido sin 
problemas. Si el conmutador está apagado, la línea 
se omite y solo quedan los puntos.

E N  P O CA S  PA L A B R A S

Muestra la línea que pasa por 
los puntos «mejores hasta el mo­
mento». Si la línea estorba (p. 
ej., porque solo quieres compa­
rar trades individuales), apágala.
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W17 Chips de filtro «Scene»

D Ó N D E

Barra lateral derecha en la ventana del Dashboard.

T É C N I C O

Chips de filtro para cada escena que aparece en los 
reportes cargados. Layout flow personalizado que 
envuelve automáticamente chips en varias líneas en 
cuanto se agota el ancho. Los chips activos reciben 
el fondo de acento, los inactivos un fondo material 
estándar neutro. La multiselección es posible (se
mántica de conjunto); si no hay chip seleccionado, 
todas las escenas cuentan como «pasadas» — es 
decir, la lógica de conjunto es «selección vacía = 
todo», no «selección vacía = nada».

E N  P O CA S  PA L A B R A S

Hacer clic en un nombre de esce­
na filtra los puntos solo a esa es­
cena. Multiselección posible. Va­
cío = todas las escenas.

W18 Chips de filtro «Strategy»

D Ó N D E

Bajo el filtro Scene en la barra lateral.

T É C N I C O

Exactamente como W17, pero para estrategias de 
entrenamiento — típicamente los dos valores «clas
sic» y «mcmc», derivados del campo strategy de 
los JSONs de reportes de benchmark. Útil si tienes 
reportes mezclados de ambas estrategias y solo 
quieres ver un tipo (p. ej., «solo mostrar runs de 
MCMC porque ya he excluido Classic»).

E N  P O CA S  PA L A B R A S

Filtrar por Classic o MCMC. Por 
defecto ambos están activos.
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W19 Chips de filtro «Mip-Splatting»

D Ó N D E

Bajo el filtro Strategy en la barra lateral.

T É C N I C O

Filtro de tres valores (en lugar de un conjunto 
como W17/W18): «All» / «On» / «Off». Trasfondo: 
Mip-Splatting se evaluó en la Fase Q1.5 como me
jora multi-escala experimental y el veredicto final 
fue «no hay una victoria clara a través de todo; 
mantener como flag opt-in». Cuando haces compa
raciones Mip on/off a menudo quieres separar muy 
nítidamente. De ahí el filtro ternario dedicado con 
los estados «deja pasar todo», «solo Mip on», «so
lo Mip off». La sección de la barra lateral solo se 
muestra si en el conjunto de datos hay al menos un 
reporte Mip Y al menos un reporte no-Mip (de lo 
contrario, filtrar no tendría sentido).

E N  P O CA S  PA L A B R A S

Si quieres comparar Mip-Splat­
ting on/off, aquí hay un filtro de 
tres vías. En otro caso, ignorar.

W20 ChipButton (conmutador de filtro, all/on/off)

D Ó N D E

Componente auxiliar, usado en W17/W18/W19.

T É C N I C O

Wrapper de botón minimalista. Contenido: texto de 
etiqueta con tamaño de fuente caption y padding 
10 horizontal / 5 vertical. Fondo condicional: si está 
activo → color de acento de la app con texto blanco; 
en otro caso, fondo material estándar neutro con 
texto negro. La forma es de cápsula (tipo pill). Estilo 
plain-button para que el material de la cápsula no 
quede solapado por un borde del sistema.

E N  P O CA S  PA L A B R A S

Los propios botones de filtro 
redondeados. Visualmente como 
una etiqueta de iOS.
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W21 Chart (scatter de Pareto)

D Ó N D E

Área central del Dashboard.

T É C N I C O

Diagrama Swift Charts con dos capas: 1. un punto 
por reporte — posición a partir de las métricas X e 
Y elegidas, color por estrategia, símbolo por estado 
Mip. Tamaño de símbolo normal 80, resaltado 200 
(si el ID coincide con el reporte sobre el que está 
actualmente el hover). 2. una línea para el frente de 
Pareto, solo si el conmutador está activo.

Overlay del chart: un rectángulo transparente regis
tra el movimiento del ratón; por fotograma se deter
mina la posición del punto más cercano en distancia 
euclídea en el plot frame y el reporte hovered se 
actualiza si la distancia es menor de 24 px (en otro 
caso se resetea). Así obtienes el tooltip sin hacer 
clic — basta con pasar por encima.

E N  P O CA S  PA L A B R A S

El scatter plot real. Cada punto 
es un run de entrenamiento. Pa­
sa por encima para el tooltip de 
detalle.

W22 Tooltip (detalle por hover)

D Ó N D E

Bajo el gráfico, mostrado al hacer hover.

T É C N I C O

Stack horizontal: nombre de escena (headline), tag 
de estrategia (caption), separador, después mé
tricas PSNR/SSIM/LPIPS/Gs/Time cada una en un 
pequeño grupo vertical (etiqueta + valor monoespa
ciado). Si Mip estaba activado, adicionalmente una 
etiqueta cápsula «Mip» en color de acento. Fondo 
semitransparente con blur, rectángulo redondeado 
con radio de 8 pt. Solo se muestra cuando el ratón 
está realmente sobre un punto. Desaparece auto
máticamente al salir.

E N  P O CA S  PA L A B R A S

La tarjeta de detalle al pie cuan­
do pasas con el ratón por encima 
de un punto. Muestra a la vez to­
das las métricas de calidad y la 
configuración del run.
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Holdout Analysis (W23–W29)

Figura 22:  Holdout Analysis — estado vacío antes de cargar un transforms.json

Estado vacío con empty state y call-to-action «Open transforms.json…». Acepta el 
formato de NeRF Studio e Instant-NGP.

Estado vacío (tras la primera apertura) — los marcadores de cámara aparecen en 
cuanto se carga un transforms.json , véase la siguiente captura.

Figura 23:  Globo de Holdout con 100 cámaras NeRF Blender mic, 5 folds de 20 cámaras 
cada uno, estrategia angular activa

LO QUE SE VE EN LA IMAGEN  La cabecera muestra el archivo cargado (transforms_​
train.json) y el número de cámaras («100 cameras»). Barra lateral izquierda: selector 
de estrategia con dos opciones — Angular (longitudinal) activo (alinea los folds a 
lo largo de sectores longitudinales/latitudinales en la esfera, así cada fold de test es 
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geométricamente denso) vs Linear
(round-robin) (basado en orden, cada k-ésimo fotograma como conjunto de test). El 
deslizador de k-folds está en 5, el selector de fold de test en Fold 1. El botón Export 
produce un fold-assignment.json para Nerfstudio/Instant-NGP. Panel central: proyec
ción de globo 3D de las 100 cámaras — puntos verdes = Train, puntos rojos = fold de 
test actual (Fold 1 con 20 cámaras). Barra lateral derecha (Angular Correlation): por fold 
20 cámaras + Mean Nearest Angle (Fold 1: 7,9°, Fold 2: 7,8°, Fold 3: 7,7°, Fold 4: 7,0°, 
Fold 5: 6,3°) — un valor más pequeño significa que las cámaras dentro de ese fold 
están juntas, así que el split de Holdout es espacialmente coherente.

Qué es: Un visualizador 3D para tu disposición de cámaras con lógica de cross-
-validation. Cargas un transforms.json  (el formato estándar de Nerfstudio / Instant-
NGP para poses de cámara), la app lee todas las cámaras, proyecta sus direcciones 
de visión sobre una esfera unidad y las muestra como pequeños marcadores esféricos 
sobre un globo virtual. Después divide las cámaras en k  folds (según la estrategia 
seleccionada: angular o lineal), marca la porción de entrenamiento en verde y la de test 
en rojo (Holdout), y calcula por fold una puntuación de Angular Correlation que te dice 
lo lejos que está el fold de test del fold de entrenamiento en el espacio de ángulos de 
visión.

CUÁNDO ABRIRLA  Cuando quieres hacer evaluación Holdout — es decir, ¿lo bien que tu 
modelo generaliza a puntos de vista no vistos? El default en el entrenamiento es «cada 
8ª vista como Holdout» (convención Mip-NeRF360), pero es un split muy lineal. Si tus 
imágenes se agrupan en el tiempo, por ejemplo (un lado del objeto primero, después el 
otro), entonces «cada 8ª» no es representativo — una posición aleatoria de secuencia 
acaba en test, pero todos sus vecinos están en entrenamiento, lo que es demasiado 
fácil. Con «angular» estratificas a lo largo del espacio de ángulos de visión: cada fold 
contiene cámaras de todas las zonas de la órbita, así que el test sondea de verdad los 
huecos de generalización.

CÓMO INTERPRETARLA  Angular vs Linear: - Angular (default): divide las cámaras por 
ángulo longitudinal (coordenada φ alrededor del eje Y) en k  sectores iguales. El Fold 
0 contiene cámaras con φ ∈ [0°, 360/k°), el Fold 1 las siguientes, y así sucesivamente. 
Ventaja: cada fold cubre una porción de la órbita; el fold de test es espacialmente 
compacto pero ampliamente distribuido por el dataset global. Bueno para grabaciones 
orbitales clásicas. - Linear (round-robin): índice de fold = (image_index modulo k). Ese 
es el simple split «cada k-ésimo». Funciona si el orden de imagen NO tiene sesgo 
espacial (p. ej., tomas de dron ordenadas aleatoriamente). Funciona mal si las imágenes 
se agrupan en el tiempo.

En el globo 3D ves de inmediato: puntos verdes (entrenamiento) y puntos rojos (test). 
Si los puntos rojos se agrupan todos en una esquina, el Holdout es malo (sin buen test 
de generalización). Si están repartidos entre los verdes, es bueno. La puntuación de 
Angular Correlation por fold (barra lateral derecha, en grados) dice además: valor más 
pequeño = el test está cerca del entrenamiento (cada cámara de test tiene una cámara 
de entrenamiento cercana, test fácil); valor más grande = el test está lejos del entrena
miento (generalización más difícil).

FLUJO DE EJEMPLO  Capturaste tu escena de truck con 251 imágenes, exporta mediante 
la entrada de menú M33 (Export SfM transforms.json) un archivo Nerfstudio. Abre la 
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ventana Holdout (⇧⌘H), carga el JSON con «Open transforms.json…», mira el globo. 
k=5 (default) te da 5 folds. Haz clic en «Fold 3» — comprueba si los marcadores rojos 
están razonablemente repartidos. Si sí: «Export fold-assignment.json», pon el archivo 
exportado en la carpeta de reportes, y en el siguiente run de entrenamiento con 
--benchmark  (o los ajustes correspondientes del Inspector) se usa exactamente esa 

asignación de fold como Holdout de test — en lugar del default «cada 8ª».

W23 Botón «Open transforms.json…»

D Ó N D E

Toolbar, arriba a la izquierda.

T É C N I C O

Abre un diálogo selector de archivo restringido a 
archivos JSON. Tras la confirmación, el módulo Hol
dout carga el archivo. El loader parsea tanto el 
formato Nerfstudio (intrínsecos de cámara más lista 
de frames con ruta de imagen y matriz transform) 
como el formato Instant-NGP (misma estructura). 
Para cada frame se extrae la dirección de visión de 
la matriz transform (eje z de la base local de la cá
mara) y se almacena. Si el parseo falla, se muestra 
un mensaje de error en el área de estado.

También vía CLI: --holdout-file /​ruta/​a/​
transforms.json abre la ventana directamente con 
el archivo cargado.

E N  P O CA S  PA L A B R A S

Carga tu JSON de poses de cá­
mara. Lo estándar son las expor­
taciones de Nerfstudio e Instant-
NGP. RadianceKit mismo puede 
exportar transforms.json vía Me­
nú → Export → SfM.

W24 Selector «Strategy» (angular/linear)

D Ó N D E

Barra lateral izquierda, arriba.

T É C N I C O

Selector tipo radio con dos opciones: Angular y 
Linear. El cambio de estrategia dispara automática
mente un nuevo cálculo de los folds. Las direccio
nes de visión son una lista de vectores unidad 3D 
en la esfera; la estrategia angular las proyecta sobre 
el ángulo longitudinal φ y ordena, la estrategia lineal 
simplemente hace un split modulo sobre el índice 
de frame.

E N  P O CA S  PA L A B R A S

Angular para tomas orbitales 
bien distribuidas (default, segu­
ro), Linear solo si tus imágenes 
no se agrupan espacialmente.
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W25 Deslizador «k Folds»

D Ó N D E

Barra lateral izquierda, en el medio.

T É C N I C O

Deslizador de 3 a 10, paso 1. Al cambiar, el cálculo 
de folds se reinicia automáticamente para que la 
lista de folds, los índices de entrenamiento/test y la 
puntuación por fold se recalculen de inmediato. El 
valor seleccionado se muestra como texto monos
paced-digit junto a la etiqueta de la derecha.

Regla práctica: k=5 es el estándar (te da un 20 % de 
test por fold, lo común para cross-validation). k=10 
si tienes muchos datos y necesitas más folds para 
significancia estadística. k=3 si tienes pocos datos.

E N  P O CA S  PA L A B R A S

Cuántos folds tiene el split. 5 es 
el default y encaja casi siempre.

W26 Selector «Test Fold»

D Ó N D E

Barra lateral izquierda, bajo el deslizador k.

T É C N I C O

Selector tipo menú. Las opciones son dinámicamen
te 0..<k, etiquetas «Fold 1» a «Fold N» (es decir, 
1-indexado en la UI, 0-indexado internamente). Si 
el índice seleccionado previamente es ≥ k (p. ej., 
porque has bajado k de 10 a 5), se restablece auto
máticamente a 0. El fold de test seleccionado se 
muestra en rojo en el globo, todos los demás en 
verde.

E N  P O CA S  PA L A B R A S

Qué fold es el actual de test. Pue­
des clicar entre ellos y ver cómo 
se ve cada uno en el globo.
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W27 Botón «Export fold-assignment.json»

D Ó N D E

Barra lateral izquierda, abajo.

T É C N I C O

Abre un diálogo de guardar con nombre predetermi
nado fold-assignment.json. Tras la confirmación, 
el módulo Holdout codifica el split actual en un 
schema JSON (asignación de fold por frame más 
bloque meta de estrategia). Ese archivo se puede 
pasar luego al siguiente run de entrenamiento con 
--benchmark , así se usa el mismo Holdout para la 

evaluación final de métricas. Los errores de escritu
ra se muestran como texto de error; el éxito en texto 
verde como «Saved to (filename)».

E N  P O CA S  PA L A B R A S

Guarda el split actual train/test 
como JSON. Después puedes pa­
sar ese archivo directamente al 
entrenamiento para que se use 
de nuevo el mismo conjunto de 
test.

W28 SCNView (globo de cámaras 3D)

D Ó N D E

Panel central en la ventana Holdout.

T É C N I C O

Vista de globo SceneKit. La escena consta de: una 
esfera wireframe (radio 1,0, 36 segmentos, gris os
curo), tres stubs de eje coloreados (rojo/verde/azul 
para X/Y/Z, cada uno de 1,2 de largo) y, por cámara, 
una pequeña esfera marcadora (radio 0,03) en la 
posición correspondiente de la dirección de visión 
sobre la esfera unidad (un poco por fuera para que 
no desaparezca DENTRO de la esfera wireframe). 
Los marcadores NO se reconstruyen en cada cam
bio de fold — la reconstrucción solo es necesaria 
cuando cambia la lista de frames (es decir, se car
ga un nuevo JSON). En su lugar, por actualización 
corre una actualización in-place de los colores del 
material: rojo para los índices de test, verde para los 
de entrenamiento, gris claro si ninguno. Así los ticks 
del deslizador siguen siendo rápidos incluso con N 
> 1000 cámaras.

El control de cámara está activado — puedes rotar, 
hacer zoom y desplazar el globo con el ratón. La 
iluminación se asegura de que los marcadores no se 
vean planos. El fondo es gris oscuro.

E N  P O CA S  PA L A B R A S

El globo 3D con las posiciones de 
cámara. Verde = entrenamiento, 
rojo = test, gris claro = sin asig­
nar (no ocurre, todas las cámaras 
pertenecen a algún sitio). Con el 
ratón puedes rotar y hacer zoom 
al globo.
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W29 FoldCard (tocar para seleccionar fold)

D Ó N D E

Barra lateral derecha, sección «Angular Correla
tion».

T É C N I C O

Una vista de tarjeta por fold — rectángulo redon
deado con radio de 6 pt, padding 10, layout vertical 
con dos filas (arriba «Fold N» + número de cáma
ras, abajo «Mean nearest angle:»
1. valor en grados). Color de fondo condicional: fold 

activo =

color de acento semitransparente, inactivo = mate
rial estándar neutro. Tocar selecciona el fold y el 
globo recolorea en vivo.

La puntuación «Mean nearest angle» es el ángulo 
más pequeño medio por cámara de test a la cámara 
de entrenamiento más cercana (calculado interna
mente en radianes, mostrado en grados en la UI).

E N  P O CA S  PA L A B R A S

Una pequeña tarjeta por fold a 
la derecha con el número de cá­
maras y la distancia media a la 
cámara de entrenamiento más 
cercana. Hacer clic la selecciona 
como test.

BayesOpt Console (W30–W39)

Figura 24:  Consola BayesOpt — estado vacío antes del inicio del trial

Estado vacío con selector de espacio de búsqueda (RadianceKit
defaults (6-dim)), deslizador de trial budget (default 40), random seed (42) y tres 
paneles vacíos para gráfico de convergencia, log de trials y lista de parámetros del 
espacio de búsqueda.

Estado vacío (tras la primera apertura) — el gráfico de convergencia y la tabla de trials 
se llenan en cuanto se inicia un run, véase la siguiente captura.
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Figura 25:  Consola BayesOpt tras 40 trials — el gráfico de convergencia sube con fuerza 
hasta el trial 15, mejor valor 0,9943, log de trials con tags init/bo/restart

LO QUE SE VE EN LA IMAGEN  Estado arriba a la derecha «Finished — best 0.9943 after 
40 trials». Barra lateral izquierda: selector de espacio de búsqueda en RadianceKit 
defaults

(6-dim), trial budget 40, random seed 42. La lista de parámetros muestra los seis 
hiperparámetros a tunear con sus rangos de valor: mipSmoothing3DScale [0.05, 0.5], 
mipFilter2DVariance [0.1, 0.6], densifyGradThreshold [5e-07, 5e-06], ssimWeight 
[0.05, 0.5], mcmcNoiseScale [1e-05, 0.0001], mcmcRelocationInterval [50, 200]. 
Centro: gráfico de convergencia (X = índice de trial 1–40, Y = valor objetivo 0–1) — 
puntos grises = muestras iniciales (LHS), puntos azules = adquisición BayesOpt, puntos 
naranjas = trials restart (#22 y #31). La línea de mejor valor sube con fuerza hasta el 
trial ~7, después solo mejora marginal hasta el trial 15, a partir de ahí una meseta plana 
en 0,99+. Barra lateral derecha: log de trials #1–#34 con score + tag (init/bo/restart). El 
botón Save Best Config arriba a la derecha escribe bayesopt-best.json .

Qué es: Una consola de optimización bayesiana para búsqueda de hiperparámetros. La 
optimización bayesiana es un método automático que intenta encontrar el óptimo de 
una función desconocida con el menor número posible de experimentos — típicamente: 
«¿qué combinación de mcmcMaxGaussians, capMultiplier, ssimWeight y gradThreshold 
entrega el mejor PSNR para mi clase de escena?» En lugar de una rejilla de 6^4 = 
1296 trials, la optimización bayesiana prueba alrededor de 40–100 trials informados y 
se acerca así al óptimo.

Importante: La versión actualmente entregada en la app no ejecuta la optimización 
contra runs de entrenamiento reales (eso tardaría días) sino contra un objetivo demo 
sintético — un paisaje multi-modal con carácter de hill-climbing más ruido suave. Es 
deliberado: la ventana está pensada para mostrarte el comportamiento del optimizador 
(curva de convergencia, puntos de muestra, mejor hasta el momento) y dejarte enten
der las definiciones del espacio de búsqueda. Para runs reales de BayesOpt dirigidos 
por entrenamiento (como se hicieron en la Fase Q7 para los ajustes preestablecidos 
scene-class) se usa un flujo CLI offline separado; la ventana es la variante UI en vivo.

CUÁNDO ABRIRLA  Tres casos de uso: 1. Quieres entender cómo funciona BayesOpt — 
entonces inicia un run demo y observa el gráfico de convergencia. 2. Estás planificando 
una nueva clase de escena (como «acuarios» o «muebles antiguos») para la que los 
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10 ajustes preestablecidos integrados no encajan a la perfección. Define mentalmente 
un espacio de búsqueda, pruébalo aquí con el «Bowl demo» o el preset «Densify», 
después exporta la mejor config como JSON y úsala como punto de partida para un run 
de entrenamiento real. 3. Quieres inspeccionar los espacios de búsqueda por defecto 
definidos en el paquete RKBayesOpt (subconjunto Mip, RadianceKit defaults) — se 
listan en el panel de parámetros de la barra lateral izquierda.

CÓMO INTERPRETARLA  - Gráfico de convergencia (columna central): Y = mejor valor de 
función objetivo alcanzado hasta el momento. X = índice de trial. Sube inicialmente con 
fuerza (BayesOpt prueba las muestras iniciales aleatoriamente, algunas con suerte), 
luego se aplana cada vez más porque se agota la región cercana al óptimo. Si la línea se 
mantiene plana durante 20+ trials, puedes detener el run — trials adicionales no apor
tarán nada. Los puntos individuales en el gráfico son los valores de trial individuales (es 
decir, no «mejor hasta el momento»), coloreados por fase: gris = muestra inicial, azul 
= adquisición BayesOpt, naranja = restart. - Tabla de trials (columna derecha): #1, #2, 
#3, … cada uno con valor y tag de fase. El mejor trial hasta el momento está marcado 
con una estrella amarilla. Desde la tabla puedes identificar el mejor trial e inspeccionar 
sus valores de parámetro después durante la exportación. - Inspector de espacio 
de búsqueda (barra lateral izquierda): muestra para el preset seleccionado todos los 
nombres de parámetro y sus rangos de búsqueda [lo, hi] . Si estás en el preset 
«RadianceKit defaults (6-dim)», ves, p. ej., «densifyGradThreshold [5e-7, 5e-6]» — es 
decir, log-uniforme entre esos dos valores.

FLUJO DE EJEMPLO  Escoge el preset «RadianceKit defaults (6-dim)», trial budget 40, 
seed 42. Haz clic en «Start». Observa: los primeros 8 trials son grises (muestras inicia
les, LHS Latin hypercube), los siguientes azules (adquiridos por BayesOpt). El gráfico 
de convergencia sube con fuerza hasta el trial ~15, después se aplana. En el trial 
~30–40 el mejor valor se estabiliza. Haz clic en «Save Best Config» — se guarda un 
bayesopt-best.json  con el nombre de preset, índice de trial, valor y los valores de pa

rámetro decodificados. Después puedes copiar manualmente ese JSON a tu definición 
de ajuste preestablecido.
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W30 Botón «Start»

D Ó N D E

Toolbar a la izquierda, en estado idle/finished.

T É C N I C O

Restablece la lista de trials, cambia al estado run
ning, genera un nuevo run ID (para detección de 
stale en clics múltiples de Start) y crea una nueva 
pause gate. Después arranca una tarea en segundo 
plano que ejecuta el optimizador como stream asín
crono. El tamaño de muestras iniciales es min(8, 
budget /​ 4 + 1) — así, típicamente 8 muestras La
tin hypercube con budget ≥ 28, menos con budget 
pequeño. Los updates de trial se reciben de forma 
incremental y se anexan a la lista. Protección stale-
-run: si entretanto un segundo clic de Start fija un 
nuevo run ID, los updates del run antiguo se descar
tan.

Estilo de acción primaria para el look prominente del 
botón.

E N  P O CA S  PA L A B R A S

Inicia un run de optimización 
nuevo con el espacio de búsque­
da, budget y seed actuales.

W31 Botón «Pause»

D Ó N D E

Toolbar a la izquierda, en estado running.

T É C N I C O

Activa la pause gate y cambia al estado paused. El 
efecto real: el runner espera en un bucle de polling 
de 50 ms antes de evaluar la siguiente función obje
tivo. Eso significa que un trial actualmente en curso 
se ejecuta hasta completarse (es sintético y solo 
tarda microsegundos), pero no se inicia un trial más. 
En cuanto Resume corre, continúa donde lo dejó.

E N  P O CA S  PA L A B R A S

Pausa el run. El cálculo actual 
aún corre hasta completarse, 
después pausa.
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W32 Botón «Stop»

D Ó N D E

Toolbar a la izquierda, en estado running y paused.

T É C N I C O

Cancela la tarea del runner, nulea la referencia, 
libera la pause gate (si todavía estaba en pause) y 
cambia al estado finished (si existen trials) o idle (si 
no). Los trials ya calculados permanecen visibles en 
la lista — Stop no los elimina. El rol destructivo del 
botón muestra el botón en rojo porque cancela el 
run.

E N  P O CA S  PA L A B R A S

Cancela el run de forma perma­
nente. Los trials se mantienen 
visibles; aún puedes exportar la 
mejor config.

W33 Botón «Resume»

D Ó N D E

Toolbar a la izquierda, en estado paused.

T É C N I C O

Libera la pause gate y vuelve al estado running. La 
tarea del runner ya está en marcha (está esperando 
en el bucle de polling); en cuanto el bucle nota 
que la pausa se ha levantado, continúa e inicia el 
siguiente trial.

E N  P O CA S  PA L A B R A S

Reanuda un run en pausa.
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W34 Botón «Save Best Config»

D Ó N D E

Toolbar a la derecha, siempre visible (pero deshabi
litado si no hay bestTrial).

T É C N I C O

Abre un diálogo de guardar con nombre predeter
minado bayesopt-best.json , restringido a JSON. 
Tras la confirmación se construye un diccionario 
payload: nombre de preset, índice de trial, valor 
(puntuación objetivo), parámetros (diccionario de 
nombres de parámetros decodificados → valores). 
La decodificación proyecta de vuelta las coorde
nadas del espacio de búsqueda normalizadas en 
[0,1]^d al rango de valor original (con escalas 
log-uniforme/lineal/integer según corresponda). La 
salida JSON está pretty-printed y con claves orde
nadas. En errores de escritura (en la versión demo 
actual) se ignora en silencio — sin UI de error por
que es una vía demo.

El botón se mantiene atenuado mientras no haya 
corrido ningún trial.

E N  P O CA S  PA L A B R A S

Guarda los valores de parámetro 
del mejor trial hasta el momento 
como JSON. Después puedes co­
piar manualmente esos valores a 
tu configuración de ajuste prees­
tablecido.
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W35 Selector «Search Space» preset

D Ó N D E

Barra lateral izquierda, arriba.

T É C N I C O

Selector tipo menú con cuatro opciones preset: 
- «RadianceKit defaults (6-dim)» — el espacio 
de búsqueda estándar completo con todos los 
hiperparámetros Q7. - «Mip subset (2-dim)» — 
solo mipSmoothing3DScale [0,05, 0,5] log-uniforme 
y mipFilter2DVariance [0,1, 0,6] lineal. Útil cuan
do quieres tunear Mip-Splatting para una clase 
de escena. - «densify-until + ssim-weight + grad-
-thresh» — tres parámetros relevantes para Densify 
(densifyGradThreshold log-uniforme, ssimWeight  
lineal, densifyUntilIter  integer). - «Bowl demo 
(1-dim)» — espacio de búsqueda pedagógico de un 
solo parámetro para demos «así es como funciona 
BayesOpt».

Mientras hay un run activo, el espacio de búsqueda 
no se puede cambiar (confundiría al optimizador).

E N  P O CA S  PA L A B R A S

Qué espacio de búsqueda de 
hiperparámetros explora Baye­
sOpt. El default es «RadianceKit 
defaults». Para intentos de tu­
ning Mip dirigido, «Mip subset». 
Para entender cómo funciona 
BayesOpt, «Bowl demo».

W36 Deslizador «Trial Budget»

D Ó N D E

Barra lateral izquierda, bajo el selector de espacio 
de búsqueda.

T É C N I C O

Deslizador de 10 a 200, paso 5. Default 40. Eso sig
nifica: BayesOpt puede hacer un máximo de N trials. 
De ellos, los primeros son muestras iniciales (Latin 
hypercube), el resto son trials BayesOpt reales. 
Reglas prácticas: un espacio de búsqueda con d di
mensiones necesita alrededor de 10*d a 20*d trials 
para un buen óptimo. En los defaults de 6-dim son 
60–120, en el subset Mip de 2-dim 20–40, en la 
Bowl demo de 1-dim 10–20.

Durante el run el deslizador está deshabilitado.

E N  P O CA S  PA L A B R A S

Cuántos intentos de optimiza­
ción como máximo. Más intentos 
= mejor solución, pero cuesta 
más tiempo. 40 es un buen de­
fault para el objetivo demo.
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W37 Deslizador «Random Seed»

D Ó N D E

Barra lateral izquierda, bajo el deslizador de budget.

T É C N I C O

Deslizador de 1 a 100, paso 1. Default 42. La seed 
se pasa tanto a las muestras iniciales Latin hypercu
be como al componente de ruido del objetivo demo. 
Reproducibilidad: misma seed + mismo espacio de 
búsqueda + mismo budget da exactamente la mis
ma secuencia de trials. Útil para «¿obtienen todos 
tus compañeros el mismo run cuando reconstruyen 
la demo?». Deshabilitado durante el run.

E N  P O CA S  PA L A B R A S

Controla el generador aleatorio. 
Misma seed = mismo run — para 
reproducir.

W38 Chart (convergencia)

D Ó N D E

Columna central de la ventana.

T É C N I C O

Diagrama Swift Charts con dos capas: 1. una línea 
para «mejor valor hasta el momento» por trial — 
una curva monotónicamente creciente o constante 
en color de acento. 2. un punto por trial con el valor 
objetivo individual, coloreado por fase. Tamaño de 
símbolo 40. Tres etiquetas de fase: «init» (gris), 
«bo» (azul), «restart» (naranja).

Una pequeña leyenda muestra los colores de fase 
arriba a la izquierda. Si la lista de trials está vacía 
(antes del primer inicio), en su lugar se muestra una 
visualización empty-state con un icono de chart y el 
aviso «Press Start to begin a BayesOpt run.»

E N  P O CA S  PA L A B R A S

El gráfico de progreso. La línea 
sólida es «la mejor solución en­
contrada hasta el momento»; los 
puntos son los intentos indivi­
duales. Si la línea se mantiene 
plana durante mucho tiempo, Ba­
yesOpt ha encontrado el óptimo.
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W39 Table (log de trials)

D Ó N D E

Columna derecha de la ventana.

T É C N I C O

Área de scroll con filas de trial apiladas de forma 
lazy. Un stack horizontal por fila: número de trial 
(monoespaciado de 3 dígitos, a la izquierda), valor 
(monoespaciado, alineado a la derecha, 70 pt de 
ancho), tag de fase (cápsula, rellena con color de 
fase al 25 % de opacidad), opcionalmente una es
trella amarilla si ese trial es ahora mismo el mejor. 
Un mecanismo de auto-scroll salta automáticamen
te al final en cuanto se añade un nuevo trial — así 
puedes seguir la progresión en vivo al pie de la pan
talla sin desplazarte tú mismo.

E N  P O CA S  PA L A B R A S

La tabla de todos los intentos. 
Valor, fase, estrella para el mejor. 
Auto-scrollea, los nuevos trials 
aparecen abajo.

Ventana principal: curva de loss y número de Gaussianos (I39–I41, 
referencia cruzada)

Tres de las visualizaciones del Inspector en la ventana principal merecen su propia 
explicación porque son constantemente visibles durante un entrenamiento en curso y 
hay reglas prácticas importantes para cuando la curva se ve sana. Las visualizaciones 
están en el Inspector bajo la sección «Loss Chart» (véase Capítulo 2 — Inspector) y 
complementan el análisis Holdout de la ventana auxiliar de arriba.

¿Cuándo es sana la curva de loss? Una curva de loss sana muestra tres fases: (1) 
Warmup — en las primeras 200–500 iteraciones, el loss cae con fuerza desde alto 
(típicamente 0,15–0,25 para L1+SSIM combinados según la escena) a aproximadamente 
la mitad. Si el loss NO cae en esta fase, la entrada suele ser incorrecta (imágenes rotas, 
malas poses SfM, muy pocos Gaussianos iniciales). (2) Densification — entre ~500 y 
densifyUntilIteration (classic 15K, MCMC hasta 20K o 25K) el loss sigue cayendo, a me
nudo con pequeños saltos hacia abajo cuando las operaciones densify insertan nuevos 
Gaussianos y el optimizador los aprovecha. El número de Gaussianos sube en esta fase. 
(3) Refinement — después de eso el loss entra en una cola que se aplana. Valores 
finales típicos: Tanks-&-Temples Truck con P4 Quality aterriza en L1 ≈ 0,023, Horse 
con Full Classic V546 en L1 ≈ 0,0230, escenas exteriores Mip-NeRF360 a menudo peor 
(0,04–0,07).

¿Qué significa una meseta? Una meseta (la curva de loss corre horizontal durante 
varios miles de iteraciones) tiene dos interpretaciones: (a) el modelo ha convergido, 
entrenar más no aportará nada — el buen caso. (b) el modelo está atascado (mínimo 
local, mala información de gradiente, tope al límite del buffer) — el mal caso. Ambos se 
ven idénticos en el gráfico. Distinción: mira el número de Gaussianos. Si también está 
plano Y cerca del tope MCMC (p. ej., 150K de 150K en .fullMCMC ), estás en el límite — 
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o sube el tope o acepta la meseta. Si el número de Gaussianos sigue creciendo pero el 
loss no cae, está atascado.

¿Cuándo abortar vs continuar entrenando? Regla práctica: 10K iteraciones sin mejora 
del min loss → abortar, las iteraciones siguientes son tiempo perdido. Antes de eso: 
puedes añadir una extensión vía Cmd+T (menú Training → Continue Training → +5K 
iterations), si ves una mejora marginal. Atención: con MCMC la meseta es a menudo 
real — el tope es el límite natural.

Una meseta del número de Gaussianos NO es una señal de «hecho». Solo significa 
que MCMC ha alcanzado el tope o que la densificación Classic se ha agotado. La 
pregunta real de «hecho» solo la responde el análisis Holdout — PSNR/SSIM/LPIPS 
sobre un conjunto de test independiente, evaluado en la ventana Holdout (W23–W29) o 
mediante el flag --benchmark .

PSNR/Holdout es la verdad, loss es solo un proxy. El loss es una métrica relativa: 
cae a medida que tu modelo se ajusta a las vistas de entrenamiento. Un loss bajo no 
significa automáticamente un buen modelo — si el modelo ha memorizado las imágenes 
de entrenamiento (overfitting), el loss sería pequeño, pero el PSNR sobre vistas no 
vistas (Holdout) sería malo. Por tanto: para la evaluación final de calidad, siempre mira 
métricas Holdout, no solo el loss final.

Caja de reglas prácticas

• User Guide y Keyboard Shortcuts son ayuda estática — rápidos para preguntas de 
palabra clave, para profundidad ten este manual a mano.

• Abre Manage Storage en cuanto el disco caiga por debajo del 10 % de espacio libre. 
Los logs y el staging de imports son los sospechosos habituales.

• Pareto Dashboard solo es útil tras al menos tres o cuatro reportes de entrenamiento. 
Eje X = costes (Time / Gs), eje Y = calidad (PSNR / SSIM). El frente de Pareto muestra 
las combinaciones eficientes.

• Usa Holdout Analysis antes de publicar benchmarks de PSNR con otros — te asegura 
que tu conjunto de test es realmente representativo.

• BayesOpt Console es ante todo una herramienta de aprendizaje y de inspección para 
definiciones de espacio de búsqueda. Para un tuning real de hiperparámetros dirigido 
por entrenamiento, usa el flujo CLI offline.

• La meseta de loss y la meseta del número de Gaussianos deben interpretarse por 
separado. El límite del tope no es una señal de «hecho». La calidad real se mide solo 
por PSNR Holdout.

• 10K iteraciones sin mejora del min-loss → detener el entrenamiento.
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C A P Í T U L O

Capítulo 6 — Configuración del 
entrenamiento

Figura 26:  Ajuste preestablecido Preview exportado como JSON y visualizado en TextEdit 
— campos id/name/category/version/createdAt/ description, trainingConfig con todos los 
parámetros relevantes (maxIterations 5000, densifyUntilIteration 3500, ssimWeight 0,20, 

renderScale 0,50, strategy classic, cameraAlignment applePhotogrammetry, densifyGradTh
reshold 2.0e-06, opacityResetInterval 3000, minOpacity 0,005, seis conmutadores boolea

nos)

LO QUE SE VE EN LA IMAGEN  Una exportación típica de un ajuste preestablecido como 
JSON. Campos de nivel superior: id  (UUID), name , (classic | mcmc | sceneClass | 
custom), (versión de schema), (timestamp), (texto libre). El objeto anidado contiene 
los parámetros críticos para la reproducibilidad — en la importación, todo el bloque se 
deserializa en el struct TrainingConfig , y los defaults de la versión actual de la app 
rellenan los campos que falten en el JSON (p. ej., tras una actualización de la app). Para 
pasar un ajuste preestablecido a otro Mac, basta con enviar este archivo JSON.
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El struct TrainingConfig  es el corazón de cada run de entrenamiento en RadianceKit. 
Recopila todos los parámetros que influyen en el entrenamiento — desde el número má
ximo de iteraciones, pasando por las ocho learning rates, hasta los campos especiales 
para MCMC, Mip-Splatting, el currículum y la lógica de tope consciente de la escena. Lo 
editas en la barra lateral en la sección Training Configuration (Vista Experto), lo guardas 
como ajuste preestablecido o lo entregas como exportación JSON a otro Mac. Al iniciar 
el entrenamiento, este mismo objeto se congela y se entrega al backend de GPU.

Este capítulo es material de referencia para power users y autores de scripts. Lista los 
81 campos públicos, los 9 ajustes preestablecidos estáticos y el único método público. 
El archivo fuente es TrainingConfig.swift — en caso de duda, el comentario de doc 
almacenado allí y el valor por defecto del inicializador son la fuente de verdad.

AV I S O  ·  U I  V S .  P R E S E T/ C L I

Solo 12 de los 81 campos tienen un deslizador, conmutador o selector directo en 
el Inspector (build de App Store sandbox): T1, T2, T17, T20, T22, T38, T56–T58, 
T60, T61, T73. Los 69 campos restantes se fijan mediante el ajuste preestable­
cido elegido (Capítulo 7) y solo pueden sobrescribirse directamente mediante un 
flag CLI (véase Capítulo 5). Esta separación es a propósito: los defaults se man
tienen estables y probados en producción, mientras que los power users siguen 
teniendo una vía de escape. Si un campo te interesa de verdad, comprueba prime
ro el Capítulo 2 (Inspector) y el Capítulo 5 (CLI) para ver si llegas a él sin trastear 
el JSON.

Índice:

1. Iteración (T1–T2)
2. Learning Rates (T3–T10)
3. Densificación — Classic (T11–T16)
4. Loss (T17–T20)
5. Progresión de grado SH (T21)
6. Rendimiento (T22–T25)
7. Diagnóstico y preparación de la nube de puntos (T26–T30)
8. Regularización (T31–T37)
9. Refinamiento (T38–T44)

10. Sky Dome (T45–T48)
11. Adam + schedule de LR (T49–T55)
12. Post-procesado + Apple AI (T56–T60)
13. Densificación MCMC (T61–T73)
14. Mip-Splatting (Q1.5) (T74–T76)
15. Densificación adaptativa (Q5) (T77–T79)
16. Currículum (Q6) (T80–T81)
17. Ajustes preestablecidos estáticos (TP1–TP9)
18. Método:
19. ¿Qué campo para qué? (Cheat Sheet)
20. Campos peligrosos
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Iteración (T1–T2)

T1 maxIterations

D E TA L L E S

Predeterminado: 30 000 (initializer), 35 000 
( .full ), 200 000 ( .fullMCMC ) Rango: 1 000 – 
500 000 (deslizador UI), sin límite superior duro en 
la lógica Definido en:

T É C N I C O

Número total de iteraciones de entrenamiento que 
ejecuta el backend. Una iteración significa un for
ward render de una sola cámara de entrenamiento, 
un backward pass sobre todos los componentes 
del loss (L1 + SSIM + regularizaciones opcionales + 
máscara de cielo) y un paso del optimizador Adam. 
Este número controla directamente los demás sche
dules: la learning rate de posición sigue una curva 
cosine annealing de 0 a T1  mismo o a T49 
positionLRScheduleEndIteration; la densificación 
se detiene en T2 densifyUntilIteration; el decay 
de ruido MCMC termina en T69 mcmcNoiseDecayEnd; 
los upgrades de grado SH ocurren en las tres mar
cas de T21 . Para la densificación clásica, el sweet 
spot empírico está en 20 000–35 000 iteraciones 
(Sesiones 1–32, tests V546), para MCMC en 60 
000–200 000 (V534). Empujar mucho más allá de 
los valores almacenados en el ajuste preestablecido 
rara vez aporta calidad adicional — el momentum de 
Adam se satura, y sin un final de decay de LR el 
loss se estanca. Al contrario, bajar de ~5 000 lleva a 
geometría incompletamente convergida (la density 
control tiene muy poco tiempo para clone/split).

E N  P O CA S  PA L A B R A S

Cuánto tiempo entrena la app. 
Más iteraciones = mejor resulta­
do, pero a partir de cierto punto 
ya no se nota mejor, solo dura 
mucho más. Los ajustes preesta­
blecidos están elegidos para que, 
sin pensar, obtengas un buen 
valor: Quick 1 000, Preview 5 
000, Balanced 20 000, Quality 35 
000, MCMC Quality 200 000. Si 
mueves la perilla tú: con MCMC, 
sube tranquilamente (100 000–
200 000); con Classic, no por en­
cima de 40 000 — a partir de ahí 
no ayuda más.

114 / 242



R A D I A N C E K I T Capítulo 6 — Configuración del entrenamiento

T2 densifyUntilIteration

D E TA L L E S

Predeterminado: 15 000 (initializer), 5 000 
( .full ), 160 000 ( .fullMCMC ) Rango: 0 – Defini­
do en:

T É C N I C O

Iteración en la que se detiene la densificación. Has
ta este punto, los Gaussianos se clonan, dividen y 
podan según las reglas parametrizadas en T11–T16  
(Classic) o T67–T70  (MCMC); después, el número 
de Gaussianos se mantiene constante y solo se 
optimizan posiciones, rotaciones, escalas, opacida
des y coeficientes SH (fase de refinamiento). En el 
paper original de 3DGS, el valor está en el 50 % 
de T1 , en el preset .full  de RadianceKit solo 
en el ~14 % (5 000 de 35 000) — consecuencia 
de los experimentos V310/V338 que mostraron que 
tras 5 000 iteraciones más densificación empeora 
el resultado (más floaters, mayor uso de memoria, 
sin ganancia de calidad). MCMC, en cambio, ejecuta 
la relocalización hasta el 80 % de T1  (V504b) por
que MCMC no produce floaters dañinos. Si T2  es 
demasiado pequeño (< 1 000), surgen muy pocos 
Gaussianos; demasiado grande bajo Classic (> 50 
% de T1 ) lleva a sobrecrecimiento y a outliers 
de saturación RGB (véase Outdoor Overtraining Fin
dings).

E N  P O CA S  PA L A B R A S

Hasta cuándo la app puede crear 
nuevos Gaussianos. Después, so­
lo se refina lo que ya existe. 
Con entrenamiento clásico a 35 
000 iteraciones, 5 000 es aquí 
el valor correcto — cualquier va­
lor superior hace la escena más 
blanda. Con MCMC, es el 80 % del 
total de iteraciones (es decir, 160 
000 para un run de 200 000). Si 
cambias el ajuste preestablecido 
Quality, mejor deja este campo 
en paz.
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Learning Rates (T3–T10)

T3 positionLearningRate

D E TA L L E S

Predeterminado: 0,00016 Rango: 1e-7 – 1e-3 (re
comendado) Definido en:

T É C N I C O

Learning rate de Adam para la posición XYZ 
de cada Gaussiano al inicio del entrenamiento 
(iteración 0). Sigue una curva cosine annealing 
y decae a lo largo del entrenamiento hasta 
T4 positionLearningRateFinal. El predeterminado 
0,00016 viene del paper original de 3DGS (Kerbl 
et al. 2023) y en RadianceKit no se escala ni siquie
ra con mayor resolución de imagen — la posición 
se mueve en coordenadas mundo, no en espacio 
de píxeles. Un aumento claro (> 0,0005) hace que 
los Gaussianos salten grandes distancias y el loss 
se vuelve inestable; valores muy por debajo (< 
0,00005) hacen que nubes de puntos mal iniciali
zadas no encuentren nunca su sitio. V414 probó 
duplicar el valor inicial → 16,8 % peor loss L1; los tu
neos V544a confirmaron el default del paper como 
óptimo. Nota: bajo .fullMCMC  lo dejamos delibera
damente en el default — MCMC necesita learning 
rates constantes para su lógica de relocalización, 
así que afinar aquí no aporta nada.

E N  P O CA S  PA L A B R A S

Lo rápido que pueden moverse 
los puntos splat por el espa­
cio. El valor predeterminado está 
muy bien afinado y básicamente 
no necesita cambios. Solo si los 
splats «tambalean» en la imagen 
o falta toda una esquina porque 
ahí nada se mueve sería el lear­
ning rate algo a ajustar — pero 
entonces típicamente hay algo 
mal aguas arriba (poses de cá­
mara, nube de puntos inicial).
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T4 positionLearningRateFinal

D E TA L L E S

Predeterminado: 0,0000016 (initializer + paper), 
0,000016 ( .full , .fullMCMC  — 10× mayor) Ran­
go: 0 – Definido en:

T É C N I C O

Valor final de la curva cosine annealing de 
LR de posición. Se alcanza ya sea en 
T1 maxIterations  o, si está fijado, en T49 
positionLRScheduleEndIteration. El preset .full  
de RadianceKit usa 0,000016 — es decir, 10× más 
alto que el default del paper 0,0000016. Los expe
rimentos V420 mostraron que 0,5× del valor final 
(0,000008) hace el loss un 6,4 % peor; V414 mos
tró que 2× el valor inicial lo empeora un 16,8 %. 
El valor final alto no es un trade-off sino una elec
ción deliberada: con un decay demasiado agresivo, 
los Gaussianos pierden durante la fase de refina
miento la capacidad de reaccionar a candidatos de 
densificación recién llegados. Mediante la extensión 
V431/V433, la fase del schedule se puede acortar 
( T49 < T1 ), de modo que T4  se alcance antes del 
final del entrenamiento y el resto del entrenamiento 
corra con el mini-LR constante — configuración típi
ca: T49 = 20 000 , T1 = 35 000 , refinamiento por 
tanto en 0,000016 durante 15 000 iteraciones.

E N  P O CA S  PA L A B R A S

Lo despacio que se vuelve la lear­
ning rate de posición al final del 
entrenamiento. Lo hemos puesto 
deliberadamente menos agresivo 
que el paper original — los splats 
aún pueden moverse un poco 
hasta el final, lo que los hace 
más nítidos. Si mueves la perilla: 
más alto = splats más inquietos 
al final, más bajo = los splats 
ya no se pueden adaptar cuando 
aparecen nuevos.
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T5 shDCLearningRate

D E TA L L E S

Predeterminado: 0,0025 (initializer + paper), 0,005 
( .full  y todos los ajustes preestablecidos MCMC 
— 2×) Rango: 0,0001 – 0,05 Definido en:

T É C N I C O

Learning rate de Adam para el componente DC 
(grado 0, es decir, albedo constante) del color 
spherical harmonic. El SH-DC corresponde al tono 
base independiente de la dirección de un Gaus
siano, esencialmente el «color base». Los experi
mentos V176 y V188 encontraron 2× más alto que 
el default del paper como óptimo — convergencia 
de color más rápida, especialmente porque con en
trenamiento corto (5 000 iteraciones), el SH-DC en 
otro caso no converge. A diferencia de las LRs geo
métricas, el SH-DC no tiene decay; la learning rate 
se mantiene constante sobre todas las iteraciones 
(o solo sigue el decay opcional de fase extendida de 
T51 ). V416 probó cuadruplicar a 0,01 → loss 6,4 % 

peor con Adam beta2=0,99.

E N  P O CA S  PA L A B R A S

Lo rápido que se adapta el color 
base de cada splat. Casi nunca 
cambias este valor tú mismo — 
los ajustes preestablecidos tie­
nen el valor correcto. Más alto 
sería más rápido pero puede lle­
var a colores inestables.
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T6 shRestLearningRate

D E TA L L E S

Predeterminado: 0,000125 (initializer + paper), 
0,00025 ( .full  y MCMC — 2×) Rango: 0,000001 
– 0,005 Definido en:

T É C N I C O

Learning rate de Adam para los coeficientes SH de 
orden superior (grados 1, 2, 3 — los componentes 
de color dependientes de la dirección de visión que 
producen brillos, reflejos y sombreado suave). 20× 
más pequeña que T5  por convención del paper, 
porque esos coeficientes crecen cuadráticamente 
en número (3 para grado 1, 5 para grado 2, 7 para 
grado 3 → 15 floats totales por Gaussiano) y sin 
una learning rate menor sobresaturarían la imagen. 
Se desbloquean en dos pasos — hasta la primera 
marca en T21 shDegreeUpgradeIterations solo está 
activo el grado 0 (así que solo T5 ), después el 1, 
luego el 2, finalmente el 3. Los valores bajos aquí 
son particularmente importantes en escenas con 
mucha iluminación difusa; en superficies muy espe
culares (pintura de coche, agua) afinar no ayuda — 
la propia representación SH está limitada.

E N  P O CA S  PA L A B R A S

Lo rápido que aprenden los efec­
tos de color dependientes de la 
vista (reflejos, brillos). Por defec­
to muy pequeño, en otro caso 
todo empieza a brillar. Mejor deja 
el valor — si quieres mejores bri­
llos, te sirve más MCMC y más 
tiempo de entrenamiento que es­
ta LR.
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T7 opacityLearningRate

D E TA L L E S

Predeterminado: 0,05 (initializer + paper), 0,1 
( .full , MCMC — 2×) Rango: 0,001 – 1,0 Definido 
en:

T É C N I C O

Learning rate de Adam para la opacidad logit de 
cada Gaussiano. La app almacena la opacidad como 
un valor float no acotado y la transforma con sig
moide a [0, 1]; la LR actúa en espacio logit. El 
default 0,05 del paper se restauró tras los tests V50 
(mejor L1 single-run 0,1664), V71 revirtió el 0,025 
de V67. La duplicación V188 a 0,1 hace el pruning 
más eficiente — los Gaussianos muertos caen más 
rápido por debajo del T14 pruneOpacityThreshold. 
V418 mostró: 0,05 con Adam beta2=0,99 es un 7,1 
% peor que 0,1 — la interacción con la configuración 
de Adam no es trivial. Valores bajos (< 0,01) hacen 
que los Gaussianos «muertos» persistan eterna
mente y desperdicien memoria; valores demasiado 
altos (> 0,5) pueden llevar a explosión de opacidad, 
por lo que el valor logit en el optimizador se hace 
clamp a [−15, 3] (véase la nota «Opacity Explosion 
Prevention» en CLAUDE.md).

E N  P O CA S  PA L A B R A S

Lo rápido que los splats se vuel­
ven transparentes u opacos. Im­
portante para la limpieza — los 
splats que no contribuyen tienen 
que desaparecer rápido para que 
no aparezca neblina. El valor pre­
determinado encaja, solo lo cam­
bian los profesionales.
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T8 opacityLearningRateFinal

D E TA L L E S

Predeterminado: 0,0 (= «sin decay») Rango: 0 o 
0,001 – Definido en:

T É C N I C O

Valor final opcional de decay cosine para la LR de 
opacidad (V427). Cuando es 0,0, el decay está des
habilitado y la LR de opacidad se mantiene cons
tante en T7  durante todo el entrenamiento. V427 
probó un decay 0,1 → 0,01 — resultado fue loss 11,5 
% peor; revertido, de ahí el predeterminado «off». 
La hipótesis tras el campo: en la fase de refina
miento, una LR de opacidad constante podría llevar 
a oscilación, de modo que splats que ya hubieran 
alcanzado el nivel correcto de transparencia serían 
empujados de un lado a otro por fluctuaciones alea
torias de gradiente. Empíricamente no es así — la 
lógica de clamp logit ya lo atrapa. El campo se man
tiene disponible para experimentos futuros; runs 
MCMC muy largos (> 500K iteraciones) también po
drían beneficiarse.

E N  P O CA S  PA L A B R A S

Si la learning rate de opacidad 
debe hacerse más pequeña hacia 
el final. Predeterminado: no. Lo 
probamos, fue peor, lo dejamos 
off. Quédate en 0.
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T9 scaleLearningRate

D E TA L L E S

Predeterminado: 0,005 (initializer + paper), 0,01 
( .full , MCMC — 2×) Rango: 0,0001 – 0,1 Defini­
do en:

T É C N I C O

Learning rate de Adam para los tres componentes 
de escala de cada Gaussiano en espacio logarítmi
co (RadianceKit almacena log(scale) para que las 
escalas se mantengan positivas). El default del pa
per 0,005, duplicado en RadianceKit a 0,01 para 
mejor convergencia de escala con las configura
ciones de learning rate optimizadas. Experimento 
V423: 0,005 con Adam beta2=0,99 → loss 18,7 
% peor y visiblemente muy pocos Gaussianos (la 
density control no podía clonar porque las actuali
zaciones de escala eran demasiado perezosas). La 
escala controla la extensión de cada Gaussiano — 
un aprendizaje demasiado rápido lleva a Gaussianos 
«aguja» (splats extremadamente largos y delgados, 
véase T34 scaleRatioPruneThreshold), un aprendi
zaje demasiado lento mantiene los splats demasia
do compactos y la density control tiene que dividir 
demasiado a menudo.

E N  P O CA S  PA L A B R A S

Lo rápido que se adapta la forma 
de los splats. El predeterminado 
es bueno. Si subes esto, obtienes 
splats «aguja» — gotas extrema­
damente largas y delgadas que 
hacen flotar la imagen.
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T10 rotationLearningRate

D E TA L L E S

Predeterminado: 0,001 (initializer + paper), 0,002 
( .full , MCMC — 2×) Rango: 0,0001 – 0,05 Defi­
nido en:

T É C N I C O

Learning rate de Adam para los cuatro componentes 
cuaternión de cada Gaussiano. El cuaternión se re
normaliza tras cada actualización de Adam (norma 
L2 = 1) — en otro caso, la matriz de covarianza de
generaría. RadianceKit duplica el default del paper 
en los ajustes preestablecidos Quality porque la ro
tación tiene magnitudes de gradiente absolutas más 
pequeñas que escala/posición (en la esfera unitaria 
cada paso se mantiene corto) y sin 2× la rotación 
estaría claramente sub-convergida en la ventana de 
35 000 iteraciones. V188 lo documenta. En esce
nas NeRF-Blender (Lego, Chair) la rotación importa 
particularmente — los bordes de objetos solo se ali
nean correctamente tras 5 000–10 000 iteraciones.

E N  P O CA S  PA L A B R A S

Lo rápido que los splats apren­
den a rotar — es decir, a orien­
tarse correctamente sobre la su­
perficie de un objeto. El prede­
terminado encaja. Dicho de otro 
modo: si los splats parecen lo­
sas tumbadas torcidas en vez de 
abrazar la superficie, el tiempo 
de entrenamiento es corto antes 
que esta learning rate baja.
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Densificación — Classic (T11–T16)

T11 densifyGradThreshold

D E TA L L E S

Predeterminado: 0,000002 (initializer, calibrado 
para 0,5× resolución), 0,0000011 ( .full , calibrado 
para 1,0×), 0,000004 ( .quickTest , calibrado para 
0,25×), 2e-7 ( .fullClassicPaper ) Rango: 1e-8 – 
1e-3 (dependiente de resolución) Definido en:

T É C N I C O

Umbral para la norma L2 del gradiente proyectado 
en espacio de pantalla dMean2D , por encima del 
cual un Gaussiano se marca para clonado o división. 
El valor absoluto depende directamente de la reso
lución de entrenamiento — dMean2D  escala aproxi
madamente como 1/resolución² (más píxeles = gra
dientes por píxel más pequeños). De ahí que cada 
paso de T22 trainingRenderScale necesite un um
bral calibrado: 0,25× → 4e-6, 0,5× → 2e-6, 1,0× → 
5e-8 … 1,1e-6 ( .full ). El default 0,0002 del paper 
está normalizado NDC y no es directamente compa
rable con la pipeline en espacio mundo de Radian
ceKit. Con el flag T52 adaptiveDensifyThreshold in
troducido en V440, el valor puede derivarse en run
time del p98 de la distribución actual de gradientes 
— pero V440 lo probó en escenas reales y produjo 
63 K Gaussianos (pérdida catastrófica por pruning); 
el flag se queda off. Q5 (T77–T79) proporciona una 
lógica adaptativa alternativa vía mediana rodante. 
Este campo no es inocuo — partir a la mitad crea 
2–4× más Gaussianos (presión de memoria, riesgo 
OOM); duplicar puede sub-densificar la escena.

E N  P O CA S  PA L A B R A S

Lo sensible que es la app al deci­
dir si un splat está sub-represen­
tado y debería duplicarse. Valor 
más bajo = más sensible = más 
splats. Más alto = menos splats. 
Es uno de los valores más peli­
grosos: demasiado bajo y tu Mac 
se llena con millones de splats y 
puede caerse. Deja el campo en 
paz, o cámbialo solo en pasos del 
10 %.
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T12 densifyFromIteration

D E TA L L E S

Predeterminado: 500 Rango: 100 – 5 000 Defini­
do en:

T É C N I C O

Primera iteración en la que la densificación se vuel
ve activa. Antes solo ocurre aprendizaje «puro» 
sobre la nube de puntos SfM inicial, sin que se 
creen nuevos Gaussianos. El default 500 viene del 
paper 3DGS y da tiempo a la inicialización para 
estabilizarse — si la densificación arranca ya en la 
iteración 0, los puntos SfM mal posicionados se 
clonan muchas veces antes incluso de encontrar su 
lugar correcto. V349 probó 1000 → loss ligeramen
te peor; el default es óptimo.

E N  P O CA S  PA L A B R A S

Cuándo empieza la app a clonar 
splats por primera vez. Antes so­
lo aprende los puntos ya existen­
tes. 500 es el predeterminado 
— da a la app suficiente tiempo 
para orientarse antes de multi­
plicar.

T13 densifyInterval

D E TA L L E S

Predeterminado: 100 (initializer, MCMC), 200 
( .full ) Rango: 50 – 1 000 Definido en:

T É C N I C O

Cuántas iteraciones hay entre dos pasos de densi
ficación. Default del paper 100 — cada 100 iteracio
nes se evalúa la lista de candidatos a densificar, 
se clona/divide, y al mismo tiempo se elimina la 
lista de candidatos a poda (sigmoid(opacity) < 
T14 pruneOpacityThreshold). Las pruebas V112 en
contraron 200 como óptimo para .full  — esto 
descarga la GPU porque corren menos pasadas de 
reorganización, y da a cada Gaussiano más tiempo 
para asentarse tras una acción de clonado. V417 
probó 100 con Adam beta2=0,99 → 5,8 % peor (957 
K Gaussianos, sobre-densificación). Bajo MCMC el 
mismo campo se interpreta como intervalo de relo
calización; véase T67 mcmcRelocationInterval para 
la lógica específica de MCMC.

E N  P O CA S  PA L A B R A S

Cada cuánto busca la app nue­
vos splats. 100 = a menudo, 
200 = medio. Más alto signifi­
ca: cada splat tiene más tiempo 
para asentarse antes de que se 
le vuelva a multiplicar. Eso es 
bueno. Reducir a 50 puede man­
tener la GPU ocupada de forma 
permanente sin que sea notable­
mente mejor.
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T14 pruneOpacityThreshold

D E TA L L E S

Predeterminado: 0,005 (initializer, paper, MCMC), 
0,001 ( .full ) Rango: 0,0001 – 0,1 Definido en:

T É C N I C O

Umbral de opacidad sigmoide por debajo del 
cual un Gaussiano se elimina en el siguiente 
paso de densificación. Funciona junto con T7 
opacityLearningRate y la lógica de clamp logit en el 
optimizador. V393 bajó el default de 0,005 a 0,001 
en .full  — resultado: los splats que solo impor
tan bajo ángulos de visión exóticos se mantienen 
más tiempo y contribuyen a detalle SH. V394 probó 
0,0001 → ligeramente peor (muy poco podado, me
moria desperdiciada). Importante: la density control 
DEBE podar siempre, aun cuando la capacidad de 
buffer ya esté llena por otras medidas (véase «Den
sity Control Must Always Prune» en CLAUDE.md) — 
en otro caso, los Gaussianos muertos se acumulan y 
el número se congela.

E N  P O CA S  PA L A B R A S

Cuándo un splat cuenta como «lo 
bastante transparente» para ser 
eliminado. 0,005 es el default del 
paper, en Quality tenemos 0,001 
— es decir, damos a los splats 
más oportunidad. Eso hace más 
fáciles de representar la luz sua­
ve y las sombras tenues. Subir 
(por encima de 0,01) hace caer 
rápido el número de splats — 
puede tener sentido con presión 
de memoria pero cuesta detalle.
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T15 opacityResetInterval

D E TA L L E S

Predeterminado: 3 000 (initializer + paper), 100 
000 ( .full  = efectivamente deshabilitado), 200 
000 ( .fullMCMC  = deshabilitado) Rango: 1 000 – 
100 000+ Definido en:

T É C N I C O

Cuántas iteraciones entre reseteos de la opacidad 
de todos los Gaussianos a un valor bajo (~0,01) — 
una medida del paper 3DGS para reevaluar splats 
«congelados». V194 mostró que con el setup de 
warmup + entrenamiento estocástico + LRs 2× de 
RadianceKit, el reset de opacidad cuesta un 5,5 % 
de calidad y que la lógica de clamp logit ya cubre 
la función reset. De ahí que en .full  esté prácti
camente deshabilitado (100 000 > 35 000, así que 
nunca se dispara). V421 probó reset cada 3 000 
con Adam beta2=0,99 → 4,9 % peor; revertido. 
Bajo .fullClassicPaper  (test paper-true Q1.5-A) 
se vuelve a poner deliberadamente en 3 000 — 
esa fue una de las palancas con las que se intentó 
alcanzar los presupuestos de Gaussianos de magni
tud-paper.

E N  P O CA S  PA L A B R A S

Cuántas iteraciones entre que la 
app resetea la visibilidad de to­
dos los splats a «casi invisible» 
— una especie de botón de re­
set para la opacidad. En nosotros 
deshabilitado (valor tan alto que 
nunca dispara) porque otros me­
canismos lo hacen innecesario. 
Solo habilitar para experimentos 
fieles al paper.
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T16 maxScreenSize

D E TA L L E S

Predeterminado: 0,0 (= deshabilitado) Rango: 0 
(off) o > 0 Definido en:

T É C N I C O

Tamaño máximo en espacio de pantalla (en píxeles 
proyectados) que un Gaussiano puede alcanzar an
tes de dividirse forzosamente. El valor está en 0 
(V48 probado y revertido) — la density control de 
RadianceKit usa en su lugar el umbral de escala 
en espacio mundo de la lógica dMean2D . Se queda 
en el catálogo de campos porque futuros experi
mentos con Mip-Splatting (T74–T76) o estrategias 
de splatting específicas de escena podrían benefi
ciarse. Habilitar (valor > 0, p. ej., 20) forzaría a los 
splats que han crecido mucho en pantalla a subdivi
dirse — relevante con superficies de pared grandes 
y suaves donde un único splat gigante ofrece muy 
poco detalle.

E N  P O CA S  PA L A B R A S

Límite de cuán grande puede lle­
gar a ser un splat en pantalla. 
En nosotros, off. Activarlo haría 
que los splats planos enormes 
(p. ej., en una pared) se rompie­
ran forzosamente en varios más 
pequeños. Déjalo off salvo que 
estés experimentando explícita­
mente con ello.
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Loss (T17–T20)

T17 ssimWeight

D E TA L L E S

Predeterminado: 0,2 (initializer + paper + .full ), 
0,05 (todos los ajustes preestablecidos MCMC) 
Rango: 0,0 – 1,0 Definido en:

T É C N I C O

Peso del término D-SSIM en la función de loss com
binada loss = (1 - λ) * L1 + λ * D-SSIM, 
donde λ = T17 . El default 0,2 del paper 3DGS es 
óptimo para la densificación clásica — V383 probó 
0,3 → 28,9 % peor, V373b confirmó 0,2 como sweet 
spot. Para MCMC se estableció independientemente 
en V521b/V534: 0,05 es óptimo porque MCMC, por 
su exploración estocástica, necesita un componente 
de señal L1 más fuerte — pesos SSIM más altos di
luirían las decisiones de relocalización. SSIM es sig
nificativamente más caro de calcular que L1 (venta
nas locales 11×11 sobre toda la imagen); Radiance
Kit usa una implementación acelerada por MPS que 
se mantiene por debajo de 1 ms por imagen 1080p. 
Los sweeps Q7 BayesOpt encontraron óptimos es
pecíficos de escena entre 0,05 ( .outdoorPreset : 
0,082) y 0,171 ( .indoorPreset ).

E N  P O CA S  PA L A B R A S

Lo importante que considera la 
app «las estructuras son simila­
res» frente a «cada píxel coinci­
de». 0,2 es el predeterminado y 
da una buena imagen. Más bajo = 
más preciso a nivel de píxel pero 
puede dar transiciones más sua­
ves. Más alto: estructuralmente 
más similar pero los detalles se 
suavizan. Deja que decidan los 
ajustes preestablecidos.
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T18 ssimWeightRefinement

D E TA L L E S

Predeterminado: 0,0 (= «sin cambio, mantener 
ssimWeight») Rango: 0 o 0 – 1,0 Definido en:

T É C N I C O

Valor SSIM opcional para la fase de refinamiento 
tras T2 densifyUntilIteration. V428 probó 0,2 → 
0,3 en refinamiento → 16 % peor loss (tanto L1 
como SSIM degradados); revertido, de ahí el default 
0,0. La hipótesis tras el campo era que tras la den
sificación — cuando ya no se crean nuevos Gaussia
nos — una mayor parte SSIM maximizaría la nitidez 
estructural. Empíricamente falso: subir el peso SSIM 
significa indirectamente bajar el peso L1, y L1 es la 
señal mucho más significativa en la fase final de 
refinamiento. El campo se mantiene disponible para 
experimentos futuros con perceptual loss (T60) o 
edge loss (T19), donde una composición de loss es
pecífica de refinamiento podría tener sentido.

E N  P O CA S  PA L A B R A S

Ajuste especial para la segun­
da fase de entrenamiento (refi­
namiento tras la duplicación de 
splats). En 0,0: la misma ponde­
ración SSIM que antes. Trastear 
no aporta empíricamente, así 
que off.

T19 edgeLossWeight

D E TA L L E S

Predeterminado: 0,0 (= deshabilitado) Rango: 0 o 
0,001 – 1,0 Definido en:

T É C N I C O

V437 loss experimental: peso de un loss L1 en 
dominio gradiente Sobel que compara directamente 
los bordes de imagen (Sobel ground-truth vs Sobel 
del render) por encima de L1+SSIM. Hipótesis: la 
información de borde es una piedra angular percep
tual de la calidad de imagen y un término explícito 
debería animar a los Gaussianos a acertar mejor los 
bordes. Resultados de prueba: peso 0,1 → 11 % peor 
loss, 0,01 → neutro para calidad pero 10 % más 
lento. La pasada Sobel cuesta un forward MPS extra 
sobre ground truth y render. De ahí que esté des
habilitado permanentemente. Caso de uso futuro: 
escenas con bordes artificiales duros (arquitectura, 
mobiliario, renderizados) podrían beneficiarse — los 
ajustes Scene Class de Q7 sin embargo no lo eligie
ron, escalaron en su lugar el peso SSIM.

E N  P O CA S  PA L A B R A S

Extra experimental que trata 
los bordes como especialmente 
importantes. Empíricamente no 
aporta nada. Sigue off.
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T20 skyMaskingEnabled

D E TA L L E S

Predeterminado: false (initializer y todos los ajus
tes preestablecidos) Rango: booleano Definido en:

T É C N I C O

Habilita el enmascaramiento de cielo. En 
cada imagen se enmascara la región 
de cielo mediante Apple Vision Framework 
(VNGenerateForegroundInstanceMaskRequest), y el 
loss en esa región se pone a cero. Razón: las esce
nas exteriores sufren a menudo de píxeles de cielo 
azul/gris/blanco que llevan a la app a colocar Gaus
sianos exactamente ahí — lo que se percibe como 
«floaters». Sin máscara de cielo, el loss en esa re
gión nunca sería cero, porque el cielo en la imagen 
varía ligeramente y la app sigue intentando recons
truirlo con splats. La máscara Vision se calcula 
una vez por cámara antes del entrenamiento y se 
mantiene en RAM. Típicamente se activa junto con 
T45 skyDomeEnabled  (lógica UI en la vista de Ajus

tes). Déjalo deshabilitado para escenas interiores 
o renderizados sintéticos — la máscara detectaría 
erróneamente techos o paredes como «cielo».

E N  P O CA S  PA L A B R A S

Activa un modo especial para 
capturas exteriores: el cielo se 
ignora durante el entrenamiento, 
así que la app no intenta recons­
truirlo con splats. Recomendado 
para cada escena exterior. Déjalo 
off para interiores o para rende­
rizados 3D de Blender.
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Progresión de grado SH (T21)

T21 shDegreeUpgradeIterations

D E TA L L E S

Predeterminado: [1_​000, 2_​000, 3_​000] (initia
lizer), [2_​000, 5_​000, 8_​000] ( .full , 
MCMC), [1_000, 2_000]  ( .preview  — gra
do 3 saltado) Rango: [Int] , cada valor en 
[0, maxIterations] , monótonamente creciente 

Definido en:

T É C N I C O

Iteraciones en las que el grado SH activo se sube 
0→1, 1→2, 2→3. Antes de la primera marca solo 
están activos los componentes DC (es decir, T5 
shDCLearningRate), después de la primera marca 
DC + 3 coeficientes de grado 1, después de la se
gunda marca + 5 coeficientes de grado 2, después 
de la tercera marca los 15 coeficientes. El consumo 
de memoria por Gaussiano crece por pasos en con
secuencia — 4 floats → 16 floats → 36 floats → 64 
floats. Los ajustes preestablecidos Quality retrasan 
los upgrades respecto a los defaults del initializer 
(V228) porque la geometría debería estabilizarse 
primero, antes de que los detalles de color con su 
frecuencia más alta se añadan encima. V384 probó 
[1K, 2K, 3K]  para .full  → 9,3 % peor — con

firma el retraso. .preview  se topa en grado 2, por
que el grado 3 no converge en 5 000 iteraciones y 
solo consume capacidad de optimizador. Q6 (T80–
T81) ofrece una lógica de currículum alternativa que 
sobrescribe esta lista de forma dinámica.

E N  P O CA S  PA L A B R A S

En qué puntos durante el entre­
namiento la app aprende que los 
colores pueden verse distintos 
desde distintos ángulos de visión 
(brillos, reflejos). Solo tarde — 
así primero la forma es correcta, 
después el color. Los valores en 
los ajustes preestablecidos están 
puestos para que esto funcione 
bien. No cambies nada salvo que 
sepas exactamente por qué.
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Rendimiento (T22–T25)

T22 trainingRenderScale

D E TA L L E S

Predeterminado: 1,0 (initializer, .full , MCMC, 
Scene-Class), 0,5 ( .preview ), 0,25 ( .quickTest ) 
Rango: 0,05 – 2,0 (típicamente 0,25, 0,5, 1,0) Defi­
nido en:

T É C N I C O

Resolución de renderizado durante el entrenamien
to relativa a la resolución original de las imágenes 
de entrenamiento. En 0,5 cada imagen se reduce 
al 50 % de ancho × 50 % de alto (es decir, 
25 % de los píxeles) y el renderizado Gaussiano 
ocurre a esa resolución más baja. Reduce cuadráti
camente tanto memoria como cómputo. Importante: 
T11 densifyGradThreshold tiene que coincidir con 
la resolución elegida — las magnitudes de gradiente 
escalan con 1/resolución², por lo que .quickTest  
(0,25×) tiene un umbral mucho más alto (4e-6) que 
.full  (1,0×, 1,1e-6). RadianceKit avisa con imáge

nes muy grandes y ajusta automáticamente — 3 MP 
de resolución objetivo. Con imágenes de entrada 4K 
extremas, 0,5 o incluso 0,25 tendría sentido; en otro 
caso, cualquier Mac correrá solo en compactación 
CPU.

E N  P O CA S  PA L A B R A S

Lo grandes que son las imágenes 
durante el entrenamiento. 1,0 = 
original, 0,5 = la mitad. Mitad 
= cuatro veces más rápido pero 
faltan los detalles más finos. Los 
ajustes preestablecidos eligen el 
valor correcto; con imágenes de 
entrada extremadamente gran­
des (más de 12 megapíxeles) la 
app baja automáticamente.
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T23 resolutionWarmupScale

D E TA L L E S

Predeterminado: 0,0 (= deshabilitado) Rango: 0 o 
0,1 – Definido en:

T É C N I C O

Optimización V133: entrena la fase de densifica
ción (iter 0 a T2 ) a una resolución más baja 
que la fase de refinamiento. V308 lo apagó de 
nuevo para .full  porque con T22 = 1,0  y cosi
ne annealing, el ahorro de tiempo era marginal y 
la calidad sufría ligeramente. Se queda en el catá
logo de campos porque podría volver a ser útil 
con entradas 4K y runs largos — el currículum Q6 
(T80) recogió una lógica similar, aunque ahí está 
atada al schedule de LR. Si está habilitado y T80 
curriculumResolutionRamp también es true, Q6 ga
na y sobrescribe este valor.

E N  P O CA S  PA L A B R A S

Función especial: en la primera 
mitad del entrenamiento apren­
de de imágenes más pequeñas, 
en la segunda de grandes. Ahorra 
tiempo. Off porque la variante Q6 
más nueva lo resuelve mejor.

T24 tileSize

D E TA L L E S

Predeterminado: 16 Rango: 8, 16, 32 Definido en:

T É C N I C O

Tamaño de los tiles de rasterización en píxeles. El 
renderizado Gaussian Splatting es basado en tiles: 
la imagen se divide en tiles de 16×16 píxeles, cada 
tile recopila los Gaussianos relevantes para él, los 
ordena por profundidad y los mezcla. 16 es el 
estándar que usan prácticamente todas las imple
mentaciones 3DGS y está codificado en duro en 
los kernels Metal de RadianceKit; cambiar este valor 
requeriría recompilación del shader y no es efectivo 
en el estado actual. Se queda como campo por si 
una versión futura del engine soporta tamaño de tile 
dinámico.

E N  P O CA S  PA L A B R A S

Parámetro de render interno. 
Predeterminado 16, no cambiar.
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T25 throttleDelayMs

D E TA L L E S

Predeterminado: 0 (initializer, .full , MCMC, 
Scene-Class), 0 ( .preview ) Rango: 0 – 100 Defi­
nido en:

T É C N I C O

Retardo artificial entre iteraciones de entrenamiento 
en milisegundos. 0 = a toda velocidad (predeter
minado). Valores más altos hacen el Mac más «uti
lizable» durante el entrenamiento, al dar a GPU/
CPU pausas regulares — la responsividad de otras 
apps mejora, pero el tiempo de entrenamiento cre
ce linealmente con el retardo. Valores típicos: 1–2 
ms («throttling ligero», +5 % de tiempo de entre
namiento, el Mac se siente más responsivo), 5 
ms («medio», +15 %), 10+ ms («eco», potencial
mente el doble de tiempo de entrenamiento). Se 
ofrece en el Inspector bajo «Performance» pero 
no en la vista predeterminada — véase el backlog 
dev_ux-backlog.md  que sugiere quitarlo de la Vista 

Experto porque, malinterpretado, extiende dramáti
camente el tiempo de entrenamiento.

E N  P O CA S  PA L A B R A S

Cuántos milisegundos de pausa 
hace la app entre pasos de en­
trenamiento. 0 = sin pausa, tan 
rápido como sea posible. Valores 
más altos hacen el Mac más uti­
lizable durante el entrenamiento 
— pero el entrenamiento tam­
bién dura más. En un M3 Ultra o 
Mac Studio puedes dejar esto en 
0; en un MacBook Air 2 o 5 sería 
un buen valor.
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Diagnóstico y preparación de la nube de puntos (T26–T30)

T26 depthDistortionWeight

D E TA L L E S

Predeterminado: 0,0 (= deshabilitado) Rango: 0 o 
0,0001 – 0,05 Definido en:

T É C N I C O

V366 experimental: peso de un loss de regulari
zación de distorsión de profundidad. Penaliza Gaus
sianos que, a lo largo de un rayo de render, están 
apilados en profundidad pero conceptualmente per
tenecen a la misma superficie — esto anima a distri
buciones de profundidad concentradas y reduce los 
floaters. Pruebas: 0,01 → 4,5 % peor, 0,001 → 8,1 
% peor. La ventaja teórica — mejorar la consistencia 
multi-vista — no se ve en el loss L1, porque la hipó
tesis asume implícitamente que la geometría de SfM 
es correcta y los Gaussianos solo necesitan «apilar
se». En la práctica, la nube de puntos SfM suele 
ser el componente más débil, no el apilado. Se man
tiene disponible para datasets multi-vista con poses 
particularmente limpias (sintéticos, Mip-NeRF 360 
con ground truth).

E N  P O CA S  PA L A B R A S

Función experimental para evitar 
múltiples splats alineados en el 
mismo sitio. No habilitado por­
que las pruebas no mostraron 
beneficio.
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T27 singleViewOverfit

D E TA L L E S

Predeterminado: false Rango: booleano Definido 
en:

T É C N I C O

Flag diagnóstico: cuando es true, cada iteración de 
entrenamiento debe usar el índice de cámara 0 en 
lugar de uno aleatorio del pool de cámaras. Razón: 
si el modelo no es capaz ni siquiera de hacer overfit 
a una sola vista (es decir, el loss sobre la vista 0 no 
va a cero ni siquiera tras 10 000 iteraciones), hay un 
bug fundamental en el forward/backward pass. Este 
switch se usó intensivamente durante el desarrollo 
de los shaders Metal y los kernels del rasterizador 
diferenciable — fase V42–V47. Hoy solo disponible 
como chequeo de sanidad si alguien ha modificado 
código del backend y quiere hacer un test de regre
sión. Vía CLI con --single-view .

E N  P O CA S  PA L A B R A S

Modo de prueba para desarrolla­
dores. Pueden usarlo para com­
probar si la app puede siquiera 
aprender de UNA sola imagen. 
Irrelevante para usuarios norma­
les, déjalo siempre off.

T28 maxCameras

D E TA L L E S

Predeterminado: 0 (= «usar todas las cámaras») 
Rango: 0 o 1 – N Definido en:

T É C N I C O

Límite diagnóstico de V43: entrenar solo con las pri
meras N cámaras, ignorar todas las demás. Razón 
original: probar la hipótesis de que demasiadas cá
maras crean conflictos de gradiente (demasiadas 
señales de loss conflictivas para el mismo Gaus
siano). Resultado de prueba: sin ventaja sistemática 
del limitado artificial — más frames aportan prác
ticamente siempre más calidad. Se queda como 
flag CLI ( --max-cameras N ) para experimentos diri
gidos, p. ej., «¿funciona el entrenamiento en las 
primeras 100 imágenes de un vuelo de dron de 1 
500?». No expuesto en la UI.

E N  P O CA S  PA L A B R A S

Campo diagnóstico para desa­
rrolladores — usa solo las prime­
ras N imágenes, ignora el resto. 
Usuario normal no necesita esto, 
valor en 0 = todas las imáge­
nes. Más imágenes = mejor re­
sultado (véase feedback_​more-
frames-better.md).
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T29 maxInitialPoints

D E TA L L E S

Predeterminado: 0 (= «usar todos los puntos 
SfM») Rango: 0 o 1 000 – 200 000+ Definido en:

T É C N I C O

Red de seguridad V54: limita el número de puntos 
iniciales SfM con los que comienza el entrenamien
to. Las reconstrucciones COLMAP densas pueden 
producir > 60 000 puntos, lo que con escalas inicia
les grandes lleva a un solapamiento de 200–300 
Gaussianos por píxel — esto crea un «campo de 
niebla» en el que el entrenamiento no converge. 
El submuestreo a ~16 000 puntos (lógica de hard-
-cap en el motor de entrenamiento) trae la densidad 
inicial al nivel usado por el 3DGS de referencia, y 
reduce dramáticamente el solapamiento. Se fija au
tomáticamente con SfMs muy densos; vía CLI con 
--max-points N .

E N  P O CA S  PA L A B R A S

Cuántos puntos de inicio de 
la reconstrucción de cámara se 
usan. Con reconstrucciones muy 
densas (más de 60 000) la app 
limita automáticamente a 16 000 
— en otro caso hay demasiada 
niebla al principio. No tienes que 
fijar esto; la app se encarga.
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T30 cameraClusterOutlierMultiplier

D E TA L L E S

Predeterminado: 10,0 (todos los ajustes preesta
blecidos — nunca sobrescrito) Rango: 1,0 – 100,0 
Definido en:

T É C N I C O

Multiplicador para el filtro de outliers del cluster de 
cámaras, introducido en la Fase 3.10 A.1. Antes del 
entrenamiento, el motor de entrenamiento calcula 
el centroide de todas las posiciones de cámara y 
la distancia máxima de cualquier cámara al centroi
de. Los puntos SfM cuya distancia al centroide su
pera multiplier × maxCameraDistance se descartan 
como outliers. El default 10× preserva el comporta
miento previo a la Fase 3.10. Un bug sutil: SfM más 
apretado (cámaras más juntas) → más pequeña → 
umbral más pequeño → más puntos se descartan 
como outliers. SfM más holgado → umbral más 
grande → menos puntos descartados. Esta es una 
de las causas de la anti-correlación funnel-vs-trai
ning de la Fase 3.9: un mejor SfM puede llevar 
aguas abajo a peor entrenamiento porque se matan 
demasiados puntos iniciales. El campo está disponi
ble como override CLI (--camera-cluster-outlier-
multiplier) para los sweeps A.3; no expuesto en la 
UI. Los valores por debajo de 5 suelen ser demasia
do restrictivos, por encima de 20 inefectivos.

E N  P O CA S  PA L A B R A S

Filtro especial que descarta pun­
tos de la reconstrucción que es­
tán lejos de la nube de cámaras. 
10 = la app es generosa, man­
tiene casi todo. Aumentar puede 
tener sentido cuando puntos le­
janos (montañas a lo lejos) pare­
cen manchas flotantes en la ima­
gen. Bajar solo en emergencias 
— perderás detalle a la distancia.
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Regularización (T31–T37)

T31 coarseToFineBlurRadius

D E TA L L E S

Predeterminado: 0 (= deshabilitado) Rango: 0 o 1 
– 10 Definido en:

T É C N I C O

V369 experimental: radio de box blur aplicado al 
inicio de la fase de densificación a la imagen ground 
truth, reducido linealmente a 0 al final de la densi
ficación ( T2 ). Hipótesis: el entrenamiento coarse-
-to-fine — primero aprender estructuras gruesas, 
después detalles — debería dar geometría más es
table. Pruebas: r=3 → 9,6 % peor, r=1 → 5,1 % peor. 
Razón del fallo: la densificación decide en base a 
gradientes en dominio de imagen, y el blur reduce 
exactamente las señales importantes para «hay que 
clonar aquí». Se queda en el catálogo de campos 
para pruebas futuras con un esquema distinto de 
density control.

E N  P O CA S  PA L A B R A S

Modo experimental «primero 
grueso, después detalle». No 
aportó nada, sigue off.

T32 scaleRegWeight

D E TA L L E S

Predeterminado: 0,0 (= deshabilitado) Rango: 0 o 
0,0001 – 0,05 Definido en:

T É C N I C O

V370 experimental: regularización L1 sobre escala 
en espacio mundo. Penaliza Gaussianos que crecen 
demasiado — evita «mega splats» que cubren su
perficies enteras de pared con un solo Gaussiano. 
Pruebas: 0,01 → 200 % peor loss (2 M Gaussianos, 
explosión total), 0,001 → 214 % peor. Razón: la 
regularización de escala entra en conflicto con la 
density control — escalas más pequeñas significa 
que se necesitan más Gaussianos, así que la den
sity control divide más a menudo, lo que a su vez 
significa más trabajo de gradiente. Deshabilitado, 
pero documentado para experimentos Mip-Splatting 
(T74): en ese contexto un límite inferior de escala 
podría tener sentido.

E N  P O CA S  PA L A B R A S

Regularización que fuerza a los 
splats a quedarse pequeños. Dis­
paró explosiones de splats en 
pruebas (millones de splats). No 
habilitar.
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T33 anisotropyRegWeight

D E TA L L E S

Predeterminado: 0,0 (= deshabilitado) Rango: 0 o 
0,0001 – 0,05 Definido en:

T É C N I C O

V445 experimental: penalización sobre el cociente 
max(scale)/min(scale), pensada para evitar Gaus
sianos «aguja» extremadamente alargados que se 
perciben como floaters. Pruebas: 0,01 → 69 % peor, 
0,001 → 15 % peor. Razón: la regularización fuerza 
a los splats a forma «redonda», lo que sobre una 
superficie plana (pared, mesa, suelo) es exacta
mente incorrecto — ahí un Gaussiano plano y ancho 
es más eficiente que uno esférico. Deshabilitado. 
V549f ofreció con T34 scaleRatioPruneThreshold 
un enfoque alternativo más dirigido, que también se 
revirtió.

E N  P O CA S  PA L A B R A S

Regularización que penaliza 
splats muy largos y delgados. 
Suena sensato pero en pruebas 
fue peor. Off.

T34 scaleRatioPruneThreshold

D E TA L L E S

Predeterminado: 0,0 (= deshabilitado) Rango: 0 o 
5,0 – 100,0 (típicamente 10,0 – 30,0) Definido en:

T É C N I C O

Pruning post-training experimental que elimina cada 
Gaussiano cuyo ratio max(scale)/min(scale) supera 
el umbral lineal aquí fijado. Apunta a floaters «aguja/
disco» extremadamente alargados que no se pue
den eliminar solo con regularización. En pruebas, 
el pruning eliminó floaters como se esperaba, pero 
también splats planos útiles en paredes y suelos — 
la imagen se volvió más agujereada. De ahí off por 
defecto; el flag CLI (--scale-ratio-prune N) sigue 
para experimentos dirigidos. Valores recomendados 
si quieres probar: 30 (muy conservador, elimina solo 
outliers extremos), 10 (agresivo, cuesta detalle).

E N  P O CA S  PA L A B R A S

Intento de filtrar splats muy alar­
gados tras el entrenamiento. Fue 
net-negativo en pruebas — floa­
ters eliminados pero también de­
talle. Off.
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T35 opacityRegWeight

D E TA L L E S

Predeterminado: 0,0 (= deshabilitado) Rango: 0 o 
0,0001 – 0,05 Definido en:

T É C N I C O

V446 experimental: penalización de cross-entropy 
binaria que tira de la opacidad hacia 0 o 1 (es 
decir, lejos de «semi-transparente»). Hipótesis: una 
distribución de opacidad más nítida mejoraría la cla
ridad de imagen. Probado combinado con T33 → 
la regularización cuesta calidad, ambos deshabilita
dos. Deshabilitado. Atención: en la beta 1.4.3 apare
ció un bug que tenía exactamente este campo con 
un valor default cambiado (initializer = 0,01), lo que 
llevó a la extinción masiva del número de Gaussia
nos (460 K → 5 en una iteración). Desde 1.4.4 fijado 
en duro a 0,0 como default.

E N  P O CA S  PA L A B R A S

Regularización que hace los 
splats o totalmente transparen­
tes o totalmente sólidos. No 
aporta nada, puede incluso vol­
verse peligroso (extinción masi­
va por bug de 1.4.3). Déjalo en 0.
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T36 opacityDecayFactor

D E TA L L E S

Predeterminado: 0,0 (initializer = deshabilitado), 
0,9995 ( .full , .classicBalanced  — estándar 
HTGS) Rango: 0 (off) o 0,95 – 1,0 Definido en:

T É C N I C O

Implementación V546 del esquema HTGS (Hierar
chical Time-Gating, Eurographics 2025): cada T37 
opacityDecayInterval iteraciones la opacidad sig
moide de cada Gaussiano se multiplica por este 
factor. 0,9995 × 100 aplicaciones dan ~95 % re
sidual por fase de densificación — una presión 
a la baja ligera pero constante sobre todas las 
opacidades, que deja caer de forma fiable a los 
Gaussianos que aportan poco por debajo del T14 
pruneOpacityThreshold. El resultado: 14 % mejor 
loss L1 en Horse Full (3-trial avg V546) vs V438 
sin decay. Activo solo durante la fase de den
sificación (hasta T2 ), después el entrenamiento 
sigue sin decay, así que las opacidades estable
cidas durante refinamiento se mantienen estables. 
No se usa bajo MCMC (MCMC tiene sus propios 
mecanismos vía T67 mcmcRelocationInterval + T68 
mcmcDeadOpacityThreshold).

E N  P O CA S  PA L A B R A S

Un «fade suave» de todos los 
splats a lo largo del tiempo 
de entrenamiento. Hace transpa­
rentes más rápido a los splats 
inactivos, así desaparecen du­
rante la limpieza. Fue la palanca 
de calidad más importante de la 
actualización V546: 14 % mejor. 
Incorporado al ajuste preestable­
cido Quality. No se recomienda ni 
siquiera trastear porque está ba­
lanceado con precisión.

T37 opacityDecayInterval

D E TA L L E S

Predeterminado: 50 Rango: 10 – 500 Definido en:

T É C N I C O

Intervalo de iteraciones al que se aplica T36 
opacityDecayFactor. Default del paper HTGS 50, 
dejado así en .full . Intervalos largos (>200) 
cancelan parcialmente el efecto porque entre dos 
aplicaciones ocurren suficientes actualizaciones de 
gradiente como para que la opacidad vuelva a subir. 
Intervalos más cortos (<20) hacen el decay dema
siado agresivo. Activo solo en la fase de densifica
ción.

E N  P O CA S  PA L A B R A S

Cada cuánto se aplica el «fade». 
50 = cada 50 iteraciones un pe­
queño paso de fade. Encaja.

143 / 242



R A D I A N C E K I T Capítulo 6 — Configuración del entrenamiento

Refinamiento (T38–T44)

T38 gradientAccumulationSteps

D E TA L L E S

Predeterminado: 1 (= «una vista por paso Adam») 
Rango: 1 – 8 Definido en:

T É C N I C O

Función V424: número de vistas cuyos gradientes 
se acumulan antes de que corra una actualización 
de Adam. Con > 1  la app corre por una vía back
ward project «unfused» separada que suma los 
gradientes a un buffer separado; la aplicación final 
escala por 1/N para mantener la magnitud constan
te. V424 probó 2-vistas → neutro para calidad pero 
10 % más lento (porque unfused es más caro que 
fused). Revertido para .full  pero usado delibera
damente para MCMC — .fullMCMC  corre con, pero 
los tests V544a mostraron que con el gap de cali
dad respecto a Classic se encoge a 5 % (en lugar 
de 11 %). En el default initializer 1, en el preset 
actual 1, queda como flag CLI ( --accum-steps N ).

E N  P O CA S  PA L A B R A S

Cuántas imágenes considera la 
app antes de ajustar los splats. 1 
= cada imagen por separado. Más 
alto = mira varias imágenes a la 
vez y después aplica una media. 
No aporta nada en el caso están­
dar; bajo MCMC, 2 puede ayudar 
un poco.
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T39 testViewIndices

D E TA L L E S

Predeterminado: []  (= vacío, todas las vistas se 
usan para entrenamiento) Rango: Set<Int> , sub
conjunto arbitrario de índices de cámara Definido 
en:

T É C N I C O

Función V546: conjunto de índices de cámara 
que NO se usan para entrenamiento sino que se 
guardan como holdout para evaluación PSNR/SSIM/
LPIPS. Se fija automáticamente cuando el flag CLI 
--benchmark  está activo: entonces cada 8ª vista 

empezando por el índice 0 (estándar LLFF, idénti
co a las convenciones Mip-NeRF 360 y del paper 
3DGS). Sin benchmark vacío — el entrenamiento 
usa todas las vistas. Atención: fijar manualmente 
este campo sin entender los índices puede inutilizar 
el benchmark (p. ej., cuando todos los índices están 
por encima de N mientras hay solo N-50 vistas → 
sin holdouts → sin evaluación). Cuando exportas tu 
propio ajuste preestablecido, testViewIndices no se 
persiste porque es dependiente de la escena y en 
otro caso dejaría valores sin sentido entre datasets 
distintos.

E N  P O CA S  PA L A B R A S

Qué imágenes durante el entre­
namiento se «dejan fuera» para 
usarlas después para medición 
de calidad. No fijas esto tú mis­
mo; el flag --benchmark  lo 
hace automáticamente (cada oc­
tava imagen es test). Si fijas tus 
propios índices: peligroso, puede 
corromper el benchmark.

145 / 242



R A D I A N C E K I T Capítulo 6 — Configuración del entrenamiento

T40 refinementPruneInterval

D E TA L L E S

Predeterminado: 0 (= deshabilitado) Rango: 0 o 
100 – 5 000 Definido en:

T É C N I C O

Función V425: cada N iteraciones durante la fase de 
refinamiento (tras T2 ) corre una pasada de prune 
adicional que elimina Gaussianos con sigmoid(opa
city) < T41 refinementPruneOpacityThreshold. Ra
zón: durante la densificación hay llamadas regulares 
de density control, después ya no — pero los Gaus
sianos cuya opacidad sigue cayendo se quedan en 
el buffer. V425 probado y revertido: el pruning adi
cional correlacionaba con V426 (Densificación de 
Dos Fases, que también acabó en un cascade failu
re de 0 Gaussianos). Deshabilitado. Flag CLI dispo
nible para experimentos; si está habilitado, 1 000 o 
2 000 son valores sensatos.

E N  P O CA S  PA L A B R A S

Limpieza adicional durante la fa­
se de refinamiento. No aporta 
nada, sigue off.

T41 refinementPruneOpacityThreshold

D E TA L L E S

Predeterminado: 0,0 (= «usar T14 ») Rango: 0 o 
0,001 – 0,1 Definido en:

T É C N I C O

V425b: umbral de opacidad separado para el pru
ning de refinamiento. Tras la densificación, la mayo
ría de los Gaussianos han alcanzado una opacidad 
claramente más alta (> 0,001), por lo que el default 
T14 pruneOpacityThreshold sería demasiado laxo. 
Si T40  está activo, este campo determina su pro
pio umbral. En 0,0 se usa T14  como antes. Solo 
relevante si T40 > 0.

E N  P O CA S  PA L A B R A S

Umbral para la limpieza adicio­
nal de refinamiento (véase T40). 
Ambos campos inactivos, así que 
irrelevante.
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T42 midTrainingCompactificationIterations

D E TA L L E S

Predeterminado: []  (= deshabilitado) Ran­
go: [Int] , valores en (densifyUntilIteration, 
maxIterations) Definido en:

T É C N I C O

Función V549: puntos de iteración explícitos duran
te la fase de refinamiento en los que corre una pa
sada de compactificación (elimina sigmoid(opacity) 
< 0,01 + Gaussianos de escala outlier, misma lógi
ca que T56 postTrainingCompactification). Razón: 
las fases de refinamiento largas pueden mostrar 
acumulación de confeti/ floaters, cuyo SH luego 
sobreajusta a artefactos específicos de vista. Confi
guración típica si está habilitado: [10000, 20000, 
30000] para 40K Classic. PERO: los tests A/B V549 
sobre el dataset Family mostraron peor L1 en todas 
las configuraciones: [10K,20K,30K]@0.01  → −48 % 
count pero +36 % L1; [20K,30K]@0.005  → −44 % 
count pero +45 % L1; [20K,30K]@0.001  → −17 % 
count pero +87 % L1. De ahí deshabilitado. Flag CLI 
--mid-compact "10000,20000" disponible, si prefie
res el trade-off visual de floaters (menos confeti en 
la vista) sobre la regresión de loss.

E N  P O CA S  PA L A B R A S

Acciones de limpieza a mitad 
del entrenamiento. En pruebas, 
la limpieza empeoró el resulta­
do final (sí, menos floaters, pero 
también menos detalle). Off, se 
puede habilitar vía CLI, por si los 
floaters te molestan más que una 
imagen un poco más blanda.
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T43 frustumCullEnabled

D E TA L L E S

Predeterminado: false Rango: booleano Definido 
en:

T É C N I C O

Función V549b: tras el entrenamiento, todos los 
Gaussianos fuera de la unión de todos los frus
tums de cámara de entrenamiento se eliminan. Esos 
Gaussianos nunca estuvieron restringidos por la se
ñal de loss y son siempre floaters. Particularmente 
efectivo para escenas en las que la novel view está 
detrás o al lado del recorrido de la cámara (p. ej., 
detrás de un vuelo de dron lineal) — los floaters allí 
nunca son visibles durante el entrenamiento pero sí 
más tarde al moverse en el visor 3D. A/B V549b 
en vuelos de dron mostró resultados positivos, de 
ahí disponible como opt-in. Default false porque 
para capturas de objeto con cobertura orbital com
pleta la unión de frustums abarca toda la escena 
y la función no elimina nada — se ofrece en Set
tings bajo «Floater Reduction» y también se prueba 
implícitamente en el preset Q9 Outdoor vía T44 
frustumCullExpansion (Q7 BayesOpt no lo habilitó, 
porque la cúpula de cielo outdoor resuelve mejor el 
mismo problema).

E N  P O CA S  PA L A B R A S

Filtro especial para vuelos de 
dron o capturas lineales: tras el 
entrenamiento, los splats que no 
fueron «vistos» por ninguna cá­
mara se eliminan. Opcional, acti­
vable en Ajustes. Para capturas 
simples de objeto, innecesario.

T44 frustumCullExpansion

D E TA L L E S

Predeterminado: 1,1 Rango: 1,0 – 2,0 Definido en:

T É C N I C O

Margen NDC para T43 frustumCullEnabled. 1,0 cor
taría exactamente en el borde de imagen, lo que 
recortaría splats tambaleantes cerca del borde de 
manera demasiado agresiva. 1,1 = 10 % de padding 
más allá del encuadre exacto de la cámara — da 
algo de tolerancia para píxeles de borde que aún 
podrían ser visibles en una novel view ligeramente 
desplazada. Valores > 1,2 hacen el cull práctica
mente inefectivo porque el frustum expandido abar
ca demasiado espacio.

E N  P O CA S  PA L A B R A S

Lo estrictamente que recorta el 
filtro mencionado arriba. 1,1 = un 
poco de margen de seguridad 
respecto al borde de imagen. De­
ja el valor.
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Sky Dome (T45–T48)

T45 skyDomeEnabled

D E TA L L E S

Predeterminado: false (initializer + todos los ajus
tes preestablecidos excepto P9 Outdoor) Rango: 
booleano Definido en:

T É C N I C O

Función V549e: antes de iniciar el entrenamiento 
se genera una nube de puntos esférica (esfera Fibo
nacci con T46  puntos de muestra), se coloca a 
un radio de T47 skyDomeRadiusMultiplier × scene_​
extent alrededor del centro de la escena y se inicia
liza con los colores de los píxeles enmascarados 
como cielo de todas las cámaras de entrenamiento 
(véase T20 skyMaskingEnabled). Estos Gaussianos 
de sky dome se insertan al inicio del buffer Gaus
siano y durante el entrenamiento están «congela
dos» (gradientes position/scale/rotation = 0, solo 
SH y opacidad permanecen optimizables). Efecto: 
en lugar de áreas negras de «confeti» a la distan
cia, el usuario ve un cielo real en novel views. El 
MVP V549e funciona muy bien en escenas de dron 
y paisaje; en el preset P9 Outdoor activado por de
fecto. Déjalo off para escenas interiores — la esfera 
colgaría inútil fuera de la habitación.

E N  P O CA S  PA L A B R A S

Activa una «cúpula de cielo» ar­
tificial alrededor de la escena. 
Hace las capturas exteriores mu­
cho más bonitas: en lugar de 
manchas negras en el borde de 
imagen, la app muestra el cielo 
real. Obligatorio para vuelos de 
dron y paisajes, inútil para inte­
riores.
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T46 skyDomeSampleCount

D E TA L L E S

Predeterminado: 5 000 Rango: 1 000 – 50 000 
(típico 2 000 – 10 000) Definido en:

T É C N I C O

Número de puntos de muestra esfera Fibonacci so
bre la esfera de la cúpula de cielo. Valores más altos 
→ cúpula más densa (mejor a resoluciones grandes 
y mucho cielo visible), pero mayor consumo de me
moria. 5 000 es el sweet spot para renderizados 4K; 
a resoluciones más bajas, 2 000–3 000 bastan. Los 
puntos se inicializan por distancia coseno a cada 
vector de vista de cámara de entrenamiento con los 
correspondientes píxeles enmascarados como cielo 
— los puntos de muestra cuyo cono de vista no es 
visto por ninguna cámara mantienen un valor inicial 
de opacidad bajo, pero permanecen sin cambios 
durante el entrenamiento (congelados).

E N  P O CA S  PA L A B R A S

Lo denso que es el cielo artificial. 
5 000 puntos suelen bastar. Más 
= transición más suave desde la 
distancia, pero cuesta algo de 
memoria.

T47 skyDomeRadiusMultiplier

D E TA L L E S

Predeterminado: 30,0 (initializer + la mayoría de 
ajustes preestablecidos), 59,0 (P9 Outdoor, óptimo 
Q7 BayesOpt) Rango: 5,0 – 200,0 Definido en:

T É C N I C O

Radio de la esfera de la cúpula de cielo relativo a 
la extensión de la escena (= distancia media entre 
posiciones de cámara). 30 = la esfera tiene 30× el 
diámetro de la nube de cámaras. Demasiado peque
ña (< 5) → la cúpula interfiere con la propia escena 
(p. ej., un splat de cúpula aterriza en primer plano); 
demasiado grande (> 100) → pérdida de precisión 
float32 en las posiciones de cúpula, lo que dispara 
fallos de render a la distancia. Q7 BayesOpt en 
Bicycle (Mip-NeRF 360) encontró 59,0 como óptimo 
específico de escena para outdoor — esto sugiere 
que el default 30,0 es demasiado pequeño para pai
sajes profundos y que los píxeles de cúpula renderi
zan visiblemente como una «pared» en regiones de 
borde de imagen.

E N  P O CA S  PA L A B R A S

Lo lejos que debe estar la cúpula 
de cielo artificial. 30 = bastante 
lejos. Con grandes paisajes, 50–
60 es mejor (el preset Outdoor lo 
hace automáticamente). Dema­
siado pequeño sería como tener 
manchas justo delante de la len­
te.
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T48 frozenGaussianCount

D E TA L L E S

Predeterminado: 0 (= sin Gaussianos congelados) 
Rango: 0 o 1 – T46  Definido en:

T É C N I C O

Número de Gaussianos al inicio del buffer cuyos 
gradientes position/scale/rotation se ponen a cero 
en el optimizador — permanecen espacialmente rí
gidos durante todo el entrenamiento. La density 
control no puede clonarlos, dividirlos ni podarlos. 
Usado para la inyección de cúpula de cielo (véase 
T45 ): cuando la cúpula está on, este campo se 

fija automáticamente a T46 skyDomeSampleCount. La 
fijación manual es posible (p. ej., para congelar una 
nube de puntos pre-colocada desde un escaneo 
LiDAR), pero no es directamente accesible en la UI. 
Importante: los primeros N Gaussianos en el buffer 
son siempre los congelados — el orden en el buffer 
decide, no un índice explícito.

E N  P O CA S  PA L A B R A S

Cuántos splats al principio están 
fijos y no pueden moverse. Se 
fija automáticamente al número 
de la cúpula de cielo cuando está 
activa. No necesitas tocarlo tú 
mismo.

Adam + schedule de LR (T49–T55)

T49 adamResetIteration

D E TA L L E S

Predeterminado: 0 (= deshabilitado) Rango: 0 o 
100 – Definido en:

T É C N I C O

Función V430: iteración en la que los acumuladores 
de momentum (m1, m2) del optimizador Adam se 
resetean a cero. La corrección de sesgo posterior 
corre con (iter - adamResetIteration) en lugar 
de iter . V430 probó reset en 5 000 (tras el fin 
de densificación) → loss 12,8 % peor. Razón: el mo
mentum de Adam que se acumuló durante la densi
ficación lleva información sobre las magnitudes de 
gradiente típicas y acelera la fase de refinamiento. 
Tirarlo cuesta las primeras ~500 iteraciones de refi
namiento en convergencia. Deshabilitado. Se queda 
como flag CLI para experimentos de investigación.

E N  P O CA S  PA L A B R A S

Botón de reset para la «me­
moria» interna del optimizador 
Adam. Hizo daño en pruebas, si­
gue off.
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T50 positionLRScheduleEndIteration

D E TA L L E S

Predeterminado: 0 (initializer = «usar maxI
terations»), 20 000 ( .full  — cosine ter
mina en 20K aunque maxIter=35K), 30 000 
( .fullClassicPaper ) Rango: 0 o 1 000 – Definido 
en:

T É C N I C O

Función V431: iteración en la que la curva cosine 
annealing para la LR de posición alcanza su mínimo. 
Si 0, es idéntico a T1 maxIterations . Si > 0, el 
schedule corre hasta este valor y se mantiene cons
tante en T4
positionLearningRateFinal después. Esto permite 
una «fase de refinamiento extendida» con learning 
rate mínima pero constante — refina posiciones 
despacio sin un nuevo decay. .full  lo hace (el 
schedule termina en 20K, el entrenamiento corre 
hasta 35K), V434c/V434d confirmaron: 15K y 25K 
ambos por igual, 20K marginalmente óptimo. Usado 
junto con T51  para modificar también las LRs no-
-posición en la fase extendida.

E N  P O CA S  PA L A B R A S

Cuándo la app deja de bajar más 
la learning rate de posición. Si 
es menor que la iteración máxi­
ma, el resto corre con una mini-
-tasa constante — esto refina 
muy despacio pero muy estable. 
Incorporado en el ajuste prees­
tablecido Quality, no necesitas 
trastear.

T51 extendedPhaseLRDecay

D E TA L L E S

Predeterminado: 0,0 (= deshabilitado, LRs cons
tantes) Rango: 0 o 0,01 – 1,0 Definido en:

T É C N I C O

Función V433: multiplicador mínimo para las LRs 
no-posición (escala, rotación, opacidad, SH) en la 
«fase extendida» — es decir, tras alcanzar T50  y 
la LR de posición ya en T4 . Si 0,1, scale/rotation/
opacity/SH se decaen ellas mismas en cosine de 1,0 
(= su LR estándar) a 0,1× de su estándar. Si 0,0 (de
fault), permanecen constantes. V457 probó decay 
completo (0,0, es decir, decay a cero) contra sin de
cay y encontró: avg 0,0400 (2 runs), el mismo loss 
que V438 sin decay. Comportamiento más limpio 
con decay pero no medible mejor. De ahí deshabili
tado. Se queda en la CLI como --nonpos-lr-scale 
F.

E N  P O CA S  PA L A B R A S

En la fase final de refinamien­
to, hacer también más pequeñas 
las learning rates de color y for­
ma. Hace el entrenamiento «más 
estable» pero empíricamente no 
mejor. Off.
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T52 adaptiveDensifyThreshold

D E TA L L E S

Predeterminado: false Rango: booleano Definido 
en:

T É C N I C O

V440 experimental: cuando es true, la app calcula 
en cada paso de densificación el p98 de la distri
bución actual de gradientes y lo usa como umbral 
dinámico (clamped a al menos 0,5× del valor confi
gurado de T11  para que no derive demasiado). 
Hipótesis: la adaptación automática a la fase actual 
de la escena haría la density control más robusta 
— p. ej., poda más estricta al principio, más laxa 
después, o viceversa. V440 probado y revertido: 
caída catastrófica a 63 K Gaussianos (pruning masi
vo, porque el p98 en las primeras iteraciones es 
extremadamente alto y después casi nada supera 
el umbral). El umbral fijo está ya bien calibrado, el 
ajuste dinámico hace más daño que bien. Q5 (T77) 
ofrece una lógica adaptativa alternativa vía mediana 
rodante que evita el problema.

E N  P O CA S  PA L A B R A S

Versión adaptativa del umbral de 
densificación. En pruebas catas­
trófico (el número de splats se 
desplomó a 63K). Off. Q5 tiene 
una variante mejor.

T53 mergeAfterDensification

D E TA L L E S

Predeterminado: false (initializer), true ( .full , 
.classicBalanced , .fullClassicPaper ) Rango: 

booleano Definido en:

T É C N I C O

Función V438: al final de la fase de densificación 
(iter T2 ) corre una pasada de merge única que 
combina Gaussianos cercanos con escala y color 
similares. Reduce el número de Gaussianos típica
mente un 5–15 % sin pérdida visible de calidad. 
Razón: tras el intenso clonado, surgen clusters de 
Gaussianos casi idénticos que no aportan nada nue
vo — mergearlos libera capacidad de optimizador 
para otras áreas. Por defecto en los ajustes prees
tablecidos Classic Quality. No usado bajo MCMC, 
porque MCMC mediante su lógica de relocalización 
no deja que esos clusters se formen en primer lugar.

E N  P O CA S  PA L A B R A S

Al final de la fase de duplicación 
de splats, combinar clones que 
son casi idénticos. Reduce el ta­
maño de datos sin efecto visible. 
Por defecto on en el preset Qua­
lity.
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T54 densifyPhase2FromIteration

D E TA L L E S

Predeterminado: 0 (= deshabilitado) Rango: 0 o 
T2  – T1  Definido en:

T É C N I C O

V426 experimental: habilita una segunda fase de 
densificación que comienza tras la pausa de refina
miento en esta iteración y corre hasta T55 . Hipóte
sis: tras una fase de refinamiento los acumuladores 
de gradiente tienen magnitudes más estables y 
pueden indicar con más precisión qué regiones aún 
necesitan Gaussianos adicionales. V426 probado y 
revertido: la densificación de dos fases cayó en 
cascade failure de 0 Gaussianos (combinada con el 
pruning de refinamiento V425 destruyó el buffer). 
Deshabilitado. Flag CLI disponible para experimen
tos.

E N  P O CA S  PA L A B R A S

Segunda ronda de multiplicación 
tras una pausa. En pruebas, ani­
quiló el inventario de splats. Off.

T55 densifyPhase2UntilIteration

D E TA L L E S

Predeterminado: 0 Rango: 0 o T54  – T1  Defini­
do en:

T É C N I C O

Fin de la densificación de dos fases V426. Solo 
relevante cuando T54 > 0 . Ambos campos juntos 
deshabilitados.

E N  P O CA S  PA L A B R A S

Fin de la segunda ronda de multi­
plicación (véase T54). Ambos off.
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Post-procesado + Apple AI (T56–T60)

T56 postTrainingCompactification

D E TA L L E S

Predeterminado: true (en todos los ajustes pre
establecidos de producción), false ( .quickTest , 
.preview ) Rango: booleano Definido en:

T É C N I C O

Función V443: tras terminar el entrenamiento, los 
Gaussianos con sigmoid(opacity) < 0,01 se eliminan 
en duro (prácticamente ya no contribuyen a la ima
gen). Reduce el número de Gaussianos típicamente 
un 58 % y el tamaño del archivo de exportación un 
55 % sin pérdida visible de calidad. On por defec
to en ajustes preestablecidos de producción — el 
resultado final debería entregarse lo más compacto 
posible. Off en .quickTest , porque un run diag
nóstico no se exporta de todos modos. A diferencia 
de T42 midTrainingCompactificationIterations 
(V549), la compactificación solo ocurre al final — el 
refinamiento puede usar todos los Gaussianos hasta 
entonces.

E N  P O CA S  PA L A B R A S

Limpieza tras el entrenamiento: 
los splats casi invisibles se elimi­
nan. Hace el archivo de exporta­
ción aproximadamente la mitad 
de grande sin pérdida de cali­
dad. Función obligatoria, déjalo 
off solo en runs diagnósticos.

T57 metalFXUpscaling

D E TA L L E S

Predeterminado: false Rango: booleano Definido 
en:

T É C N I C O

Función V444: habilita el Apple MetalFX Spatial 
Upscaler en lugar de interpolación bilineal en la 
salida del visor 3D. Cuando la resolución de entre
namiento < tamaño de la vista (p. ej., entrenando 
a 0,5×, visualización de vista a resolución comple
ta), MetalFX puede entregar una imagen claramente 
más nítida. Cambia en vivo en la vista, no se 
requiere reentrenar. Mutuamente exclusivo con T58 
mpsLanczosScaling — MetalFX tiene prioridad. Re
comendación: habilitar cuando la imagen en el visor 
parece «deslavada» comparada con el detalle es
perado.

E N  P O CA S  PA L A B R A S

Afilado de imagen basado en ML 
de Apple en el visor 3D. Ayuda 
cuando has entrenado a una re­
solución más baja y quieres mos­
trar el resultado a pantalla com­
pleta. Conmutador en vivo, prué­
balo.
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T58 mpsLanczosScaling

D E TA L L E S

Predeterminado: false Rango: booleano Definido 
en:

T É C N I C O

Función V444: MPSImageLanczosScale para el es
calado de vista en lugar de interpolación bilineal. 
Lanczos es un método de resampling basado en 
sinc clásico que entrega resultados significativa
mente más nítidos que bilineal con overhead mí
nimo. Conmutador en vivo. Sobrescrito por T57  
cuando ambos están on.

E N  P O CA S  PA L A B R A S

Método de afilado clásico para el 
visor 3D (Lanczos). MetalFX (T57) 
es basado en ML y normalmente 
mejor; Lanczos es una alternati­
va menos agresiva.

T59 livePreviewInterval

D E TA L L E S

Predeterminado: 50 (initializer y la mayoría de 
ajustes preestablecidos) Rango: 0 (off) o 10 – 5 
000 Definido en:

T É C N I C O

Cada cuánto se refresca el visor 3D durante el 
entrenamiento con los Gaussianos actuales. 50 = 
cada 50 iteraciones un nuevo render en el visor — 
suficiente para observar el progreso sin ralentizar 
el entrenamiento. 0 = el visor no se actualiza en ab
soluto (entrenamiento en segundo plano, velocidad 
máxima). Ajuste típico: bajo .quickTest  bajarlo a 
10 (quieres ver cada paso), en runs MCMC largos 
subirlo a 500–2000 (el overhead de actualización 
suma a ratos).

E N  P O CA S  PA L A B R A S

Cada cuánto se refresca la previ­
sualización 3D durante el entre­
namiento. 50 = cada 50 iteracio­
nes. Más alto = menos a menudo 
= un poco más rápido, pero ves el 
progreso con menos frecuencia. 
0 = sin previsualización (para la 
velocidad máxima).
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T60 perceptualLossWeight

D E TA L L E S

Predeterminado: 0,0 (= deshabilitado) Rango: 0 o 
0,001 – 0,5 Definido en:

T É C N I C O

Función futura V444: peso de un término de per
ceptual loss vía MPSGraph (red pequeña tipo VGG). 
Capturaría similitud estructural y textural a un nivel 
semántico más alto que L1+SSIM — típico en pi
pelines de investigación donde «píxel-perfecto» im
porta menos que «se ve realista». Implementación 
pendiente (stub de código presente, pero el forward 
pass no implementado). Predeterminado 0,0. Se 
queda en el catálogo de campos para activación 
futura; flag CLI --percep-weight F  reservado.

E N  P O CA S  PA L A B R A S

Función planificada que con 
asistencia de IA apunta a «as­
pecto natural» en lugar de «pre­
ciso a nivel de píxel». Aún no 
totalmente implementado.

Densificación MCMC (T61–T73)

T61 densificationStrategy

D E TA L L E S

Predeterminado: .classic  (initializer + ajustes 
Classic), .mcmc  (todos los ajustes preestablecidos 
MCMC + Scene-Class) Rango: .classic  o .mcmc  
Definido en:

T É C N I C O

Elige entre densificación clásica (clone/split/prune, 
Kerbl et al. 2023) y densificación MCMC (Stochas
tic Gradient Langevin Dynamics con relocalización, 
Kheradmand et al. NeurIPS 2024). Con .classic  
se evalúan T11–T16 , con .mcmc  los T62–T73 . 
Cuidado al cambiar: los defaults Classic y MCMC 
están calibrados de forma completamente distinta 
— quien gire el selector en la Vista Experto sin 
cargar un ajuste preestablecido coincidente arries
ga una extinción masiva tipo bug-1.4.3 (460 K → 
5 en una iteración, porque el opacity reg 0,01 de 
MCMC mata las opacidades Classic). De ahí que los 
defaults del initializer MCMC estén deliberadamente 
«soft-washed» (todos los valores reg 0,0).

E N  P O CA S  PA L A B R A S

Qué algoritmo se usa para mul­
tiplicar los splats. Classic = mé­
todo original (rápido, muchos 
splats). MCMC = método más 
nuevo (más lento, muchos menos 
splats, pero más compacto). Los 
ajustes preestablecidos eligen el 
correcto. Solo cambia tú si tam­
bién cargas el ajuste preestable­
cido coincidente (P5–P7 o P8–
P10).
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T62 mcmcMaxGaussians

D E TA L L E S

Predeterminado: 150 000 (initializer + .fullMCMC  
+ .mcmcBalanced ), 100 000 ( .mcmcPreview ), 1 
500 000 ( .fullMCMCMip  — variante Mip-Splatting 
con presupuesto 10×), 1,19 M ( .renderPreset ), 
1,25 M ( .outdoorPreset ), 670 K ( .indoorPreset ) 
Rango: 0 (= «usar capacidad de buffer») o 10 000 
– 5 000 000 Definido en:

T É C N I C O

Cota superior dura para el número de Gaussianos 
bajo estrategia MCMC. El número crece gradual
mente por T70 mcmcGrowthRate  (típicamente 5 %) 
por paso de relocalización hasta este tope. V473/
V531 encontraron 150 K como sweet spot — por 
encima de 200 K diluye la calidad del splat (dema
siados Gaussianos redundantes pequeños), por de
bajo de 100 K deja la escena sub-densificada. Con 
escenas muy grandes (p. ej., vuelo de dron de 1 545 
fotos con 158 K init SfM), 150 K es demasiado bajo 
— de ahí la extensión 1.4.5 T72 mcmcCapMultiplier + 
T73 mcmcAutoScaleByScene. Q7 BayesOpt encontró 
óptimos específicos de escena entre 670 K (Indoor) 
y 1,25 M (Outdoor). Con valor 0, el engine usa la 
capacidad completa del buffer como tope.

E N  P O CA S  PA L A B R A S

Número máximo de splats bajo 
MCMC. 150 000 es el predeter­
minado y basta para la mayoría 
de las escenas. Los ajustes Out­
door y Render (P8, P9) llegan a 
1+ millón para escenas más ricas 
en detalle. Subir puede aportar 
detalle, cuesta memoria; bajar es 
más bien un freno de emergen­
cia.
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T63 mcmcNoiseScale

D E TA L L E S

Predeterminado: 0,00005 (5e-5 = default del pa
per) Rango: 1e-6 – 1e-3 Definido en:

T É C N I C O

Multiplicador para el ruido Gaussiano que en cada 
iteración MCMC se añade a la posición de cada 
Gaussiano (lógica SGLD). Más alto = más explo
ración (los Gaussianos vagan más, encontrando 
puntos potencialmente mejores), más bajo = más 
explotación (los Gaussianos se quedan donde ya 
están bien). V467 y V536 confirmaron 5e-5 como 
óptimo — 1e-5/2e-5 demasiado poca exploración, 
1e-4 demasiada (los splats se difunden). Cosine-
-decayed sobre el tiempo de entrenamiento hasta 
T69 mcmcNoiseDecayEnd — al final del rango de de
cay, el ruido es efectivamente 0 y los Gaussianos 
convergen.

E N  P O CA S  PA L A B R A S

Cuánta «vibración» aleatoria 
permite la app a los splats para 
que encuentren ellos mismos el 
mejor sitio. El valor predetermi­
nado es óptimo en pruebas. Si 
lo subes, los splats se vuelven in­
quietos.

T64 mcmcOpacityRegWeight

D E TA L L E S

Predeterminado: 0,0 (= deshabilitado en defaults 
de RadianceKit, paper: 0,01) Rango: 0 o 0,001 – 
0,05 Definido en:

T É C N I C O

Penalización L1 específica de MCMC sobre la opaci
dad. Default del paper 0,01 (empuja los Gaussianos 
no usados hacia cero, los hace disponibles para 
relocalización). V464b mostró sin embargo: sin reg 
es medible mejor en RadianceKit (Sesión 28 confir
mado). Razón: el criterio de pruning definido con 
T68 mcmcDeadOpacityThreshold es suficiente por sí 
solo — una penalización L1 adicional también fuerza 
a Gaussianos valiosos de baja opacidad a morir. De 
ahí default 0. Atención: en el build beta 1.4.3 el 
default del initializer estaba erróneamente en 0,01, 
lo que resultó en el bug de extinción masiva (véase 
explicación T61); desde 1.4.4 fijado a 0,0.

E N  P O CA S  PA L A B R A S

Regularización especial de 
MCMC. Off porque el otro meca­
nismo de MCMC (umbral en T68) 
ya cubre esto. Déjalo en 0.
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T65 mcmcScaleRegWeight

D E TA L L E S

Predeterminado: 0,0 (= deshabilitado, paper: 0,01) 
Rango: 0 o 0,001 – 0,05 Definido en:

T É C N I C O

Penalización L1 específica de MCMC sobre los auto
valores de escala. Default del paper 0,01. V464b: 
sin reg mejor, mismo razonamiento que T64. Desha
bilitado en todos los ajustes preestablecidos MCMC 
de RadianceKit. Misma precaución que T64: bug 
1.4.3.

E N  P O CA S  PA L A B R A S

Como T64 pero para el tamaño de 
splat. Off.

T66 mcmcRelocationInterval

D E TA L L E S

Predeterminado: 100 (initializer + todos los ajustes 
preestablecidos MCMC, estándar del paper), 155 
(P9 Outdoor — óptimo Q7 BayesOpt) Rango: 50 – 
500 Definido en:

T É C N I C O

Intervalo de iteraciones en el que MCMC reubica 
los Gaussianos muertos (sigmoid(opacity) < T68 
mcmcDeadOpacityThreshold) a nuevas posiciones. 
V537 probó 50 (demasiado disruptivo, el loss fluc
túa) y 200 (marginalmente peor, MCMC pierde res
ponsividad). 100 es óptimo. Q7 BayesOpt en Bicycle 
encontró 155 como óptimo específico de escena 
para outdoor — los intervalos ligeramente más lar
gos dan a Adam más tiempo para integrar los Gaus
sianos recién colocados antes de que el siguiente 
evento reloc los ponga bajo presión.

E N  P O CA S  PA L A B R A S

Cuántas iteraciones entre que 
MCMC mueve splats muertos a 
otro sitio. 100 es estándar. No 
necesitas trastear tú mismo — el 
ajuste preestablecido Outdoor ya 
tiene el valor óptimo.
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T67 mcmcWarmupIterations

D E TA L L E S

Predeterminado: 500 Rango: 100 – 5 000 Defini­
do en:

T É C N I C O

Número de iteraciones iniciales durante las que no 
ocurre relocalización MCMC. Solo tras este warmup 
entra en acción la lógica de reloc. Razón: en las pri
meras iteraciones los valores de opacidad no se han 
estabilizado — si reloc empezara directamente, los 
Gaussianos serían colocados en sitios equivocados 
y tendrían que moverse de nuevo enseguida, lo que 
destruiría el momentum de Adam. Default del paper 
500. RadianceKit adopta este valor porque V464b 
mostró que es robusto.

E N  P O CA S  PA L A B R A S

Cuántas iteraciones se permite a 
MCMC «asentarse» primero an­
tes de empezar a mover splats. 
500 es estándar y encaja.

T68 mcmcDeadOpacityThreshold

D E TA L L E S

Predeterminado: 0,005 (initializer, estándar del pa
per), 0,01 ( .fullMCMC  y todos los ajustes preesta
blecidos MCMC — óptimo V535) Rango: 0,001 – 
0,05 Definido en:

T É C N I C O

Umbral sigmoid(opacity) por debajo del cual un 
Gaussiano cuenta como «muerto» y es elegible pa
ra relocalización. V535 encontró 0,01 como óptimo 
(0,005 marginal, 0,02 peor). Más alto = reloc más 
agresivo (más Gaussianos movidos), más bajo = 
más cauteloso. 0,01 corresponde aproximadamente 
a «0,5 % de visibilidad visual». P10 Indoor usa 
0,0142 como óptimo vía Q7 BayesOpt.

E N  P O CA S  PA L A B R A S

Por debajo de qué transparencia 
un splat cuenta como «muerto» 
para que MCMC lo empuje a otro 
sitio. 0,01 es óptimo en nuestras 
pruebas. No necesitas trastear tú 
mismo.
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T69 mcmcNoiseDecayEnd

D E TA L L E S

Predeterminado: 0 (initializer = «sin decay»), 
160 000 ( .fullMCMC  = 80 % de 200K), 96 
000 ( .mcmcBalanced  = 80 % de 120K), 40 000 
( .mcmcPreview ) Rango: 0 o 1 000 – Definido en:

T É C N I C O

Iteración en la que el ruido T63 mcmcNoiseScale  se 
amortigua del todo a cero (cosine decay desde iter 
0 hasta aquí). V497c/V502 encontraron 80 % de 
maxIterations como óptimo — da a MCMC suficiente 
tiempo de exploración pero deja el último 20 % a 
la convergencia sin ruido. 0 = ruido constante sobre 
todas las iteraciones (rara vez sensato, MCMC no 
puede converger entonces).

E N  P O CA S  PA L A B R A S

Cuándo se detiene el «tamba­
leo» aleatorio de los splats. En 
los ajustes MCMC al 80 % del 
total de iteraciones — primero 
exploración, después convergen­
cia. Deja el valor.

T70 mcmcGrowthRate

D E TA L L E S

Predeterminado: 0,05 (estándar del paper = 5 %) 
Rango: 0,01 – 0,2 Definido en:

T É C N I C O

Tasa de crecimiento del tamaño objetivo de la po
blación MCMC por paso de relocalización. La lógica: 
en cada evento reloc el tamaño objetivo de pobla
ción se multiplica por (1 + growthRate) , hasta al
canzar T62 mcmcMaxGaussians (o la variante escala
da vía T72/​T73). V512/V522 encontraron 0,05 como 
óptimo — valores más altos llevan a crecimiento 
demasiado rápido (los Gaussianos se insertan antes 
de que el momentum de Adam pueda integrarlos), 
valores más bajos a escenas sub-densificadas al 
final.

E N  P O CA S  PA L A B R A S

Lo rápido que crece el número de 
splats bajo MCMC. 5 % por paso 
es óptimo. Deja el valor.
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T71 mcmcSigmoidK

D E TA L L E S

Predeterminado: 100,0 Rango: 10,0 – 500,0 Defi­
nido en:

T É C N I C O

Parámetro de nitidez sigmoide para la atenuación 
de ruido MCMC. En el paso SGLD, el ruido por 
Gaussiano se amortigua por — los Gaussianos de 
alta opacidad (cuyo logit es positivo) reciben ex
ponencialmente menos ruido que los de baja opaci
dad. K = 100 es nítido, significa que la transición 
de «ruido pleno» a «sin ruido» ocurre muy rápido 
en torno a opacidad 0,5. V484–V487 encontraron K 
= 100 como óptimo — valores más pequeños (10–
50) también dejan tambalearse a los Gaussianos de 
alta opacidad (destruye los convergidos), los más 
grandes (> 500) hacen la transición artificialmente 
dura y los Gaussianos muertos ya no se mueven en 
absoluto.

E N  P O CA S  PA L A B R A S

Parámetro especial que determi­
na lo nítidamente que MCMC dis­
tingue entre «lo bastante trans­
parente para mover» y «sólido, 
no tocar». El predeterminado es 
óptimo. No trastear.

T72 mcmcCapMultiplier

D E TA L L E S

Predeterminado: 3,0 (initializer + .fullMCMC ), 2,0 
( .mcmcPreview ), 2,5 ( .mcmcBalanced ), 2,98 (P8 
Render), 5,32 (P9 Outdoor), 1,76 (P10 Indoor) Ran­
go: 0 (= deshabilitado) o 1,0 – 10,0 Definido en:

T É C N I C O

Función 1.4.5: escalado de tope consciente de la 
escena. Cuando T73 mcmcAutoScaleByScene es true, 
el tope efectivo se calcula como (clamped a la ca
pacidad del buffer). Contexto: con escenas grandes 
(p. ej., vuelo de dron de 1 545 fotos → 158 K 
SfM init), T62 = 150 000  es demasiado bajo — la 
density control no podría crecer en absoluto. Con 
multiplicador 3,0, el tope se escala a 474 K en este 
ejemplo (158 K × 3,0). Q7 BayesOpt encontró ópti
mos específicos de escena: outdoor se beneficia 
de un multiplicador alto (5,32 → ~830 K de tope 
con 156 K bicycle init), indoor se contenta con 1,76 
(las paredes saturan más rápido). Para la resolución 
completa del tope véase el método.

E N  P O CA S  PA L A B R A S

Multiplicador que adapta auto­
máticamente el tope de splats 
al tamaño de la escena. Escena 
grande = más puntos de inicio = 
mayor tope. El default 3× encaja 
para la mayoría de las escenas; el 
ajuste Outdoor va a 5× (grandes 
rangos de profundidad), Indoor a 
1,76× (las paredes acotan las co­
sas de todas formas).
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T73 mcmcAutoScaleByScene

D E TA L L E S

Predeterminado: true (initializer + todos los ajustes 
preestablecidos MCMC) Rango: booleano Definido 
en:

T É C N I C O

Función 1.4.5: interruptor maestro para la lógica 
de tope consciente de la escena (véase T72 +). 
Cuando es false, solo se usa T62 mcmcMaxGaussians 
como tope (vuelta al comportamiento 1.4.4). On por 
defecto porque los problemas de extinción masiva 
con escenas grandes desde 1.4.3 volverían en otro 
caso. Deshabilítalo manualmente solo cuando quie
ras fijar explícitamente un tope duro — p. ej., para 
entrenar una variante 150 K cuyo tamaño final sea 
planificable.

E N  P O CA S  PA L A B R A S

Habilita el ajuste automático del 
tope de splats al tamaño de la 
escena. On por defecto. Déjalo 
off solo cuando quieras exacta­
mente un número específico de 
splats.

Mip-Splatting (Q1.5) (T74–T76)

Estado: Q1.5 fue rechazado el 2026-05-25 tras 14 iteraciones autónomas + com
probación nocturna de confianza con 1,5 M como «closed no-win» (max Δ@2× = 
+0,27 dB, la puerta original requería ≥ +1,5 dB de media sobre 0,5×/2×, FALLA 
en 0/11 escenas pareadas). Los campos permanecen opt-in para experimentos de 
investigación; todos los ajustes preestablecidos de producción los tienen off. Véase 
el veredicto: docs/​plans/​2026-05-25-phase-q1.5-final-verdict.md.
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T74 useMipSplatting

D E TA L L E S

Predeterminado: false (todos los ajustes de pro
ducción), true ( .fullMCMCMip  — hermano de inves
tigación) Rango: booleano Definido en:

T É C N I C O

Habilita Mip-Splatting (Yu et al. CVPR 2024): filtro 
de suavizado 3D + filtro 2D + compensación α 
que limita la frecuencia por Gaussiano al bound 
de Nyquist de la tasa de muestreo de cámara de 
entrenamiento más densa. Objetivo teórico: eliminar 
aliasing al renderizar a escalas distintas del entre
namiento (0,5× o 2× de la resolución de entrena
miento). Habilitado en los shaders de preprocess y 
backward projection, corrección funcional verificada 
en el test Q1.5-D. Pero: la puerta de aceptación 
original (Δ@1× ≥ +0,3 dB Y avg(Δ@0,5×, Δ@2×) ≥ 
+1,5 dB) no se alcanzó en ninguna de las 11 escenas 
pareadas. Máximo observado: family 750K classic 
Δ@2× = +0,270 dB. Las escenas outdoor (Truck, 
Flowers) incluso mostraron empeoramiento en 1× y 
0,5×. Hipótesis: el suavizado 3D compite con la re
localización MCMC a Gs alto. El campo se mantiene 
para una reevaluación multi-escala futura con meto
dología correcta Mip-NeRF-360 (véase el backlog 
O3 en la ruta de benchmark).

E N  P O CA S  PA L A B R A S

Filtro de aliasing de un paper de 
2024. Teóricamente genial, en la 
práctica no aportó nada en nues­
tras pruebas y a veces incluso 
hizo daño. Sigue disponible para 
los curiosos, pero no lo recomen­
damos. Déjalo off.
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T75 mipSmoothing3DScale

D E TA L L E S

Predeterminado: 0,2 (default del paper) Rango: 
0,05 – 1,0 Definido en:

T É C N I C O

Parámetro de escala de suavizado 3D (Yu et al. 
§3.3, default del paper 0,2). Más grande = más 
suavizado en espacio mundo por Gaussiano (= 
más anti-aliasing pero también más blur a la esca
la default), más pequeño = más nítido pero más 
propenso a aliasing. Solo se consulta cuando T74 
useMipSplatting =

true. No se ha optimizado más en las pruebas Q1.5 
— la puerta A/B ya se perdió con el default del paper 
0,2, sweeps adicionales serían inútiles.

E N  P O CA S  PA L A B R A S

. Si no has habilitado Mip, irrele­
vante.

T76 mipFilter2DVariance

D E TA L L E S

Predeterminado: 0,3 (= exactamente el comporta
miento legacy V242) Rango: 0,1 – 1,0 Definido en:

T É C N I C O

Varianza del filtro 2D Mip añadida a la diagonal 
Σ_2D (varianza directamente, no al cuadrado). 0,3 
es exactamente el valor legacy V242 que estaba 
codificado en duro en el kernel antes de Mip-
Splatting. Cuando T74 useMipSplatting = false, el 
kernel ignora este valor por completo y escribe el 
0,3 codificado — para que la línea base no pueda 
regresar (garantía S3-1 ronda 1 de Codex). Cuando, 
se usa el valor aquí fijado. Se queda en el catálogo 
de campos para sweeps Mip.

E N  P O CA S  PA L A B R A S

Otro parámetro de Mip-Splatting. 
Con Mip off: irrelevante.
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Densificación adaptativa (Q5) (T77–T79)

T77 adaptiveDensification

D E TA L L E S

Predeterminado: false Rango: booleano Definido 
en:

T É C N I C O

Función Q5: tracker de mediana rodante como al
ternativa al T11 densifyGradThreshold fijo. Cuando 
es true, en cada paso de densify, el umbral actual 
se sobrescribe con median(últimas N muestras 
avgGrad) × T79

adaptiveDensifyMultiplier. N = 
T78 adaptiveWindow . Más estricto que el V440 

p98 (la trampa catastrófica de pruning a 63 K), 
median + 2× se sitúa en torno al p70–p80 de la 
distribución de gradientes en estado estable. Prue
bas Q5: sola FALLA 0/3 escenas, pero junto con 
Q6 (véase T80/T81) PASA 1/3 escenas — el bundle 
Q5+Q6 pasó el 2026-05-25 como opt-in y se habi
lita vía CLI --adaptive-densify . Q6 es el «porta
dor» de la ganancia de calidad, Q5 contribuye más 
a la estabilidad.

E N  P O CA S  PA L A B R A S

Umbral de densify autoaprendi­
do. En lugar de un ajuste fijo de 
sensibilidad, la app se adapta a 
la escena. Por sí sola no fue me­
jor en pruebas, pero junto con el 
currículum de Q6 sí. O ambos on 
o ambos off.

T78 adaptiveWindow

D E TA L L E S

Predeterminado: 1 000 Rango: 100 – 10 000 Defi­
nido en:

T É C N I C O

Ventana de mediana rodante en eventos de 
densificación (NO iteraciones — cada paso T13 
densifyInterval da una muestra). Default 1 000 — 
con eso, las últimas 100 000 iteraciones de entre
namiento contribuyen a la mediana, así que típica
mente toda la historia de entrenamiento hasta aquí. 
Fase temprana (antes de T78  muestras): el tracker 
devuelve nil → fallback al umbral fijo T11 . Solo re
levante cuando.

E N  P O CA S  PA L A B R A S

Cuántos viejos pasos de densify 
alimentan la mediana para T77. 
Default 1000 es bueno. Solo rele­
vante cuando Q5 adaptive está 
on.
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T79 adaptiveDensifyMultiplier

D E TA L L E S

Predeterminado: 2,0 Rango: 1,0 – 4,0 Definido en:

T É C N I C O

Multiplicador sobre la mediana rodante para el um
bral adaptativo. Default 2,0 corresponde aproxima
damente al p70–p80 de la distribución típica de 
gradientes. Más bajo = crecimiento más agresivo 
(más clones), más alto = más estricto (menos clo
nes). Pruebas Q5 en rango 1,5–3,0 — 2,0 mejor 
default. Solo relevante cuando.

E N  P O CA S  PA L A B R A S

Factor para T77/T78. Default 2,0 
= más estricto que la mediana tí­
pica. No trastear.

Currículum (Q6) (T80–T81)

T80 curriculumResolutionRamp

D E TA L L E S

Predeterminado: false Rango: booleano Definido 
en:

T É C N I C O

Función Q6: la resolución de entrenamien
to empieza en 0,5× y cambia en T50 
positionLRScheduleEndIteration /​ 2 (o T1 
maxIterations /​ 2, si T50 no está fijado) a T22 
trainingRenderScale. Usa la infraestructura resize/​
restoreImageBuffers desarrollada en Q1.5.1. So
brescribe T23 resolutionWarmupScale cuando está 
habilitado. Q6 pasó como «portador de la ganancia 
de calidad» en el bundle Q5+Q6 (véase T77) — el 
aumento gradual de resolución da a la app tiempo 
para encontrar la geometría gruesa a menor resolu
ción antes de pasar al trabajo de detalle fino. Vía 
CLI: --curriculum-resolution.

E N  P O CA S  PA L A B R A S

«Primero grueso, después fino» 
para la resolución de entrena­
miento. Media resolución en la 
primera mitad, después resolu­
ción completa. Ayuda en ciertas 
escenas, no en otras — mejor ha­
bilitarlo junto con T81.
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T81 curriculumSHProgression

D E TA L L E S

Predeterminado: false Rango: booleano Definido 
en:

T É C N I C O

Función Q6: sobrescribe T21 
shDegreeUpgradeIterations con [maxIter/​4, 
maxIter/​2, maxIter*3/​4], distribuyendo los upgra
des SH de forma uniforme a lo largo del tiempo 
de entrenamiento en lugar de cargarlos al principio. 
Hipótesis: una geometría estable se establece antes 
de la explosión de detalle de color, lo que coloca 
con más precisión los efectos de brillo dependien
tes de la dirección de visión. Q5+Q6 juntos PASAN 
1/3 escenas, Q6 como portador de la ganancia (Q5 
sola FALLA). Vía CLI: --curriculum-sh .

E N  P O CA S  PA L A B R A S

«Primero forma, después color» 
— los efectos de brillo se des­
bloquean solo tarde en el entre­
namiento, así que los splats pri­
mero encuentran su posición y 
tamaño. Puede habilitarse junto 
con T80; por sí solo no aporta 
tanto.

Ajustes preestablecidos estáticos (TP1–TP9)

Aquí solo las diferencias estructurales respecto al default del initializer. La descripción 
completa de marketing de los once ajustes preestablecidos UI P1–P11 está en el Capí
tulo 7.

TP1 .preview

D E TA L L E S

Ajuste preestablecido diagnóstico/previsualización 
para sistemas ≥ 10 GB de RAM. Overrides vs. initia
lizer: - 30 000 → 5 000 - 15 000 → 3 500 (70 % 
de maxIter) - 1,6e-6 → 1,6e-5 (10× más alto, decay 
menos agresivo) -,,,, cada 2× (V176) - 3 000 → 100 
000 (efectivamente off, V172: el reset destruye en
trenamientos cortos) - [1K, 2K, 3K]  → [1K, 2K]  
(V182: el grado 3 no converge en 2K iter) - 1,0 → 
0,5

E N  P O CA S  PA L A B R A S

Valoración inicial de una serie de 
imágenes recién importada — 2–
3 min de espera; tras eso, el 
resultado basta para un binario 
«¿vale la pena un run Quality?».
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TP2 .full

D E TA L L E S

Producción Quality Classic. Overrides: - 30 000 
→ 35 000 (V550: pruebas 40K Truck overtraining 
+10,7 % Gs con −1,3 % L1) - 15 000 → 5 000 
(V310 sweet spot, V338 7K peor) - Todas las LRs 2× 
(V188) - 1,6e-6 → 1,6e-5 (V45 10×) - 2e-6 → 1,1e-6 
(V335) - 100 → 200 (V112) - 0,005 → 0,001 (V393) 
- 3 000 → 100 000 (V194 deshabilitado, V421 con
firmado) - [1K, 2K, 3K]  → [2K, 5K, 8K]  (V228 
retrasado) - 0,0 → 0,9995 (V546 HTGS, 14 % de 
mejora) - 50 (sin cambios, V546) - false → true 
(V438) - 0 → 20 000 (V431) - true (V443, ya default 
initializer para .full )

E N  P O CA S  PA L A B R A S

Cualquier captura fotográfica es­
tándar (objeto, sala pequeña, es­
cultura) con < 500 imágenes. La 
mejora de loss del 14 % anuncia­
da en V546 vs V438 se confirmó 
como promedio de 3 trials en 
Horse Full.

TP3 .fullClassicPaper

D E TA L L E S

Hermano de prueba Q1.5-A de TP2, Classic fiel al 
paper. Overrides vs. TP2: - 35 000 → 30 000 (es
tándar del paper) - 5 000 → 15 000 (paper: 50 % 
de maxIter) - 1,6e-5 → 1,6e-6 (default del paper) 
-,, vuelta a defaults del paper (0,05, 0,005, 0,001) - 
1,1e-6 → 2e-7 (calibrado para ~1-2M Gs en Bicycle) 
- 200 → 100 (paper) - 0,001 → 0,005 (default del 
paper) - 100 000 → 3 000 (paper §5.2, arriesgado 
— puede disparar la regresión V194) - 0,9995 → 
0,0 (el paper no tiene decay) - 20 000 → 30 000 
(cosine corre hasta 100 % de maxIter)

E N  P O CA S  PA L A B R A S

Experimentos de investigación 
Q1.5 que necesitan presupues­
tos de Gaussianos de magnitud-
-paper (1–2 M) para pruebas 
Mip-Splatting. Tras el veredicto 
«closed no-win» de Q1.5 el ajus­
te preestablecido sigue accesible 
para usuarios avanzados pero no 
se recomienda en producción.
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TP4 .fullMCMC

D E TA L L E S

Producción Quality MCMC. Overrides vs. initializer: 
- 30 000 → 200 000 (V534, MCMC necesita 
5× más iter que Classic) - 15 000 → 160 000 
(V504b 80 % de maxIter) - 1,6e-6 → 1,6e-5 - Sche
dule de LR como TP2 (todas 2×) - 0,2 → 0,05 
(V521b/V534: MCMC necesita señal L1 más fuerte) 
- [1K, 2K, 3K]  → [2K, 5K, 8K]  - .classic  → 
.mcmc  - 150 000 (ya en initializer, confirmado en el 

preset) - 5e-5 (V467/V536 óptimo) - 0,005 → 0,01 
(V535 óptimo) - 0 → 160 000 (80 % de maxIter, 
V497c/V502) - 3,0 (ya en initializer) - true (ya en 
initializer) - 3 000 → 200 000 (efectivamente off, 
MCMC usa reloc en lugar de reset)

E N  P O CA S  PA L A B R A S

Entrega web, capturas de objeto 
con aspiraciones de detalle, vue­
los de dron (aunque entonces P9 
Outdoor es aún mejor). 71 % me­
nos Gaussianos que Classic a L1 
comparable.

TP5 .fullMCMCMip

D E TA L L E S

Hermano de prueba Q1.5-D de TP4, con Mip-Splat
ting + presupuesto MCMC de magnitud-paper. Ove
rrides vs. TP4: - mcmcMaxGaussians 150 000 → 1 
500 000 (10×, magnitud paper) - useMipSplatting 
false → true (Mip on)

E N  P O CA S  PA L A B R A S

Todos los demás campos idén­
ticos a TP4. Q1.5 D-PASS en 
Bicycle 2026-05-24 (rompe la ra­
cha de FAIL multi-escala de 12 
iter). El veredicto final Q1.5 del 
2026-05-25 sigue siendo closed-
-no-win — ganancia Mip-Splat­
ting no reproducible a través de 
11 escenas pareadas. El ajuste 
preestablecido se mantiene opt-
-in.

TP6 .classicBalanced

D E TA L L E S

Mid-tier Classic. Overrides vs. TP2: - 35 000 → 20 
000 (V149: 20K = 30K con 33 % menos tiempo) - 
20 000 → 0 (cosine corre hasta maxIter = 20K, sin 
fase extendida)

E N  P O CA S  PA L A B R A S

Casos estándar con menor tiem­
po de espera. V149 identificado 
como sweet spot.
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TP7 .mcmcPreview

D E TA L L E S

Diagnóstico MCMC. Overrides vs. TP4: - 200 000 
→ 60 000 (V494b) - 160 000 → 48 000 (80 %) - 
150 000 → 100 000 (V473b) - 160 000 → 40 000 
(V494b) - 3,0 → 2,0 (1.4.5: Preview = escalado más 
ligero)

E N  P O CA S  PA L A B R A S

Ver rápido un resultado MCMC 
para juzgar si vale la pena TP4 o 
un ajuste Scene-Class.

TP8 .mcmcBalanced

D E TA L L E S

Mid-tier MCMC. Overrides vs. TP4: - 200 000 → 
120 000 (V518) - 160 000 → 96 000 (80 %) - 160 
000 → 96 000 (80 %) - 3,0 → 2,5 (entre Preview 2,0 
y Full 3,0)

E N  P O CA S  PA L A B R A S

MCMC sin el run completo 200K. 
~120 K iteraciones son un buen 
compromiso entre calidad y 
tiempo de espera.

TP9 .quickTest

D E TA L L E S

Prueba de funcionamiento pura. Overrides vs. initia
lizer: - 30 000 → 1 000 - 15 000 → 500 - 2e-6 → 
4e-6 (calibrado para 0,25× resolución) - 100 → 50 
- 3 000 → 100 000 (off, ya que demasiado corto) - 
1,0 → 0,25

E N  P O CA S  PA L A B R A S

Chequeo de sanidad «¿se inicia 
el entrenamiento con sentido en 
absoluto?». Duración < 30 s en 
M3 Ultra. Garantizado que se ve 
blando.

Método:

Firma: public func resolveMcmcMaxGaussians(initialPointCount: Int, 
bufferCapacity: Int) -> Int Definido en:

TÉCNICO  Fuente única de verdad para la pregunta «¿hasta cuántos Gaussianos se pue
de dejar crecer a MCMC?» Calculado a partir de tres entradas: el T62 mcmcMaxGaussians 
configurado (con suelo de extinción masiva 150 000 si 0), el (número de puntos init de 
SfM) y el (tamaño de buffer Gaussiano preasignado). Lógica:

1. base = T62 > 0 ? T62: 150_​000 (el suelo de extinción masiva protege contra bugs 
de default de initializer como el incidente de extinción masiva 1.4.3)

2. Si T73 mcmcAutoScaleByScene && initialPointCount > 0 && T72 
mcmcCapMultiplier > 0:
• scaled = max(base, ceil(initialPointCount × T72)) else

3. Si bufferCapacity > 0 : return min(scaled, bufferCapacity)
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4. Else return scaled

Ejemplo: Bicycle (Mip-NeRF 360, 194 frames de foto) → SfM init ~156 K puntos, 
T62 = 150 000 , T72 = 5,32 , capacidad de buffer 8 M. Tope resuelto = min(8M, 
max(150K, ceil(156K × 5,32))) = min(8M, 830K) = 830 K. Ese es el tope de creci
miento efectivo al que se atiene la lógica de relocalización MCMC.

EN PALABRAS CLARAS  Calcula el número máximo real de splats bajo MCMC. Toma tu 
ajuste, mira con cuántos puntos empieza tu escena, y escala por el Multiplier , si 
está activada la adaptación automática. Así el tope se adapta a la escena en lugar de 
forzar el mismo valor para una escena diminuta y una enorme. No tienes que llamar tú al 
método — el entrenamiento lo usa internamente.

¿Qué campo para qué? (Cheat Sheet)

Objetivo Campos a ajustar

Más detalle a la 
distancia

T62 mcmcMaxGaussians arriba, T72 mcmcCapMultiplier 5+

Más detalle en ge
neral (Classic)

T1 maxIterations  arriba (≤ 40K), T2 densifyUntilIteration ≤ 
14 % de T1

Reducir floaters en 
vuelos de dron

T43 frustumCullEnabled on, T20 skyMaskingEnabled on, 
T45 skyDomeEnabled  on

Cielo agradable en 
escenas exteriores

T45 skyDomeEnabled  on, T47 skyDomeRadiusMultiplier 30–60

Archivo de expor
tación más peque

ño

Estrategia .mcmc  (T61), T56 postTrainingCompactification on, 
T62 mcmcMaxGaussians ≤ 200K

Entrenamiento 
más rápido

T22 trainingRenderScale 0,5, T1 maxIterations  a la mitad — 
¡pero no ambos!

Mejores brillos T21 shDegreeUpgradeIterations con [2K, 5K, 8K]  (sin front-
-load temprano), MCMC + 200K iter

Mantener el Mac 
responsivo

T25 throttleDelayMs 5–10 (cuesta ~15 % de tiempo de entrena
miento)

Previsualización en 
vivo más a menudo

T59 livePreviewInterval abajo a 10–20

Transiciones más 
suaves en sombras

T17 ssimWeight  ligeramente arriba (0,15–0,25), pero no por enci
ma de 0,3

Mantener compac
tos los interiores

Ajuste preestablecido P10 Indoor (, T72 = 1,76 )
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Campos peligrosos

Estos campos pueden, con una mala configuración, llevar a OOM, crash de la app, ex
tinción masiva de Gaussianos o datos de benchmark inutilizables. Trátalos con cuidado:

• T11 densifyGradThreshold — partir a la mitad puede crear 2–4× más Gaussianos, lo 
que rápidamente revienta la memoria GPU. Ten en cuenta también: debe coincidir con 
T22 trainingRenderScale (1,0× → 1e-6, 0,5× → 2e-6, 0,25× → 4e-6).

• T72 mcmcCapMultiplier — con escenas grandes con > 200 K puntos init SfM y un 
multiplicador > 5, surge un tope resuelto de millones de Gaussianos. En Macs de 36 
GB de RAM, OOM es posible. El ajuste preestablecido Outdoor 5,32 funciona solo 
porque Mip-NeRF 360 Bicycle tiene 156 K puntos init → tope 830 K.

• T39 testViewIndices — fijarlo manualmente puede inutilizar el benchmark (todos los 
índices > N → sin holdouts). Deja que lo fije el flag --benchmark .

• T64 mcmcOpacityRegWeight y T65 mcmcScaleRegWeight — En la beta 1.4.3 puestos a 
0,01, lo que llevó a la extinción masiva (460 K → 5 Gaussianos en una iteración). 
Desde 1.4.4 fijados en 0,0, pero subirlos manualmente puede reproducir el problema.

• T15 opacityResetInterval — si no está en 100 000+ (efectivamente off) y el entre
namiento es más corto que 10 000 iteraciones, el reset destruye la convergencia. 
.preview  por eso lo tiene en 100 000 a pesar de maxIterations = 5 000.

• T54/​T55 densifyPhase2* — la densificación de dos fases acabó en pruebas en una 
cascada de 0 Gaussianos. Deja ambos en 0.

• T74 useMipSplatting — Q1.5 closed-no-win 2026-05-25, puede incluso empeorar el 
PSNR en algunas escenas outdoor. Default off, opt-in solo para investigación.

Si un campo está en esta lista y quieres cambiarlo, primero haz copia de seguridad de 
tu ajuste preestablecido actual (exporta como JSON) y considera si puedes medir el 
resultado de forma reproducible — en otro caso, no sabrás después si has provocado 
una mejora o un empeoramiento.
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C A P Í T U L O

Capítulo 7 — Ajustes preestablecidos de 
calidad integrados

Figura 27:  Sección de ajustes preestablecidos con los cuatro grupos expandidos — 
CAPTURE CLASS (4 ajustes: Drone/Aerial, 360° Walkaround, 360° Walkaround (High Detail), 
Photo/Object), CLASSIC (5 ajustes: Quick/Preview/Balanced/Quality/Ultra Detail), MCMC (3 

ajustes, nota „No threshold tuning«), HYBRID (1 ajuste: Balanced (Hybrid))

LO QUE SE VE EN LA IMAGEN  Sección de ajustes preestablecidos en el Inspector, los cuatro 
grupos expandidos. CAPTURE CLASS con los cuatro ajustes curados para el mundo real 
(Drone / Aerial, 360° Walkaround, 360° Walkaround (High Detail), Photo / Object) — es 
el grupo principal y el único visible en el modo principiante. CLASSIC con Quick (1K 
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iter), Preview (5K iter, selección activa con marca de verificación azul), Balanced (20K 
iter), Quality (35K iter) y Ultra Detail (35K iter). MCMC con el subtítulo „No threshold 
tuning« — MCMC no necesita umbral Densify-Until: Preview (60K iter, 100K Gaussia
nos), Balanced (120K, 150K), Quality (200K, 150K). HYBRID con el Balanced (Hybrid) 
(20K iter, 150K Gaussianos). Fila de acciones al pie: Save…, Export…, Import…

Un ajuste preestablecido es una configuración preparada para el entrenamiento. 
RadianceKit incorpora trece ajustes preestablecidos en cuatro grupos: cuatro ajustes 
Capture-Class (P9–P12) — recetas curadas, validadas a ojo sobre material real de la 
comunidad para tipos reales de captura (dron, recorrido 360°, foto-objeto) y el eje 
principal desde la v1.6 —, cinco ajustes Classic (P1–P5: Quick/Preview/Balanced/Quality/
Ultra Detail), tres ajustes MCMC (P6–P8) y un ajuste Híbrido (P13) que combina las 
estrategias Classic y MCMC. Los antiguos ajustes «Scene-Class» (Render/3D, Outdoor, 
Indoor, sintonizados en la Fase Q7 de forma académica frente a escenas de Mip-
NeRF-360 y NeRF-Blender) se retiraron como grupo visible en la v1.6 — la Capture-
Class, validada a ojo sobre material real, es ahora el eje principal; las configuraciones 
sintonizadas en Q7 se conservan solo internamente. Eliges los ajustes preestablecidos 
en la barra lateral en Presets o en el modo principiante durante la importación. Los 
botones +  abren diálogos para crear tus propios ajustes preestablecidos en paralelo — 
los trece integrados no se pueden eliminar, pero sí duplicar.

En la vista Experto los ajustes preestablecidos aparecen agrupados por tipo de captura 
y estrategia (Capture Class / Classic / MCMC / Híbrido). Un clic sobre una entrada 
escribe la configuración de entrenamiento almacenada en el estado actual. No es una 
instantánea — si después mueves deslizadores, el estado cambia, pero el propio ajuste 
preestablecido permanece intacto; un aviso de color indica entonces «modificado».

Cuál es el ajuste preestablecido adecuado en cada caso depende principalmente del 
tipo de escena y del hardware. Las tres tablas generales al final del capítulo lo resumen.
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P1 — Quick

D Ó N D E

Inspector → Sección Presets → Grupo «Classic» → 
Entrada «Quick». Sufijo UUID …001 .

T É C N I C O

Ajuste preestablecido de diagnóstico con 1 000 ite
raciones, estrategia clásica (adaptativa) de densifi
cación y un escalado de resolución de entrenamien
to de 0,25× (la imagen de entrada se reduce al 25 
% antes del entrenamiento). No pretende entregar 
una escena, sino determinar rápidamente si el setup 
(poses de cámara, nube de puntos, serie de imáge
nes) muestra siquiera movimiento significativo en 
los valores de loss. En un M3 Ultra suele tardar me
nos de 30 segundos con 50–200 imágenes. La pe
queña resolución oculta la calidad real de la imagen, 
pero mantiene la huella de memoria y el esfuerzo 
de renderizado muy bajos. También se selecciona 
automáticamente por defecto en el primer arranque 
cuando el sistema tiene menos de 10 GB de RAM.

E N  P O CA S  PA L A B R A S

Prueba rápida de funcionamien­
to. Metes las imágenes, esperas 
medio minuto y ves si aparece 
el contorno aproximado de la es­
cena. Si la imagen en el visor 
parece una masa difusa — enca­
ja, así debe ser. Si en cambio solo 
ves puntos oscuros o una forma 
totalmente distorsionada, proba­
blemente las poses de cámara 
son incorrectas (véase Capítulo 
9). Para un resultado comparti­
ble necesitas como mínimo P2 o 
P3.

P2 — Preview (Classic)

D Ó N D E

Inspector → Sección Presets → Grupo «Classic» → 
Entrada «Preview». Sufijo UUID …002 .

T É C N I C O

5 000 iteraciones de densificación Classic, escalado 
de resolución 0,5×, tasas de aprendizaje duplicadas 
respecto al estándar. La densificación (clonado + 
división) está activa durante las primeras 2 500 ite
raciones, después solo poda. Ajuste preestablecido 
por defecto para sistemas con ≥ 10 GB de RAM. En 
un M3 Ultra suelen ser de 90 segundos a 3 minutos 
para una escena de 200 imágenes. Entrega una im
presión utilizable de geometría y pose de cámara, 
pero las texturas se ven visiblemente blandas — la 
resolución de renderizado 0,5× no se puede sortear 
directamente después reentrenando con P3 o P4, 
porque las tasas de aprendizaje están calibradas 
para coincidir con la media resolución.

E N  P O CA S  PA L A B R A S

Es el estándar para «echar un 
vistazo rápido». Si acabas de im­
portar imágenes nuevas y quie­
res ver si la escena se puede 
reconstruir en absoluto, este es 
el nivel adecuado. Unos 2–3 mi­
nutos de espera y luego puedes 
rotar en el visor 3D y juzgar si 
vale la pena invertir en más en­
trenamientos. Solo cuando el re­
sultado de la previsualización ya 
tiene buen aspecto vale la pena 
pasar a Balanced o Quality.
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P3 — Balanced (Classic)

D Ó N D E

Inspector → Sección Presets → Grupo «Classic» → 
Entrada «Balanced». Sufijo UUID …005 .

T É C N I C O

20 000 iteraciones de densificación Classic a reso
lución completa. La densificación se ejecuta duran
te las primeras 15 000 iteraciones, a partir de la 
iter 3 000 con un intervalo de densificación de 100. 
Empíricamente el «punto óptimo» de las sesiones 
de entrenamiento documentadas: con densificación 
clásica en Horse Full y Truck, el loss L1 se estabiliza 
entre la iter 18 000 y la 22 000; un entrenamiento 
más largo no aporta mejoras significativas por de
bajo de Quality (P4). En un M3 Ultra suelen ser 30–
60 segundos con 200 imágenes, 5–8 minutos con 1 
000+ imágenes.

E N  P O CA S  PA L A B R A S

El «buen compromiso». La ma­
yoría de las escenas ya se ven 
bien con esto, sin que tengas 
que esperar una hora. Si quieres 
mostrar el resultado final en al­
guna parte (redes sociales, web, 
una demo para un cliente), suele 
ser suficiente. Solo cuando quie­
res hacer zoom en el modelo 
de splats o necesitas detalles de 
textura de superficie vale la pena 
saltar a P4 Quality o P7 MCMC.

P4 — Quality (Classic)

D Ó N D E

Inspector → Sección Presets → Grupo «Classic» → 
Entrada «Quality». Sufijo UUID …003 .

T É C N I C O

35 000 iteraciones de densificación Classic con 
V546 «Opacity Decay» (HTGS, Eurographics 2025): 
después de cada ciclo de densificación, la opacidad 
de todos los Gaussianos existentes se multiplica por 
un factor < 1,0, lo que elimina de manera fiable 
durante la poda los Gaussianos que se han vuelto 
inactivos y, así, consigue un 14 % mejor de loss 
L1 con el mismo número de iteraciones que el run 
clásico de 35 000. El loss SSIM está habilitado 
( ssimWeight=0.05 ). En un M3 Ultra suelen ser 2–
4 minutos con 200 imágenes. Alcanza un L1 final 
≈ 0,023 en NeRF-Blender (Lego, Chair, Drums) — 
la mejor variante Classic en los más de 560 experi
mentos documentados. Nota: necesita ~3–5 GB de 
memoria GPU; en sistemas de 8 GB, P3 es la opción 
segura.

E N  P O CA S  PA L A B R A S

La mejor variante clásica. Entre­
ga texturas nítidas y geometría 
fina, especialmente en capturas 
de objetos (una escultura, una 
silla, un jarrón). En grandes es­
cenas exteriores o salas, sin em­
bargo, apenas notas diferencia 
con Balanced — ahí vale más la 
pena pasarse a un ajuste prees­
tablecido MCMC (P6–P8) o a uno 
Capture-Class (P9–P12) que dar 
el salto de P3 a P4. Quien quiera 
el máximo absoluto de la familia 
Classic, toma P5 Ultra Detail.
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P5 — Ultra Detail (Classic)

D Ó N D E

Inspector → Sección Presets → Grupo «Classic» → 
Entrada «Ultra Detail». Sufijo UUID …008 .

T É C N I C O

Alrededor de 35 000 iteraciones de densificación 
Classic — el ganador del run held-out de la matriz 
de calidad (2026-06-10). En las tres escenas Mip-
NeRF-360 probadas, Ultra Detail supera al ajuste 
preestablecido MCMC «Quality» integrado (P8) con 
un tiempo de wall-clock comparable en torno a 
+0,94 dB PSNR. Es así el ajuste preestablecido 
Quality más fuerte del grupo Classic y la variante 
Classic más nítida que entrega RadianceKit. En un 
M3 Ultra suele estar en el mismo rango de tiempo 
que P4 Quality (2–5 minutos con 200 imágenes), 
pero necesita algo más de memoria GPU; en siste
mas de 8 GB, P3 sigue siendo la opción segura.

E N  P O CA S  PA L A B R A S

El nivel Classic más nítido y 
el ganador held-out de nuestras 
pruebas de calidad: en escenas 
reales, alrededor de un decibe­
lio mejor que la variante MCMC 
«Quality» — con un tiempo de 
espera similar. Si quieres máxi­
ma fidelidad de detalle con la 
probada densificación clásica y 
tienes suficiente memoria GPU, 
esta es la primera elección. Si la 
memoria no alcanza o necesitas 
un archivo de exportación lo más 
pequeño posible, quédate con P4 
Quality o con un ajuste preesta­
blecido MCMC.

P6 — Preview (MCMC)

D Ó N D E

Inspector → Sección Presets → Grupo «MCMC» → 
Entrada «Preview». Sufijo UUID …006 .

T É C N I C O

60 000 iteraciones de densificación MCMC (3DGS-
MCMC, NeurIPS 2024) con un tope de 100 000 
Gaussianos. MCMC reemplaza la lógica heurística 
de clone/split por una relocalización de cadena de 
Markov Monte Carlo: los Gaussianos muertos se 
reubican mediante profundidades de muestreo pon
deradas por sigmoide, lo que arroja un número con
trolado y reproducible de Gaussianos. El tope limita 
estrictamente el máximo a 100K — ahorra memoria 
y tiempo de renderizado, pero cuesta detalle. En 
un M3 Ultra suelen ser 5–8 minutos con 200 imá
genes. Adecuado como «prueba de funcionamiento 
MCMC» — te ayuda a valorar si pasar de Classic a 
MCMC tendría sentido antes de invertir más tiempo 
en P7 o P8.

E N  P O CA S  PA L A B R A S

Como P2 Preview, pero con el 
método más reciente MCMC. A 
menudo entrega nubes de splats 
más compactas y distribuidas 
con mayor uniformidad que la 
variante Classic. Para una valora­
ción inicial de una escena, los 5–
8 minutos suelen ser suficientes. 
Si te gusta el resultado de previ­
sualización, el siguiente paso es 
P7 (Balanced) o directamente P8 
(Quality MCMC).
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P7 — Balanced (MCMC)

D Ó N D E

Inspector → Sección Presets → Grupo «MCMC» → 
Entrada «Balanced». Sufijo UUID …007 .

T É C N I C O

120 000 iteraciones MCMC con un tope de 150 000 
Gaussianos. El nivel intermedio de MCMC — casi el 
número final de Gaussianos de P8 Quality, pero solo 
el 60 % de las iteraciones. Empíricamente, el loss 
L1 en las sesiones de entrenamiento documentadas 
se sitúa entre 0,026–0,028 sobre Horse Full, frente 
a P8 con 0,0246 — es decir, alrededor de un 7 % 
más alto, pero con la mitad de tiempo de espera. En 
un M3 Ultra suelen ser 8–15 minutos con 200 imá
genes. Utiliza un procedimiento que escala el tope 
efectivo de Gaussianos a la densidad de puntos de 
la nube SfM de entrada (véase T75 en el Capítulo 
6).

E N  P O CA S  PA L A B R A S

MCMC con una profundidad de 
detalle decente, pero sin el lar­
go run completo de P8. Para la 
mayoría de las escenas con es­
to basta, especialmente cuando 
quieres meter un run de MCMC 
en un hueco de tiempo de comi­
da. Si la memoria está justa (p. 
ej., en procesadores M con solo 
16 GB), quédate aquí — P8 nece­
sita más memoria GPU.

P8 — Quality (MCMC)

D Ó N D E

Inspector → Sección Presets → Grupo «MCMC» → 
Entrada «Quality». Sufijo UUID …004 .

T É C N I C O

200 000 iteraciones MCMC con un tope de 150 
000 Gaussianos, loss SSIM 0,05, decay de ruido 
MCMC sobre el 80 % de las iteraciones. Mejor L1 
en un solo run de los más de 560 experimentos: 
0,0238 en Horse Full, promediado sobre 3 trials 
0,0246 (frente a P4 0,0230 en la misma escena). 
MCMC entrega un 71 % menos de Gaussianos (150K 
frente a ~524K) — crucial cuando quieres entregar 
el resultado en la web, porque la nube más peque
ña produce archivos de exportación notablemente 
más pequeños. Tiempo de entrenamiento en un M3 
Ultra, normalmente 20–35 minutos con 200 imáge
nes; en sets de 1 000+ imágenes, más bien 1–2 
horas. Mejor elección cuando se desea máxima cali
dad de imagen con un tamaño final mínimo.

E N  P O CA S  PA L A B R A S

La mejor variante MCMC. Entre­
ga nubes de splats muy limpias 
y compactas — ideal cuando lue­
go quieres embeber el resultado 
como visor 3D web o enviarlo 
como archivo (el archivo es más 
pequeño que P4 Quality con una 
calidad óptica comparable). Pero 
necesitas paciencia — en captu­
ras grandes, más de una hora de 
espera. Plantéalo más bien como 
un run «de la noche».
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Figura 28:  Grupo CAPTURE CLASS expandido con los cuatro ajustes curados para el mundo 
real — Drone / Aerial (MCMC, 40K iter, tope 1,5 M), 360° Walkaround (MCMC, 40K, tope 
1,5 M), 360° Walkaround (High Detail) (Híbrido, 40K, tope 1,5 M, opt-in) y Photo / Object 

(Híbrido, 40K, tope 1,5 M). Este grupo está arriba del todo y es el único visible en el modo 
principiante.

LO QUE SE VE EN LA IMAGEN  Inspector con el grupo CAPTURE CLASS expandido — el 
grupo principal de ajustes preestablecidos desde la v1.6, el único mostrado en el modo 
principiante. Cada entrada es una receta validada a ojo sobre material real de la comu
nidad para un tipo concreto de captura (dron, recorrido 360°, foto-objeto), no un valor 
optimizado frente a un test set académico. La selección por clic escribe la configura
ción de entrenamiento almacenada en el estado actual.
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P9 — Drone / Aerial

D Ó N D E

Inspector → Sección Presets → Grupo «Capture 
Class» → Entrada «Drone / Aerial». Sufijo UUID 
…010 .

T É C N I C O

Ajuste preestablecido Capture-Class para órbitas 
aéreas y de dron de edificios y paisajes. Densifica
dor MCMC, 40 000 iteraciones, tope 1,5 millones de 
Gaussianos, loss SSIM 0,5 más término edge-aware 
0,1. Lo decisivo es la penalización de anisotropía 
con peso 0,003 a un umbral de relación de 6 — el 
«mataespaguetis» contra los típicos artefactos en 
forma de aguja que produce el material de dron. 
Validado en un vuelo de dron DJI 4K real sobre el 
viaducto de Pensford (comprobado a ojo, no solo 
métricamente).

E N  P O CA S  PA L A B R A S

Para tomas desde el aire — vue­
los de dron alrededor de un edifi­
cio, sobre un paisaje, a lo largo 
de una fachada. La fuerte pe­
nalización de anisotropía limpia 
los artefactos en forma de aguja 
o espagueti que el material de 
dron suele producir. Si tu mate­
rial está capturado desde el sue­
lo, encaja mejor Photo / Object o 
un ajuste preestablecido Classic.

P10 — 360° Walkaround

D Ó N D E

Inspector → Sección Presets → Grupo «Capture 
Class» → Entrada «360° Walkaround». Sufijo UUID 
…011 .

T É C N I C O

Ajuste preestablecido Capture-Class para vídeos de 
recorrido 360°. Densificador MCMC, 40 000 itera
ciones, tope 1,5 millones de Gaussianos, loss SSIM 
0,5 más término edge-aware 0,1, penalización de 
anisotropía suave (peso 0,001 a umbral de relación 
15). La máscara de personas y de cielo están acti
vas. El ajuste preestablecido espera un vídeo equi
rectangular 360° que internamente se reproyecta a 
recortes en perspectiva de unos 90° de ancho antes 
de iniciar el entrenamiento. Validado en recorridos 
360° en 8K con palo selfie (escena Monument, 
comprobado a ojo).

E N  P O CA S  PA L A B R A S

Para vídeos de recorrido 360° — 
caminas con una cámara 360° o 
un palo selfie por una sala o alre­
dedor de un objeto. RadianceKit 
descompone él mismo el panora­
ma esférico en ángulos de visión 
normales y enmascara transeún­
tes y cielo. Para máxima nitidez 
sobre el mismo material, prueba 
además la variante High Detail 
(P11).
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P11 — 360° Walkaround (High Detail)

D Ó N D E

Inspector → Sección Presets → Grupo «Capture 
Class» → Entrada «360° Walkaround (High Detail)». 
Sufijo UUID …013  (Opt-in).

T É C N I C O

Ajuste preestablecido Capture-Class opt-in para 
vídeos de recorrido 360° con máximo detalle. Den
sificador Híbrido (clonado/división clásico por gra
diente absoluto + ruido MCMC + relocalización), 40 
000 iteraciones, tope 1,5 millones de Gaussianos, 
penalización de anisotropía 0,0015 a umbral de rela
ción 15, loss SSIM 0,2 y término edge-aware 0 — la 
receta de screen-split «r50» bloqueada. En material 
360° supera al ajuste preestablecido MCMC están
dar «360° Walkaround» (P10) en PSNR, LPIPS y 
confeti visible, y con cerca de un tercio del número 
de splats. Está deliberadamente opt-in junto al ajus
te preestablecido 360 estándar, hasta que se valide 
en más escenas.

E N  P O CA S  PA L A B R A S

La alternativa más nítida al ajus­
te preestablecido 360 estándar 
(P10): más detalle, menos confe­
ti, archivo notablemente más pe­
queño. Está deliberadamente al 
lado en vez de reemplazarlo — 
confirmado hasta ahora en un 
puñado de escenas. Si tu reco­
rrido 360° está capturado limpia­
mente, prueba este ajuste prees­
tablecido primero y compara el 
resultado con P10.

P12 — Photo / Object

D Ó N D E

Inspector → Sección Presets → Grupo «Capture 
Class» → Entrada «Photo / Object». Sufijo UUID 
…012 .

T É C N I C O

Ajuste preestablecido Capture-Class para órbitas 
de objeto a partir de fotos individuales nítidas (sin 
vídeo). Densificador Híbrido-t1 (con relocalización), 
40 000 iteraciones, tope 1,5 millones de Gaussia
nos, loss SSIM 0,5 más término edge-aware 0,1, 
penalización de anisotropía suave (peso 0,001 a 
umbral de relación 15), Opacity Decay 0,9995 cada 
50 iteraciones, sin enmascarado. Validado en 163 
fotos de alta resolución de 41 MP de un esqueleto 
(comprobado a ojo). Pocas vistas (hasta unas 600) 
se mantienen así por debajo del umbral de colapso 
del Híbrido.

E N  P O CA S  PA L A B R A S

Para capturas de objeto a par­
tir de fotos individuales nítidas 
— rodeas una escultura, una ma­
queta, un producto con la cáma­
ra y haces fotos en vez de vídeo. 
Sin enmascarado, porque las fo­
tos nítidas suelen tener un fondo 
limpio. Para fuentes de vídeo to­
ma en su lugar un ajuste preesta­
blecido 360° o Drone.
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P13 — Equilibrado (Híbrido)

D Ó N D E

Inspector → Sección Presets → Grupo «Híbrido» → 
Entrada «Equilibrado (Híbrido)». Sufijo UUID …009 .

T É C N I C O

20 000 iteraciones con la estrategia de densifi
cación Híbrida: el clone/split clásico guiado por 
gradiente coloca capacidad donde la pérdida la ne
cesita, el ruido SGLD de MCMC sigue explorando, 
y los Gaussianos muertos se relocalizan en lugar 
de perderse en la poda. El decaimiento de opaci
dad (V546) sustituye los reinicios de opacidad; una 
penalización de anisotropía (peso 0,001, umbral de 
relación 15) mantiene a raya los splats en forma de 
aguja. El tope de Gaussianos escala con la escena 
(base 150K, scene-aware ×3,0). Validado en cinco 
escenas frente a MCMC puro con el mismo presu
puesto: de media +0,45 dB PSNR con un 20–30 
% menos de Gaussianos (stonehenge +1,23, family 
+0,82, garden +0,47 dB). En un M3 Ultra, típica
mente 5–10 minutos con 200 imágenes.

E N  P O CA S  PA L A B R A S

Una primera elección fuerte para 
un resultado final: detalle más 
nítido que los ajustes preesta­
blecidos MCMC con un archivo 
igual de compacto, en una frac­
ción del tiempo de entrenamien­
to de P8. Si solo tienes tiem­
po para un run de calidad y 
ninguna de las clases de cap­
tura encaja claramente, empieza 
aquí. Los ajustes preestableci­
dos Classic siguen siendo mejo­
res para pruebas rápidas, y los 
ajustes preestablecidos Capture-
Class (P9–P12) son la primera 
elección cuando tu escena enca­
ja claramente en uno de esos 
tipos de captura.
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¿Qué ajuste preestablecido en cada caso?

Escenario Primera prueba Run principal

Prueba de funcionamien
to de imágenes nuevas, < 

30 s

P1 Quick —

Órbita de objeto a partir 
de fotos individuales níti

das

P2 Preview P12 Photo / Object

Escaneo de un solo obje
to (vídeo), < 500 fotos

P2 Preview P4 Quality o P8 Quality 
MCMC

Vídeo de recorrido 360° P6 Preview MCMC P10 360° Walkaround (níti
do: P11 High Detail)

Órbita aérea / de dron, 
paisaje

P6 Preview MCMC P9 Drone / Aerial

Entrega web (pequeño, 
compacto)

P2 P8 Quality MCMC (archivo 
más pequeño con calidad 

completa)

Detalle nítido en poco 
tiempo, exportación com

pacta

P2 o P6 P13 Equilibrado (Híbrido)

Máxima fidelidad de deta
lle, estrategia Classic

P3 o P6 P5 Ultra Detail

Impresión, marketing, de
talle completo

P3 o P6 P4 Quality (Classic) o P5 
Ultra Detail
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Comparativa rápida
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Pre­
set

Estra­
tegia

Iter. Máx-
Gs

Escala 
render

Tiempo típico (200 imágenes, 
M3 Ultra)

Q-Sweep

P1 Quick Classic 1 000 ∞ 0,25× ~30 s —

P2 
Preview

Classic 5 000 ∞ 0,5× 2–3 min —

P3 
Ba
lan
ced

Classic20 000 ∞ 1,0× 30–60 s —

P4 Qua
lity

Classic35 000 ∞ 1,0× 2–4 min V546 
HTGS

P5 
Ul
tra 
De
tail

Classic ~35 
000

∞ 1,0× 2–5 min Ma
triz Δ+0,94 

dB

P6 
Preview 
MCMC

MCMC60 000 100 
K

1,0× 5–8 min —

P7 
Ba
lan

ced MCMC

MCMC 120 
000

150 
K

1,0× 8–15 min —

P8 Qua
lity MCMC

MCMC 200 
000

150 
K

1,0× 20–35 min V544a

P9 Dro
ne / 
Ae
rial

MCMC40 000 1,5 
M

1,0× 10–25 min Ojo / 
Via
duc
to

P10 360° 
Wal

karound

MCMC40 000 1,5 
M

1,0× 10–25 min Ojo / 
Mo
nu

ment

P11 360° 
Wal

karound 
(High 
De
tail)

Híbrido40 000 1,5 
M

1,0× 10–25 min Ojo 
(opt-
-in)

P12 Pho
to / 
Ob
ject

Híbrido40 000 1,5 
M

1,0× 10–25 min Ojo / 
Es

que
leto

P13 Equi
li

bra
do 
(Hí
bri
do)

Híbrido20 000 150 
K

1,0× 5–10 min Ma
triz Δ+0,45 
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Ajustes preestablecidos personalizados

Con el botón Save… en la sección Presets (I1 en el Capítulo 2) guardas la configuración 
de entrenamiento actual como tu propio ajuste preestablecido. Los ajustes preestable
cidos personalizados no son «Built-in» y se pueden renombrar, exportar (como JSON), 
compartir mediante arrastrar y soltar, duplicar y eliminar. Los trece ajustes preestable
cidos integrados P1–P13 permanecen intactos al pulsar el botón de eliminar.

Regla práctica: Si cambias algo en un ajuste preestablecido que vas a querer más ve
ces — Sky-Dome activo, mayor peso SSIM para una clase de escena concreta, distinto 
número de iteraciones —, guarda la variante como tu propio ajuste preestablecido. Así 
sabes de inmediato en el siguiente run que se trata de una configuración que se desvía 
del estándar.
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C A P Í T U L O

Capítulo 8 — Formatos de exportación

Figura 29:  Selección de formato de exportación en el modo principiante — seis tarjetas de 
formato

Figura 30:  Cuadrícula de formatos de exportación tras un entrenamiento de 5K iter sobre 
un ramo de flores — las seis tarjetas con cálculo dinámico de tamaño (PLY 742 KB seleccio

nado, SPZ 74 KB, glTF 708 KB, .splat 96 KB, Orbit Video ~Zero KB, Web Viewer 133 KB), 
historial de exportación a la derecha con el PLY ya guardado

189 / 242



R A D I A N C E K I T Capítulo 8 — Formatos de exportación

Lo que se ve en la imagen (2 991 Gaussianos, grado SH 3, ramo sintético de 
Blender libre de IP como conjunto de prueba): Las cifras de tamaño bajo cada 
tarjeta de formato se calculan en vivo a partir del número actual de Gaussianos y el 
overhead del formato — no están fijadas. Con 2 991 Gaussianos (grado SH 3) obtienes 
742 KB de PLY, 74 KB de SPZ (factor ~10× más pequeño por la cuantización), 708 KB 
de glTF (con extensión KHR_​gaussian_​splatting, por eso casi equivalente al PLY), 96 
KB de .splat (formato comprimido de 24 bytes por Gaussiano). Orbit Video muestra 
«~Zero KB» porque el tamaño solo se conoce tras codificar el MP4. Web Viewer 
(133 KB) empaqueta un archivo HTML autónomo con visor WebGL embebido y datos 
de splat comprimidos — más grande que el .splat puro por el overhead del visor. 
El historial de exportación a la derecha enumera la exportación PLY ya completada 
(«training_20260527T211321Z.ply, 743 KB, 23:13») con la insignia de formato y la 
acción Reveal in Finder.

Un entrenamiento terminado entrega una nube de Gaussianos — una colección de unos 
pocos cientos de miles a millones de distribuciones Gaussianas 3D que en conjunto 
reconstruyen la escena. RadianceKit conoce diez formas de escribir esa nube a disco. 
Seis son formatos de datos 3D puros (PLY, Compressed PLY, SPZ, SOG, glTF, .splat), 
uno empaqueta la nube junto con un visor HTML listo (Web Viewer), uno renderiza un 
archivo MP4 desde una trayectoria de cámara orbital (Orbit Video) y dos no exportan 
contenido Gaussiano sino solo el resultado de SfM (poses de cámara y nube de puntos 
gruesa) para reutilizar en otras pipelines de entrenamiento (transforms.json + COLMAP 
Workspace).

Qué formato es el adecuado en cada caso depende del objetivo. Para archivar todos 
los datos sin pérdida de calidad usas PLY. Para visores web en tu propia página, .splat 
o el Web Viewer integrado suelen bastar. Si el archivo tiene que ser mínimo, vale la 
pena SPZ o SOG. Para reutilizar el resultado de SfM en Nerfstudio, Postshot o Brush, 
transforms.json y el COLMAP Workspace son las vías correctas.

Todas las funciones de exportación están en el menú «Export», así como en el modo 
principiante en la última etapa del asistente. La mayoría de los formatos son totalmente 
compatibles con el sandbox y funcionan en la versión de App Store. Solo SOG requiere 
un binario externo ( cwebp ) que no está necesariamente presente en el build de App 
Store — detalles en E4.
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E1 — PLY (.ply)

D Ó N D E

Barra de menús → Export → 3D Formats → Export 
PLY… (⌘E). Modo principiante: paso del asistente 
Export → tarjeta de formato «PLY». Tamaño: típi
camente 100 % (valor de referencia). Compatible 
con: SuperSplat, PolyCam, todos los visores 3DGS.

T É C N I C O

PLY es el formato de almacenamiento canónico pa
ra 3D Gaussian Splatting. RadianceKit escribe un 
archivo binario little-endian con el layout de pro
piedades 3DGS estandarizado: por Gaussiano, posi
ción de tres componentes, tres normales siempre a 
cero, tres coeficientes SH DC ( f_dc_0..2 ) para el 
color RGB base, seguidos de hasta 45 coeficientes 
SH adicionales ( f_rest_0..44 ) en la disposición 
canal-mayor transpuesta definida por el paper de 
Kerbl 2023 (primero todos los coeficientes del canal 
R, luego todos los de G y luego todos los de B), se
guido por la opacidad logit (valores brutos previos 
al sigmoide), tres escalas en espacio logarítmico y 
una rotación cuaternión wxyz. El grado SH máximo 
exportado se acota al mínimo entre el deseo del 
usuario y el grado realmente aprendido; el prede
terminado es 3 (45 coeficientes rest). Antes de 
escribir, el tamaño del payload se calcula en entero 
de 64 bits para detectar overflow en nubes extre
madamente grandes. El archivo se escribe de forma 
atómica, lo que en nubes grandes ocupa brevemen
te el doble de espacio en disco.

E N  P O CA S  PA L A B R A S

Este es el «archivo original». El 
archivo más grande, la mayor 
compatibilidad, sin pérdidas. Si 
no sabes qué formato escoger, 
escoge PLY — se abre en casi 
cualquier herramienta de 3DGS. 
Para 1 millón de Gaussianos, eso 
son entre 200 y 800 MB según el 
grado SH. Si el archivo se hace 
demasiado grande, mira E2 (PLY 
comprimido) o E3 (SPZ).
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E2 — PLY comprimido (.ply)

D Ó N D E

Barra de menús → Export → 3D Formats → Export 
Compressed PLY…. Modo principiante: tarjeta de 
formato «Compressed PLY». Tamaño: aprox. 10–20 
% vs. PLY (compresión de 5 a 10 veces). Compa­
tible con: SuperSplat, motor PlayCanvas, visores 
basados en web.

T É C N I C O

La variante PlayCanvas del formato PLY con cuanti
zación por chunks. Los Gaussianos se agrupan en 
chunks de 256. Por chunk se almacenan en la 
cabecera, por separado, los límites min/max para 
posición, escala y color; los Gaussianos individuales 
referencian sus valores relativos a esos límites y 
se comprimen a 32 bits cada uno: posición y esca
la con empaquetado 11-10-11 bits, rotación como 
cuaternión «Smallest-Three» 2-10-10-10 bits, color 
como RGBA 8-8-8-8. Los coeficientes SH superio
res se cuantizan con solo 8 bits por componente 
( shCoeffCount * 3  uchar por Gaussiano). El for
mato en sí sigue siendo PLY con cabecera ASCII 
y por tanto en principio validable con herramientas 
de PLY, pero las propiedades de vértice están de
claradas como campos uint . El grado SH es por 
defecto 0 (sin coeficientes rest) para maximizar la 
compresión — se pueden seleccionar grados SH su
periores de forma explícita.

E N  P O CA S  PA L A B R A S

La variante de PLY que ahorra es­
pacio. La misma compatibilidad 
con engines que el PLY normal, 
pero 5 a 10 veces más pequeño. 
SuperSplat y PlayCanvas lo leen 
de forma nativa. Para despliegue 
web casi siempre es mejor que 
el PLY normal. La pérdida de ca­
lidad por la cuantización normal­
mente no se nota visualmente, 
mientras la escena no contenga 
detalles de muy alta frecuencia.
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E3 — SPZ (.spz)

D Ó N D E

Barra de menús → Export → 3D Formats → Export 
SPZ…. Modo principiante: tarjeta de formato «SPZ». 
Tamaño: aprox. 10 % vs. PLY (90 % más pequeño). 
Compatible con: Niantic Scaniverse, Niantic Spatial 
Fields, MetalSplatter.

T É C N I C O

El formato SPZ v2 de Niantic. Las posiciones se 
empaquetan como fixed-point de 24 bits (lo que 
da una resolución de aprox. 0,25 mm), las escalas 
como cuantización de 8 bits en espacio logarítmico, 
las rotaciones como Smallest-Three de 8 bits (en v2 
solo se almacena xyz, w se deriva en el decoder a 
partir de la norma del cuaternión), las opacidades 
como valores sigmoideados de 8 bits. El SH DC se 
almacena con una fórmula de empaquetado especí
fica de SPZ (dc_​raw * 0.15 * 255 + 0.5 * 255), 
las bandas SH superiores con 5 bits (banda 1) o 
4 bits (banda 2-3) por coeficiente. Todo el blob bi
nario empaquetado se comprime después con gzip 
estándar (RFC 1952), lo que da un formato contene
dor gzipped con bytes mágicos 1f 8b . RadianceKit 
invoca para ello el gzip  del sistema, porque la API 
zlib integrada de Apple genera un framing propio 
de Apple que no sería compatible con los lectores 
SPZ de Spatial Fields o MetalSplatter. El gzip  del 
sistema también sigue siendo lanzable dentro del 
sandbox de macOS.

E N  P O CA S  PA L A B R A S

El archivo estándar más peque­
ño. Si conoces Scaniverse de 
Niantic — ese es el formato que 
usa la app. Muy pequeño, muy 
amable con la carga para apps 
móviles. Utilizable directamente 
en el propio visor en la nube de 
Niantic (Spatial Fields). Cerca de 
un 90 % más pequeño que un 
PLY con los mismos datos, mien­
tras que en la mayoría de las 
escenas es ópticamente apenas 
distinguible.
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E4 — SOG (.sog)

D Ó N D E

Barra de menús → Export → 3D Formats → Ex
port SOG…. Modo principiante: tarjeta de formato 
«SOG». Tamaño: aprox. 5–6 % vs. PLY (compre
sión de 15 a 20 veces — la opción más pequeña). 
Compatible con: motor PlayCanvas, editor SuperS
plat.

T É C N I C O

«Spatially Ordered Gaussians» — un formato Play
Canvas que almacena la nube lista para GPU en va
rias imágenes WebP sin pérdida. Primero, todos los 
Gaussianos se ordenan espacialmente mediante có
digo Morton 3D (Z-order de 30 bits, 10 bits por eje), 
lo que da más adelante a las imágenes localidad de 
caché en el renderer. Luego las posiciones se cuan
tizan a valores de 16 bits con transformación loga
rítmica simétrica (para un mejor rango dinámico) y 
se dividen en dos imágenes RGBA ( means_l.webp  
para los 8 bits bajos, means_u.webp  para los 
altos). Las rotaciones se codifican como Smallest-
Three con 3×8 bits más modo de 2 bits en 
una imagen RGBA (el modo aterriza en alfa como 
252 + largest ). Las escalas y el SH DC se cuan

tizan, cada uno, con un codebook de 256 entradas 
(distribuido por percentiles sobre todos los valores); 
los índices acaban en scales.webp  y sh0.webp . 
Las cinco imágenes más un meta.json  con code
books y bounds se empaquetan en un archivo ZIP 
(encoder propio porque el sandbox bloquea el zip  
del sistema) y se guardan con la extensión .sog .

Aviso de sandbox: SOG es la única opción de 
formato que requiere un binario externo. La etapa 
del encoder WebP llama a cwebp  desde /​usr/​
local/​bin/​cwebp o /​opt/​homebrew/​bin/​cwebp. Si no 
se encuentra el binario cwebp, el código recurre 
a la codificación PNG cruda — pero: el fallback 
PNG no funciona en SuperSplat. En la versión 
de App Store, evalúa la disponibilidad según la 
variante del build; en la variante de desarrolla
dor, cwebp debe instalarse mediante Homebrew 
( brew install webp ).

E N  P O CA S  PA L A B R A S

El formato 3DGS más pequeño en 
conjunto, notablemente más pe­
queño que SPZ. Pero: necesita la 
herramienta cwebp  en tu Mac, 
porque RadianceKit por sí misma 
no puede generar todos los for­
matos de imagen. Instálala una 
vez con Homebrew y todo funcio­
na. En la versión de App Store 
posiblemente no esté plenamen­
te funcional — si en la exporta­
ción sale PNG en lugar de WebP, 
no podrás abrir el archivo di­
rectamente en SuperSplat. Quien 
trabaje sin Homebrew, que use 
SPZ (E3) en su lugar.
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E5 — glTF (.glb)

D Ó N D E

Barra de menús → Export → 3D Formats → Ex
port glTF…. Modo principiante: tarjeta de formato 
«glTF». Tamaño: comparable al PLY. Compati­
ble con: visores glTF con extensión KHR_​gaussian_​
splatting (borrador de estándar Khronos).

T É C N I C O

Escribe un archivo binario .glb  autocontenido (sin 
archivo bin separado adjunto) conforme a la espe
cificación de la extensión KHR_​gaussian_​splatting. 
Las posiciones se almacenan como datos de vérti
ce POSITION  regulares de glTF (float3); todos los 
demás atributos (rotación como float4, escala como 
float3, opacidad como float, coeficientes SH como 
float3 × shCoeffCount) están en atributos de vértice 
adicionales y se referencian mediante la extensión. 
Importante: glTF usa un sistema de coordenadas 
right-handed Y-up, COLMAP/3DGS trabaja en Y-
-down/Z-forward. Por eso, el exportador aplica una 
rotación de 180 grados alrededor del eje X — las 
posiciones se reescriben como (x, -y, -z) , los 
cuaterniones se ajustan a (w, x, -y, -z) . Esto da 
una visualización geométricamente correcta y con 
handedness (no espejada) en los visores glTF. Los 
chunks JSON y binarios se rellenan con padding a 
alineación de 4 bytes como exige el estándar GLB.

E N  P O CA S  PA L A B R A S

El formato estándar oficial de 
Khronos para datos 3D, en la 
nueva extensión para Gaussian 
Splats. Ventaja: glTF está exten­
dido en todos los grandes en­
gines 3D (Babylon.js, Three.js, 
Unity, Unreal). Desventaja: la ex­
tensión todavía está en fase de 
draft en 2026, muchos visores 
aún no la pueden leer. Tiene sen­
tido sobre todo si integras datos 
de splat en una pipeline glTF 
existente o escribes un visor que 
ya es capaz de glTF.
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E6 — Splat (.splat)

D Ó N D E

Barra de menús → Export → 3D Formats → Ex
port .splat…. Modo principiante: tarjeta de formato 
«.splat». Tamaño: exactamente 32 bytes por Gaus
siano. Compatible con: gsplat.js, visores basados 
en web (referencia antimatter15), la mayoría de las 
demos 3DGS en navegador.

T É C N I C O

El formato .splat  de antimatter15 — 32 bytes 
por Gaussiano, sin cabecera, sin indirección. Layout 
por entrada: 3 × float32 posición (coordenadas 
mundo), 3 × float32 escala (transformada con exp 
desde el espacio logarítmico del buffer interno), 4 
× uint8 color RGBA (coeficiente SH DC escalado 
con SH_C0 = 0.282...  y clamped a [0,255]), 4 × 
uint8 cuaternión (w,x,y,z, normalizado y codificado 
en el rango de bytes como 128 + 128*q ). Solo se 
almacena el SH DC — las bandas SH superiores 
se descartan. Eso hace al formato extremadamente 
compacto, pero cuesta los cambios de color depen
dientes de la vista que se dan con reflejos o brillos 
especulares. El orden de escritura es exactamente 
el orden de índice de la nube (sin ordenación espa
cial); los visores web como gsplat.js  renderizan 
basándose en ese supuesto.

E N  P O CA S  PA L A B R A S

El formato de elección si quieres 
mostrar el splat en tu propio vi­
sor web con gsplat.js . Muy 
compacto (32 bytes/Gaussiano), 
pero sin grado SH superior — 
así que sin reflejos brillantes ni 
cambios sutiles de color según el 
ángulo de visión. Para la mayoría 
de las aplicaciones web no es un 
problema, porque el color DC es 
totalmente suficiente y la falta 
de dependencia de la vista ape­
nas se nota.
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Figura 31:  Web Viewer abierto en Firefox — el splat del ramo renderizado con esferas de 
marcadores de cámara alrededor, barra de pestañas del navegador visible arriba, sin nece
sidad de configurar CDN/ servidor. flowers-01.html  autónomo abierto directamente 
desde el Finder con doble clic en el navegador por defecto — el programa WebGL2 embe
bido renderiza la nube Gaussiana de inmediato, sin red ni servidor. Los marcadores negros 
alrededor del ramo son las cámaras de entrenamiento, opcionalmente conmutables. Arras

trar con el ratón rota, scroll hace zoom.
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E7 — Visor web (.html)

D Ó N D E

Barra de menús → Export → Media → Export 
Web Viewer…. Modo principiante: tarjeta de formato 
«Web Viewer». Tamaño: datos de splat codificados 
en base64 (≈ 4/3 de overhead) + aprox. 5 KB de en
voltorio HTML/JS. Compatible con: cualquier nave
gador moderno con WebGL2 (todos los escritorios, 
iOS 15+, Android 5+).

T É C N I C O

Empaqueta la nube Gaussiana junto con un rende
rer WebGL2 escrito totalmente inline en un único 
archivo .html . No hay dependencias de CDN, ni 
WASM, ni segundo archivo. La nube se codifica in
ternamente primero como binario .splat  (misma 
lógica de 32 bytes que E6), después se incrusta 
en base64 y luego se decodifica con atob  en el 
navegador. El renderer integrado hace su propia or
denación WebGL2, controles de órbita con ratón y 
ordenación por CPU por frame; todo el código JS 
(shader, matemáticas, bucle) es visible en el HTML 
de salida. La convención de ejes en la frontera 
almacenamiento–renderer es exactamente la mis
ma que en E5: posición (x, -y, -z) , cuaternión 
(w, x, -y, -z) . Opcionalmente se puede mostrar 

un overlay de branding (conmutador del free-tier). 
Como todo es inline, el archivo también funciona 
directamente desde el protocolo file:/​/​ — no se 
necesita servidor web local para probarlo.

E N  P O CA S  PA L A B R A S

Un único archivo HTML que pue­
des enviar a alguien por correo 
o embeber en una web. Doble 
clic en el Finder y el navegador 
muestra tu escena con rotación 
con el ratón. No hace falta subir­
lo a una nube, ni un segundo 
archivo, ni un servidor. Ideal para 
presentaciones a clientes, port­
folio, adjuntos de correo. Des­
ventaja: el archivo se hace alre­
dedor de un tercio más grande 
que un .splat  puro por la 
codificación en base64 — para 
escenas muy grandes, por tanto, 
merece la pena un hosting sepa­
rado del archivo .splat  junto 
con un visor estándar.

198 / 242



R A D I A N C E K I T Capítulo 8 — Formatos de exportación

Figura 32:  Único fotograma extraído de flowers-01.mp4 — el ramo en renderizado de perfil, 
plataforma blanca con marcadores de cámara visibles, fondo negro (fondo de vista prede

terminado, cambiable en Ajustes). La cámara orbita la escena en una trayectoria paramétrica 
(elevación + distancia fijas, yaw rota), duración típicamente 6–10 segundos a 30 o 60 fps. 

Resolución del fotograma escalable de 480p a 8K mediante VideoPreset.
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E8 — Vídeo orbital (.mp4/.mov)

D Ó N D E

Barra de menús → Viewport → Record Turntable 
Video O bien Barra de menús → Export → Media → 
Export Orbit Video…. Modo principiante: tarjeta de 
formato «Orbit Video» con deslizador de duración 
3–30 s. Tamaño: depende de duración, resolución, 
bitrate. Compatible con: todas las plataformas 
(H.264 y HEVC son estándar de Apple).

T É C N I C O

Renderiza la nube Gaussiana a lo largo de una 
trayectoria de cámara orbital paramétrica y codifi
ca cada fotograma mediante AVAssetWriter en un 
archivo MP4 o MOV. La configuración de la órbita 
controla la velocidad de rotación (vueltas), distan
cia, elevación, FOV, duración y factor de ease-in/
out. La exportación de vídeo orbital pasa por el pro
pio ForwardPass de RadianceKit con evaluación SH 
completa — idéntica píxel a píxel a la vista del visor 
en la app (WYSIWYG). Por fotograma, la matriz de 
ajuste mundial (calculada por el renderer para rotar 
las coordenadas internas al mundo orbital Y-up) se 
multiplica con la cámara, tras lo cual se aplica un 
volteo de convención de cámara (camFlip: órbita Y-
-up → COLMAP Y-down). El render target offscreen 
se extrae mediante IOSurface a un CVPixelBuffer 
para el encoder. El encoder soporta H.264 y HEVC, 
bitrate y resolución configurables de 480p a 8K. 
Antes del primer fotograma, el renderer espera 200 
ms para que se complete la ordenación inicial de 
splats. Esta exportación está limitada por GPU — a 
8K y millones de Gaussianos, el tiempo de renderi
zado por fotograma es de varios segundos, así que 
son posibles tiempos totales de renderizado de 10–
30 minutos para un vídeo de 6 s.

E N  P O CA S  PA L A B R A S

Un archivo MP4 terminado con 
una rotación alrededor de tu es­
cena. Perfecto para redes socia­
les, marketing, presentaciones. 
Puedes ajustar duración (3–30 
segundos), sentido y velocidad 
de rotación. El archivo se puede 
embeber directamente en YouTu­
be, Instagram, PowerPoint y don­
de sea. A veces es lento porque 
la app tiene que renderizar por 
completo cada fotograma — para 
un vídeo 8K puedes planificar de 
cinco a treinta minutos, según el 
número de Gaussianos.
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E9 — SfM Transforms (transforms.json)

D Ó N D E

Barra de menús → Export → Photogrammetry → Ex
port SfM (transforms.json)…. Tamaño: típicamente 
1–10 KB (solo poses + intrínsecos, sin imágenes, sin 
Gaussianos). Compatible con: nerfstudio, Brush, 
gsplat, OpenSplat, Meshroom, todos los entrenado
res 3DGS feed-forward modernos.

T É C N I C O

Escribe el formato transforms.json  de nerfstudio 
con una lista de poses de cámara más intrínsecos 
compartidos. Por cámara, la matriz de vista (inter
na de RadianceKit: World-to-Camera en convención 
COLMAP) se invierte, tras lo cual los vectores base 
Y y Z local de cámara se espejan para pasar a 
la convención nerfstudio (estilo OpenGL, la cáma
ra mira a lo largo de -Z , +Y  es arriba). La 
matriz 4×4 final aterriza como array anidado row-
-major de doubles en el campo transform_matrix  
de cada frame. Los intrínsecos se almacenan en el 
nivel superior (focal x/y, punto principal x/y, ancho/
alto de imagen, camera_​model = "OPENCV", más 
los coeficientes de distorsión k1, k2, p1, p2 ) — 
excepto cuando el exportador detecta varios con
juntos de intrínsecos distintos, caso en que se es
criben por frame. Las rutas de imagen se escriben 
como images/​<filename> relativas al archivo JSON; 
el usuario debe crear una carpeta hermana images/​ 
con las fotos de entrenamiento.

E N  P O CA S  PA L A B R A S

Este archivo JSON describe, para 
cada foto, dónde estaba la cáma­
ra y a dónde miraba. El archivo 
por sí solo es pequeño e inútil 
— se usa junto con las imágenes 
originales en una carpeta. Nerfs­
tudio, Brush y algunos otros en­
trenadores leen exactamente es­
te formato, y con él puedes pasar 
tus resultados de SfM de Radian­
ceKit a otra herramienta sin que 
allí haya que recalcular la re­
construcción de la cámara. Aho­
rra horas en escenas grandes.
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E10 — COLMAP Workspace (sparse/0/)

D Ó N D E

Barra de menús → Export → Photogrammetry → 
Export SfM (COLMAP Workspace)…. Tamaño: tres 
archivos binarios juntos típicamente 4–8 MB — 
points3D.bin  domina (una línea por punto 3D de 

la nube sparse), images.bin  y cameras.bin  están 
cada uno notablemente por debajo de 100 KB. 
Compatible con: el propio COLMAP, Nerfstudio, 
Postshot, Meshroom, todas las herramientas que 
esperan un directorio sparse/​ de COLMAP.

T É C N I C O

Escribe el layout estándar sparse/​0/​ de COL
MAP con tres archivos binarios: cameras.bin , 
images.bin , points3D.bin . La referencia de for

mato es la documentación oficial de COLMAP. 
cameras.bin  contiene la lista de intrínsecos dedu

plicados (las cámaras con intrínsecos idénticos + 
tamaño de imagen se fusionan en una sola entrada); 
el modelo de cámara usado es OPENCV  (modelo 
4), con fx/fy/cx/cy más los cuatro coeficientes de 
distorsión k1/k2/p1/p2. images.bin  lista por imagen 
la pose como cuaternión wxyz  más traslación, 
seguidos del ID de cámara y el nombre de ar
chivo; no se almacenan correspondencias 2D-3D. 
points3D.bin  contiene la nube de puntos SfM con 

posición, color (RGB 0-255) y valores predetermi
nados para reproyección y longitud de track. Todo 
se escribe en little-endian. La reimportación en Ra
dianceKit funciona a través del menú File → «Import 
COLMAP/Metashape Workspace…» (véase Q3 en el 
capítulo de backends SfM).

E N  P O CA S  PA L A B R A S

El formato oficial de COLMAP. 
Si quieres continuar tu entrena­
miento en Postshot, Nerfstudio 
u otro software compatible con 
COLMAP, esta es la vía. Tres ar­
chivos pequeños más tus imá­
genes originales, y el programa 
de destino lo acepta como si 
el propio COLMAP hubiera sido 
el programa origen. Más progra­
mas lo entienden que el formato 
transforms.json (E9), al mismo 
tiempo algo menos cómodo por­
que es binario en lugar de basa­
do en texto.
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¿Qué formato en cada caso?

Objetivo Formato

Visor web en tu propia página E7 Web Viewer (.html)

Visor web con gsplat.js E6 Splat (.splat)

Reutilización de pipeline en Post
shot / Nerfstudio

E9 transforms.json + E10 COLMAP Workspace

Edición en SuperSplat E1 PLY o E2 Compressed PLY

Niantic Scaniverse / Spatial Fields E3 SPZ

Máxima compresión E4 SOG (cwebp requerido)

Vídeo de marketing/redes E8 Orbit Video
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Comparativa rápida

Forma­
to

Extensión Sandbox Tamaño (1M Gauss) Mejor uso

E1 PLY .ply sí ~250 MB Archivo, 
máxima 

compatibili
dad

E2 Com
pressed 

PLY

.ply sí ~40 MB Web + Su
perSplat

E3 SPZ .spz sí (spawn 
de gzip)

~40 MB Niantic + 
móvil

E4 SOG .sog condi
cional 

(cwebp)

~20 MB Máxima 
compresión

E5 glTF .glb sí ~250 MB Pipeline Kh
ronos

E6 Splat .splat sí ~32 MB Visor web 
gsplat.js

E7 Web 
Viewer

.html sí ~45 MB Archivo au
tónomo pa
ra navega

dor

E8 Vídeo 
orbital

.mp4 / .mov sí variable Redes/mar
keting

E9 SfM 
Trans
forms

.json sí ~5 KB Traspaso de 
poses

E10 
COLMAP 
Works
pace

Directorio sí ~4–8 MB Traspaso de 
poses bina

rio

La columna de tamaño son valores de referencia aproximados para 1 millón de Gaussia
nos con grado SH 3. Los valores reales varían según la compresibilidad de la escena; el 
grado SH 0 reduce PLY/glTF por un factor de 4.
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C A P Í T U L O

Capítulo 9 — Backends de SfM

Figura 33:  Modo Experto con selector de Camera Alignment en el Inspector (Apple Photo
grammetry / Native (Beta))

Figura 34:  Inspector con Native (Beta) activo — segunda opción del selector de Camera 
Alignment seleccionada, el resto de parámetros de configuración del entrenamiento sin 

cambios

LO QUE SE VE EN LA IMAGEN  El selector de Camera Alignment en el Inspector es un control 
segmentado con dos opciones — Apple Photogrammetry (predeterminado para builds 
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de App Store, totalmente compatible con el sandbox) y Native (Beta) (el backend pro
pio de la pipeline FAST+BRIEF+GLOMAP de RadianceKit, desarrollado durante la Fase 
3.8/3.9, estado 2026-05). Native (Beta) está validado únicamente en escenas orbitales 
y es más rápido que Apple Photogrammetry con ≥1 000 fotogramas, pero todavía no 
alcanza la puerta de calidad de la Fase 3 §5 (finalLoss ≤ 0.0115) — de ahí la etiqueta 
Beta. Los resultados de SfM externos de Metashape, COLMAP u otro software de 
fotogrametría se pueden importar adicionalmente mediante el menú File (Q3 formato de 
texto COLMAP, Q6 Workspace Import) — el selector no cambia, pero las poses impor
tadas reemplazan al resultado de SfM.

SfM significa Structure from Motion. A partir de un conjunto de fotos solapadas, el 
software reconstruye para cada imagen la posición y la dirección de visión de la cámara 
en un sistema de coordenadas 3D común. En el proceso se genera una nube de puntos 
3D gruesa, que inicializa el entrenamiento con Gaussian Splatting. El resultado de SfM 
es la entrada para el entrenamiento propiamente dicho y determina de forma decisiva la 
calidad final de la imagen.

RadianceKit ofrece cinco vías de SfM: dos backends integrados en la app (Q1 Apple 
Photogrammetry, Q4/Q5 Native), dos vías de importación desde herramientas externas 
(Q3 formato de texto COLMAP, Q6 Workspace Import binario) y Q2 COLMAP binario, 
que solo está disponible en builds de desarrollador fuera del App Store. Cuál es la 
adecuada depende del tipo de escena (órbita alrededor de un objeto, espacio interior, 
vuelo de dron) y de si un software externo ya proporciona una reconstrucción.
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Q1 — Apple Photogrammetry

D Ó N D E

Expert View → Inspector → Configuración del entre
namiento → Selector Camera Alignment, entrada 
«Apple Photogrammetry».

T É C N I C O

Envuelve el framework de fotogrametría integrado 
de Apple, desarrollado originalmente para Object 
Capture. Apple extrae internamente las característi
cas con una pipeline propietaria (los pasos no están 
documentados públicamente), las verifica mediante 
matching multi-vista y resuelve el bundle adjust
ment en el Apple Silicon Neural Engine + GPU. El 
backend es totalmente compatible con el App Store 
(sin binario externo, Sandbox=true, on-device), pero 
solo entrega poses de cámara más una nube de 
puntos gruesa — sin métricas de diagnóstico como 
longitud de track o error de reproyección. Escala 
según la recomendación de Apple hasta unos pocos 
cientos de imágenes. Con más de ~500 fotogra
mas en vuelos lineales de dron o grandes escenas 
exteriores se han observado de forma reproducible 
bloqueos o descarte silencioso de cámaras indivi
duales.

E N  P O CA S  PA L A B R A S

Esta es la forma más sencilla. In­
troduces las imágenes y la app 
calcula. Funciona muy bien pa­
ra escaneos clásicos de objetos 
— cuando caminas alrededor de 
un mueble o una escultura y ha­
ces 50–200 fotos. Para vuelos 
de dron sobre paisajes o con 
muchísimas imágenes (más de 
500), el método de Apple tiende 
sin embargo a volverse inestable. 
Para esas escenas prueba el bac­
kend Native (Q4/Q5) o calcula las 
cámaras en Metashape y cárga­
las mediante Workspace Import 
(Q6).

P OW E R - U S E R

Q2 COLMAP binario — lanza el programa externo COLMAP como subproceso y por 
eso no está disponible en la versión de App Store (sandbox). Solo funciona en 
builds de desarrollador fuera del App Store. Para la calidad que ofrece COLMAP, 
en la versión de App Store existe Workspace Import (Q3 o Q6): calcula el SfM en 
COLMAP o Metashape externamente y carga el resultado.
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Q3 — Formato de texto COLMAP (Metashape / ETH3D)

D Ó N D E

Menú «File → Import COLMAP / Metashape Works
pace…» (Cmd+⇧+I) O arrastrar y soltar una carpeta 
con sparse/​0/​cameras.txt.

T É C N I C O

Lee la exportación de texto COLMAP estanda
rizada — tres archivos de texto cameras.txt , 
images.txt , points3D.txt  en la subcarpeta 
sparse/​0/​ — y la convierte en el modelo interno 
de resultado de SfM. Misma definición de forma
to que la exportación binaria de COLMAP, solo 
que como ASCII en lugar de binario. Lo expor
tan Agisoft Metashape, RealityCapture, PolyCam y 
el benchmark ETH3D exactamente en este layout. 
El parser comparte la detección de modelo de 
cámara con el parser binario (todos los modelos 
comunes: SIMPLE_PINHOLE, PINHOLE, OPENCV, 
OPENCV_FISHEYE, FULL_OPENCV). Robusto frente 
a líneas de comentario y líneas vacías. Escala en las 
pruebas hasta ~1 400 cámaras (ETH3D Tunnel) sin 
problemas.

E N  P O CA S  PA L A B R A S

Si ya has trabajado con Metasha­
pe, RealityCapture u otro softwa­
re comercial de foto-3D y has 
exportado el resultado — puedes 
cargar esa exportación directa­
mente en RadianceKit, sin que 
la app tenga que recalcular. Esto 
ahorra horas de espera. Carga 
simplemente toda la carpeta me­
diante el menú File o arrástrala a 
la ventana.
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Q4 — Native SfM (incremental)

D Ó N D E

Expert View → Inspector → Configuración del entre
namiento → Selector Camera Alignment, entrada 
«Native (Beta)». Incremental es el modo predeter
minado de este backend — no hay un selector 
de mapper separado en el Inspector. Por CLI, 
el modo se puede establecer explícitamente con 
--native-sfm  o --sfm-mapper incremental.

T É C N I C O

Implementación propia acelerada por GPU 
de toda la pipeline de SfM: características 
FAST+BRIEF O SuperPoint+LightGlue vía CoreML 
(con --coreml-features ), seguidas de matching 
Hamming-KNN, matriz fundamental RANSAC, cons
trucción de tracks, selección del par inicial, two-
-view bootstrap (F→E más DLT), mapper incremen
tal greedy con registro PnP y triangulación multi-
-vista, y bundle adjustment final vía Levenberg-
Marquardt reducido por Schur con loss Huber y 
jacobianos analíticos a través de Cholesky solve. 
Totalmente compatible con App Store: sin binario 
externo, Sandbox=true. Con el detector de colapso 
R2 entregado en la Fase 3.10: si la app registra me
nos del 60 % de los fotogramas de entrada o la tasa 
de puntos por cámara cae por debajo de 13, conmu
ta automáticamente al mapper global (Q5). Empíri
camente limpio en escenas orbitales o de plato gira
torio; en movimientos más generales (vuelo de dron, 
espacios interiores con geometría compleja) la tasa 
de éxito es menor — pero el detector atrapa esos 
casos. Escala con fiabilidad hasta ~200 cámaras, 
más con un tiempo de ejecución claramente mayor.

E N  P O CA S  PA L A B R A S

Las virtudes de Apple (compati­
ble con App Store, rápido para 
órbitas) con valores de diagnós­
tico adicionales. Funciona espe­
cialmente bien cuando caminas 
alrededor de un motivo como en 
un Object Capture. Con tomas 
más complicadas (vuelo de dron 
o salón), RadianceKit detecta au­
tomáticamente que no va a salir 
bien y cambia al método global. 
Marcado como «Beta» porque 
aún está en pruebas — la reco­
mendación estándar sigue sien­
do Apple Photogrammetry para 
escaneos sencillos de objetos y 
Workspace Import (Q3 o Q6) para 
sets exteriores exigentes.
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Q5 — Native SfM (global)

D Ó N D E

Se llama automáticamente cuando el mapper incre
mental (Q4) dispara el detector de colapso (menos 
del 60 % de los fotogramas de entrada registrados 
o tasa de puntos por cámara por debajo de 13). 
Forzable manualmente solo vía CLI --sfm-mapper 
global. En el Inspector, el método global no es ac
cesible por un selector aparte — la app decide por 
sí misma cuándo conmutar.

T É C N I C O

Variante global de la pipeline nativa. Primero extrac
ción de características + matching como en Q4, 
después estimación de pose relativa para todos 
los pares verificados, seguido de rotation averaging 
(sincroniza todas las rotaciones de cámara en el 
sistema de coordenadas mundial) y translation ave
raging (basado en LSQR sobre una formulación 
sparse libre de matrices, para evitar overflow de en
teros con grandes cantidades de cámaras). Escala 
en principio a ~5 000 cámaras, en la práctica con 
calidad degradada por encima de unos pocos cien
tos — la medición de la puerta de aceptación de 
la Fase 3.8 §5 sobre K-1351 dio finalLoss 0.07 en 
lugar de los 0.0115 objetivo. Se trata como «fallback 
tier»: entra en juego cuando el mapper incremental 
degenera, pero no se reverifica en cuanto a calidad.

E N  P O CA S  PA L A B R A S

La vía plan-B para el motor na­
tivo. Se llama automáticamente 
cuando la vía incremental, más 
rápida, falla. Entrega un resulta­
do utilizable, pero con escenas 
muy grandes o difíciles normal­
mente no es tan precisa como lo 
que obtienes de Metashape o de 
una instalación externa de COL­
MAP. Si Native se convierte en tu 
flujo estándar, en esos casos vale 
la pena el rodeo por Workspace 
Import (Q3 o Q6).
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Q6 — Importación de workspace de texto Metashape / COLMAP (Fase 
Q7)

D Ó N D E

Menú File → «Import COLMAP / Metashape Works
pace…» (Cmd+⇧+I). Arrastrar y soltar una carpeta 
con sparse/​0/​cameras.{bin,txt} e images/​.

T É C N I C O

Detecta automáticamente si una carpeta seleccio
nada mediante arrastrar y soltar o panel de apertura 
coincide con uno de los tres layouts de workspace 
de COLMAP (sparse/​0/​, sparse/​ o raíz) y si la 
reconstrucción es binaria ( cameras.bin ) o texto 
( cameras.txt ). La vía binaria utiliza el parser bina
rio de COLMAP, la vía de texto el loader de ETH3D 
— ambas producen el mismo modelo de resultado 
de SfM y el resto de la pipeline (importar imáge
nes, iniciar entrenamiento MCMC) es agnóstica a la 
fuente. Las imágenes se abren mediante el sistema 
de bookmarks del sandbox de la app, con seguridad 
por ámbito, de modo que la importación también 
funciona en la versión de App Store. Pensado espe
cíficamente para el caso «exportación de Metasha
pe sin recalcular la reconstrucción». La detección 
mencionada en la entrada del menú File avisa en el 
registro de la app si la carpeta elegida no es un 
workspace reconocible.

E N  P O CA S  PA L A B R A S

Específicamente la función para 
usuarios de Metashape. Si tienes 
licencia de Metashape o Reality­
Capture e hiciste allí la recons­
trucción de cámara, puedes sim­
plemente arrastrar la carpeta de 
exportación aquí y empezar a en­
trenar de inmediato. Ahorra va­
rias horas de tiempo de cálculo 
en escenas grandes, porque Ra­
dianceKit no hace entonces el 
SfM por su cuenta.
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¿Qué backend en cada caso?

Escenario Backend recomendado

Escaneo de objeto, 50–
200 fotos

Q1 Apple Photogrammetry

Exteriores grandes / dron / 
>500 imágenes

Q6 Workspace Import (calcular en Metashape o COLMAP y 
luego cargar)

Exportación de Metasha
pe/RealityCapture disponi

ble

Q6 Import (sin SfM necesario)

Conjunto académico de 
texto COLMAP / ETH3D

Q3 importación de texto COLMAP

Estrictamente compatible 
con App Store + escena 

orbital

Q4 Native incremental

Q4 falla Q5 Native global (automático)

Datos de benchmark 
ETH3D

Q3 (autotest precomputado)
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Comparativa rápida

Bac­
kend

App Store Sand­
box

Binario externo Mejor 
uso

Máx. ~cá­
maras

Q1 Apple 
PG

✅ ✅ — Objeto or
bital

~300

Q2 COL
MAP bi

nario

❌ (solo 
build de de
sarrollador)

— colmap/glomap Exteriores 
grandes

~5 000

Q3 im
portación 
de texto 
COLMAP

✅ ✅ — Bench rigs ~1 500

Q4 Nati
ve incre
mental

✅ ✅ — Objeto or
bital

~200

Q5 Nati
ve global

✅ ✅ — Fallback 
de Q4

~1 351

Q6 
Works

pace Im
port

✅ ✅ — Reutilizar 
Metasha

pe

por fuente
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C A P Í T U L O

Capítulo 10 — Modo principiante

El Modo principiante (en alemán Einsteiger-Modus, Cmd+1) es el flujo guiado para todo 
el que reconstruye una escena de Gaussian Splatting 3D por primera vez. En lugar de 
mostrar una barra lateral llena de campos del Inspector, la app te guía por cuatro pasos: 
primero importar imágenes o un vídeo y elegir un ajuste preestablecido de calidad, 
después corre el procesado (SfM + Entrenamiento), a continuación la escena terminada 
se puede inspeccionar en una previsualización 3D, y finalmente se exporta al formato 
deseado. Una barra de progreso estrecha en el borde superior de la ventana siempre te 
muestra en qué paso estás.

Comparado con el Modo Experto (Cmd+2), que muestra todos los paneles de control a 
la vez, el Modo principiante oculta las opciones no usadas, da avisos de validación con 
pocas o malas imágenes y, en cada paso, solo ofrece los botones que tienen sentido en 
el estado actual. Puedes cambiar entre Modo principiante y Modo Experto en cualquier 
momento (Cmd+1 / Cmd+2); todo el estado — imágenes importadas, ajuste preestable
cido elegido, entrenamiento en curso, nube de puntos terminada — se conserva y está 
disponible al instante en el otro modo.
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Z1 — Importar (elegir imágenes y ajuste preestablecido)

Figura 35:  Modo principiante paso 1 — zona de drop vacía antes de la importación 
de imágenes, ruta de migas arriba (Import → Frame Quality → Cameras → Training → Pre

view → Export), insignias de formato JPG/PNG/TIFF/HEIC/MP4/MOV/PLY/SPZ/SPLAT/SCENE/
COLMAP

LO QUE SE VE EN LA IMAGEN  La ruta de migas (Import activo) muestra el flujo de cuatro 
pasos. Zona de drop a la izquierda con tres CTAs: «Browse Files» (NSOpenPanel), «Try 
Sample Scene» (demo empaquetada), «Download Sample Photos (~427 MB)» (sub
conjunto de flores Mip-NeRF360). Las insignias de formato debajo listan todos los tipos 
de archivo aceptados. A la derecha «Imported Files» con contador «0 images» y esta
do vacío «No files imported yet». Abajo, selector de Quality (predeterminado: Preview) 
y «Start Processing» (deshabilitado mientras no haya imágenes).

El primer paso consiste en darle material de imagen a la app. Mediante arrastrar y soltar 
al gran campo discontinuo del medio, mediante el botón «Browse Files» o haciendo 
clic en la escena de muestra empaquetada. A la derecha aparece una lista de todas las 
imágenes importadas con resolución y tamaño de archivo; debajo, en la barra de herra
mientas flotante, eliges el ajuste preestablecido de calidad y arrancas la pipeline con 
«Start Processing». Los avisos de validación (rojos con < 3 o < 10 imágenes, naranjas 
con 10–19) indican si la app espera una reconstrucción razonable o no.
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C-01 ProgressIndicator (indicador de paso)

D Ó N D E

Arriba sobre el flujo, siempre visible.

T É C N I C O

Muestra una barra de progreso horizontal a lo lar
go de toda la pipeline (Frame Quality → SfM → 
Training) con asignación de etapas: Frame Quality 
ocupa 0–5 % (Fase 3.11, muy corta), SfM ocupa 0–
30 % de la barra, Training 30–100 %. Junto a ella, 
texto de estado y visualización en porcentaje nom
brada por fase («SfM 41 %», «Training 12 500/20 
000»), para que los usuarios no lean la aparente 
regresión «41 % SfM → 25 % Training» como un 
error — la barra muestra el progreso global de la 
pipeline, no el de la subetapa. El cálculo de ETA 
arranca en cuanto se mide suficiente velocidad de 
entrenamiento (típicamente tras las primeras 100 
iteraciones). La misma visualización también se usa 
en el Modo Experto encima del Inspector.

E N  P O CA S  PA L A B R A S

La barra estrecha de arriba del 
todo es tu mapa a través del 
flujo. Te dice no solo qué está ha­
ciendo la app ahora mismo (ali­
neando cámaras, entrenamiento 
corriendo, …), sino también lo le­
jos que ha llegado en conjunto. 
La división es deliberada para 
que el cálculo de cámaras ocu­
pe el primer tercio de la barra 
y el entrenamiento propiamente 
dicho los dos tercios traseros — 
de otro modo parecería que el 
progreso de repente ha vuelto a 
cero tras el SfM. Así puedes re­
clinarte tranquilo, una mirada a 
la barra basta para ver la etapa 
aproximada. El texto al lado te 
dice si estás ahora en la etapa 
SfM (p. ej., «SfM 41 %») o en 
entrenamiento (p. ej., «Training 
12 500/20 000»), para que los 
números no parezcan confusos. 
Si no se muestra el ETA, el en­
trenamiento es simplemente aún 
demasiado joven — la app solo 
estima cuando ha medido sufi­
ciente velocidad.
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C-03 DropZoneView (área de arrastrar y soltar)

D Ó N D E

Lado izquierdo del paso Import, gran rectángulo 
discontinuo con símbolo. Se muestra en Modo prin
cipiante con la etiqueta «Drop photos or a video 
here».

T É C N I C O

Área de drop que rebota brevemente el símbolo y 
tiñe el fondo en cuanto los elementos arrastrados 
pasan sobre el campo. Acepta JPG, PNG, TIFF, 
HEIC, MP4, MOV, PLY, SPZ, .splat, paquetes .radian
cescene y directorios. Enrutado de drop por tipo: 
las imágenes se recopilan y se pasan ordenadas, 
los vídeos disparan la vía de frame-sampling, los ar
chivos splat abren la previsualización directamente, 
los paquetes de escena se leen. Los directorios se 
enumeran y se importan todas las imágenes conte
nidas. Los bookmarks security-scoped para acceso 
compatible con sandbox se adquieren y liberan 
correctamente. Las extensiones no soportadas se 
muestran como banner de aviso durante 5 segun
dos.

E N  P O CA S  PA L A B R A S

El gran campo discontinuo es el 
control principal del primer pa­
so. Solo arrastra ahí fotos o un 
vídeo, o toda una carpeta — la 
app coge todo lo que conoce y 
ignora el resto. Cuando el campo 
se vuelve azul y el símbolo rebota 
brevemente, la app ha reconoci­
do el arrastre. Suelta y la impor­
tación arranca de inmediato: las 
imágenes se mueven a la lista 
de la derecha, los vídeos dispa­
ran automáticamente el paso de 
frame-sampling, y los archivos 
.ply / .spz / .splat  ya en­

trenados abren la previsualiza­
ción directamente. Si un formato 
no encaja en absoluto (p. ej., PDF 
o BMP), aparece un breve aviso 
en el borde superior — la app no 
se traga en silencio material des­
conocido.

C-05 Botón Browse Files

D Ó N D E

Dentro de la zona de drop, botón prominente.

T É C N I C O

Botón que abre el diálogo de archivo de macOS con 
selección múltiple y los tipos de archivo JPG, PNG, 
TIFF, MP4, MOV, carpetas, así como el formato de 
escena propio de la app. Las URLs resultantes son 
security-scoped y se enrutan por las mismas vías 
de importación que arrastrar y soltar. Cuando el 
usuario selecciona una carpeta, se enumera recursi
vamente para imágenes.

E N  P O CA S  PA L A B R A S

Si arrastrar y soltar no te resulta 
cómodo, haz clic en este botón y 
navega en el diálogo de archivo 
de macOS a tus fotos. Puedes se­
leccionar varios archivos a la vez 
(Cmd-clic en las imágenes indivi­
duales) o seleccionar toda una 
carpeta — la app busca enton­
ces recursivamente en la carpeta 
todos los tipos de imagen so­
portados. Esto es especialmente 
práctico cuando tus grabaciones 
están anidadas en subcarpetas 
(p. ej., «shoot-day1/», «shoot-
-day2/») — un clic en la carpeta 
principal basta. Funcionalmente, 
el botón hace exactamente lo 
mismo que arrastrar y soltar; eli­
ge la vía que te resulte más có­
moda.
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C-06 Botón Try Sample Scene

D Ó N D E

Dentro de la zona de drop, solo visible cuando el 
bundle de la app contiene la escena de muestra y 
aún no se han importado imágenes/splats.

T É C N I C O

Solo aparece cuando (a) un sample-scene.splat , 
.spz  o .ply  está presente en el bundle de la 

app Y (b) no se han importado imágenes/vídeos y 
no hay nube de puntos. Al hacer clic, carga la nube 
de puntos terminada (prefiriendo el formato más 
pequeño — .splat  ~3 MB, .spz  ~1,4 MB, fallback 
.ply ) y, tras 400 ms, fija valores de cámara codifi

cados en duro a partir de los metadatos originales 
de la escena de flores para una perspectiva de en
trada estéticamente agradable.

E N  P O CA S  PA L A B R A S

Si abres la app por primera vez y 
solo quieres ver qué sale al final 
— haz clic aquí. Eso abre una es­
cena de flores ya entrenada que 
puedes rotar y exportar de inme­
diato, sin que la app tenga que 
calcular. La cámara está prefija­
da en una perspectiva de entrada 
estéticamente agradable, así que 
ves de inmediato algo bonito. 
Perfecto para probar los contro­
les 3D y el paso de exportación 
sin riesgo, antes de abordar tus 
propias grabaciones. En cuanto 
importas tus propias imágenes, 
el botón desaparece automática­
mente — solo se muestra mien­
tras el proyecto está completa­
mente vacío.

C-07 Botón Download Sample Photos

D Ó N D E

Dentro de la zona de drop, junto a «Try Sample 
Scene»; mismas condiciones de visibilidad.

T É C N I C O

Dispara una descarga (repo github.com/​bkindler/​
radiancekit-sample-photos) que carga aprox. 427 
MB de 960 fotogramas a resolución completa y 
los mete en la app. Durante la descarga, el botón 
se deshabilita. El progreso aparece en la barra de 
progreso superior como «Downloading X %» en su 
propia etapa, porque esa etapa mantiene su propia 
escala 0–100 % y no se solapa con la posterior 
etapa SfM.

E N  P O CA S  PA L A B R A S

Como la escena de muestra, solo 
que con las fotos fuente en lugar 
del resultado terminado. De este 
modo puedes dejar correr una 
vez toda la pipeline tú mismo y 
ver lo que tardan SfM y entre­
namiento realmente en tu Mac. 
La descarga es grande (aprox. 
medio DVD = 427 MB), pero solo 
ocurre una vez — después las fo­
tos están en local y puedes reini­
ciar la pipeline tantas veces co­
mo quieras con distintos ajustes 
preestablecidos. Mientras corre 
la descarga, la barra de progre­
so superior muestra el estado ac­
tual de descarga en porcentaje, 
para que estimes cuándo va a 
arrancar. Truco: usa una Wi-Fi rá­
pida o red por cable — los 427 
MB tardarán si no un rato.
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C-09 Selector Quality Presets

D Ó N D E

Barra de herramientas flotante inferior del overlay 
de importación, a la izquierda del botón Start.

T É C N I C O

Control con etiqueta «Quality» agrupa los ajustes 
preestablecidos disponibles por categoría (Classic / 
MCMC / Custom). Los ajustes integrados se agru
pan por categoría; las cabeceras de sección están 
codificadas en duro. Los ajustes custom solo visi
bles cuando existe alguno. Estado bloqueado: los 
ajustes que no están en la lista gratuita (Quick + 

Preview) reciben un sufijo «🔒» junto al nombre 
cuando el usuario no ha comprado; al seleccionar, 
el selector vuelve a Preview y abre automáticamen
te el sheet de compra. Al seleccionar, el ajuste se 
aplica, lo que reemplaza toda la configuración de 
entrenamiento.

E N  P O CA S  PA L A B R A S

Aquí eliges con qué precisión 
y cuánto debe calcular la app. 
«Quick» y «Preview» se pueden 
usar sin compra y entregan un 
resultado inicial en unos minu­
tos — ideal para probar si tus 
imágenes son razonables en ab­
soluto. «Balanced» y «Quality» 
necesitan la versión completa y 
entregan modelos notablemente 
más limpios, pero tardan horas 
en lugar de minutos. MCMC es 
una estrategia distinta que se las 
arregla con menos splats Gaus­
sianos — bueno si quieres expor­
tar el modelo de forma compacta 
después o ponerlo en la web. 
Reconoces los ajustes premium 
por el pequeño candado junto al 
nombre; si tocas uno sin licen­
cia, el selector vuelve a Preview 
y el sheet de compra se abre au­
tomáticamente. Regla práctica: 
empieza siempre con Preview, 
mira el resultado y después deci­
de si vale la pena un run más 
largo.

C-10 Botón Start Processing

D Ó N D E

Barra de herramientas flotante inferior del overlay 
de importación, a la derecha del selector de ajustes.

T É C N I C O

Botón que se mantiene atenuado mientras no se ha
yan importado imágenes ni un vídeo. Al hacer clic, 
arranca la pipeline y cambia la máquina de etapas 
en el orden Frame Quality → SfM → Training. El 
propio botón no tiene más estado; un procesado en 
curso aparece en su lugar como pantalla de proce
sado separada.

E N  P O CA S  PA L A B R A S

El botón «Vamos». Mientras es­
té atenuado, faltan imágenes de 
entrada o un vídeo. Una vez que 
has arrastrado fotos, se vuelve 
activo y haces clic para iniciar 
SfM y entrenamiento en secuen­
cia. A partir de ahí, la app se hace 
cargo de todo el flujo y aterrizas 
automáticamente en la pantalla 
de procesado (Z2). No tienes que 
hacer clic en nada más — solo 
tras el final del entrenamiento la 
app cambia de nuevo a la previ­
sualización (Z3). Si cambias de 
idea, también puedes cancelar 
en cualquier momento después 
con Cancel.
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C-11 Deslizador de muestreo de vídeo

D Ó N D E

Lista de imágenes a la derecha, visible solo cuando 
se ha importado un vídeo (en lugar de imágenes).

T É C N I C O

Deslizador 0,5 fps – 30 fps en pasos de 0,5. Al 
cambiar, la densidad de fotogramas se actualiza y, 
además, se calcula el número de fotogramas objeti
vo (al menos 10) a partir de densidad y duración del 
vídeo. El deslizador queda fuera de la lista de imá
genes, porque los ítems de lista bloquearían even
tos de ratón de los deslizadores. Bajo el deslizador 
se muestran los fotogramas objetivo calculados 
(«247 frames») y la duración del vídeo («1m23s 
video»). El tooltip avisa: «Doubling the density dou
bles the number of frames and increases SfM time 
by ~100%.»

E N  P O CA S  PA L A B R A S

Si has importado un vídeo en 
lugar de fotos, este deslizador 
decide cuántas imágenes indivi­
duales debe extraer la app del ví­
deo. Más imágenes = mejor cali­
dad, pero linealmente más tiem­
po de cálculo. Para un vídeo orbi­
tal de 30 segundos, 5 fps (150 
imágenes) es un buen comienzo; 
para grabaciones de 1 minuto, 
3 fps suele ser totalmente sufi­
ciente. Bajo el deslizador, la app 
muestra en vivo cuántos fotogra­
mas resultan con el ajuste actual 
— así ves de inmediato si das 
en el rango razonable de unas 
100–300 imágenes. Si el resulta­
do queda pobre, mueve el desli­
zador a la derecha e inténtalo 
de nuevo; pero duplicar la fre­
cuencia de fotogramas también 
dobla aproximadamente la dura­
ción del SfM.

C-12 Botón Clear All

D Ó N D E

Lista de imágenes a la derecha, abajo a la derecha; 
visible solo cuando se han importado imágenes.

T É C N I C O

Botón rojo. El clic abre un diálogo de confirmación 
con título «Clear all imported files?» y mensaje «N 
images will be removed.». La confirmación borra 
todas las imágenes/vídeos importados, los directo
rios de staging, la nube de puntos, el estado de 
entrenamiento, el resultado de SfM y todos los ca
chés; la etapa salta de vuelta a Import. En Cancel, 
todo se conserva. El diálogo se configura como vía 
predeterminada no destructiva (botón destructivo 
marcado en rojo).

E N  P O CA S  PA L A B R A S

Si quieres empezar de cero del 
todo, haz clic aquí. El aviso de 
confirmación aparece porque el 
borrado descarta todas las im­
portaciones actuales, incluidas 
cualquier cámara ya calculada y 
resultados de entrenamiento — 
no puedes deshacerlo. Útil cuan­
do quieres reemplazar por com­
pleto el material de imagen elegi­
do o deshacerte de un proyecto 
viejo antes de iniciar uno nuevo. 
Nota: eliminar una sola imagen 
se hace desde la lista de la dere­
cha (véase el siguiente ítem), no 
con este botón. Tus archivos en 
disco no se borran en el proceso 
— la app solo olvida sus referen­
cias.
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C-13 Lista de archivos ForEach (eliminación individual de imagen)

D Ó N D E

Lista de imágenes a la derecha, cada entrada.

T É C N I C O

Lista sobre las imágenes importadas con swipe-to-
-delete. Por imagen una fila con icono, nombre de 
archivo, resolución («1920 × 1080») y tamaño de 
archivo (formateado KB/MB). La resolución viene de 
una caché de metadatos rellenada de forma asín
crona desde las cabeceras de imagen, para que 
la UI no bloquee. La acción de borrado ofrece el 
borrado por swipe típico de macOS (swipe a la 
izquierda en una fila con trackpad), así como borra
do por teclado para la fila seleccionada. Nota: la 
vía extendida de borrado de imagen con botón me
nos explícito, backspace y Cmd-Z para deshacer se 
añadió solo en Modo Experto en el Project Naviga
tor — en Modo principiante se queda con el borrado 
por swipe.

E N  P O CA S  PA L A B R A S

La lista de la derecha muestra 
cada imagen importada con re­
solución y tamaño de archivo — 
práctico para ver de un vistazo 
si has mezclado material de alta 
y baja resolución. Para eliminar 
una sola imagen, deslízala con 
dos dedos hacia la izquierda en 
el trackpad — como en Mail de 
iOS — o selecciónala y pulsa Su­
primir. La app no elimina el archi­
vo en sí; solo lo saca del proyecto 
actual. Si necesitas un botón me­
nos en condiciones o deshacer 
con Cmd-Z, pasa al Modo Experto 
(Cmd+2), allí existe en el Project 
Navigator. En Modo principiante 
se queda deliberadamente con el 
patrón simple de swipe.
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C-15 Avisos de validación (3 niveles)

D Ó N D E

Bajo la lista de imágenes, sobre el botón Clear All.

T É C N I C O

Tres umbrales sucesivos basados en el número de 
imágenes importadas (solo activos cuando hay imá
genes y no vídeo): - < 3 imágenes: banner rojo 
(octógono rojo), texto «At least 3 images are requi
red. Camera alignment cannot be computed from 
fewer images.» - 3–9 imágenes: banner rojo, texto 
«With fewer than 10 images, SfM often fails and the 
trained scene tends to overfit […]. 15–20 images 
minimum recommended; 30+ for object captures.» 
- 10–19 imágenes: banner naranja (triángulo de avi
so), texto «Workable, but quality usually improves 
with 20+ images and good coverage around the 
scene.»

A partir de 20 imágenes el banner desaparece. Los 
umbrales están codificados en duro y se basan en 
más de 560 experimentos de entrenamiento empíri
cos.

E N  P O CA S  PA L A B R A S

La app mira cuántas imágenes 
has importado y te da una va­
loración codificada por colores. 
Rojo significa: es muy proba­
ble que esto falle — o SfM 
no puede calcular cámaras o 
el entrenamiento sobreajusta so­
bre muy poco material. Naranja 
significa: podría funcionar, pero 
no esperes calidad sobresalien­
te, porque el algoritmo encuen­
tra poco solapamiento entre las 
imágenes. Sin banner significa: 
buenas condiciones, tienes sufi­
ciente material. Si quieres real­
mente modelos limpios, apunta a 
al menos 30–50 tomas uniforme­
mente distribuidas alrededor de 
tu motivo — también con gusto 
bastantes más para escenas ex­
teriores o salas grandes. Puedes 
empezar a pesar del aviso, pero 
no te sorprendas si SfM aborta 
sin comentarios o el modelo se 
ve agujereado.
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C-16 Detección de workspace COLMAP

D Ó N D E

Al soltar una carpeta — no un botón visible, sino 
lógica de detección.

T É C N I C O

Al soltar un directorio se comprueba si contiene uno 
de los tres layouts canónicos de workspace: sparse/​
0/​cameras.bin, sparse/​cameras.bin o directamente 
cameras.bin  en la raíz. Si es así, la enumeración 

estándar de imágenes se aborta y en su lugar 
se abre un alert modal preguntando al usuario si 
se debe usar la reconstrucción existente o si las 
imágenes deben pasarse de nuevo por Apple Pho
togrammetry. Misma vía también para workspaces 
en formato de texto (cameras.txt) y exportaciones 
ETH3D. Véase el backend Q6 del Capítulo 9 para 
detalles. Funciona en Modo principiante igual que 
en Modo Experto.

E N  P O CA S  PA L A B R A S

Si ya has trabajado con Me­
tashape, RealityCapture o COL­
MAP y has hecho ahí el cálculo 
de cámaras, puedes simplemen­
te arrastrar la carpeta de ex­
portación aquí. RadianceKit de­
tecta automáticamente por el 
contenido que es un workspa­
ce COLMAP (comprueba sparse/​
0/​, cameras.bin  y similares) 
y te pregunta si debe asumir 
el cálculo terminado o calcular­
lo por sí mismo. Asumirlo aho­
rra horas de espera en escenas 
grandes, porque SfM se omite 
por completo — el entrenamien­
to arranca de inmediato. Los 
workspaces en formato de texto 
(cameras.txt) y las exportaciones 
ETH3D también se detectan. Esta 
función está disponible en Modo 
principiante igual que en Modo 
Experto; más detalles están en el 
Capítulo 9 bajo el backend Q6.

¿Cuándo pasar a la siguiente etapa?

Puedes hacer clic en Start Processing en cuanto (a) se haya importado al menos una 
imagen o un vídeo y (b) el banner de validación esté en naranja o haya desaparecido. 
Con un banner rojo, la app sí te deja arrancar, pero con alta probabilidad podrás 
cancelar el procesado de inmediato. Recomendado: al menos 20 imágenes, nítidas, con 
solapamiento claro entre tomas consecutivas, todas aproximadamente desde la misma 
distancia al motivo. Elige un ajuste preestablecido antes de empezar que encaje con 
tu presupuesto de tiempo — con 30 imágenes y el ajuste Quick estás listo en unos 
minutos, con Quality dura más bien 1–2 horas.
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Z2 — Procesado (SfM + Entrenamiento)

Figura 36:  Z2 fase SfM — icono de etapa «Structure from Motion» con 41 % en el círculo 
grande, barra de estado superior en «SfM 25 %», botón Cancel abajo a la derecha

Fase SfM (se están alineando las cámaras): El gran círculo de progreso muestra el 
progreso de la subetapa (aquí 41 % de la sesión Apple Photogrammetry en curso). 
Texto de estado «Aligning cameras…» arriba a la izquierda. La ruta de migas marca 
«Cameras» como etapa activa. La barra de estado superior muestra el progreso global 
de la pipeline (25 %) — SfM ocupa la primera mitad de la barra. Cámaras de wireframe 
flotantes en el fondo sugieren que se están estimando poses.

Figura 37:  Z2 fase de entrenamiento — icono de etapa «Training Gaussians» al 6 %, métri
cas en vivo arriba (Training: 400/5000 — Loss: 0,1642 — 138,7 it/s), ETA 33 s, Pause/Cancel 

abajo

Fase de entrenamiento (se están optimizando los Gaussianos): El icono de subeta
pa cambia a «Training Gaussians», el porcentaje cuenta iteraciones del ajuste preesta
blecido elegido (aquí 400 / 5 000 para el ajuste Preview, es decir, 8 % de la etapa). 
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La línea de métricas en vivo muestra el valor de loss (0,1642), iteraciones por segundo 
(138,7 it/s) y ETA (33 s). El progreso global de la pipeline sube del 50 % al 100 % 
durante esta fase. El botón Pause (en lugar de solo cancel en la fase SfM) permite 
reanudar después; Cancel descarta el resultado del entrenamiento y vuelve a Z1.

En cuanto corre la pipeline, la app oculta el overlay de importación y muestra una pan
talla de procesado a pantalla completa. En el medio corre un gran círculo de progreso 
(220 × 220 píxeles) con icono de etapa, texto de estado y número de porcentaje; en el 
fondo, una animación sutil de splats visualiza simbólicamente el cálculo en curso. Arriba 
a la izquierda se puede mostrar un panel de info que muestra métricas en vivo de entre
namiento y SfM. Abajo hay Pause/Resume, Cancel y, en caso de error, un botón Retry.

C-18 SplatTrainingView (animación de fondo)

D Ó N D E

Fondo a pantalla completa tras el círculo de progre
so, oculto al cancelar o en error.

T É C N I C O

Animación decorativa que, según el progreso de la 
pipeline (0…1), renderiza un número creciente de 
pequeñas partículas splat animadas. La fuente es 
un valor de progreso calculado que mapea las fases 
SfM a 0–0,2 y el entrenamiento a 0,2–1,0 (Frame 
Quality a 0–0,05). De este modo los splats visible
mente «se construyen» mientras corre el entrena
miento. Puramente decorativo — la visualización no 
muestra resultados intermedios reales del entrena
miento actual (eso sería la live preview en Modo 
Experto). En cancel o fallo se oculta y solo se man
tiene visible el círculo de estado.

E N  P O CA S  PA L A B R A S

En el fondo corre una pequeña 
animación de puntos danzantes, 
para que la pantalla no parezca 
tan vacía durante el cálculo. Este 
no es tu modelo 3D real — eso 
solo lo ves tras el entrenamien­
to en el paso Z3. La animación, 
sin embargo, tiene la misma to­
nalidad, así que puedes leer por 
la densidad aproximada lo lejos 
que ha llegado el entrenamiento. 
Al principio solo unos pocos pun­
tos son visibles, hacia el final 
el fondo se rellena bastante más 
densamente — un bonito indica­
dor visual además de la visuali­
zación en porcentaje del círculo. 
Si la animación te molesta (p. ej., 
porque quieres trabajar al lado 
en segundo plano), puedes pasar 
al Modo Experto, donde se omite.
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C-19 Gran círculo de progreso

D Ó N D E

Centro de la pantalla de procesado, 220 × 220 píxe
les.

T É C N I C O

Dos anillos renderizados uno sobre otro: por fuera 
un anillo de pista atenuado, por dentro un anillo de 
progreso relleno con stroke de acento o rojo (rojo 
en error). Dentro del círculo, un icono de etapa (ce
rebro para entrenamiento, cámara para SfM, pelícu
la para extracción de fotogramas de vídeo, destellos 
para Frame Quality), título de etapa y el número de 
porcentaje animado en vivo en fuente redondeada 
de 32 puntos. El icono pulsa suavemente mientras 
el procesado está activo. La visualización interpola 
en un timer de 30 Hz de forma suave hacia el 
progreso real actual — con un «creep» constante 
(0,0003/frame) más un share proporcional (4 % del 
gap) y un techo suave que se fija al 80 % del 
siguiente hito esperado (para SfM a partir de una 
tabla de hitos codificada). De este modo el progreso 
se siente fluido, incluso si las actualizaciones SfM 
reales solo llegan cada pocos segundos.

E N  P O CA S  PA L A B R A S

El gran círculo en el medio es 
tu visualización principal mien­
tras la app calcula. Se rellena 
con suavidad, incluso cuando las 
actualizaciones de cálculo reales 
solo llegan cada pocos segundos 
— esto te da la sensación de 
que algo está pasando, en lugar 
de mirar un porcentaje conge­
lado durante minutos. El símbo­
lo del medio cambia según si 
se están extrayendo fotogramas 
(icono de película), se están ali­
neando cámaras (icono de cáma­
ra) o se están entrenando Gaus­
sianos (icono de cerebro). El nú­
mero de porcentaje se refiere al 
sub-paso actual — ves la pipeli­
ne global en la barra estrecha de 
arriba del todo. En error, el anillo 
se vuelve rojo en lugar de azul, y 
el icono ya no pulsa, así notas de 
inmediato que algo ha ido mal.
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C-22 Botón Info (mostrar métricas)

D Ó N D E

Arriba a la izquierda en la pantalla de procesado, 32 
× 32 píxeles.

T É C N I C O

Botón simple con fondo material. Conmuta el panel 
de info on/off. El icono cambia entre info-circle 
outline e info-circle filled cuando está activo. Ani
mación de fade-in suave. Tooltip «Show detailed 
processing metrics».

E N  P O CA S  PA L A B R A S

Por defecto, la pantalla está deli­
beradamente ordenada — solo el 
gran círculo de progreso, no ves 
más al principio. Si como usuario 
técnicamente interesado quieres 
saber con más precisión qué es­
tá pasando (qué iteración, lo alto 
que es el loss, cuántos Gaussia­
nos), haz clic en el símbolo i 
arriba a la izquierda. Un pequeño 
panel se despliega abajo y mues­
tra todos los valores en vivo. Un 
nuevo clic lo oculta de nuevo. El 
ajuste no es persistente — en ca­
da nuevo run de entrenamiento 
el panel está inicialmente oculto 
de nuevo, lo que se elige delibe­
radamente para no asustar a los 
principiantes.

C-23 Panel de info (métricas en vivo)

D Ó N D E

Abajo a la izquierda en la pantalla de procesado, 
visible solo cuando showProcessingInfo == true.

T É C N I C O

Panel de dos columnas con fondo material ultradel
gado. Columna izquierda: líneas de info específicas 
de etapa — para SfM, texto de estado y porcentaje; 
para entrenamiento, iteración, loss combinado, loss 
L1, loss D-SSIM, número de Gaussianos (coloreado 
en naranja), velocidad (it/s), tiempo transcurrido, 
ETA calculado, grado SH y learning rate. Columna 
derecha: texto de estado, string de info de tiempo, 
gráfico de loss inline (véase C-28) y un discoverabi
lity nudge (véase C-32). Todos los valores se leen 
del estado de entrenamiento, que se actualiza en 
cada tick de entrenamiento.

E N  P O CA S  PA L A B R A S

El panel de info muestra todos 
los valores en vivo que en Mo­
do Experto estarían permanente­
mente en la barra lateral del 
Inspector: iteración actual, valor 
de loss (menor: mejor), número 
de Gaussianos, velocidad, tiempo 
restante estimado, grado SH y 
learning rate. En el lado derecho 
corre además una curva de loss 
diminuta, que te dice de un vista­
zo si el entrenamiento va en la 
dirección correcta. Si el entrena­
miento parece perezoso, una mi­
rada aquí ayuda — un loss que 
ya no cae, o un ETA que ya no dis­
minuye, indican problemas. Si el 
loss explota (de repente se hace 
enorme) o muestra NaN, el entre­
namiento se ha vuelto inestable 
y un Cancel + Retry o cambiar a 
un ajuste preestablecido distinto 
es sensato.
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C-25 Botón Pause/Resume

D Ó N D E

Barra de navegación inferior, visible solo durante la 
etapa de entrenamiento (NO durante SfM) y mien
tras corre el procesado.

T É C N I C O

Botón con borde. Llama a Pause o Resume según 
el estado. La etiqueta cambia entre «Pause» (con 
icono de pausa) y «Resume» (icono de play). Du
rante el paso SfM el botón no se muestra, porque 
Apple Photogrammetry no tiene semántica de pau
sa. El estado de pausa preserva por completo la 
iteración, el estado de Gaussianos y el momentum 
del optimizador — Resume continúa donde se detu
vo previamente.

E N  P O CA S  PA L A B R A S

Mientras corre el entrenamiento, 
puedes detenerlo en cualquier 
momento y reanudar después. 
Útil cuando quieres hacer otra 
cosa en el Mac mientras tanto 
que necesita mucha GPU — p. ej., 
edición de vídeo, prueba de jue­
gos o una exportación de render 
desde otra app. Haz clic en Pau­
se, haz tu cosa, haz clic en Re­
sume, el entrenamiento continúa 
exactamente donde estaba. Con­
tador de iteración, número de 
Gaussianos y momentum del op­
timizador se preservan por com­
pleto, el estado de pausa no te 
cuesta calidad. Durante la fase 
SfM, Pause no está disponible — 
Apple Photogrammetry no tiene 
función de parada, en una emer­
gencia ahí tienes que trabajar 
con Cancel.

C-26 Botón Cancel

D Ó N D E

Barra de navegación inferior, visible mientras corre 
el procesado (SfM o entrenamiento).

T É C N I C O

Botón rojo con borde. Abre un diálogo de confir
mación con título «Stop and discard progress?», 
botones «Discard Progress» (destructivo) y «Keep 
Running» (cancel). En la confirmación se fija la can
cel flag, se termina la tarea de entrenamiento, se 
termina el subproceso SfM si procede, y se escribe 
una línea de resumen con estado de cancelación en 
el log JSONL. A diferencia de Pause, los buffers y el 
estado de entrenamiento se descartan.

E N  P O CA S  PA L A B R A S

El botón de cancelar. A diferen­
cia de Pause, esto es final — si 
quieres reiniciar después, el pro­
cesado corre desde el principio, 
todas las iteraciones ya entrena­
das se pierden. Útil cuando te 
equivocaste con el ajuste prees­
tablecido, el entrenamiento corre 
muchísimo más despacio, o la 
app está produciendo obviamen­
te resultados basura y no quieres 
esperar. Antes del cancel real, la 
app pregunta de nuevo mediante 
un diálogo de confirmación, para 
que no pierdas accidentalmente 
horas de tiempo de cálculo. Si 
solo quieres interrumpir breve­
mente, mejor toma Pause.
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C-27 Botón Retry

D Ó N D E

Barra de navegación inferior, visible cuando la pipe
line ha fallado (el estado SfM empieza con «SfM 
failed» o el entrenamiento está en estado de error).

T É C N I C O

Botón de acento. Reinicia toda la pipeline. Antes 
de arrancar se comprueba si aún están presentes 
las imágenes/vídeos importados. Los logs de error 
anteriores se mantienen en el directorio JSONL; un 
nuevo run escribe un nuevo archivo de log con la 
marca de tiempo actual.

E N  P O CA S  PA L A B R A S

Si SfM o entrenamiento aborta 
con un mensaje de error, puedes 
intentarlo de nuevo aquí. A veces 
eso ayuda, porque muchos pasos 
(RANSAC, densificación) tienen 
componentes aleatorios y un se­
gundo intento puede tener éxito 
donde el primero falló. Toda la 
pipeline corre entonces de nuevo 
desde el principio — SfM y entre­
namiento, en un nuevo archivo 
de log JSONL. Si también el se­
gundo intento falla, normalmen­
te las imágenes de entrada son el 
problema (muy pocas, muy poco 
solapamiento, motion blur, mala 
luz); entonces vuelve atrás con 
Back y cambia tu material. Truco: 
mira en paralelo en los training 
logs (Help → Open Training Logs), 
allí dice con más detalle dónde 
exactamente se atascó.
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C-28 Gráfico de loss inline

D Ó N D E

En el panel de info, columna derecha, visible solo 
durante el entrenamiento con historial no vacío.

T É C N I C O

Área de dibujo compacta (40 píxeles de alto), dibuja 
el historial de loss como línea de 1 píxel en color de 
acento. Los datos se filtran a valores finitos (protec
ción NaN para entrenamientos inestables). Min/Max 
se calculan sobre todo el historial — el gráfico hace 
así auto-zoom al rango de valores. El último valor de 
loss queda arriba a la derecha sobre el gráfico. El 
propio historial se construye en el estado de la app 
en cada tick de entrenamiento (típicamente cada 
100 iteraciones).

E N  P O CA S  PA L A B R A S

Una curva de loss diminuta que 
te muestra de un vistazo si 
el entrenamiento está «conver­
giendo» (la línea cae a la dere­
cha) o si está estancado o explo­
tando (línea plana o en subida). 
Con un entrenamiento sano, la lí­
nea cae con fuerza al principio y 
luego se aplana — ese es el cur­
so esperado, similar a una curva 
de bajada a la mitad. El gráfi­
co hace auto-zoom al rango de 
valores actual, así que también 
las pequeñas mejoras al final del 
entrenamiento permanecen visi­
bles. Si la línea de repente dispa­
ra hacia arriba o se congela, es 
una buena señal de que algo va 
mal — o el material es problemá­
tico o un ajuste preestablecido 
distinto sería más adecuado. El 
gráfico lo encuentras en el panel 
de info, que muestras arriba a la 
izquierda con el símbolo i.
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C-32 Discoverability nudge (pista del Modo Experto)

D Ó N D E

En el panel de info, columna derecha abajo, visible 
solo durante el entrenamiento Y en Modo princi
piante.

T É C N I C O

Línea pequeña con icono de ojo y texto de caption 
«Switch to Expert Mode (⌘2) for live splat pre
view», en tono discreto y fuente de 10 puntos. Sin 
elemento interactivo, solo una pista. No reacciona al 
clic — el usuario tiene que pulsar realmente Cmd+2 
o hacer clic en el menú Mode → Expert Mode.

E N  P O CA S  PA L A B R A S

Una pista sutil de que en Modo 
Experto durante el entrenamien­
to la versión intermedia actual de 
tu modelo 3D es visible en vivo 
en la vista. En Modo principiante 
esto se oculta deliberadamente 
para mantener la UI tranquila — 
pero muchos usuarios ni siquiera 
saben que esta función existe, 
así que aquí lo señalamos con 
suavidad. Pulsa Cmd+2 y el en­
trenamiento continúa en segun­
do plano mientras puedes mirar 
cómo tu modelo se va formando 
ante tus ojos. Esta también es 
una buena herramienta para es­
timar ya tras unas pocas miles 
de iteraciones si el resultado va 
a ser bueno, o si más bien prefie­
res cancelar y empezar de cero. 
Cmd+1 te trae de vuelta a la vista 
Simple en cualquier momento.

¿Cuándo pasar a la siguiente etapa?

La app cambia automáticamente a Z3 (Preview) en cuanto el entrenamiento se com
pleta con éxito — no tienes que hacer clic. La barra de navegación inferior cambia 
entonces de Pause/Cancel a un botón Back (atrás a Import) y un botón Export (adelante 
a Export). En casos de error (mensaje de error rojo, el icono de etapa es una X) aparece 
Retry en su lugar, y tienes que decidir si arrancar de nuevo o ir atrás a Import con Back 
para cambiar material de imagen.
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Z3 — Previsualización (rotar modelo 3D)

Figura 38:  Paso de previsualización del Modo principiante con visor 3D

Figura 39:  Z3 previsualización tras completarse el entrenamiento — ramo Blender recons
truido, la cabecera muestra «Training complete — 3.022 Gaussians in 13s», botones Back y 

Export abajo

LO QUE SE VE EN LA IMAGEN  La ruta de migas marca «Preview» como etapa activa. La 
vista 3D a pantalla completa renderiza la escena de ramo ya entrenada (conjunto de 
prueba sintético en Blender, subconjunto de 60 frames de 960 cámaras hemisféricas). 
Barra de estado de cabecera: «Training complete — 3 022 Gaussians in 13 s» — da el 
número final de Gaussianos y el tiempo de entrenamiento. Arrastrar en la vista rota la 
cámara (yaw/pitch); la rueda de scroll hace zoom a lo largo de la dirección de visión. 
El botón «Back» (abajo a la izquierda) vuelve a Z2 para reanudar o re-run; el botón 
«Export» (abajo a la derecha, primario) navega adelante a Z4.

Tras completarse el entrenamiento, la app aterriza automáticamente en la previsualiza
ción. Aquí ves tu modelo Gaussian Splatting terminado en una vista Metal a pantalla 
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completa y puedes rotarlo, hacer zoom y desplazarlo con ratón y trackpad. Sobre 
la vista hay un pequeño overlay con controles de cámara e info — auto-rotación, 
estadísticas de entrenamiento, botón de reset. Antes del siguiente paso (Export) es 
recomendable inspeccionar el modelo desde distintos ángulos para asegurarte de que 
la reconstrucción está limpia.

C-36 SplatViewportView (vista principal 3D)

D Ó N D E

Fondo a pantalla completa del paso de previsualiza
ción.

T É C N I C O

Vista 3D basada en Metal que renderiza la nube de 
puntos terminada. El renderer es el propio rasteriza
dor ForwardPass de RadianceKit — el mismo que ya 
renderiza los splats durante el entrenamiento — así 
que es verdadero WYSIWYG (lo que se entrena se 
muestra y se exporta exactamente igual). Pipeline 
de renderizado basado en tiles con transparencia 
independiente del orden. Si el renderer no puede 
inicializarse (p. ej., porque Metal no está disponible 
en el sistema), aparece en su lugar un fondo negro 
con texto «Metal not available». La vista ignora el 
safe area, para que el modelo llegue al borde de la 
ventana.

E N  P O CA S  PA L A B R A S

La vista principal. Aquí ves tu 
modelo 3D terminado reconstrui­
do de tus fotos, renderizado en 
la GPU en tiempo real. Haz clic 
y arrastra con el botón izquierdo 
del ratón para rotar. Rueda de 
scroll o gesto de trackpad con 
dos dedos para zoom. Botón de­
recho o Cmd+arrastrar para ha­
cer pan. El modelo consiste en 
decenas de miles de elipsoides 
3D semitransparentes («Gaus­
sianos») que reconstruyen tu es­
cena de forma fotorrealista — 
cada uno tiene una posición, 
orientación, forma y color que el 
entrenamiento ha aprendido. En 
el raro caso de que tu Mac no 
soporte Metal, ves en su lugar 
un fondo negro con un mensaje 
de aviso — RadianceKit necesita 
absolutamente una GPU capaz de 
Metal.
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C-37 CameraControlsOverlay (overlay de controles)

D Ó N D E

Sobre la vista, flotante.

T É C N I C O

Overlay UI compacto con botones para auto-rota
ción (turntable), reset de cámara, elección de fondo 
(gris/negro/blanco), guardar captura, toggle del pa
nel de info. Vincula a los parámetros de cámara 
(distancia, azimut, elevación, target, FOV) y controla 
el auto-turntable. Durante el entrenamiento (cuando 
el usuario en Modo Experto quiere ver la vista co
rriendo en paralelo), el overlay muestra además una 
línea compacta de estado de entrenamiento.

E N  P O CA S  PA L A B R A S

La pequeña barra flotante sobre 
el modelo. Aquí inicias la auto-
-rotación (el modelo rota por sí 
mismo, bueno para capturas y 
demos cortas), reseteas la cá­
mara con Reset a la posición 
inicial (por si te pierdes), cam­
bias el fondo (gris para neutro, 
negro para máximo contraste, 
blanco para modelos brillantes) 
y haces capturas directamente 
que se guardan bajo  /Pictures. 
Práctico cuando quieres mostrar 
un determinado detalle desde un 
ángulo muy específico sin tener 
que exportar adicionalmente to­
do el modelo. La auto-rotación 
también es una buena prueba de 
si el modelo se ve igual de bien 
por todos los lados o si hay un 
«lado deslucido» que surgió por 
tomas que faltan.

C-38 Botón Export (barra de navegación)

D Ó N D E

Barra de navegación inferior en Z3.

T É C N I C O

Botón de acento con etiqueta «Export» e icono de 
share. El clic dispara el cambio a Z4. Antes, la 
vista padre comprueba si la versión completa está 
desbloqueada — si no, en lugar de la etapa de ex
portación se muestra la vista de lock (véase U-06).

E N  P O CA S  PA L A B R A S

Cuando estás contento con el re­
sultado, haz clic en Export y ate­
rrizas en el último paso, donde 
eliges el formato y guardas. Sin 
una versión completa comprada, 
aterrizas en su lugar en un blo­
queo de pantalla con una pista 
de desbloqueo y un botón de 
compra — la app no quiere em­
pujarte la versión completa, pero 
Export es una de las funciones 
premium. Una vez completada 
la compra, la app sigue directa­
mente en estado desbloqueado y 
aterrizas en la etapa de exporta­
ción familiar. Si cambias de idea, 
vuelves a la previsualización con 
el botón Back y puedes seguir ro­
tando el modelo.
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¿Cuándo pasar a la siguiente etapa?

Antes de exportar, rota el modelo una vez por completo y comprueba: ¿Están presentes 
todas las áreas que cubriste en tus imágenes de entrada? ¿Hay «floaters» flotantes 
(nubes de splat Gaussianos flotando libremente en el aire)? ¿Se ve el fondo/cielo limpio 
o emborronado? Los problemas graves solo se pueden corregir reentrenando — ya sea 
con más imágenes, un ajuste preestablecido distinto, o en Modo Experto con ajustes de 
reducción de floaters.

Z4 — Exportar (elegir formato y guardar)

Figura 40:  Paso de exportación del Modo principiante con tarjetas de formato

Figura 41:  Z4 tarjetas de exportación — 6 formatos (PLY 742 KB seleccionado, SPZ 74 KB, 
glTF 708 KB, .splat 96 KB, Orbit Video, Web Viewer 133 KB), barra lateral de historial de 

exportación a la derecha con PLY ya exportado
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LO QUE SE VE EN LA IMAGEN  La ruta de migas marca «Export» como etapa activa. Cuadrí
cula de tarjetas a la izquierda «Choose Export Format» con las seis opciones: PLY 
(estándar 3DGS, 742 KB, con coeficientes SH completos — preseleccionado aquí con 
check azul), SPZ (formato 3DGS comprimido, ~90 % más pequeño que PLY, 74 KB), 
glTF (con extensión KHR_​gaussian_​splatting, 708 KB), .splat (compatible con visor web 
vía antimatter15, 96 KB), Orbit Video (MP4 360° de la escena, cálculo de tamaño en 
vivo), Web Viewer (HTML autónomo con visor 3D embebido, 133 KB). Las cifras de 
tamaño se calculan en vivo a partir del número actual de Gaussianos y el overhead 
del formato. A la derecha, «Export History» lista las exportaciones ya completadas con 
insignia de formato, nombre de archivo y marca de tiempo — el clic revela en Finder. 
CTA primaria abajo a la izquierda: «Export PLY (3DGS Standard)» con subtítulo de 
Gaussianos «2.991 Gaussians · SH degree 3».

En el último paso eliges entre 6 formatos de exportación (PLY, SPZ, glTF, .splat, vídeo 
orbital, visor web) mediante una cuadrícula de tarjetas de 2 columnas, haces clic en 
Export y eliges el destino en el diálogo de macOS. A la derecha corre un historial de 
todas las exportaciones previas — al seleccionar tarjeta se muestra de inmediato bajo 
cada una el tamaño de archivo estimado, así p. ej. prefieres SPZ si quieres ir a la web 
(pequeño), y PLY si quieres importar a otro software (SuperSplat, Postshot, Blender vía 
plugin) (grande y completo).

C-39 Cuadrícula de formatos de 2 columnas

D Ó N D E

Lado principal izquierdo del paso de exportación.

T É C N I C O

Cuadrícula de tarjetas con dos columnas flexibles 
y 12 puntos de espaciado. Itera sobre los formatos 
ofrecidos en Modo principiante — un subconjun
to filtrado de la lista completa de formatos que 
contiene solo los 6 más importantes: PLY, SPZ, 
glTF, .splat, vídeo orbital, visor web. Compressed 
PLY y SOG se ofrecen SOLO en Modo Experto.

E N  P O CA S  PA L A B R A S

Una cuadrícula de tarjetas con 
los 6 formatos que son relevan­
tes en Modo principiante: PLY 
(formato estándar para otras he­
rramientas 3D), SPZ (variante 
comprimida para web), glTF (es­
tándar oficial Web3D), .splat (pa­
ra el visor web antimatter15), ví­
deo orbital (MP4 terminado para 
presumir) y Web Viewer (archivo 
HTML autónomo con reproductor 
3D embebido). Así cubres el 90 % 
de los casos de uso. Si necesitas 
uno de los formatos menos ha­
bituales (PLY comprimido o SOG 
para compresión extrema), pasa 
al Modo Experto, allí están dispo­
nibles los 8 formatos. La selec­
ción compacta aquí es delibera­
da, para que los principiantes no 
se vean abrumados por la varie­
dad.
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C-40 Botón de tarjeta de formato

D Ó N D E

Cada tarjeta en la cuadrícula.

T É C N I C O

Botón simple con layout de tarjeta: icono (p. ej., 
document zipper para PLY, archive box para SPZ, 
icono de vídeo para vídeo orbital) arriba, nombre 
de formato como headline, caption de descripción 
(truncado a 2 líneas), debajo el tamaño de archivo 
estimado (calculado en vivo a partir de formato, 
número de Gaussianos y grado SH y formateado co
mo KB/MB). Al hacer clic se selecciona el formato. 
La tarjeta seleccionada recibe un fondo de acento, 
borde de acento y un icono de check arriba a la 
derecha. El tooltip es la descripción del formato.

E N  P O CA S  PA L A B R A S

Una tarjeta por formato. Haz clic 
en una, se resalta con un co­
lor de acento y un check, y el 
botón de export debajo ajusta 
su texto («Export PLY», «Export 
SPZ», etc.). Cada tarjeta mues­
tra un símbolo encajado, el nom­
bre, una explicación breve de dos 
líneas y el tamaño de archivo 
estimado para tu resultado de 
entrenamiento actual. El tamaño 
te ayuda a elegir con sentido 
— si quieres enviar el resulta­
do por correo, toma la variante 
más pequeña (normalmente SPZ 
o .splat); si quieres seguir tra­
bajando en otro software 3D, to­
ma el de mejor compatibilidad 
(típicamente PLY). Al pasar por 
encima de una tarjeta, el tool­
tip muestra una descripción más 
detallada, por si las diferencias 
entre los formatos no te quedan 
claras.

C-41 Deslizador de duración de vídeo

D Ó N D E

Bajo la cuadrícula de formatos, visible solo cuando 
se elige un formato de vídeo (vídeo orbital o vídeo 
social).

T É C N I C O

Deslizador 3–30 segundos en pasos de 1 segundo, 
vincula a la duración del vídeo en el estado de la 
app. Ancho máximo 300 píxeles. Solo se muestra 
cuando se selecciona un formato de vídeo. Para 
formatos no de vídeo, el deslizador se elimina por 
completo de la vista — sin espacio muerto.

E N  P O CA S  PA L A B R A S

Si eliges un vídeo orbital como 
exportación, aquí puedes deter­
minar la duración. 3 segundos 
= rotación muy rápida, 30 segun­
dos = rotación lenta y tranqui­
la alrededor de tu modelo. Para 
reels de redes sociales (Insta­
gram, TikTok), normalmente 6–10 
segundos es ideal — lo bastan­
te largo para mostrar el modelo, 
lo bastante corto para que los 
espectadores no se vayan. Para 
presentaciones o vídeos de port­
folio puedes con gusto tomar 15–
20 segundos. El deslizador solo 
aparece cuando se selecciona un 
formato de vídeo; para formatos 
de archivo como PLY o SPZ no 
tendría sentido y se oculta.
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C-42 Botón Export

D Ó N D E

Bajo la cuadrícula de formatos (y bajo el deslizador 
de duración, si se eligió vídeo).

T É C N I C O

Gran botón de acento. Etiqueta: «Export {format-
-name}», icono de share. Al hacer clic se abre 
el diálogo de guardar de macOS con una exten
sión adecuada al formato y nombre predeterminado 
«scene.{ext}»; en la confirmación, la exportación se 
escribe en la URL elegida. Deshabilitado cuando no 
hay resultado de entrenamiento o ya está corriendo 
una exportación.

E N  P O CA S  PA L A B R A S

Clic, elige el destino en el diálogo 
de macOS, listo — la app escribe 
el archivo en el formato elegido 
en el destino seleccionado. Nom­
bre predeterminado es «scene.
{extensión}» (p. ej., «scene.ply» 
o «scene.spz»), lo puedes cam­
biar en el diálogo como quieras 
antes de guardar. El botón está 
atenuado mientras no haya aún 
resultado de entrenamiento (no 
debería ocurrir aquí, porque en 
otro caso no estarías en el paso 
de exportación) u otra exporta­
ción ya está corriendo. En cuanto 
corre la exportación, aparece ba­
jo él una visualización de progre­
so; la app sigue operable, así que 
puedes preparar ya la siguiente 
exportación.

C-43 Barra de progreso de exportación

D Ó N D E

Bajo el botón Export, visible solo mientras corre una 
exportación.

T É C N I C O

Visualización de progreso con ancho máximo 300 
píxeles, debajo el caption «Exporting… N %». El va
lor corre de 0 a 1 y se actualiza durante la escritura 
— con PLY en chunks de 10 000 Gaussianos, con 
SPZ una vez tras la cuantización, con vídeo orbital 
en intervalos de frame.

E N  P O CA S  PA L A B R A S

Mientras corre la exportación, 
ves aquí el progreso como barra 
estrecha más visualización en 
porcentaje. PLY suele estar listo 
en segundos, porque el archivo 
simplemente se escribe binaria­
mente. SPZ tarda un poco más, 
porque los datos se cuantizan y 
comprimen en el proceso. El ví­
deo orbital es la exportación más 
costosa en tiempo — aquí cada 
fotograma se rerenderiza; según 
resolución y duración, puede du­
rar un minuto o más. Durante la 
exportación, la app sigue opera­
ble, así que puedes preparar ya 
el siguiente formato o seguir ha­
ciendo clic en la vista.
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C-44 Visualización de error de exportación

D Ó N D E

Bajo la barra de progreso, visible solo cuando ocu
rrió un error durante la última exportación.

T É C N I C O

Línea roja con icono de aviso y texto de error. Fondo 
rojo con opacidad del 8 %, esquinas redondeadas. 
Ancho máximo 400 píxeles. Causas comunes de 
error: SOG espera cwebp  en el PATH del sistema 
(no compatible con App Store); error de escritura 
con espacio de disco lleno; error de sandbox con 
destinos de guardado fuera del área permitida.

E N  P O CA S  PA L A B R A S

Si la exportación va mal, aquí 
aparece en rojo una breve des­
cripción en texto claro del pro­
blema. Normalmente la causa es 
obvia — sin espacio en disco, 
sin permisos de escritura para la 
carpeta de destino, o un destino 
fuera de las áreas permitidas por 
el sandbox. Específicamente con 
el formato SOG ocurre que falta 
cwebp  en el sistema; en este 

caso SOG no es utilizable y tienes 
que recurrir a SPZ. Si el mensaje 
de error no está claro, mira en el 
directorio de logs (Help → Open 
Training Logs), allí dice de forma 
más exhaustiva qué fue mal. En 
caso de duda, ayuda simplemen­
te elegir un destino distinto — p. 
ej., el escritorio.

C-46 Lista de historial de exportación

D Ó N D E

Lado derecho del paso de exportación.

T É C N I C O

Lista sobre el historial de exportación (persistente 
como JSON en los UserDefaults, mantenida tras ca
da exportación exitosa). Cada fila muestra insignia 
de formato (pequeña, color de acento), marca de 
tiempo (HH:mm), nombre de archivo (truncado a 1 
línea) y tamaño formateado. El clic en una fila abre 
Finder con el archivo seleccionado. Estado vacío: 
«No exports yet».

E N  P O CA S  PA L A B R A S

Una lista de tus exportaciones 
previas — formato, hora, nom­
bre de archivo, tamaño, en orden 
cronológico. Haz clic en una fila y 
el archivo se resalta en Finder sin 
que tengas que navegar por car­
petas tú mismo. Práctico cuando 
necesitas la última exportación 
de nuevo una hora después y ya 
no sabes dónde la guardaste — 
el historial lo recuerda. Si nun­
ca has exportado nada, aquí hay 
una pista amistosa «No exports 
yet». La lista sobrevive a los re­
inicios de la app, porque se alma­
cena en los UserDefaults.
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C-48 Menú contextual del historial (clic derecho)

D Ó N D E

Clic derecho en una fila del historial.

T É C N I C O

Menú contextual en cada entrada de la lista con 
dos acciones: «Reveal in Finder» (abre Finder con 
archivo seleccionado, como el clic simple) y «Copy 
Path» (coloca la ruta de archivo completa como 
texto en el portapapeles). Lo último es útil para 
arrastrar y soltar en otras apps o para pasar a la 
línea de comandos.

E N  P O CA S  PA L A B R A S

El clic derecho en una entrada 
del historial abre un pequeño 
menú con dos acciones. «Reveal 
in Finder» hace lo mismo que un 
clic normal — abre Finder con el 
archivo seleccionado, así que lo 
ves de inmediato. «Copy Path» 
coloca la ruta de archivo comple­
ta en el portapapeles, para que la 
puedas pegar p. ej. en comandos 
de terminal, en otras apps o en 
una nota. Particularmente prác­
tico cuando quieres pasar la ex­
portación a alguien o abrirla en 
otro programa que trabaja con 
entrada de ruta. Funcionalmente 
un detalle pequeño pero útil que 
apuesta por patrones de interac­
ción típicos de Mac.

¿Cuándo está completo el flujo?

Tras una exportación exitosa, tienes tu modelo 3D como archivo en disco y el historial 
muestra una nueva entrada. No hay un botón «Done» — puedes anexar cualquier 
número de exportaciones en distintos formatos sin reentrenar. Si quieres volver a la 
previsualización (p. ej., para comprobar de nuevo una perspectiva de cámara), usa el 
botón Back en la barra de navegación inferior. Si quieres empezar una escena comple
tamente nueva, ve vía Back a Z1 y usa allí Clear All, o File → New Project (Cmd+⇧+N).

Cambiar a Modo Experto

Pulsa Cmd+2 en cualquier momento o elige Mode → Expert Mode ( M8 ). Todo el estado 
se conserva: imágenes importadas, ajuste preestablecido elegido, entrenamiento en 
curso o terminado, nube de puntos terminada, historial de exportación, incluso la etapa 
actual. En Modo Experto, en lugar de la etapa de cuatro pasos, se muestra la barra 
lateral completa del Inspector con todos los ~150 campos de control. En particular: 
el Project Navigator (véase Capítulo 2) ofrece las operaciones de imagen extendidas 
(botón menos, borrado por backspace, deshacer con Cmd-Z, previsualización Quick 
Look), la previsualización en vivo en la vista durante el entrenamiento, así como todos 
los parámetros de loss, MCMC, densificación y Mip-Splatting. Cmd+1 cambia de vuelta 
a Modo principiante — esto tampoco pierde estado.
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Preguntas frecuentes

¿Por qué mi botón Start Processing se mantiene atenuado?

Aún no has importado imágenes o un vídeo. Arrastra al menos un archivo a la zona de 
drop o usa «Browse Files». En cuanto la lista de imágenes a la derecha contenga al 
menos una entrada, el botón se vuelve activo. (Con solo 1–2 imágenes sí arranca, pero 
SfM aborta directamente con un error — véase el banner de validación rojo.)

¿Por qué mi botón Export está bloqueado?

En Modo principiante hay dos niveles: (a) Si la pipeline de entrenamiento aún no ha 
terminado y no tienes ninguna, el botón está deshabilitado — tienes que terminar pri
mero Z2. (b) Si aún no has comprado la versión completa (PurchaseManager.hasAccess 
== false), ves, en lugar de la etapa de exportación, una vista de lock con icono de 
candado y botón «Unlock Full Version», que abre el sheet de compra. Los ajustes Quick 
y Preview permiten entrenar gratis, pero la exportación es premium.

¿Por qué no puedo elegir un ajuste preestablecido?

Puedes elegirlo — pero si tocas un ajuste premium (Balanced, Quality, variantes MCMC) 
sin una versión completa comprada, el selector vuelve automáticamente a Preview y el 
sheet de compra se abre. Quick y Preview son los únicos ajustes utilizables libremente.

¿Por qué mi zona de drop está vacía y de un gris discontinuo, aunque estoy arras­
trando imágenes?

Probablemente un desajuste de tipo UTI. La app acepta JPG, PNG, TIFF, HEIC, MP4, 
MOV más los formatos splat propios de la app. Otros formatos de imagen (BMP, GIF, 
WebP, formatos RAW) NO se reconocen. Si estás seguro de que tu tipo de imagen 
debería estar incluido, comprueba la extensión del nombre de archivo — la app va prin
cipalmente por extensión, no por contenido del archivo.

¿Por qué SfM tarda tanto, aunque solo tengo 30 imágenes?

Apple Photogrammetry no escala linealmente — con algunas constelaciones de imagen 
(espacios interiores con texturas complejas, motion blur, mala luz) tarda significativa
mente más de lo que sugeriría el número de imágenes. Si SfM sigue colgado tras más 
de 10 minutos con 30 imágenes, aborta e inténtalo de nuevo con mejor material, o 
pasa al Modo Experto y prueba COLMAP/Native SfM (Cmd+2 → Inspector → Camera 
Alignment).

¿Dónde encuentro mis training logs?

Help → Open Training Logs (Cmd+⇧+L). Eso abre ~/​Documents/​RadianceKit/​Logs/​. 
Cada sesión de entrenamiento escribe su propio archivo JSONL con marca de tiempo 
en el nombre de archivo — la primera línea es la configuración, después sigue una línea 
de progreso cada 100 iteraciones, la última línea es el resumen con loss final y flag de 
éxito.

241 / 242



R A D I A N C E K I T Capítulo 10 — Modo principiante

C O LO F Ó N

Compuesto en SF Pro · Código en SF Mono · 
Typst 0.14 · 22. June 2026

© 2026 Bjoern Kindler · Bischofshofener Str. 9, 82008 Unterhaching, Alemania

Hecho con ♥ en Unterhaching

242 / 242


	Introducción — Lo que debes saber
	¿Qué es RadianceKit?
	¿Qué es Gaussian Splatting?

	Capítulo 1 — Barra de menús
	Menú File
	Menú Mode
	Menú Training
	Menú Viewport
	Menú Export
	Menú Help
	Aviso: Cmd-Z en el menú Edit
	Resumen de atajos de teclado

	Capítulo 2 — Inspector (Vista Experto)
	Sección Look (L1–L5)
	Sección Presets (I1–I11)
	Sección Training Configuration (I12–I22)
	Sección Enhancements (I26–I29, I42–I44)
	Sección Metrics (I30–I38)
	Sección Loss Chart (I39–I41)
	¿Cómo leer la curva de loss?

	¿Cuándo recurrir al Inspector?

	Capítulo 3 — Ajustes
	Pestaña General
	Pestaña AI Helpers
	Ajustes espejo del Inspector
	¿Cuándo qué?

	Capítulo 4 — Ventanas auxiliares
	User Guide (W1–W4)
	Keyboard Shortcuts (W5–W6)
	Manage Storage (W7–W12)
	Pareto Dashboard (W13–W22)
	Holdout Analysis (W23–W29)
	BayesOpt Console (W30–W39)
	Ventana principal: curva de loss y número de Gaussianos (I39–I41, referencia cruzada)
	Caja de reglas prácticas

	Capítulo 6 — Configuración del entrenamiento
	Iteración (T1–T2)
	Learning Rates (T3–T10)
	Densificación — Classic (T11–T16)
	Loss (T17–T20)
	Progresión de grado SH (T21)
	Rendimiento (T22–T25)
	Diagnóstico y preparación de la nube de puntos (T26–T30)
	Regularización (T31–T37)
	Refinamiento (T38–T44)
	Sky Dome (T45–T48)
	Adam + schedule de LR (T49–T55)
	Post-procesado + Apple AI (T56–T60)
	Densificación MCMC (T61–T73)
	Mip-Splatting (Q1.5) (T74–T76)
	Densificación adaptativa (Q5) (T77–T79)
	Currículum (Q6) (T80–T81)
	Ajustes preestablecidos estáticos (TP1–TP9)
	Método:
	¿Qué campo para qué? (Cheat Sheet)
	Campos peligrosos

	Capítulo 7 — Ajustes preestablecidos de calidad integrados
	¿Qué ajuste preestablecido en cada caso?
	Comparativa rápida
	Ajustes preestablecidos personalizados

	Capítulo 8 — Formatos de exportación
	¿Qué formato en cada caso?
	Comparativa rápida

	Capítulo 9 — Backends de SfM
	¿Qué backend en cada caso?
	Comparativa rápida

	Capítulo 10 — Modo principiante
	Z1 — Importar (elegir imágenes y ajuste preestablecido)
	¿Cuándo pasar a la siguiente etapa?

	Z2 — Procesado (SfM + Entrenamiento)
	¿Cuándo pasar a la siguiente etapa?

	Z3 — Previsualización (rotar modelo 3D)
	¿Cuándo pasar a la siguiente etapa?

	Z4 — Exportar (elegir formato y guardar)
	¿Cuándo está completo el flujo?

	Cambiar a Modo Experto
	Preguntas frecuentes


